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I. GRAFIK DIZAYN

Ushbu qo£llanmaning birinchi qismida biz grafik dizayn haqida 
so£z yuritamiz. Rasm chizish yoki kompozitsiyalar qila olish 
to£g£risida emas, buning uchun qobiliyat va ta’bning o£zi yetarli. 
Bundan tashqari, ko£pgina foydalanuvchilar Photoshop yoki 
CorelDRAWni ozgina o£rganib olib, o£zlarini dizayner deb 
hisoblasalar-da, biz hech qanday grafik paket bilan ishlash 
xususiyatlari to£g£risida gapirmaymiz. Grafik dizayn xuddi fan singari 
aniq aksioma va qoidalar yordamida tuzilgan, adashishlar va 
kashfiyotlar qilingan fandir.

Siz faqat shu bobni o£qibgina dizayner bolmaysiz. Lekin biz 
o£ylaymizki, sizlar asosiy narsani tushunasiz: agar biror narsa 
to£g£ri bajarilgan bo£lsa, u obyektiv sabablarga ko£ra sifatli tayyor- 
langan, lekin yaratuvchi bu darajaga o£z qobiliyati va nazariy 
bilimlari hisobiga erishdi.

Biz o£quvchi shu narsani tushunishini xohlaymiz: rassomlik 
qobiliyatiga ega bo£lmasdan turib ham dizayner bo£lish mumkin. 
Lekin buning uchun inson «nima yaxshi-yu, nima yomon»ligini 
aniqlaydigan qoidani juda to£g£ri tushunib olishi kerak.

Biz o£lcham, shakl, tekstura rangi, joylashishi va shrift kabi 
tushunchalar to£g£risida fikr yuritamiz. Yana kompozitsiya masalasiga 
ham to£xtalamiz. Shakllantirishga urinib ko£raylik, tanlash, ayniqsa, 
tanlashdan voz kechish nimaga asoslanadi. 0 £zingiz tushunasiz, 
ko£pincha variantlar juda ko£p bo£ladi, yaxshilari esa sanoqli. Biz 
boshlovchi dizaynerlar yo£l qo£yadigan asosiy xatolami va ulaming 
kattaroq hamkasblarida bo£ladigan adashishlarni aks ettirishga 
harakat qilamiz.

Lekin bu dizaynga soddalashtirilgan qarash, xolos. Agar bu 
sizga qiziqarli ko£rinsa, dizaynning asosiy savoli — «qanday qilib 
chiroyli qilish mumkin». Bu savolga to£liqroq javob bera oladigan 
ko£plab kitoblar mavjud.
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1.1. Oicham

Olcham nimaligi hammamizga u yoki bu darajada yaxshi 
ma’lum — maktab davrlarida geometriya fani aniq ta’rif bergan. 
Lekin inson his-tuyg‘usi uchun o ‘lcham aniq m atem atik 
ifodalangan tushuncha hisoblanmaydi. M asalan, agar biz 
evkaliptning balandligini 100 metrga yaqinligini bilsak, bu bizga 
unchalik ko‘p narsa bennaydi. Lekin agar bu 30 qavatli uyning 
balandligi ekanligini bilsak, u holda bu daraxtning balandligi 
to‘g‘risida aniq tasawur hosil qila olamiz.

Shunday qilib oMcham — nisbiy tushuncha. Biz uni 20 cm, 3 m, 5 
km sifatida emas, balki «mitti», «o‘rtacha», «katta», «ulkan», 
«bahaybat» kabi qabul qilamiz. Hammasi inson qabul qiladigan 
sezgilarga asoslanadi, inson sezgisi esajuda egiluvchan. Biz jumaldagi 
miniaturani ko‘rayotganimizdagi katta va kichik tushunchalar katta 
kartinani ko‘rayotganimizdagi katta va kichik to ‘g‘risidagi 
tushunchalardan farq qiladi.

Ishdagi aniq bir obyektning o‘lchamlarini tanlashda kompo- 
zitsiya birgalikda qandaydir g‘oyaga (umuman olganda, zamonaviy 
dizaynning asosiy vazifasi — ma’lumot yoki buyruqni maksimal 
darajada yetkazib berish) ega bo‘lishi to‘g‘risida o‘ylash kerak. 
Shuning uchun, aytaylik, uyali telefon reklamasida aynan uyali 
telefon ajralib turishi kerak.

Kompozitsiyadagi biror-bir obyektga 
e’tiborni nafaqat uning hajmini boshqa 
obyektlarga nisbatan kattaroq qilib jalb 
qilish mumkin, balki buning teskarisi: 
katta hajmdagi detallarga keskin qarshi 
turuvchi kichkina detalga ham jalb qilish 
mumkin. Bu holatda, aynan u asosiy 
ma’lumot sifatida, qolganlari esa fon 
sifatida qabul qilinadi. Bu narsa e’tiborni 
bitta raqamga jalb qilingan 1.1-rasmda 
ko‘rsatilgan.

Shuning uchun bitta kompozitsiyada 
yaxshi «ishlovchi» obyekt (ko‘pincha) 
boshqa o‘lchamlarni yaxshilab o‘zgartir- 
masdan turib mos kelmaydi. Bunda ishni 
bajarayotganda nafaqat ko‘zga (ko‘z bilan 
olingan ma’lumotni qanchalik aldamchi-

1.1-rasm . K om po- 
zitsiyadagi obyektga 
e’tibomi nafaqat uning 
hajmini kattaroq qilib 
jalb qilish m um kin, 
balki buning aksi ham 
boMishi mumkin.
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ligini professionallar juda yaxshi bilishadi), balki shakl, tekstura va 
ranglar odamning olchamini qabul qiluvchi sezgilariga ta ’siri 
to‘g‘risidagi o‘z bilimlariga ham tayanishi kerak.

Shakl va oHcham
Olchamni qabul qilish obyektning shakliga bogliq boladi. Bu 

inson ko‘zining yorug‘lik interferensiyasini qabul qilish 
xususiyatlari bilan bogliq. Amalda murakkab tuzilishga ega, asosan 
bo‘laklardan iborat obyektlarning o ‘lcham j
jihatidan qiyin baholanishiga ko‘p bor duch 
kelish mumkin. Albatta, agar ularning nisba- 
tan katta, qolgan kompozitsiya obyektlariga 
nisbatan gabaritlarini solishtirsak, bunday 
muammo yuz bermaydi. Lekin murakkab 
shaklning kichik bo‘laklari, umuman obyekt- 1.2-rasm . Bu 
ning o‘lchamiga ta’sir qiluvchi qismi sifatida qabul figuradagi nurlar

n . 1  . 1 1 1  . tl , . , lari sifatida qabulBu misol bizm shaklnmg o lchamm qabul qj]jnmaycjj
qilishga m unosabatin i belgilovchi asosiy
tushunchaga olib keladi. Bu kompaktlilik yoki zichlik. Ba’zida eng
zich figura sifatida adabiyotlarda doira keltiriladi. Bizningcha, bu

qilinmaydi. obyektning qirra-

juda ham to‘g‘ri emas.
r

iv I 1

— i Biz shaklning kom -
^ \ j  paktliligini uning maydo-

|  nini belgilangan chegara-
lardagi to‘ldirilmagan sohaga 

/  i nisbat sifatida aniqladik.
I A / r  1 1 1_ -o  A / r -  1 1 -Murakkabmi? Misol orqali 

tushuntiramiz. Aytaylik, siz- 
ga ikki figura — to‘rtburchak 
va doirani ikki tanga va 
markalarga joylashtirish kerak

a

b

| C t  J W J  XCU31 L V ± ± li3 1  L  F

bo‘lib qoldi (1.3-rasm).
Ko‘rinib turibdiki, mar- 

ka uchun kvadrat kompakt- 
roq figura, tanga uchun esa 
doira hisoblanadi.1.3-rasm. Doira va kvadrat 

shaklidagi obyektlarni 
joylashtirish: 

a - markaga; b — tangaga.

Qabul qilishning mana 
shu nisbiyligini doimo yodda 
tutish kerak, chunki aynan
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kompaktlilik oclchamlarni qabul qilishni belgilaydi. Zichroq figura 
doimo yirikroq ko‘rinadi. Bu narsa 1.3-rasmdagi markada aniq 
ko‘rinib turibdi.

Bu xossadan amalda quyidagicha foydalaniladi. Aytaylik, ikkita 
masala turgan bo‘lsin: vizitkalardan foydalanish uchun shartli 
ravishda «AGGW» deb nomlanuvchi kompaniyaning logotipini 
chizish kerak bo‘lsin. Agar siz kartochkada bu elementning 
muhimligini ta ’kidlamoqchi va unga e’tiborni jalb qilmoqchi 
bo‘lsangiz, u holda logotipning kompakt shaklda tayyorlashga to‘g‘ri 
keladi (1.4-rasm, a). Agar logotip e’tiborni jalb qilmasligini, balki 
faqat fon sifatida ishlatilishini xohlasangiz, u holda sizning 
tanlovingiz (1.4-rasm, b ) bo‘lishi kerak. Va bu, e’tibor bering, 
vizitkaning bir xil o‘lchamlarida ko‘rinadi.

AGGW
b

1.4-rasm. Logotip shakli: a — kompakt; b — kompakt bo‘lmagan.

Tekstura va lcham
Teksturaning qo‘llanilishi yangi effektlarni yasash, predmet 

qiyofasini murakkablashtirish, unga ma’no berish imkoniyatini 
yaratadi. Lekin tekstura yana obyektning o‘lchovini qabul qilishga 
ham ta’sir qilishi mumkin va buni albatta hisobga olish kerak.

M
1.5-rasm. Yorug‘roq predmetlar katta ko‘rinadi: yorqin chiziqlaming 

yo‘nalishi shu yo‘nalish bo‘yicha predmetning uzayishi kabi illuziyani
hosil qiladi.
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1.5-rasmda bir xil geometrik oMchamga ega ikkita kvadrat 
keltirilgan. Lekin shunga qaramasdan tik polosali kvadrat ancha 
«og‘ir», gorizontal tekislikka nisbatan yirikroq ko‘rinadi. Gorizontal 
polosali kvadrat esa yengil ko‘rinadi.

Bu effekt anchadan beri m a’lum. Eski jurnallardan to ‘la 
ayollarga vertikal polosali ko‘ylaklar kiyish to‘g‘risidagi tavsiya- 
larni o‘qish mumkin — ular ayollarni asliga nisbatan ixcham 
ko‘rsatish xususiyatiga ega.

Amalda bu hodisadan ko‘p foydalaniladi. Obyektga qo‘shimcha 
«mustahkamlik» berish kerak bo‘lsa, gorizontal yo‘nalganligi yorqin 
ravishda ko‘rinib turadigan rasmlardan (aytaylik, g‘isht taxlamli 
tekstura) foydalaning. Agar aksincha, bosib turuvchi o‘lchamdan 
qutulmoqchi bo‘lsangiz, vertikal yo‘nalishga asoslaning.

Tekstura bilan yana bitta effekt bog‘langan. 1.6-rasmdagi birinchi 
tasvir go‘yoki bizdan uzoqlashib borayapti, ikkinchisi esa, 
aksincha, yaqinroq ko‘rinadi. Bu effekt oq rangning o‘zining 
fonidagi barcha predmetlami «egishi»ga asoslangan. Bu effektni bilish 
va uning asosi haqida kitobda ko‘plab misollar keltirilgan aylanaviy 
gradiyentlar bilan ishlashni qo‘llay bilish kerak.

Shunday qilib, tekstura obyektlarini tasvirlashda ijobiy hamda 
salbiy (uni noto‘g‘ri tanlanganda) ta’sir qilishi mumkin ekan. 
Bunga juda e’tibor bering va shunda bunga o‘xshash narsa siz bilan 
sodir bo‘lmaydi.

a b

1.6-rasm. Oq va qora aylanaviy polosalaming almashishiga asoslangan 
effektlar: a — uzoqlashish; b — yaqinlashish.

Rang va o ‘lcham. Bu biz uchun o‘lchamlarga bag‘ishlangan 
eng murakkab qismdir. Masala yana o‘sha — uni qabul qilishning 
nisbiyligidir. Ko‘pincha biz yirikroq, boshqalari orasida ajralib 
turadiganlariga, garchi bunga obyektiv sabablar bo‘lmasa-da, 
e’tibor beramiz.
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Shunday qilib, birinchi va eng asosiy xossa: qora fondagi yorqin 
obyektlar yorqin fondagi qora obyektlarga nisbatan yirikroq 
ko£rinadi (1.7-rasm).

1.7-rasm. Qora fondagi yorqin obyektlar yorqin fondagi qora obyektlarga 
nisbatan yirikroq ko‘rinadi.

Bir-biridan yorqinligi bo£yicha keskin ajralib turuvchi, masa- 
lan, logotipdagi obyektlarning simmetrikligini ta ’kidlamoqchi 
bo£lsangiz, buni albatta hisobga olishingiz kerak. Tomoshabinga siz 
o£z ishingizni unchalik sifatli bajarmagandek ko£rinishingiz uchun 
qora elementni kattalashtirishga to£g£ri kelishi mumkin.

1.8-rasmda biz qora doira radiusini 2%ga orttirdik — yo£qsa logotip 
o£ylagan natija chiqmasdi.

Design 
WEB

1.8-rasm. Bu ishda doiralar bir xil ko‘rinishi uchun qora doiraning 
radiusi oq doiranikiga nisbatan 2% ga oshirilgan.



Shunga o£xshash, yorqin-qizil element o£zi bilan teng to£q- 
ko£k elementga nisbatan ancha kattaroq ko£rinadi. Buni ham ish 
jarayonida e’tiborga olish kerak.

1.2. Rang

Biz rangli dunyoda yashaymiz. Har kuni, hatto uydan 
chiqmasdan turib ham inson juda katta sondagi ranglami ko£radi. 
Biz bunga ko£nikib qolganmiz va ranglaming tabiati, ular bizga va 
bizning xatti-harakatlarimizga qanday ta ’sir qilishi haqida 
o£ylamaymiz ham. Garchi bu, balki unchalik to£g£ri bo£lmasa-da: 
har bir ayol qanday holda yorqin-qizil ko£ylak kiyishni, kulrang 
kostyum esa qanday holda to£g£ri kelishini juda yaxshi biladi.

Biz ranglaming asiri bo£lib yashaymiz. Bizning fikrlarimiz, his- 
tuyg£ularimiz — hammasi o£zining rangiga ega. Qora rang — fikrlar, 
ko£k — sog£inch, zangori — kayfiyat kabilami esga olish va tushunish 
uchun yetarli: predmetning psixologik qabul qilinishi uning rangi 
bilan yetarlicha qattiq bog£langan.

Odatiy hayotda bu unchalik katta ahamiyatga ega emas. Lekin 
hozir gap ranglaming kompyuter grafikasida qo£llanilishi to£g£- 
risida borayapti va bu yerda biz nafaqat ranglardagi farq, balki bir 
rangning darajasini ham his qila olishimiz, ulami qo£llanilishi inson 
tomonidan qabul qilishga qanday ta’sir qilishini tushunishimiz 
kerak.

To£g£ri tanlangan ranglar tasvirga e’tibomi jalb qilishi ham, 
qaytarishi ham mumkin. Siz quvonch, qiziqish, sog£inch, qo£r- 
quv, zerikish kabi ranglami o£zgartirgan holda hosil qilishingiz 
mumkin.

Ranglar juda ko£p, lekin psixologlaming ta’kidlashlaricha, har 
bir shaxsning o£z xususiyatlari bilan bog£liq bo£lgan sevimli 
ranglari bor. Shuning uchun ham ranglami tanlashda o£rtacha 
tomoshabinning tavsiya qilingan psixologik portretiga ham suyanish 
kerak.

Qo£shimcha murakkablik shundan ham kelib chiqadiki, rang 
obyektiv fizikaviy kattalik sifatida tabiatda bo£lmaydi. Ranglami his 
qilish, garchi elektromagnit nurlanishlaming obyektiv faktorlari 
ta’sirida ro£y bersa ham subyektiv deb hisoblanadi. Bundan tashqari, 
ranglami tasvirlashda turli mamlakatlarda milliy-madaniy an’analarga 
asoslangan turlicha rang modellaridan foydalaniladi. Kompyuter 
grafikasi bilan professional tarzda shug£ullanadigan har qanday



kishi duch keladigan ranglardagi tasvirlaming rang-barangligini 
shu bilan tushuntiradi.

Shakldan farq qilib, subyektiv tushunchaligiga qaramay, 
ranglar olamida dizayner bilishi va amalda qo£llay olishi kerak bo£lgan 
umumiy qonuniyatlar mavjud.

Biz oldin rang qanday tuzilganligini tahlil qilib olishimiz kerak. 
Aslida bu jiddiy monografiyaning mavzusi, shuning uchun biz 
fiziologik va spektral xususiyatlariga to£xtalib o£tirmaymiz, balki 
hammasini soddalashtiramiz.

Dastlab rangni tashkil etuvchilarga ajratamiz. Barcha mavjud 
modellardan faqat HSV (Hue — Saturation — Value, Rang — 
To£yinganlik — Yorqinlik) gina uni biz odatlangan holda tasvirlaydi 
va ko£nikishni talab qilmaydi.

HSV tizimi uchta komponentaga ajratiladi.
♦ Rang (Hue) — bu bevosita rang to£g£risidagi malumot. Buni 

oddiy tilda tushuntirish qiyin, shuning uchun o£z qarashlaringizga 
ishoning.

♦ To ‘yinganlik (Saturation) — ranglar, kundalik hayotdan siz 
bilasizki, u yoki bu darajada to£yingan bo£ladi. Oddiy tilda ko£proq 
to£yingan rangni ko£proq suvli deyishadi.

♦ Yorqinlik (Value) — osongina topish mumkinki, yorqinroq 
rang yorug£roqdek qabul qilinadi.

Shuni ta’kidlash kerakki, nafaqat har bir inson, balki butun 
xalqlar bir xil rangga turlicha munosabat bildirishadi. Bu shu xalq 
tarbiyalagan an’analar bilan bog£liq. Masalan, Yevropa mamla- 
katlarida oq rang — tozalik va begunohlik rangi, ba’zi bir sharq 
xalqlarida esa u motam rangi hisoblanadi.

Asosiy ranglami xarakterlashga urinib ko£ramiz.
Ranglaming issiqva sovuqqa bo£linishi 1.9-rasmdatasvirlangan. 

Bu bo£linish ma’lum darajada shartli: rang qanchalik yuqori va 
quyi yarim doiralarga yaqin bo£lsa, uni issiq yoki sovuqqa ajratishga 
ishonch shuncha kamroq.

Qizil
Ko£pchilik kishilarda qizil rang olov bilan to£g£ridan-to£g£ri 

bog£lanish hosil qiladi. Shuning uchun ham uning ta’siri ham har 
xil bo£lishi mumkin — salbiydan tortib ijobiygacha. U pulsni 
tezlashtirish va qorachig£ni kengaytirish xossasiga ega, lekin o£zining 
yorqinligi tufayli tez charchatadi, ayniqsa, ko£p miqdorda bo£lsa 
(masalan, agar xona devorlari shu rangda bo£lsa).
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Sariq

1.9-rasm. Ranglami sovuq va issiqqa bo‘linishini ko‘rsatuvchi 
aylana doirasi.

Toza qizil rang — bu xavotirlanish va hayajonlanish rangi, lekin 
uning turlari (jigarrang, qizg£ish) tinchlantiruvchi ta’sir qiladi. Qizil 
o£ziga diqqatni jalb etadi (deyarli barcha ogohlantiruvchi belgilar 
qizil fonda yoki qizil yozuvda qilinishi tasodifiy emas).

Bu rang kompyuter grafikasida ko£p qo£llaniladi, lekin charchatib 
qo£ymasligi uchun u bilan ishlashda ehtiyot bo£lish kerak.

Qizil rang to£g£ri keladi:
■ Agressivlikni, faollikni ta’kidlash uchun. Masalan, eng yaxslii 

sport mashinalari, jumladan, Ferrari asosan qizil rangda ishlab 
chiqariladi;

■ Kuchli hisni, seksual xohishni. Buni shu bilan tasdiqlash 
mumkinki, erotik dasturli tungi klublar bezagida juda ko£p qizil 
rang ishlatiladi;

■ Ayovsizlikni ifodalash uchun (qizil — qon rangi);
■ Boylik, dabdabalilikni ta’kidlash uchun (ayniqsa qora rang 

bilan birgalikda).
Sariq
Bu rang doirasidagi eng yorqin rang. U yaxshi kayfiyat, 

umidvorlikni uzatish uchun juda mos rang. Aynan shuning uchun 
sariq — turistik kompaniyalar reklamasida eng ko£p qo£llaniladigan 
ranglardan biri.
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Bundan tashqari, sariq rang — bu oltin rangi. Shuning uchun 
u ko£pchilikda omad, boylik va dabdaba tuyg£ularini vujudga keltiradi.

Binafsha rang
Iliq, musbat, yorqin va zamonaviy rang tetiklashtiradi. Pulsni 

tezlashtiradi va qorachig£ni kengaytiradi. Zamonaviy duzaynda, 
ayniqsa, web-dizaynda ko£p qo£llaniladigan ranglardan biri.

Binafsha rang, agar xohlasangiz, quyidagilami ta’kidlash uchun 
ishlatilishi mumkin:

■ Zamonaviylik. 0 £zini brendining asosiy qirrasi sifatida 
zamonaviylikni tanlagan ko£plab kompaniyalar «firma rangi» sifatida 
binafsha rangni tanlashadi. Bu ayniqsa, uyali telefon operatorlari 
orasida keng tarqalgan:

■ Harakatchanlik;
■ Optimizm. Yorqin plakatlami yaratish uchun binafsha rang 

bachkana, lekin amaliy jihatdan ideal variant.
Tajribalaming ko£rsatishicha, binafsha rang yashil rang bilan 

birga juda yaxshi ko£rinadi.
Lolarang
Ranglar doirasini qizil rangdan ko£k rangga borgan sari sekin- 

asta o£tishini payqamay qolamiz, axir xuddi o£sha yerda ajoyib 
rang berkinib turibdi — lolarang. Bu qabul qilishga juda qiyin rang, 
chunki u tabiatda deyarli uchramaydi. U xuddi ko£k va yashil 
ranglarga o£xshab sovuq guruhga kiritiladi. U torlik, chegaralanganlik 
tuyg£usini hosil qilish xususiyatiga ega. U yana tez charchatadi va 
faollikni susaytiradi.

Lolarang «yerlik emas», unga qandaydir yashirinlik xos. 
Yaqingacha mistikada lolarangga alohida o£rin ajratilgan. Agar siz 
ko£zboylog£ichlaming tomoshalarini ko£rgan bo£lsangiz, ulaming 
kiyimi, narsalari, pardalarida bu rang juda ko£p. Lolarang kishilarda 
noaniq, tushunarsiz qo£rquvni hosil qila oladi.

Shunday qilib lolarang quyidagilar uchun to£g£ri keladi:
■ mistik kayfiyatni hosil qilish uchun;
■ yashirinuvchanlikni ta’kidlash uchun.
K o‘k
Ko£k rang sovuq guruhga kiradi, rang doirasining eng quyisida 

joylashadi. U tinchlantiradi, ba’zan melanxolik kayfiyatni tarqatadi.
Bu rangni «doimiy muzlik» zonasi ranglariga kiritish mumkin: 

u sovuq va tozalik sezgisini uzatadi. Tinchlantirib, juda yaxshi ta’sir 
qiladi, yotoqxonalaming dizayni uchun juda mos.

12



Toza ko£k rangning to£yinganligi va yorqinligining o£zgarishi 
bizga juda ko£p ranglami berishi mumkin (to£g£ri, CMYK — 
tizimning o£ziga xosligi tufayli aynan ko£k rangni bosib chiqarishda 
yaxshi tasvirlanmaydi).

■ Sokinlikni ta’kidlash uchun ko£k rangdan foydalaning;
■ Tozalik. Siz e’tibor bergan bo£lsangiz kerak, barcha sifatli 

tozalovchi vositalar ko£k yoki yashil rangda bo£ladi. Bu tasodifiy 
emas: olimlaming isbotlashicha aynan shu rang ko£pgina kishilarda 
tozalik tuyg£usi bilan mos keladi:

■ Mustahkamlik.
Zangori
Ajoyib rang. U ham iliq, ham sovuq bo£lishi mumkin, ammo 

ko£pincha u birlashgan joyda yotadi, shuning uchun uni ham sovuq 
guruhga, ham iliq guruhga kiritish mumkin.

Zangori rang tinchlantiruvchi ta’sir qiladi, qon bosimini pasay- 
tiradi, qon aylanishini normallashtiradi. Bu eng tabiiy va eng «tirik» 
rang. Uning dizayndagi asosiy vazifasi aynan shunda — obyekt 
bilan tabiat aloqasini uzatish. Umuman olganda, logotiplar ko£rib 
chiqsa, zangori rang asosan tabiat resurslarini qazib oladigan 
kompaniyalarda yoki ekologik tashkilotlarda uchraydi.

Agar siz zamonaviy blokbasterlami ko£rsangiz, u holda biologik 
qurollar, boshqa dunyo jonzotlari va boshqa biologik mavjudotlar 
yashil (ayniqsa yorqin yashil) rangda bo£lishiga e’tibor bergan 
bo£lishingiz kerak.

Bundan tashqari, zangori rang — mistika va yashirinlilik rangi.
Zangori rang quyidagilami uzatish uchun mos keladi:
■ barcha biologik ko£rinishdagi tiriklik;
■ tabiat bilan aloqa;
■ yashirinlik.
Yashil
Yashil rang tinchlantiradi va sovitadi. Bunday natija sovuq suv 

va muzga o£xshashligi tushuntiriladi. Ba’zan yolg£izlik tuyg£usini 
vujudga keltiradi.

Asosiy ranglar: qora va oq
Siz sezgan bo£lsangiz kerak, biz barcha asosiy ranglami ko£rib 

chiqdik, lekin rang aylanasining hamma yerida bo£lgan va shu bilan 
hech qayerda ko£rinmaydigan ikkita rang — qora va oq ranglar 
haqida so£z yuritmadik.

Qora rang o£zining takrorlanmas yaxlitligi bo£yicha — o£zida 
zerikish, alamni olib yuruvchi og£ir rang. Charchoq va o£ng£ay- 
sizlikni keltirib chiqaradi. Shunga qaramasdan kishilar shu rangdagi
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kiyimlami tanlashadi. Bu holda u klassikaga, shu bilan birga aniq 
bir stil hosil qiladi. Yana bu rang qolgan barcha ranglar bilan u yoki 
bu darajada kelisha oladi. Qora rang — bu dabdaba rangi, ayniqsa, 
qizil rang bilan birgalikda. Bizning an’analarirnizda uni motam rangiga 
kiritish qabul qilingan.

Oq rang — juda quvnoq rang. Toza havo bilan bogliqligi tufayli 
u yengillik, erkinlik va vaznsizlik tuyg‘ularini hosil qiladi. Pulsni 
tezlashtiradi va qorachig‘ni kengaytiradi. Oq rang fonni yaratishda 
anchagina ko‘p qo‘llaniladi. Oq rang o‘zicha hech qanday malumot 
yetkazmaydi, boshqa barcha ranglar bilan yaxshi moslashib, 
yorqinroq rangli ohanglami hosil qiladi. Bu rang begunoh va tozalik 
ramzi hisoblanadi.

Ranglarning o ‘zaro mosliklari
Ranglaming ozaro mosligi masalasi — bu dizayndagi eng bahsli 

va turlicha talqin etiladigan savollardan biri. Haqiqatan bu yerda 
«har kimning ta’bi har xil» tamoyili hamma narsadan ustun. 
Shuning uchun universal qoidalar to‘g‘risida, afsuski, gap ham 
bo‘lishi mumkin emas.

Lekin qandaydir qonuniyatlarni topish mumkin. Shunday 
qilib, birinchi va eng sodda tamoyil — yorqin ranglarni tanlash. 
Kiyimni «ohang» bo‘yicha tanlanganidek, web-sahifada ham 
ranglami tanlash mumkin.

To‘g‘ri, bunday yondashuv juda qoloq va professional ishlar uchun 
to‘g‘ri kelmaydi. 0 ‘zaro mos keladigan ranglami qidirish uchun 
ranglar doirasidan foydalanish qiziqarliroq (1.10-rasmga qarang).

Sariq
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■ Aralash ranglar yomon o‘rin almashmaydi, ammo bunday 
variantni tanlash odatda zerikarli va bachkana hisoblanadi.

■ Bir-biriga qaram a-qarshi joylashgan ranglar yomon 
kelishadigan ranglar hisoblanadi. Yagona istisno — ko‘k rang sariq 
bilan juftlikda yomon ko‘rinmaydi.

■ Eng yaxshi tanlov — 1.10-rasmda to ‘g‘ri chiziq bilan 
tutashgan ranglardan bitta keyingi rang. Bu ranglar o‘zining ko‘plab 
turlariga juda yaxshi mos keladi, asosiysi yorqinlikda juda katta farq 
bolmasligida.

Yana bir muhim narsa, qora va oq qolgan barcha ranglar bilan, 
ayniqsa, bir-biri bilan juda yaxshi mos keladi. Shuning uchun, 
agar tanlash imkoniyati bolsa, ishni aynan shu ranglar yordamida 
osonroq bajariladi.

Lekin ranglami tanlashda asosiysi oriyentir bo‘lib bari bir ta’b 
(kimdadir bu tug‘ma boladi) va tajriba (vaqt o‘tishi bilan orttirilgan) 
bolishi kerak. Axir har qanday ranglar to‘g‘risida nazariyalarga 
tushmaydigan, lekin sifatli va talantli dizaynerlik ishining namunasi 
bo‘la oladigan juda ko‘plab yechimlar mavjud-ku.

1.3. Shakl

Shakl — bu har qanday obyektning eng muhim qismidir. Biz 
rang, tekstura, o ‘lcham to ‘g‘risidagi m a’lumotlarni tushurib 
qoldirishimiz mumkin, lekin shakl to‘g‘risida doimo eslashga to‘g‘ri 
keladi. Har qanday dizaynerlik ishi obyektlar uchun shakllarni 
tanlab olishdan boshlanmog‘i lozim.

«Shakl» tushunchasiga ta’rif berish ancha murakkab. Agar ozgina 
bo‘rttirib gapirsak, bu obyektning barcha geometrik munosabatlari 
yig‘indisidir. Judayam ko‘p miqdordagi shakllar bor, shuning uchun 
ularni faqat qurilishiga ko‘ra sinflarga ajratish mumkin.

■ Ko ‘pburchaklar. Bunday figuralar to‘g‘ri chiziqlardan quriladi. 
Ularga biz o‘rganib qolgan to‘g‘ri chiziq, uchburchak, kvadrat, 
yulduzchalar hamda murakkabroq figuralar ham kiradi (1.11- 
rasm, a).

m Egri chiziqlilar. Bu figuralar silliqlangan chiziqlarga asoslangan 
figuralardir (1.11-rasm, b). Ularga doira, oval, yoy va boshqalar 
kiradi.

■ Amorf. Bular aniq bo‘lmagan murakkab shakllardir (1.11- 
rasm, d). Amorf figuralar teksturalarga juda yaqin bo‘ladi, shuning 
uchun ba’zida ularni differensiyalash qiyin bo‘ladi.
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a) b) d)

1.11-rasm. Figuralarning uch tipi: a — ko‘pburchak; b — egri chiziqlilar;
d — amorf.

Shakllar bilan ishlash — bu dizaynerlik ishining eng oddiy va 
eng qiziqarli qismidir. Shakllarning mosligi to ‘g‘risida ko‘p 
avlodlaming tajribalari mavjud, shuning uchun ko‘pchilik shakllar 
bilan ishlaganda (rang bilan ishlagandagidan farq qilib) o‘z 
qarashlari yetarli bo‘ladi. Lekin shakllaming asosiy formalari 
to‘g‘risida keyinroq gaplashamiz.

Chiziq
Chiziq — geometrik figuralaming eng soddasi. Nazariy jihatdan 

u faqat bitta o‘lchamga — uzunlikka ega bo‘ladi. Garchi amalda 
ulaming rangi, tipi (aytaylik, punktir chiziqlardan foydalanish 
keng tarqalgan) va yo‘g‘onligini ham berishga duch kelamiz. Ba’zida 
chiziq bilan to ‘g‘ri to‘rtburchak o‘rtasidagi farqni bilish qiyin.

Chiziqlaming ikkita asosiy funksiyalari bor: boshqa obyektlami 
ajratish va birlashtirish.

Ajratish — kitoblami bezashda 
keng rivojlangan va rivojlanayotgan 
klassik usul hisoblanadi. Dizaynda 
ham u juda faol ravishda ishlatiladi 
(1.12-rasm).

Lekin chiziqlaming qo‘llanilishi 
(tipografiya term inologiyasida 
ajratish chiziqlari deb ataladi) 
bachkana va judayam oshkora usul 
hisoblanadi. Agar sizga ishni oddiy 
va tez qilish kerak bo‘lsa, bu yaxshi

OQ QORA

1.12-rasm. Chiziqlarni ajratish 
uchun foydalanish.
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variant, lekin agar ajratish chiziqlari yordamida original nimadir olmoqchi 
bo‘lsangiz, ishlashga to‘g‘ri keladi.

A\-tayluk, matn bloklarini ajratish uchun Sabab 
fondagi ranglar farqidan yoki bo‘sh blok- 
lardan foydalanish qiziqarliroq.

Chiziqlarning birlashtirish funksiyasi 
qiziqarliroq. Aytish mumkinki, bu zamonaviy 
dizaynning eng yorqin va keng tarqalgan 
qirralaridan biri. Chiziqlar bu holda ma’lu- 
motlar bliklari yoki grafik komponentalar 
o‘rtasidagi o‘zaro muhim ta’sir funksiyasini 
bajaradi (1.13-rasm).

Chiziqlar — bu xohlagan vaqtda yordamga 
kelishga tayyor bo‘lgan o‘ziga xos «kaltak- 
qutqaruvchi». Bu mutaxassisning ishida doimo bo‘lishi kerak 
bo‘ladigan ikki narsa: yaxlitlik va dinamizmni kompozitsiyaga 
kiritishning eng oddiy usuli.

Ish davomida chiziqlar o‘quvchilar uchun bir elementdan 
ikkinchisiga o‘tishni ko‘rsatib turuvchi yo‘naltiruvchi rolini o‘y- 
nashlari kerak. Shuning uchun ulardan foydalanishda nafaqat tashqi 
jozibani, balki mantiqiy asoslanganlikni ham o‘ylash kerak.

To ĝ r̂i to‘rtburchak
To‘g‘ri to‘rtburchak — dizayn uchun butunlay o‘ziga xos figura, 

kompyuter dizayni uchun ayniqsa. Va buning sababi oddiy. Ko‘pgina 
saqlovchilar: plakatlar, kitob sahifalari — deyarli barcha poligrafik 
mahsulotlari, kompyuter ekrani to ‘g‘risida gapirmayoq, to ‘g‘ri 
to‘rtburchak shaklida bo‘ladi. Bunday holat bu figurani avtomatik 
tarzda eng ko‘p ishlatiladigan, eng keng tarqalgan figura qilib qo‘yadi.

To‘g‘ri to‘rtburchakka asoslangan dizayn — bu eng oddiy va 
oshkora ko‘rinib turgan yo‘l. Buning isboti sifatida siz ko‘plab web- 
sahifalarni ko‘rishingiz mumkin va ishonch hosil qilishingiz 
mumkinki, ulaming barchasi shu formadan kelib chiqqan.

To‘g‘ri to ‘rtburchaklar bilan ishlaganda eng muhimi — 
proporsiyani to ‘g‘ri tanlash. Kvadratga yaqin keluvchi figuralar 
unchalik yaxshi variant hisoblanmaydi: bunday yechim o‘zining 
simmetrikligi tufayli modadan qolgan hisoblanadi. Lekin judayam 
cho‘zilgan ham yomon: agar gorizontal bo‘yicha bo‘lsa, «yer- 
lashganligi» vertikal bo‘yicha muvozanatsizligi tufayli cho‘zilgan 
bo‘ladi.

v
Oqibat

1.13-rasm. Chiziq- 
larning birlash- 

tiruvchi funksiyasi.

17



Qadimdan oltin kesim deb ataluvchi to ‘g‘ri to ‘rtburchak 
tomonlarining nisbati ma’lum. Bu nisbat 0,618 ga teng. Albatta, 
bu har qanday vaziyatdan chiqish degani emas, lekin uni albatta 
hisobga olish kerak — butun klassik arxitektura oltin kesimga 
asoslangan.

Uchburchak
Bu flgura ko‘p jihatdan yaxshi, lekin 

chiziqlar yoki to ‘g‘ri to ‘rtburchaklar 
singari keng tarqalm agan. Sababi 
shundaki, uchburchak kompozitsiyadagi 
qolgan figuralar bilan qiyin moslashadi.

Uchburchak, aytaylik, logotip asosida 
yomon ko‘rinmaydi (1.14-rasm).

Bu holatda figura asosining pastga 1-14-rasm. Uchburchak 
t , t • r- • asosidagi logotipga misol.qo yilganligi ajoyib tuyg um — figuranmg

va bu esa o‘z navbatida kompaniyaning mustahkamligini beradi. 
Bunday effekt anchadan beri m a’lum, shuning uchun butun 
dunyodagi ko‘plab firmalar uchburchakni o‘z belgilari qilib 
tanlaganlar.

Bu figura bilan erishiladigan ikkinchi effekt — «ko‘rsatuvchi» 
effektdir. Uchburchakning strelkani — biz ko‘nikkanimizdek, 
yo‘nalishning standart ko‘rsatkichini eslatishi uni tomoshabinlar 
e’tiborini yo‘naltiruvchi element sifatida ishlatishga imkon beradi. 
Masalan, 1.15-rasmda shartli idea.com saytidagi so‘zlarning 
qiymatlariga e’tibor qaratilgan.

1.15-rasm. Fondagi uchburchak bu misolda ko‘rsatkichli strelka 
vazifasini o‘taydi.
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Fon sifatida ishlatiladigan uchburchak yordamida biz bir 
tomondan saytning sifatlarini ajoyib tarzda gruppaladik, ikkinchi 
tomondan — bu malumotni birdaniga sayt nomiga yo‘naltira oldik. 
Boshqa usullar bilan bunga erishish oson emas.

Doira
Doira ko‘pgina rivojlangan jamiyatlarda eng mukammal, ilohiy 

figura hisoblangan. Doira quyoshning belgisi bo‘lgan. Maqbara va 
qurbonlik uchun mehroblar doira shaklida qurilgan.

Zamonaviy dizaynda bu figuraga talab qolmagan. Doira sahifalari 
va ekranning to‘g‘ri to‘rtburchak shakli judayam kontrastga kirishadi.

Albatta, kontrast — bu unchalik yomon emas, lekin kompyuter 
dizayni sohasida kontrast asosida sifatli ishlar bajarish — buni haqiqiy 
professional mutaxassisgina bajara oladi.

1.16-rasmda bosmaxonalardan birining saytini birinchi sahifasi 
ko‘rsatilgan. Sahifaning yaxshi chiqishiga sabab shuki, rubrikator 
aylananing butun uzunligi bo‘yicha tarqatilmagan, uning bir 
tomoni bo‘ylab kompakt tarzda joylangan. Bundan tashqari, 
yuqoridagi yirik gorizontal matnli blok kompozitsiyaga stabillik 
qo‘shadi. Lekin baribir brauzer oynasida sahifa unchalik muhim 
ko‘rinish olmaydi.

PUBUSHING HOUSE
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1.16-rasm. Aylana asosida qurilgan web-sahifa. 
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Siz o‘zingiz eslashga urinib ko‘ring, aylana asosida qurilgan 
saytlami ko‘p ko‘rganmisiz. Bu sahifani original tarzda bezatishning 
eng yaxshi usuli, lekin shu bilan birga uni buzib qo‘yishning ham 
eng oddiy usuli hisoblanadi.

Hozirgacha doira o‘zini to‘la oqlaydigan yagona narsa bu 
logotiplami yaratishdir. Deyarli barcha firmalardagi belgilaming 
yarmi o‘zining asosidagi doirani qabul qilgan. Garchi, faqat 
ba’zilarini istisno qilganda, bu ishlar ma’no jihatdan ham, bajarilishi 
jihatdan ham originalligi bilan ajralib turmasa-da, eng keng tarqalgan 
misol — aylana yordamida «0» harfiga o‘xshatiladi (1.17-rasm).

K
1.17-rasm. Aylana yordamida «0» harfiga o‘xshatish — bu figuradan 

dizaynda muvaffaqiyatsiz foydalanishga misol.

Bir so‘z bilan aytganda, agar sizda tajriba kam bo‘lsa, bu figura 
bilan hozircha ishlamagan ma’qul. Qachon yaxshi mutaxassis 
bo‘lganingizda aylana bilan ishlash siz uchun bartaraf qilinib, 
original natijalami olsa bo‘ladigan qiyinchiliklami chaqiruvchisi 
bo‘lib qoladi.

Egri chiziqlar
Egrilik — bu bir nechta har xil darajadagi egrilikka (matematik 

til bilan u ikkinchi tartibli egri chiziq deyiladi) ega bo‘lgan chiziq 
(1.18-rasm).
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1.18-rasm. Ikk inch i tartib li egri ch iziq lardan  tuzilgan  figura.

Zamonaviy kompyuter dizaynida bu figuralar yetarli darajada 
keng qo‘llaniladi (asosan ular to ‘g‘ri chiziqlar bilan bir xil 
maqsadlarda ishlatiladi). Ammo ular bilan haddan tashqari qiziqib 
bo‘lmaydi: siz asming boshlarida urf bo‘lgan Modern stilida 
bajarilgan ishni olishingiz mumkin, bu esa, unchalik sifatli emas.

Formaning yo‘qligi
Albatta, formaning yo‘qligi to‘g‘risida gapirish unchalik ham 

to ‘g‘ri emas — forma doimo mavjud bo‘ladi. Lekin uning 
murakkabligi tahlil qilish imkoniyatini yo‘q qilsa, bunday obyektni 
formasiz deb atash mumkin.

Formasiz obyektlardan foydalanish — to‘g‘ri burchakli for- 
malarning qat’iy mantiqiyligiga qarama-qarshi qo‘yiluvchi 
zamonaviy dizaynning yana bitta ustunligidir. Va undan u yog‘iga 
borish mumkin bo‘lmagan simmetriyaga qarshi kurashning 
chegarasidir.

Formasizlikni quyidagilami ta’kidlash uchun ishlatish mumkin:
■ mustaqillik;
■ ultra zamonaviylik;
■ ommaviylik;
■ e’tiroz;
■ nostandartlilik.
Formasizlik ayniqsa shrift bilan hamkorlikda yorqin namoyon 

bo‘lishi mumkin. Bu ko‘rinishda u insonning originalligi, agressiv- 
ligini juda to‘g‘ri aks ettiradi.

Formaning yo‘qligi kamchilik hisoblanmaydi, ko‘proq aksincha — 
axir boshqa hech nima original yechimni topishda bunchalik keng
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imkoniyatlar bermaydi. Bu yerda obyektlarning kompanovkasi 
figuralarni tanlashdan kam ahamiyatga ega bo‘lmaydi. Ammo bu 
haqda keyinroq gapiramiz.

Shriftli dizayn
Shriftlar bilan ishlash — dizayner ishining eng qiziqarli, ko‘proq 

rejali va eng murakkab qismidir. Agar siz matnlar bilan u yoki bu 
darajada shu kasbning ustasi bolmoqchi bo‘lsangiz, shriftlaming 
dizayni bo‘yicha maxsus adabiyotlami sotib olib va ulami o‘rganishga 
ancha vaqt sarflashingiz kerak bo‘ladi.

Shunday qilib shriftlar asosan uch turli bo‘ladi:
■ bezakli;
■ qat’iy;
■ erkin stilda.

Design
°) Design

b) Design
d)

1.19-rasm. Shriftlarning uch tipi: a —bezakli; b — qat’iy; 
d — erkin stilda.

Garnitura
Shriftlarning dizaynida biz yuqorida aytib o‘tilgan yaxlitlik va 

kontrastning boshqa tamoyillari ishlaydi. Kesimli va maydalangan 
shriftlar ko‘proq mos keladi. Bunga tajriba davomida qanchalik 
ko‘p ishlatilishini ko‘rib, ishonch hosil qilishlari qiyin emas.

Maydalangan shriftlar qo‘lyozma ko‘rinishida ishlangan shriftlar 
bilan ham mos kelmaydi, lekin bu absolyut qoida emas. Dekorativ 
va kesimli shriftlar bir-biri bilan juda yomon moslashadi — bunday 
qo‘shnichilikdan qochishga harakat qiling.

0 ‘lchov
Yozuvlaming olchovini tanlash anchagina murakkab hisoblanadi. 

Dastlabki keladigan fikr — agar birorta yozuv katta bolsa, u holda 
ko‘ruvchilar tomonidan ham unga qiziqish katta bo‘ladi. Lekin bu 
unchalik qiziqarli emas.
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Information
&

Design
1.20-rasm. Judayam yirik matn ko‘ruvchi informativlik funksiyasini 

yo‘qotadi va dizayn elementi sifatida qabul qilina boshlanadi.

Ammo yirik harflar logotiplar, sarlavhalar, ko‘rsatkichlar — 
bir so‘z bilan aytganda dekorativ funksiaysi informativlik 
funksiyasidan kam bo‘lmagan hamma elementlar tarkibida juda 
yaxshi ko‘rinadi.

Mayda shriftlar o‘zida harfni ham jamlaydi. Bizning ishda u 
o‘quvchi qiynalmay o‘qiy olishi uchun unchalik ko‘p bo‘lmasligi 
kerak. Bundan tashqari, alohida matnli bloklar yetarli darajada 
mustaqil, ya’ni bo‘shliq bilan ajratilgan bo‘lishi kerak.

Rang
Umuman olganda bu bo‘limda aytilgan rangli dizaynga 

bag‘ishlangan barcha qoidalar matnlar uchun ham o‘rinlidir. 
Faqat bir fikrni qo‘shib qo‘yish kerak: agar siz bitta so‘zdagi 
bitta harfni yoki bitta gapdagi bitta so‘zni ajratib ko‘rsatmoqchi 
bo‘lsangiz, u holda yoki rangdan foydalaning, yoki garnituradan. 
Ularni birgalikda ishlatish hayratlanarli darajada yomon natijaga 
olib keladi (1.21-rasm).

PHOTOSHOP PHOTOSHOP 
PHOTOSHOP

1.21-rasm. Fragmentni ikki marta ajratib ko‘rsatish 
(gamitura va rang bilan) — yomon usul.
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1.4. Qisqacha kompozitsiya to‘g‘risida

Kompozitsiya to£g£risida suhbat boshlash hech bo£lmasa shuning 
uchun murakkabki, bu mavzu alohida e’tibor talab qiladi. Biz 
kompozitsiyalar mavzusini ochishga talabgor emasmiz — buning 
uchun, agar siz haqiqatda tajribali dizayner bo£lmoqchi bo£lsangiz, 
o£qishingiz mumkin bo£lgan maxsus kitoblar bor. Ammo agar siz 
kompozitsiyalar nazariyasi bilan umuman tanish bo£lmasangiz, 
bu bo£limni diqqat bilan o£qib chiqing.

Kompozitsiyalar nazariyasining asosida biz ko£p narsani 
ixtiyorsiz, instinkt va reflekslar darajasida qabul qilishni tushu- 
namiz. Obyektlaming bir xil joylashishida barcha kishilarda bir xil 
reaksiya hosil bo£ladi. Masalan, 1.22-rasmdagi aylana bilan 
to£rtburchakning qanday joylashishida sizda havfsirash, o£ng£ay- 
sizlik tuyg£usi hosil bo£ladi. Mualliflaming ishonchi komilki, bu b 
variantdir.

1.22-rasm. Kompozitsiyadagi obyektlaming turlicha joylashuvlari qarama- 
qarshi tuyg‘ularni vujudga keltirishi mumkin: a — stabillik; b — o‘ng‘aysizlik.

Shunday qilib, har qanday kompozitsion ish asoslangan 
bo£lishi kerak. Dizaynda esa, ko£pchiligimizni hayratlantirgan, 
nazariyani bilmasdan turib, kerakli natijaga deyarli erishish 
mumkin emas.

Kompozitsiyaning asosida ikki tushuncha yotadi: yaxlitlik va 
kontrast.

Yaxlitlik
Bu tushuncha o£zida bitta maqsadga olib kelishi kerak bo£lgan 

ko£plab talablami jamlaydi. Hatto aytish mumkinki, yaxlitlik — 
bu usul emas, balki dizayndagi maqsad, yakuniy natijada ish, u
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logotip yoki Web-sahifa bo£ladimi, yaxlit butun ko£rinishga 
bo£lgan talabdir.

Amalda esa, bu o£zini vositalar tomonidan chegaralashni 
bildiradi. Sodda qilishdan qo£rqmang! Aksincha, sizning 
dizayningizdan soddaroq nimadir o£ylab topish qiyin bo£ladigan 
darajada soddalikka intiling. Agar shriftning bitta gamiturasidan 
foydalanishga imkoniyat bo£lsa, bitta gamitura ishlating, imkoniyat 
bo£lsa, butun dizaynni bitta figuraga keltiring.

Yaxlitlik tamoyiliga ko£pincha boshlovchi web-ustalar amal 
qilishmaydi. Bizningcha, siz GIF-animatsiyalar, katta hajmli 
elementlar, ulkan sarlavhalar va juda yorqin ranglarda yaratilgan 
ijod namunalarini ko£p ko£rgansiz. Ayniqsa, o£zlarini tajribali 
dezayner hisoblovchi va o£z xizmatlarini anchagina katta mablag£ 
evaziga taklif qiluvchi bu asarlaming mualliflari juda o£ng£aysiz 
ko£rinishadi. Ulaming xatolarini takrorlamang, aqlsiz yoki uquvsiz 
ko£rinishdan qo£rqmang — oddiylikka intiling.

Kompozitsiyada yaxlitlikka erishishning eng muhim kompo- 
nenti — bu muvozanatga erishish. Muvozanat — sizning ishingisni 
ko£rgan kishilarda «bu yerda nimadir yetishmayapti», degan tuyg£u 
hosil bo£lmasligi kerak.

Kompozitsiya muvozanatiga nafaqat obyektlaming nisbatan bir 
tekisda taqsimlanishi hisobiga emas, balki ulaming o£lchamlari, 
rangi, yorqinligi, formasi hisobiga ham erishiladi. Masalan, web- 
sahifaning bir tomonida sizda kattagina matnli blik bo£lsa, u holda 
ikkinchi tomondan bezak yoki qora fon hisobiga muvozanatga 
keltirish mumkin.

Muvozanat asosan ikki tipli bo£ladi: rasmiy va norasmiy.
Rasmiy muvozanat kompozitsiyaning optik markazi atrofidagi 

simmetriyani nazarda tutadi. Rasmiy muvozanatga ko£proq 
simmetriyaning hisobiga erishiladi.

Rasmiy muvozanat — bu kompozitsiyadagi garmoniyaga 
erishishning eng oddiy usullaridan biridir. Lekin u simmetriyani 
nazarda tutadi, simmetriya esa, bu kitobda bir necha bor ta’kid- 
langanidek, zamonaviy dizaynda deyarli aqlli yechim deb hisob- 
lanmaydi. Har holda kompozitsiyasiz simmetriya bilan ishlagan 
ma’qulroq. Bu hech bo£lmasa shu narsani bildiradiki, klassik san’at, 
ayniqsa, klassik arxitektura, o £z asosida rasmiy muvozanat 
tamoyillariga amal qilib keladi, ya’ni oltin kesim proporsiyasi, 
formalaming qafiyligi, absolyut simmetriya.
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Rasmiy muvozanatni quyidagi sifatlar aniq ta’kidlashi mumkin:
■ konservatizm;
■ doimiylik;
■ mustahkamlik;
■ munosiblik.
Ammo hozir ikkinchi tip — norasmiy muvozanat ko‘proq 

ishlatiladi. U rasmiy muvozanat kabi aniq-ravshan belgilarga ega 
emas, shuning uchun unga tajriba yordamida va ta’bga asoslangan 
holda erishish mumkin.

Norasmiy muvozanatga ko‘plab usullar bilan 
erishish mumkin, lekin ulaming mazmuni bitta — 
anchagina sodda fikrga olib keladi: simmetriyadan 
tashqari hamma narsa mumkin. Ya’ni agar siz web- 
sahifada yoki reklama varaqchasiga yirik figurani 
joylashtirgan bo‘lsangiz va u boshqalardan kuchli 
darajada ustunlik qilayotgan bo‘lsa, boshqa figura- 
larning ranglarini o‘zgartirish hisobiga uning 
yorqinligini kamaytirish mumkin. Ya teskarisi, yirik 
matnli blok o‘lchami bo‘yicha ancha kichik, lekin 
butun figuralar bilan yengil muvozanatga kirishadi 
(1.23-rasm).

Norasm iy m uvozanatga erishishda eng 
murakkabi biz shu bobdagi qoidani buzmaslik — 
hammasini oddiy qilish. Yariantlaming ko‘pligi shunga olib keladiki, 
biz u yerga ozgina qo‘shamiz va bunga qo‘shimcha qo‘shamiz, natijada 
zamonaviy dizaynni o‘miga obyektlar uyulmasini hosil qilamiz.

Kompozitsiyaning yaxlitligi uchun barcha elementlar (iloji 
boricha) yagona ritmga rioya qilgan holda joylashsin. Ritm — bu 
kompozitsiyada obyektlar bilan bo‘sh o‘rinlaming yoki obyektlar 
bilan boshqa obyektlarning belgilangan tartibiga rioya qilishdir 
(1.24-rasm).

COLOMNS inc.

1.24-rasm. Logotip dizaynida ritmdan foydalanish.
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Aniq bir ritmga erishishga intilishda (axir u ishning umumiy 
«kayfiyatiga» kuchli ta’sir qiladi) eng oddiy yechimdan — oshkora 
simmetriyadan qochishga harakat qiling.

Kontrast
Kontrast to‘g‘risida biz oldin gapirib o‘tdik. Kontrast — bu 

zamonaviy dizaynning asosi. U yoki bu darajadagi professional 
ishlar kontrastga asoslanadi yoki komponenta sifatida kontrastga ega 
bo‘ladi.

Bir tomondan, kontrast — yaxlitlikning qarama-qarshisidir. 
Bu bilan kompozitsiyadagi butunlikka erishilmaydi, aksincha, 
kontrastning maqsadi obyektlar o‘rtasidagi farqlarni ta’kidlashdir. 
Lekin bu ikki tushunchalami bir-biriga qarshi qo‘ymaslik va ular 
o‘zaro kelisholmaydi deb o‘ylamaslik kerak. Aynan kontrast bilan 
yaxlitlik o‘rtasidagi «oltin oraliq»ga intilish kerak.

Kontrast to ‘g‘risidagi asosiy fikrlar oldinroq aytib o‘tildi. 
Shuning uchun hozir biz oldinroq aytilganlami kompozitsiyadagi 
kontrastning har biri to‘g‘risida bir nechta so‘z qo‘shgan holda 
jamlaymiz.

■ O ‘lcham. Kontrastga erishishning eng yaxshi usullaridan biri — 
bir xil geometrik flguralar o‘lchamlari o‘rtasidagi farq. Lekin shuni 
esda tutish kerak: agar bu farq yetarli darajada katta bo‘lmasa, 
tomoshabin uni dizayneming ishi deb emas, balki xatolik deb 
qabul qiladi (1.25-rasm).

a b

1.25-rasm. Kontrast: a — figuralar orasidagi yetarlicha bolmagan farq xatolik 
singari qabul qilinadi; b — bu farqning orttirilishi holatni tuzatishi mumkin.

Forma
Formadan yaxshisi kompozitsiyani yaxlitligini ta’kidlash uchun 

foydalangan ma’qul. Masala shundaki, egri chiziqli va to‘g‘ri chiziqli 
flguralar o‘zaro oshkora, qo‘pol, naturalistik kontrastga egaki,
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faqat ko‘pchilik professional ishlami bajara olmaydi. Agar figuralar 
bir-birlariga o‘xshamasa (masalan, kvadrat va uchburchakdek), u 
holda ulaming birlashtirilishi yakunlanmaganlik tuyg‘usini beradi, 
tomoshabinlami g‘ashini keltiradi (1.26-rasm).

1.26-rasm. Kontrast: a — egrichiziqli va to‘g‘richiziqli figuralar juda qo‘pol 
kontrast yaratadi; b — bir tipdagi formalar orasidagi farq unchalik sezilarli

ifodalanmagan.

■ Rang. Ranglardagi farqlar yordamida toMa kontrastga erishib 
boMmaydi. Lekin u toMdiruvchi sifatida, «ikkinchi ovoz» uchun 
juda ajoyib variant.

■ Shrift. Shriftlar o‘z-o‘zidan formalaming oshkora kontrastlikni 
namoyon qiladi. Shuning uchun gamituralar o‘rtasidagi ortiqcha 
oshkora farqlami qidirish dizayndagi tavtalogiya kabi rolni o‘ynaydi. 
Ehtiyot boMing!

Butun kompozitsiya bo‘yicha kontrast — bu hamma sanab 
o‘tilgan kontrastlaming yig‘indisi. Unga erishishda meyorga e’tibor 
bering: masalan, uning oMchamlari tufayli shundoq ham yaxshi 
kontrast berayotgan elementni alohida rang bilan ajratmang.

II. CORELDRAWDA ISHLASH

2.1. Hujjatni yaratish va ochish

CorelDraw dasturi ishga tushirilgandan keyin ekranda COREL 
DRAWga XUSH KELIBSIZ (welcome to Corel DRAW) so‘zi 
nomayon bo‘ladi va dasturni ishga tushirishning bir nechta 
variantlarini tanlashni so‘raydi: Yangi hujjat (New Graphic), oxirgi 
ishlangan hujjatni ochish (Open Last Edited), hujjatni ochish 
(Open Graphic), tayyor shablonlami ochish (Template), dastur 
0‘rgatuvchini ishga tushirish (CorelTUROR), nima yangilik? 
(What is New?)

28



*]

. f n v

V

* •:

L-jr
NewGraphic Open Last Edited Open Graphic

Template CorelTUTOR W ha fs  New?
.

O p e n a r i  ex isting  file.'

thf; W e lccm e  Screen at -tartVp D B S ifJ O B P -C O fH
ISSSlv

Yangi hujjatni yaratish uchun menyuning Fayl (File) va Yangi 
hujjat buyrug‘i (New) yoki uskunalar panelidagi maxsus tugma 
bosiladi. Hujjatni ochish uchun menyuning Fayl (File) va Ochish 
(Open) buyruqlari yoki uskunalar panelidagi maxsus tugmalar 
yordamida amalga oshiriladi.

CorelDRAW dasturida bir vaqtning o‘zida bir nechta hujjatlar 
bilan ishlash imkoniyatlari bor, shu bilan birga kerak boMmagan 
hujjatlami yopib qo‘ysa ham boMadi. Bu esa, menyuning Fayl 
Yopish (Close) buyrugM yordamida amalga oshiriladi.

Dastur interfeysi
Dastur ishga tushirilgandan keyin ekranda dastur oynasi 

namoyon boMadi, bu oyna foydalanuvchi interfeysi (user interface) 
yoki ishchi joyi (workspace) deb ataladi. Interfeys foydalanuvchi 
va kompyuter orasidagi muloqotni o‘rnatadi, ishlash uchun kerak 
boMgan barcha sharoitni yaratadi.

Shuni nazarda tutish kerakki, interfeys foydalanuvchi 
tomonidan o‘zgartirilgan boMib, umumiy ko‘rinishidan o‘zgacha 
boMishi ham mumkin.

Foydalanuvchi interfeysi quyidagilardan tashkil topadi: sarlavha, 
bosh menyu, hujjatlami ko‘rish uchun ishchi oynalar, tasvirlami 
muharrirlash uchun bir nechta panellar yig‘indisidan iborat.

Oynaning markazidagi katta bo‘sh joy ish joyi deb nomlanib, 
har bir hujjat uchun alohida ochiladi.
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Bosh menyu
Ekranning yuqori qismida bosh menyu buyruqlari (menu bar) 

joylashgan bo‘lib u quyidagilardan tashkil topadi:

Fail (File)
Muharrirlash (Edit) 
Ko‘rish (View) 
Kompanovkalash (Layout) 
Boshqarish (Arrange) 
Effektlar (Effects)

• Rastrli tasvirlar (Bitmaps)
• Matn (Text)
• Servis (Tools)
• Oyna (Window)
• Yordam (Help)

Har bir guruhning bir-biriga yaqin amallarni bajaruvchi buy- 
ruqlar yig‘indisidan, masalan, Matn (Text) menyusi matnlar ustida 
amallar bajaradigan buyruqlar, Effektlar (Effects) menyusi — 
vektorli va rastrli tasvirlar uchun har xil effektlar berish va 
muharrirlashda foydalaniladigan buyruqlardan tashkil topgan.

Shu bilan birga qo‘shimcha menyu (Context-sensitive menu)ga 
kiritilgan bu menyu vazifasi joriy bo‘lgan asbobning obyektlari 
haqida ma’lumot beradi.
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Vositalar satrlari
Menyu satri tagida asboblar satri (Toolbars) joylashgan. 

Asboblar satrini ekranning xohlagan joyiga va har xil ko‘rinishda 
joylashtirish mumkin.

Ekranda kerakli oynalami joriy qilish uchun menyuning oyna 
(Window)si yordamida amalga oshiriladi va ular ustida quyidagi 
amallar bajariladi: Asboblar (Toolbars) satriga sichqonchani o‘ng 
tom oni bilan chertib muloqot oynasini tashkil etamiz va 
Parametrlar (Options), Rostlashgan kerakli bo‘lgan asboblar 
tanlanadi.

Xossalar (Property Bar) satri
CBOHCTBa (Property Bar) asboblar satridagi maydonlar va 

tugmalar yig‘indisi foydalanilayotgan asboblar yoki tanlangan 
obyektga bog‘liq bo‘ladi, masalan, asboblar satridagi matn bloki 
tanlanganda matnning parametrlari ko‘rsatiladi.
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CBOHCTBa (Property Bar) satridagi asboblardan birontasi 
tanlanmagan bolsa, hujjatning umumiy parametrlari ko‘rsatiladi, 
masalan, sahifa formati, uning oriyentatsiyasi va hokazo ko‘rsatiladi.

*  \  G.35 n 
T  E.35 n

Holat satri (Status Bar)
Ekrandagi ishchi oynaning pastgi qismida holat satri (Status 

Bar) joylashgan, bu satrda obyektlar haqida ma’lumotlar beriladi 
yoki quyidagi parametrlar: obvodka va zalivkalar, shrift turlari, 
tanlangan obyekt malumoti va joriy asboblar haqidagi malumot- 
lar beriladi. Holat satrining ko‘rinishi va tuzilishini o‘zgartirish 
ham mumkin.

Arlistic 7ent: AvanfGarde BkBT [Normall on Laysi 1 Fil: Black 
Ojtline None

Asboblar paneli (Toolbox)
Asboblar paneli ishchi oynaning chap tomoniga joylashtirilgan 

boladi. Asboblar panelidagi grafik obyekti ustida quyidagi amallar 
bajariladi — obyektlarni yaratish, ajratish, muharrirlash va 
ko‘chirish.

Asboblar bilan ishlash paytida kursor tanlangan obyektga qarab 
shaklini o‘zgartiradi. Shu bilan birga, asboblar panehdagi ba’zi bir 
asboblar guruhini «Suzuvchi»(«njiaBaiomHe») panel ko‘rinishida 
yoki «Flyout» ko‘rinishida sozlash mumkin.
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Docker kot'rinishidagi panel
Docker ko‘rinishidagi paneli muloqot oyna shaklida boladi. Bu 

panellar har doim ekranda mavjud boladi va ishchi oyna yonida 
joylashadi. Ekranga kerakli bo‘lgan panelni chaqirish uchun 
menyuning Oyna (Window) va Docker (Dockers) ko‘rinishidagi 
panel buyrug‘i va ochilgan ro‘yxatdagi panellardan bittasi tanlanadi.

• Object Manager paneli (^HcneTHep 06i>eKT0B) — obyekt 
parametrlarini tasvirlaydi, obyekt iyerarxiya qatlamlarini boshqaradi.

• View M anager paneli (^ncneTHep bh/iob) — «tasvir 
ko‘rinishlari»ni tasvirlaydi va boshqaradi.

• Graphic and Text Styles paneli (Cthjih TeKCTa h rpa(|)HKH) — 
grafik va matn stillarini yaratadi va o‘zgartiradi.

• Color Styles paneli (UBeTOBbie cthjih) — obyektlar bilan 
ishlashda ranglarni tanlaydi va ular yordamida amallar bajaradi.

• Symbols and Special Characters paneli (Chmbojim h 
cneiiMajibHbie 3HaKH) — mavjud bolmagan belgilami tasvirlashda 
foydalaniladi.

• Internet Bookmark Manager paneli (^HcneTHep 3aKjia^OK 
Internet) — gipermatnlami boshqarish va yaratishda ishlatiladi.

• HTML Object Conflict paneli (AHajiH3aTOp koh(|)jihktob 
06i)eKT0B HTML) — Internetda nashr etilgan awalgi hujjatlar- 
ning to‘g‘riligini tekshiradi va noto‘g‘rilarini tuzatadi.
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• Script and Preset Manager paneli (/jHcncTHcp MaicpocoB h 
roTOBLix o6pa3LioB) — makro dasturlarni yozishda foydalaniladi.

• Object Data paneli (ma’lumotlar jamg‘armasi) — har bir 
obyektning jadvaldagi ma’lumotlari berkitiladi, masalan, narxi, 
oMchami va hokazo ma’lumotlar.

• Object Properties paneli (CBOHCTBa o6i>cktob) — hujjat- 
dagi obyektlarning barcha parametrlari haqida ma’lumot beradi va 
o‘zgarish kiritadi.

• Link Manager paneli (Z^HcneTHep CBii3aHHLix H3o6pa- 
xeHHH) — hujjatda mavjud emas, faqat u bilan bog‘langan 
tasvirlarni boshqaradi.

• Bitmap Color Mask paneli (li,BCTOBaji Macxa ToiieiiHoro 
H3o6pa>KCHHJi) — rastrli tasvirlar bilan ishlashda ranglar maskasini 
yaratadi.

• Lens paneli (JlHH3a) — linza turini tanlash va uning 
parametrlarini o‘rnatadi.

• Artistic Media paneli (MMHTauHJi) — vektorli qalamning 
murakkab turlari bilan ishlaydi.

• Transformation paneli (TpaHcc})opMHpoBaHHc) — obyektlarni 
siljitishning har xil turlari bilan ishlash.

• Shaping paneli ( I i3MeHeHHe cj^opMLi) — bir nechta 
obyektlarni uch xil ko‘rinishda biriktirish.

• Color (U,BeT) va Color Palette Browser (I^BeTOBLie 
najiHTpLi) panellari — ranglar bilan ishlash.

• Browse (063op) paneli — hujjatlarni boshqarish va ularni 
har xil ko‘rinishlarda ko‘rish.

• Cliparts (BeKTopHLie H3o6paxeHHii), Photos (O o to t- 
pac[)HH), 3Dmodels (TpexMepHLie Mo^ejin) panellari — dastur 
bilan birgalikda o‘rnatilgan kompakt disklar bilan ishlash (CD- 
ROM).

• FTP Sites (CaHTLi FTP) paneli — FTP saytlarini saqlash va 
katta massivli ma’lumotlarni ko‘chirish uchun ular bilan tez 
bog‘lanish.

Agarda yuqorida ko‘rsatilgan menyuda qandaydir buyruq 
boTmasa u holda menyuni (Menu) Parametrlar (Options) 
yordamida qo‘shish mumkin.

34



W orkspace

E1 Workspace
General
Display
Edit
Warnings
5ave
Memory
Plug-Ins

+ Text

+ Toolbox

+ Customize
0 -  Document 
0 -  Glohdl

W o rk s p a c e

Current workspace: _default

W orkspaces available:

Adobe(R) lllustrator(R) 
CorelDRAWB

Click an item on the left lo  
display Ihe relafed options

Click Ihe N ew  button to 
create a  custom workspace.

W orkspace settings may be 
saved f or later teuse

New... Delete Set as current

Detault workspace

OK OTMeHa Help

Interfeysni saqlash va o‘zgartirish
CorelDRAW dasturi interfeysini foydalanuvchi o‘zi xohlaganday 

qilib rostlashi va uni xotirada saqlash imkoniyati bor.
Uning uchun quyidagi amallar bajariladi: Menyuning (Tools) 

dan Optsii... (Options) buyruq tanlanadi va ochilgan muloqot 
oynasidan Interfeys (Workspace) tanlanadi. Yangi... (New) tugmasi 
ekranga Yangi interfeysni (New Workspace) yoritadi. Yangi 
interfeysni (New Workspace)da interfeysning yangi parametrlarini 
kiritish uchun foydalaniladi; masalan, Nom-maydoniga yangi 
interfeys nomi (Name of new workspace) kiritiladi va yangi 
interfeysni joriy qilish uchun belgi (Set as current) qo‘yiladi.

New Workspace

Nam e of new  w orkspace :

Base n e w  w o rksp a ce  on: 

D escrip fion  of n e w  w orkspace : 

Set as cu rren t w c rksp a ce

defau lt -

□  K C ance l H e lp
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Hujjatlarni xotirada saqlash
CorelDRAW dasturida hujjatlami xotirada bir nechta usul bilan 

saqlash mumkin.
Menyuning Fayl (File) va Saqlash (Save) buyrug‘i yordamida 

joriy hujjatni joriy jildda saqlaydi. Bu amal asboblar panelidagi 
maxsus tugma yordamida ham amalga oshiriladi.

CoxpaHHTb K aK ... (Save As) buyrug‘i esa joriy hujjatni boshqa 
nom va boshqa jildda, va boshqacha formatda saqlash imkoniyatini 
beradi. Bu amalni bajargandan keyin yangi hujjatni xotirada saqlab, 
ekranga Tasvirni saqlash (Save Drawing) ni beradi.

• Versiya (Version) ro‘yxatidan CorelDRAW dasturining 
awalgi variantlaridan birini yoki yangi variantini tanlab hujjatni 
mos formatda xotirada saqlaydi.

Faqat dasturning eski variantlarida hujjatlarni saqlaganda bir 
nechta parametrlar yo‘qolib ketishini esda tutish lozim.

Save Draw ing

flariKa: O  SYSTEM  (C:]

_RE5T0RE 

' lin f

_ |P ro g ra n n  Files 

' lu nz ipped  

_ |  W IND O W 5 

' I Mon AOKyM eHTbl

File name: 

Files of type: 

S ort type: 

Keywords: 

Notes:

Ju lia .cd r -

S ave

\% 6 65 46 .cd r ij: Backup_of

£  6 6 5 46 2 22 2 22 .cd r *-” 'B ackup_o f

: :  B acku p _o f_6 65 46 .cd r *■ Backup_of

j |  B acku p _o f_6 65 46 2 22 22 2 .cd r i ;  Backup_of

'■j B ack u p _ o f_ G ra p h ic l.c d r S  G ra p h ic l.(

£  B ackup_of_W E B .cdr W EB.cdr

Cancel

Version:

CDR - Core lDFlAW -
Defau lt -

LiEeTHOfi OlffbeKTj

Version 9 .0 T

Thum bnail:

_► | |1 0 K  (color) T f

A dvanced ...

S e lected  onlv 

\ ~  Em bed ICC profile

No w hite  spaces, specia l characte rs  

Em bed Fonts u s ingT rueD cc (TM)

! S ave  w ith  em bedded V BA  P ro ject

• Thum bnail ro ‘yxati xotirada saqlashning bir nechta 
variantlarini beradi: hujjatlaming o‘lchamini bir qancha kichik qilib 
berishi ham mumkin, faqat keyinchalik fayllarni qidirganda 
qiyinchilik tug‘diradi. 1K (mono), 2K (mono), 4K (color), 8K 
(color) oq va qora, yoki rangli tasvirlami har xil sifatda xotirada
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saqlasa ham bo‘ladi. Agarda hech biri tanlanmagan bo‘lsa, u holda 
maxsimal sifatli tasvirli hujjat xotirada saqlanadi.

• Selected only (Faqat tanlangan obyektlar) tanlanganda yangi 
faylga ajratilgan obyektlar saqlanadi, shu bilan birga boshqa faylda 
obyektning alohida qismini ham saqlash mumkin.

• ICC profile (ICC profilini joylashtirish) hujjatdagi ranglarni 
boshqarishda dastur faqat CPT CDR, TIFF, JPEG, PICT h  
EPS formatli fayllar bilan ishlaganda bajariladi.

• No white spaces, special characters (Bo‘sh joy va maxsus 
belgilarsiz) belgisi hujjatni xotirada saqlaganda bo‘sh joy tagini 
chizish bilan, maxsus belgilarni Web standartidagi belgilar bilan 
almashtiradi.

• Embed Fonts using TrueDoc (Shriftlarni TrueDocdan 
foydalanib yozish) hujjatda TrueDoc texnologiyasidan foydalan- 
gani haqida ma’lumot beradi.

• Keywords (kalit so‘zlar) va Notes (Tuchunsha berish) 
hujjatlami tez topish uchun ularga tushuntirish so‘zlari yoziladi.

• Advanced tugmasi... (Qo‘shimcha) ekranga Save (saqlash) 
dialog oynasini va Options, parametrlari o‘rnatilgan bo‘ladi.

• Save presentation exchange (Boshqa muharrirlagichlar 
formatida saqlash) CMX formatida ishlaydigan boshqa muharrir- 
lash faylini oching. Buni ishga tushirganda faylning o‘lchami katta 
bo‘ladi.

^xj
Save

+ Workspace 

-  Document 

General 

Page

Guidelines 

Grid 

Rulers 

Styles 

Save

+ Publish To Internet 

+ Global

' r  Save

| Save presentation exchange (CMX) 

r  Use cuirent thumbnail

F le  optimization:

[s / Use bitmap compression:

Use graphic object compression

T entures:

'•• Save textures with the lile

R ebu id  textures w hen opening Ihe file

Blends and extrudes:

Save blends and extrudes with the lile 

•  Rebuild Uends and extiudes w hen opening Ihe lile

Help
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• Use current thumbnail (mavjud miniaturadan foydalanish) 
rastrlangan hujjatni miniatura yordamida saqlashni ta’minlaydi. Bu 
faylni saqlashga moljallangan vaqtni malum miqdorda kamaytiradi, 
ammo agarda hujjat bir necha marta qayta ishlangan bo£lsa, xatolikka 
olib kelishi mumkin.

• File optimization maydonida (faylni optimallashtirish) ikki 
xil turdagi fayllami saqlaydi, rastr (Use bitmap compression) vektor 
tasvirlami va bu faylning olchamini kicliik qiladi.

•Textures maydoni (Matn zalivka) va Blends and extrudes 
(«Ketma-ket o£tish» va «Ekstrudiya») tarkibiga qaraganda bir 
xil:

> Save ... with the file (fayl bilan saqlash) fayl o£lchami katta 
bo£ladi, faqat hujjat o£qilganda tezroq ochiladi;

>Rebuild ... when opening the file ( n o c T p o i m . ... n p n  o t k p l it h h  
4)aiiJia) — yuqoridagi teskari faylni o£qish ko£p vaqt talab etadi va 
o£lchami katta bo£ladi.

Ekranda tasvirlash
Vektor grafikasi muharrirlarining ekranida (ishchi maydonda) 

qanday tasvirlar bo£lsa, bosmadan shu ko£rinishda chiqariladi. 
Ekrandagi ishchi oynada tayyor bo£lgan tasvirlami ko£rish uchun 
menyuning Ko£rish (View) dan foydalaniladi. Dasturda besh xil 
ko£rinishni ko£rish mumkin: Oddiy konturli (Simple Wireframe), 
Konturli (Wireframe), Chemovoy (Draft), Normal (Normal), 
Yaxslii (Enhanced).

Agarda hech biri tanlanmasa u holda normal (Normal) holatini 
kompyuter o£zi tanlaydi.

Ekranni masshtablash
Ekrandagi tayyor bo£lgan rasmlami katta va kicliik hollarda 

ko£rish funksyalari mavjud. Shuning uchun asboblar panelidagi 
(Toolbox) Masshtab (Zoom) tanlanib, kattalashtirish yoki ki- 
chiklashtirish parametri ko£rsatiladi.

D  -  ig D E i HE
*]

ToFit 
T o Page 
ToWidth 
To Height 
10%
25%

75%
1002
200%
400%
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Standart asboblar panelida 
masshtablash parametrlari berilgan va 
ular quyidagilar: Ajratilgan obyektlar 
(To Selected), hamma obyektlar (To 
Fit), Saliifa (To Page); Sahifaning eni 
bo£yicha (To Width), Sahifaning bo£yi 
bo£yicha (To Height); 10%, 25%, 50%, 
75%, 100%, 200%, 400% ga
masshtablashga bo£linadi.

Ekrandagi tasvirlar kattalashtiril- 
ganda hujjatdagi ba’zi bir obyektlar ko£- 
rinmay qoladi. Obyektlar bilan ishlashga 
to£g£ri kelganda shu obyektlar siljitiladi. 
Buning uchun quyidagi ikkita imko- 
niyatlardan bittasi tanlanadi:

1. Vertikal va gorizontal siljitishlardan.
2. Maxsus asbob Panoramadan 

(Pan). Bu holda ekrandagi kursor qo£l shaklini oladi va obyektni 
xohlagan tomonga siljitishi mumkin.

ChizgHch
Chizg£ich ekranda ko£rinib turadi, agarda u yo£q bo£lsa menyu- 

ning Ko£rish (View) tanlanib Chizg£ich (Rulers) buyrug£ini 
belgilash kerak bo£ladi, ikkinchi marta bu amal bajarilsa ekrandan 
chizg£ich olib tashlanadi.

Chizg£ichni ekranning xohlagan joyiga qo£yish mumkin. Buning 
uchun <Shift> tugmasi bilan birgalikda sichqonchani olib borib 
xolilagan joyga qo£ysa bo£ladi. Agarda <Sliift> tugmasi bilan birgalikda 
chizg£ichga ikki marta sichqoncha bilan chertilsa awalgi holiga 
qaytariladi.

Agarda <Shift> tugmasisiz ikki marta chertilsa, u holda 
cliizg£iclining (Rulers) Parametrlari (Options) ekranda namoyon 
bo£ladi.

CorelDRAW dasturidagi chizg£ich har xil o£lchov birliklarida 
beriladi. 0 £lchov birliklari (Units) quyidagilardir:
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-U-Xj
Rulers

0 -  Workspace 
Document 

!■■■■ General 
| j "  Page 
| j -  Guidelines 
I -  Grid 

Rulers 
!■■■■ Styles 
!■■■■ Save

S "  Publish Tg In te rne t 
El - Global

^  | R u le rs

Units —

Horizontal:

Vertical:

| Same units foi 

pOrig in —

Horizontal origin:

Vertical origin: fOO mj||jmeters

Hint: Changing the Horizontal 
Ruler Units sets the 
default drawing units.

10 per tick 

f ^  Show fractions

Show Rulers

Edit Scale..

□ K □TMeHa Help

• dyuymlar (inches), l(engliz) dyuymi 24,5 m m  teng;
• millimetrlar (millimeters);
• pikalar (picas), 1 pika 12 punktga teng;
• punktlar (points), 1 punkt 1/72 engliz dyuymiga teng (24,5 m m );
• pixellar (pixels), nisbiy olchov birlik (absolyut qiymatga ega 

emas);
• sisero (ciceros), 1 sisero 12 punktga teng;
• Dido punktlari (didots), 1 Dido punkti 1/72 farang dyuymiga 

teng (27,06 m m ) ;

• futlar (feet), 1 fut 304,8 m m  ga teng;
• yardlar (yards), 1 yard 914,4 m m  ga teng;
• milar (miles), 1 mil 1609 m  ga teng;
• santimetrlar (centimeters);
• metrlar (meters);
• kilometrlar (kilometers).

Hujjatning umumiy ish maydoni 45 x 45 metrga teng. Bu esa, 
dasturdagi ko‘rgazmalar va katta hajmli obyektlar bilan ishlaganda 
juda qo‘l keladi.
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Sahifalarning parametrlari

A4
Custom *  
Slide

]□  297̂ 0 *  ! □  1=1 "n0 mlirne'e's -  >  2.54mrn J  a* flfmro ■  ^  10 «0 ^

Legd
Tabloid
Statement/Half Ekrandagi hujjatning sahifa formati to ‘g‘ri to‘rt-
Fanfold
Double burchak shaklidagi ko‘rinishda boladi. Agarda sahifa
Broad Sheet
AO
A1 formatini o‘zgartirmoqchi bo‘lsangiz CBOHCTBa (Property
A2
A3 Bar)dan foydalansa bo‘ladi.
A5
AS Agarda Kitob (Portrait)ni tanlasangiz hujjatning bo‘yi
B4 (ISO) 
B5[IS0] bo‘yicha ko‘rinishda, Albom (Landscape)ni tanlasangiz
B4 (JIS) 
B5 (JIS) 
C3 
C4

hujjatning eni bo‘yicha ko‘rinishda sahifalaydi.
C5
CS
RA2
RA3 Yuqoridagi sahifalashninig o‘lchamlarini bosmadan
RA4
Envelope #9 
Envelope #10 
Envelope #11 
Envelope#12 
Envelope #14 
Envelope Monarch 
Envelope Check 
DL

chiqariladigan payti bilan chalkashtirmaslik kerak.

g: rpaHMLva oOpeaa

irpaHMua nenaTHOM o6nacTM :

Agar tayyor bolgan hujjatni bosmadan chiqarmoqchi bolsangiz 
menyuning Ko‘rish (View)ni tanlab bosmaga chiqishi kerak bolgan 
maydon tanlanadi (Printable Area) va ekranda shtrix chiziqlar bilan 
bosmaga chiqadigan maydon chegaralangan boladi.

2.2. Vektor va rastr graflka

Rastr grafikasida obyektlar bit kartasidagi torda rangli nuqtalar 
(piksellar) yordamida tasvirlanadi.

Rastrli tasvirlar bilan ishlash uchun rastr muharrirlaridan 
foydalanamiz. Rastr tasvirlarni boshqa form atlardan rastr
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krinishiga tkazish (Convert to Bitmap) yo‘li bilan amalga 
oshiriladi. Rastr tasvirlarni muharrirlaganda piksel ranglarini 
zgartirish imkoniyati tug‘iladi, faqat ranglami o‘zgartirganimizda 
obyektning shakli o‘zgarishiga o‘z ta’sirini o‘tkazadi.

Vektor grafikasi matematik obyektlar ustida tashqi qurilmalarga 
(m onitor,printer) bog‘liqsiz holda amallar bajaradi.Vektor 
grafikasida birinchi navbatda obyektning formasi o‘zgaradi, rangi 
esa ikkinchi darajali bo‘ladi. Sababi vektor grafikasida rang bilan 
shakl bir-biriga bog‘liq emas, shakl birinchi darajali, rang esa 
ikkinchi darajali bo‘ladi.

2.3. Obyektlar bilan ishlash

CorelDRAW dasturi vektorli tasvirlarni yoritishda yupqa 
chiziqlardan tortib har xil shaklga ega kistlardan foydalaniladi.

Vektor grafikasi «qo‘l yordamida» chizishdan yiroq, shuning 
uchun awal obyektning vektorli konturini chizib, keyin esa, uni 
qanday qilib muharrirlashni o‘ylab ko‘rish kerak.

Shuni nazarda tutib CorelDRAW dasturi geometrik figuralami 
(to‘g‘rito‘rtburchak, ko‘pburchak, ellips, spiral va hokazo) chizish 
va muharrirlash imkoniyatiga ega va yanada «erkin chizish» (pero, 
kalligrafik pero, va hokazo), gradient torlar (Mesh Fill) va har xil 
egri chiziqlami chizish uchun Bezie (Bezier) asboblariga ham ega.

Vektor konturlarni m uharrirlashda qanday asbob bilan 
yoritilganidan qat’iy turda Forma (Shape) va maxsus muharrir 
panelidan (Node Edit) (tugunlami muharrirlaydi) foydalanadi.

Konturlar va tayanch nuqtalar
Kontur — bu dastuming obyektlami chizishda foydalaniladigan 

to‘g‘ri chiziq bo‘lib, obyektning tuzilmasini tashkil qiladi. Kontur 
keyinchalik To‘ldirish (Fill) va 
Chegaralash (Outline) sifatida 
foydalanilib bosmaga ham chiqa- 
rilishi mumkin. Agarda kontur- 
ning ba’zi bir parametrlari yo‘q 
bo‘lsa, oddiy holda kontur ko‘- 
rinmaydi, faqat maxsus ko‘rish 
imkoniyati bor va bosmaga chiqa- 
rilmaydi.
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Form a (Shape) asbobi yordam ida 
ajratiladigan kontur alohida obyekt (object) 
bo‘lib hisoblanadi.

Kontur qoplangan segmentlardan tash- 
kil topgan bo‘lib, u Bezie egri chizig‘i, 
tayanch nuqtasi va tugunlar (nodes)dan 
iborat bo ‘ladi. CorelDRAW dasturida 
kontuming uch xil turi mavjud. Agarda bitta 
tayanch nuqtasi zgartirilsa, u bilan bog‘liq 
shakl ham zgaradi. Segmentning shakli 
zgartirilgani, boshqarish nuqtalarining 
ham o‘zgarishini beradi.

Standart obyektlar asboblari
Standart geometrik obyektlar (to‘g‘ri to‘rtburchak, kvadrat, 

ellips, aylana va hokazo) yordamida murakkab geometrik obyektlami 
chizishi mumkin.

To‘g‘ri to‘rtburchak asbobi (Rectangle)
To‘g‘ri to‘rtburchak asbobi (Rectangle) to‘g‘ri to‘rtburchak- 

lar, kvadrat va uchlari aylana shaklidagi to‘g‘ri to‘rtburchaklarni 
chizishda foydalaniladi.

To‘g‘ri to ‘rtburchak chizish uchun asbobni ishga qo‘shib 
sichqoncha tugmasini kerakli shaklga ega bo‘lguncha surilib, 
sichqoncha qo‘yib yuboriladi.

Agarda m arkazdan to ‘g‘ri to ‘rt- 
burchak chizmoqchi bo‘lsak, <Shift> 
tugmasi bilan birgalikda ishlatiladi.
Kvadrat chizish uchun <Ctrl> tugmasi 
bilan birgalikda ishlatiladi.

Obyektning parametrlarini o ‘zgar- 
tirish uchun obyekt ajratilib sichqon- 
chaning o‘ng tomon tugmasi bosiladi va 
menyu ochiladi, bu yerda Xossalar 
(Properties) dan obyektning Xossalari 
(Object Properties) tanlanadi.

Agarda to‘g‘ri to‘rtburchak uchlarini 
aylana shakliga keltirmoqchi bo‘lsangiz,
Xossalar (Properties) dan foydalanib 
(Corner roundness)dagi har bir to ‘rt-

E2 -J

□

a
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burchak uchining qancha foyzga aylana hosil qilishini ko‘rsatish 
kerak. Har bir uchini alohida aylana qilish imkoniyati ham mavjud 
bo‘lib, u Xossalar (Property Bar) yordamida amalga oshiriladi.

... 120 1DD SD Ellips asbobi (Ellipse)
Ellips asbobi (Ellipse) ellips va 

aylanalarni chizish uchun ishlatiladi.
Ellipsni ekran markazida chizish 

uchun <Shift> bilan birgalikda, 
aylanani chizish uchun esa <Ctrl> 
bilan birgalikda ishlatiladi.

Obyektning xossalaridagi ellipsni 
har xil o‘zgartirishlar qilish mumkin. 
Bu yerda ellips turlarini tanlash mum- 
kin: Ellips (Ellipse), Sektor (Pie) 
yoki Yoy (Arc).

Obyekt (Object) guruhi asboblari
Uchta asbobdan tashkil topgan bo‘- 

lib, ular quyidagilardir: Ko‘pburchak
(Polygon); Spiral (Spiral); Kordinat sistemali qog‘oz (Graph Paper).

Ko^pburchakning asbobi (Polygon)
Ko‘pburchakni tomonlari berilgan geometrik obyekt deb tushunish 

mumkin. Ko‘pburchak turlaridan biri yulduzcha hisoblanadi, uning 
uchlari qavariq ko‘pburchak ichigajoylashgan va maydonni kesib o‘tib 
tutashtirilgan tomonlardan iborat figura bo‘ladi.

Ko‘pburchaklarni yuqorida keltirilgan obyektlarga o‘xshatib 
chizilgan.

Agarda <Ctrl> bilan birgalikda chizilsa, muntazam ko‘pburchak 
chiziladi, ya’ni ko‘pburchakning hamma tomonlari teng bo‘ladi.

Parametrlarni o‘zgartirish uchun Obyektning Xossalaridan 
(Object Properties) foydalaniladi.

Ko‘pburchaklarni chizganda (Polygon) tanlanadi va uchlar, 
tomonlar soni ko‘rsatiladi. 0 ‘ng tomonda joylashgan oynada 
obyektning qanday ko‘rinishda bo‘lishi ko‘rsatiladi.

UcMarining qanaqa ko‘rinishda bo‘lish kerakligi (Sharpness) 
yordamida beriladi, ya’ni obyektning tomonlari qancha ko‘p bo‘lsa, 
uchlari chuqur bo‘ladi. Ko‘pburchak (Polygon) va Yulduz (Star) 
turlaridan birini tanlash uchun ko‘rsatkich berilgan.
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Bu ko‘rsatkichlar asboblar paneli Xossa (Property Bar) da 
berilgan.

J j x j

Polygon T ool

Memory 
Plug-Ins 

+ Text
-  Toolbox 

PickTool 
Shape Tool 
Knife Tool 
Eraser Tool 
Zoonrij Pan Too 
Freehand/Bezif 
Dimension Tool 
Angular Dimen: 
Connector Too 
Rectangle Tool 
Ellipse Tool —  
Polygon Tool 
Spiral Tool 
Graph Paper Tt 
Mesh Fill Tool

-  Customize

t  Polygon Tool 

- Polygon

Star

Polygon as Star

Number of points/sides: 13 

Sharpness:

OK OTMeHa Help

Bu yerda shuni nazarda tutish kerakki, dasturda asboblar 
panelidagi (Polygon Tool) ko‘pburchaklar parametrida ko‘p- 
burchakning yana bir turi — yulduz ko‘pburchak (Polygon as 
Star) ham mavjud.

Spiral asbobi (Spiral)
Spiral asbobi (Spiral) asosan ma’lum 

bir radiusga va o‘ramga ega geometrik 
obyektlarni chizishga mo‘ljallangan.

Bu asbob b ilan  ishlash to ‘g‘ri 
to‘rtburchaklarni chizishga o‘xshaydi. Bu 
yerda spiral turini simmetrik (Sym- 
metrical) va logarifmli (Logarithmic) 
turning bittasini tanlash kerak.

Eni va uzunligi teng bo‘lgan spiral- 
lar <Ctrl> tugmasini bosib turib chiziladi. 
Spiral parametrlarini (Property Bar) 
o‘zgartirsa bo‘ladi.
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4.

Koordinat qogozi ( Graph Paper)
Koordinat qog‘ozi (Graph Paper) 

yordamida oldindan berilgan para- 
metrlar bilan katakcha quriladi. Bu 
katakchalarni grafiklar, diagram- 
malar chizganda foydalansa boladi.

Katakcha chizish yuqoridagi 
asboblarga o ‘xshash b o cladi, 
masalan, to‘g‘ri to‘rtburchak bilan 
ishlaganga o‘xshaydi. Faqat bitta 
farqi katakcha olchamli boladi. U 
Koordinat qog‘oz asbobi (Graph 
Paper Tool) va muloqot oynasining 
P aram etrlari (O ptions) orqali 
amalga oshiriladi.

Katakchalar soni eniga (Number of cells wide) nechta katakcha, 
katakchalar soni (Number of cells high) esa bo‘yiga nechta katakcha 
joylashtirishni ko‘rsatadi. Agarda kvadrat shakldagi katakcha kerak 
bolsa, u holda <Ctrl> tugmasi bilan birgalikda ishlatiladi. Para- 
metrlarini esa Xossalar (Property Bar)dan o‘zgartirsa boladi.

Egri chiziqlar guruhining asboblari (Curve)
Egri chiziqlar guruhining (Curve) asboblar paneli: Chizish 

(Freehand), Bezie (Bezier), Pero (Natural 
Pen), 0 ‘lchovli chiziq (D im ension), ^  ^  ^  ^  n,- sj
boglovchi chiziqlar (Connector Line) va "_________
bog‘lag‘ich (Connector) dan iborat.

Chizish asbobi (Freehand)
Chizish (Freehand) asbobi 

asosan xohlagan turdagi chiziqlami 
chizishga moljallangan. Bu asbob 
yordamida chizilganda avtomatik 
ravishda tayanch nuqtalari tanlangan 
vektor konturi tashkil qilinadi. 
K ontur chizilgandan keyin 
muharrirlanadi.

Bu asbob bilan chizilganda mos 
chiziq qalinligi va rangi tanlanadi. 
Xohlagan paytda chizilgan chiziqni
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davom ettirib chizsa boladi, buning uchun kursorni chiziqning 
oxirgi nuqtasiga keltiriladi va kursorning ko‘rinishi o‘zgaradi, shu 
paytda sichqoncha bilan chiziqni davom ettirsa boladi. Chizish 
(Freehand) asbobi bilan asosan to‘g‘ri chiziq chiziladi, buning uchun 
dastlabki va oxirgi nuqtalar ko‘rsatilsa bo‘ldi.

Imitatsiya asbobi (Artistic Media)
Im itatsiya (Artistic Media) 

asbobi rastr grafikasiga tegishli 
asboblardan biri bo‘lib hisoblanadi.
CorelDRAW dasturi ham bu asbobga 
ega. Bu asbob shtamp ko‘rinishidagi 
peroga o‘xshaydi.

Imitatsiya asbobining quyidagi 
turlari mavjud:

• 06pa3eu (Preset) rejimi tay- 
yor formadagi namunalardan qalinligi 
o‘zgaradigan obyektlar chizish. Bu 
rejimda obyektlar figurali shtrixlar 
bilan chiziladi.

•  K h c t l  (Brush) rejimi har 
xil murakkab shakldagi formalarni va matnlarni bo‘yashda 
ishlatiladi.

• PacnLDiHTejiL o6LeKroB (Object Sprayer) rejimi har xil 
grafik elementlarni trayektoriya uslublaridan foydalanib joylash- 
tiradi. Bu rejim asosan murrakab romlar, girlyandlar va hokazolar 
yaratishda ishlatiladi.

• KajuiHrpa4)H5i (Calligraphic) rejimi pero yordamida qiya 
ko‘rinishdagi obyektlarni chizishda ishlatiladi.

• HaxHM (Pressure) rejimi har xil shtrixlarni yoritishda 
ishlatiladi.

Odpaseu, (Preset) rejimi
Bu 06pa3eu (Preset) rejimi tanlanganda quyidagi parametrlar 

bilan ishlash imkoniyatini beradi:
CrjiaacHBaHHe (Freehand Smoothing) maydonida (rasmda 1 

raqami bilan berilgan ) 0—100 gacha asosiy shtrixning silliqlanish 
darajasini ko‘rsatadi.

TojnnHHa (Width) maydoni (raqam 2) dekorativ shtrixning 
0,764—254 m m  diapazondagi maksimal qalinligini aniqlaydi.
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Preset Stroke (OopMa niTpHxa)da (raqam 3) dekorativ 
shtrixlaming har xil formalari berilgan.

1 2 3

Bu asbob bilan ishlash PMCOBaHMC (Freehand)dan hech qanday 
farqi yoq.

Kucmb (Brush)rejimi
Khctb (Brush) rejimi tanlanganda CBoiiCTBa (Property Bar)ning 

asboblar satrida quyidagi parametrlar bilan ishlash imkoniyati tug£iladi: 
CrjiaaaiBaHHe (Freehand Smoothing) Maydoni (rasmda 1 

raqami bilan berilgan) 0—100 gacha asosiy shtrixning silliqlanish 
darajasini ko£rsatadi.

To;imMHa (Width) maydoni (raqam 2) dekorativ shtrixning 
0,764—254 m m  diapazondagi maksimal qalinligini aniqlaydi.

OopMa k h c t h  (Brush Stroke) (raqam 3)da dekorativ shtrix- 
laming har xil shakllari berilgan.

CoxpaHHTL (Save) tugmasi (raqam 4) kistni berilgan obyekt 
shaklini xotirada saqlaydi. Buning uchun obyektni ajratish kerak, 
M MMTaunM (Artistic Media) ishga tushiriladi, keyin Khctl 
(Brush) rejimi tanlanadi va CoxpaHHTL (Save) tugmasi bosilgandan 
keyin yangi kistga nom berishni so£raydi va uni CMX formatli 
faylda xotiraga yozadi.

yqajiHTL (Delete) — tugmasi (5 raqami) bosilganda ro£yxatdagi 
variantlardan tanlangani o£chiriladi.

Property Bar : Artistic Media Brush

** J ' iSg) a # 100 Jp H-H 15,4 mm ^ Tt y  'i

1 2 3 4 5
Pacnbimmejib oQbeKmoe (Object Sprayer) rejimi
PacnLDiHTejiL o Sl c k t o b  (Object Sprayer) rejimi tanlanganda 

CBOHCTBa (Property Bar) ning asboblar satrida quyidagi 
parametrlar bilan ishlash imkoniyati tug£iladi:
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CrjiaxHBaHHe (Freehand Smoothing) Maydoni (rasmda 1 
raqami bilan berilgan) 0—100 gacha asosiy shtrixning silliqlanish 
darajasini ko£rsatadi.

Pa3Mep (Size) maydoni (raqam 2) 1 dan 999% gacha
maksimal va minimal dekorativ shtrix o£lchamini foiz nisbatida 
aniqlaydi.

ricpcMCHb oSteKTOB (Spraylist) (raqam 3) har xil shakldagi 
dekorativ ko£rinishdagi burkagich turlari.

Save (raqam 4) yuqoridagi Kmctb (Brush) dagiga o£xshash 
vazifani bajaradi.

y^ajiHTb (Delete) tugmasi (raqam 5) ro£yxatdagi keraksiz 
so£zlami o£cliiradi.

nopjmoK pacnbuieHHH (Spray Order) ro£yxati (raqam 6) 
kontur enidagi obyektlarni har xil ko£rinishda joylashishini bildi- 
radi — CjiyqaiiHO (Ramdomly) xohlagancha, IIocjieflOBaTejibHO 
(Sequentially) ketma-ket, IIo HanpaBJieHHio (By Direction) 
yo£nalishida berilgan.

/IoGaBMTb b  cnncoK oSteKTOB (Add to Spraylist) (raqam 7) 
yangi elementlami obyektlar ro£yxatiga qo£shadi.

AKTHBH3aHHH cnHCKa oSteKTOB (Spraylist Dialog) tugmasi 
(raqam 8) ekranga yangi elementlar (Create Playlist) chiqariladi 
va u ikkita oyna: Barcha obyektlar ro£yxati (Spraylist) va aktiv 
bo£lgan obyektlar ro£yxatini chiqaradi (Playlist).

OSteKTbi/IlHTepBajibi (Dabs/Spacing) (raqam 9) obyektlar 
nisbatini va intervalini o£zgartiradi. HffrepBajibi (Spacing)ning 
pastgi qismida obyektlar orasidagi interval aniqlanadi, yuqoridagi 
06-bCKTbi (Dabs)da esa — har bir interval nuqtasidagi obyektlar 
soni aniqlanadi.

BpameHHe (Rotation) tugmasi (raqam 10) barcha obyekt- 
laming aylanish parametrlarini o£zgartiradi.

CMemeHHe (Offset) tugmasi (raqam 11) obyektlarning 
konturga nisbatan siljish qiymati va yo£nalishi beriladi.

BoccTaHOBHTb 3HaMCHMM (Reset Value) tugmasi (raqam 12) 
avval faylda saqlangan param etrlarni qayta tiklash uchun 
ishlatiladi.

a x||im 4.|,g : :  . ♦• . B a | Randomiv ^
P ro p e rty  Bat": O b je c t Sp ra ye r

1 2 3 4 5 6  7 8  9 1 0 1  112
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KaAJimpaffiuH (Calligraphic) rejimi
KajuiHrpa(J)iiH (Calligraphic) rejimi ishga tushirilganda asboblar 

panelidagi CBoiiCTBa (Property Bar)da quyidagilar bilan ishlash 
imkoniyati tug£iladi:

CmaacHBaHHe (Freehand Smoothing) (rasmda 1 raqami bilan 
berilgan), Tojnu,HHa (Width) (raqam 2) maydonlari yuqoridagi 
K h c t l  (Brush) rejimiga o£xshash xizmatni bajaradi.

Angle (Yroji) (raqam 3) «nepo»ning qiyalik burchagini 
bildiradi.

0,0 ^  °

1 2 3
HaoKUM (Pressure) rejimi
HaxHM (Pressure) rejimi tanlanganda CBOHCTBa (Property 

Bar)sida quyidagi parametrlar bilan ishlash imkoniyati tug£iladi:
CmaacHBaHHe (Freehand Smoothing) (rasmda 1 raqami bilan 

berilgan), Tojmi,HHa (Width) (raqam 2) maydonlari yuqoridagi 
K h c t l  (Brush) rejimidagiga o£xshash xizmatni bajaradi.

Kistning qalinligi tanlanganda < ^ >  (qalin qilish uchun) va 
<sU> (qalinligini kamaytirish uchun) tugmalaridan foydalaniladi.

Ee3be (Bezier) asbobi
Bezie (Bezier) asbobi yordamida 

maksimal aniqlikdagi xohlagan egri 
chiziqlami chizish mumkin. Bu asbob 
yordamida xohlagan shaklni chizish 
imkoniyati bor.

To‘gfri chiziqli segmentlarni qurish
T o£g£ri chiziqni chizish uchun 

Bezie (Bezier) asbobidan foydalaniladi. 
Buning uchun Bezie asbobi tanlanib, 
kursorni boshlang£ich nuqtaga olib 
borib, sichqonchani chap tom on 
tugmasi bilan chertiladi. Chertilgan
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joyda qora rangli nuqta paydo bo£ladi, bu segmentning birinchi 
tayanch nuqtasi, bu nuqta boshqa nuqta tanlanguncha joriy bo£lib 
turadi. Kursomi keyingi nuqta joylashadigan joyga siljitib, sichqoncha 
bilan chertiladi, natijada ikkita nuqta birlashtirilib to£g£ri cliiziq paydo 
qilinadi.

Tayanch nuqtalar turlari
CorelDRAW dasturida segmentning bir nechta nuqtalarini 

birlashtirishning uchta turi bor:
1. Ikkita egri chiziqni «egrilikga» 

birlashtiruvchi tayanch nuqta — 
burchak tayanch nuqta (cusp 
node) deyiladi. Bu turdagi tayanch 
nuqtani boshqarishda to £g£ri 
chiziqlarning «richaglarining» 
uzunliklari va yo£nalishlari bir-biriga 
bog£liq bo£lmaydi.

2. Ikkita egri chiziqni birlash- 
tiruvchi tayanch nuqta silliq 
tayanch nuqta (smooth node) 
deyiladi. Bu turdagi tayanch
nuqta boshqarish to£g£ri chiziqlarining faqat uzunliklari bilan farq 
qiladi, yo£nalishi esa umumiy bo£lgan urinma bo£ladi. Birinclii 
boshqarish to£g£ri cliizig£ining siljitilislii, ikkinclii to£g£ri cliiziqning 
siljisliiga olib keladi.

3. Ikkita egri chiziqni bir xil egrilik bilan birlashtirilgan bo£lsa, 
simmetrik tayanch nuqta (symmetrical node) deyiladi. Bu turdagi 
tayanch nuqtaning boshqarish to£g£ri chizig£i va yo£nalishi bir- 
biriga bog£liq bo£ladi.
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Egri chiziqli segmentlar
Bezie asbobi yordamida egri chiziqli segmentlarni ham yaratsa 

bo‘ladi. Buning uchun asbobni ishga qo‘shib, kursomi boshlang‘ich 
nuqtaga olib kelinadi va sichqonchani chap tomon tugmasi chertilib 
yon tomonga suriladi. Paydo bo‘lgan tayanch nuqtadan boshqarish 
to‘g‘11 chizig‘i olinadi. Boshqaruvchi to ^ r i chiziq uzunligi va qiyalik 
burchagidan segment egriligi aniqlanadi.

Qavariq segmentni olish uchun birinchi tayanch nuqtani 
qavariq tomonga, ikkinchisini esa, teskari tomonga surish kerak.

Agarda ikkinchi nuqtani ham shu tomonga sursa S-ko‘rinishidagi 
egri chiziq paydo bo‘ladi.

Murakkab konturni hosil qilishda kamroq tayanch nuqtalarni 
hosil qilgan maqsadga muvofiq bo‘ladi.

• Bitta yo‘nalishga ega egri chiziq bitta tayanch nuqtani talab 
qiladi.

• 0 ‘z yo‘nalishini sekin o‘zgartiradigan egri chiziq ikkita tayanch 
nuqta talab qiladi (boshida va oxirida).

• Yo‘nalishini burchak ostida 0‘zgartiruvchi egri chiziq uchun 
har bir egrilikda tayanch nuqta kerak bo‘ladi.

Pci3MepHcm a u h u h  (Dim ension) asboblari

*  ^  □  o  \  'ir « ,  \  <£,

T [ fmm | Piefiic

xj

r j l  I  Ml Vt' k  Decimal 0,00 » | Suffiw: Dynamic

1 2  3 4 5 6

Chizmalar va sxemalar bilan ishlaganda shakllarning to‘g‘ri 
chizilishi bilan bir qatorda ularning razmerlarining to ^ r i  bo‘lishi 
katta ahamiyatga ega. Yektor grafikasi dasturlari sxemalar chizish 
uchun qo‘l keladi. Dasturda bu amallami bajarish uchun oltita 
asbob mavjud:

1. ABTOMaTHHecKafl pa3MepHaii j i h h h h  (Auto Dimension) asbobi 
sichqonchani qaysi yo‘nalishda siljishiga qarab oMchamli to‘g‘ri chiziq 
chizadi. (Yertikal, gorizontal oMchamli to ^ ri chiziqlarning bir-biriga 
o‘tish <Tab> tugmasi yordamida amalga oshiriladi.)

2 . BepTHKajiBHaii pa3MepHaii j ih h h 5 i  (Yertical Dimension) 
asbobi faqat vertikal o‘lchamli to‘g‘ri chiziq paydo qiladi.
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3. r0pH30HTajTbHafl pa3MepHa5T JIHHH5T (Horizontal Dimension) 
asbobi faqat gorizontal oMchamli to ^ ri chiziq paydo qiladi.

4. H aK jiO H H afl pa3 M ep H aii j ih h h h  (Slanted Dimension) asbobi 
faqat qiya bo‘lgan olchamli to^ri chiziq
paydo qilib obyekt o‘zgarishi bilan u 
ham o‘zgaradi.

5. BHHOCKa (Callout) asbobi 
obyektlarga biriktirilgan yorliqlarni 
yaratadi.

6. YrjiOBaii pa3MepHaii j i h h h 5i  
(Angular Dimension) asbobi bur- 
chakning qiymatini ko‘rsatadigan 
0‘lchagich yoy yaratadi.

o
c i

U|ejiHOK

6rjD

Xohlagan turdagi 0 ‘lchamli to ‘g‘ri chiziq yaratish uchta 
bosqichdan tashkil topadi:

• Birinchi chertish boshlang‘ich nuqtani aniqlaydi;
• Ikkinchi chertish oxirgi nuqtani aniqlaydi;
• Uchinchi chertish o ‘lcham yoziladigan yerdan to ‘g‘ri 

chiziqgacha masofani bildiradi.
Obyektga 0‘lchamli yoki ulanuvchi to ^ r i  chiziqni bog‘lash 

uchun joriy bo‘lgan nuqtalarning biriga kursorni olib kelib, 
sichqoncha bilan chertiladi.

Burchakni olchovchi chiziqni paydo etish to‘rtta bosqichdan iborat:
• Birinchi chertilish burchakning 

dastlabki nuqtasini aniqlaydi;
• Ikkinchi va uchinchi cherti- 

lishlar nurda burchak nuqtalarini 
belgilaydi;

• To‘rtinchi chertish esa nurdagi 
nuqtalardan olcham yozilgan yozuv- 
gacha bo‘lgan masofani belgilaydi.

BunocKa (Callout) asbobi
BbmocKa (C allout) asbobi 

obyektning bironta nuqtasi bilan matnli yoki tushuntirma so‘z 
bilan bog‘laydi. Shu bilan birga <BMHOCKH>lar obyektga bog‘langan 
bo‘ladi.

Bu amal quyidagicha bajariladi: dastlabki chertish obyektning 
tayanch nuqtasiga bogMashni bildiradi, ikkinchi chertish egilish

90 deg rees
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nuqtasini ko£rsatadi va nuhoyat uchinchi chertish matn kiritish 
uchun ishlatiladi.

CoedummejibHdH j iu h u h  (Connector Line) va HHmepaKmmmiu 
coeduHumem (Interactive Connector) asboblari

Coc/iMHMTCjibHaM j ih h h h  (Connector Line)ning asosan xizmati 
ikkita obyektni bir-biri bilan bog£lash uchun ishlatiladi. Bu esa, 
birlashtirilgan obyektlarni surish va transformatsiya qilish 
imkoniyatini beradi. Agarda obyektlar mavjud bo£lmasa oddiy to£g£ri 
chiziqda aylanib qoladi. Agarda faqat bitta obyekt bo£lsa, u holda 
ikkinchi tomoni sahifaga bog£langan bo£ladi.

Biriktiruvchi cliiziqni hosil qilish uchun obyektlaming mos tayanch 
nuqtalariga sichqoncha yordamida chertiladi. Cliiziqning parametrlari 
(rangi, qalinligi) o£zgartirilsa ikkita obyekt ham o£zgaradi.

HHTepaKTHBHLin coc/iMHMTCjib (Interactive Connector) asbobi 
har xil blok sxemalar yaratishga moljallangan. Cocn w h  mtCjI bHas-i 
j i h h h h  (Connector Line) asbobidan farqi faqat vertikal va 
gorizontal cliiziqlar yaratadi. Shu bilan birga obyektlar siljitilganda 
tayanch nuqtalarga bog£lanish saqlanadi, agar kerak bo£lsa uni 
olib tashlasa ham bo£ladi.

HHTepaKTHBHLiii coc/iMHMTCjib (Interactive Connector) asbobi 
yordamida ikkita obyektni bog£lash uchun dastlab kursor birinchi 
obyektning tayanch nuqtasiga olib kelinib, sichqoncha bilan chertiladi 
va ikkinchi obyektning tayanch nuqtasigacha chiziq tortiladi.

Berilgan obyektni transformatsiya qilganda biriktiruvchi chiziq 
avtomat ravishda o£zgaradi va bog£lanishni uzmaydi. Agar biriktirilgan 
obyektlardagi tayanch nuqta o£chirilsa, eng yaqin nuqta tayanch 
nuqta qilib olinadi.



CmpejiKa (Pick) asbobi
Obyektklar ustida qanaqa amal baja- 

rilmasin obyekt boshqalaridan ajratilgan 
bolishi kerak.

Bu amalni bajarish uchun maxsus 
ajratish asbobi OrpejiKa (Pick) ishlatiladi.

Obyekt ajratilganligini uning yonidagi 
markerlardan va obyekt markazidagi krestdan 
bilsa bo£ladi. Agarda bir nechta obyektlar 
ajratilgan bo£lsa, markerlar katta to£rtburchak 
shaklidabo£ladi.

Obyektlarni ajratish usullari
CTpejiKa (Pick) asbobi yordamida 

obyektlar bir nechta usullar bilan ajratiladi:
• A lohida obyektni sichqonchani 

chertish bilan ajratsa bo£ladi.
• niTpHxoBoii paMKa (marquee) yordamida obyektlarni 

ajratganda belgilangan maydondagi obyektlar ajratiladi va ular 
shtrixlangan ramka ko£rinishida bo£ladi.

• Obyektlami ajratishda klaviaturadan ham foydalanilsa bo£ladi. 
<Tab> tugmasini bosish orqali obyektlami ketma-ket, <Shift> 
+ <Tab> — tugmalari bilan birgalikda ishlatilsa teskari holatda 
ajratiladi.

• Hamma obyektlarni ajratish uchun OSteKTLi (Objects) 
buyrug£i va menyuning Pc/iaKTnpoBaTb/Bbi/iCjiMTb Bce (Edit/ 
Select All) tanlanadi. Bu amalni OrpejiKa (Pick) asbobining 
tugmasini ikki marta bosish bilan amalga oshirsa bo£ladi. Ajratishni 
bekor qilish uchun ish joyidan boshqa yeriga sichqoncha bilan 
chertiladi yoki <Esc> tugmasi bosiladi.

CmpejiKa (Pick)asbobining boshqa 
funksiyalari

OrpejiKa (Pick) asbobini ishlatganda 
obyektlarni ajratilganlik markeri faqat 
ajratilganlik belgisini bildirib qolmay, 
boshqa maqsadlarda ham ishlatiladi.

Marker yordamida obyektlami massh- 
tablash mumkin. <Shift> tugmasi bilan 
ishlatilsa markazdan masshtablanadi.
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<Ctrl> bilan birgalikda ishlatilsa bir 
butunga kattalashadi. Yon tomondagi 
markerlar esa noproporsional masshtab- 
laydi.

Ikkinchi marta obyektlami ajratganda 
markerlar yo£nalish shaklini oladi.

Burchakdagi yo£nalishlar yordamida 
obyektni o£q atrofida aylantiradi.

Yon tomondagi yo£nalishlar esa 
obyektni gorizontal yoki vertikal tomonga 
qiyshaytirishni bildiradi.

Shuning bilan birga OrpejiKa (Pick) 
asbobi obyektlarni yoki obyektlar 
yig£indisini ko£chirishi mumkin, shu- 
ning uchun obyektni olib, kerakli to- 
monga surish mumkin.

0 o p M a  (Shape) asbobi
OopMa (Shape) asbobi vektor 

konturlarini muharrirlashga m o£ljal- 
langan. Bu asbob obyektning shaklini 
o£zgartiradi, ya’ni tayanch nuqtalarni 
ko£chiradi, yangi tayanch nuqtalar 
qo£shadi va hokazo amallar bajaradi.

OopMa (Shape) asbobi yordamida 
ajratilgan obyektning hamma tayanch 
nuqtalari ko£rsatiladi, kursor olib borilgan 
nuqtalari esa joriy bo£ladi.

0opMa (Shape) asbobi yordamida standart va xohlagan 
obyektlar bilan ishlash

IIpHMoyrojiLHHK (Rectangle) asbobi yordamida yaratilgan 
obyektlaming tayanch nuqtalarini o£zgartirish natijasida aylana 
shaklini olislii mumkin.

3jumnc (Ellipse) asbobi bilan yasalgan obyektlar esa sektor 
yoki duga shakliga keltirilishi mumkin.

MHoroyrojiLHHK (Polygon) asboblari bilan yasalgan obyektlar 
esa simmetrik tarzda obyektning boshqa turiga o£zgaradi.

Matnli obyektlar bilan ishlashda esa harflar orasidagi va so£zlar 
orasidagi intervallami o£zgartirish imkoniyati tug£iladi.
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PedaKmop y3Jioe (Node Edit) paneli
Hamma tayanch nuqtalar, segmentlar bilan ishlaydigan amallar 

Pe/iaKTop yanoB (Node Edit) panelida joylashgan. Bu panel menyuning 
Docker (Window/Dockers) tipidagi OKHo/naHc;i[/idan Pe/iaKTop 
y3JiOB (Node Edit) ishga tushiriladi yoki <Ctrl> + <F10> 
tugmalari yordamida ishga tushiradi.

OopMa (Shape) asbobini ishga tushirganda Pe/iaKTop Y 3 jio b  
(Node Edit)ning ma’lumot berish satrida (CBoiiCTBa (Property 
Bar)) bu panelning barcha buyruqlari namoyon bo£ladi.

JP ro pe rtY  Bar : E d it :u rv e , p o ly g o n  &  e n v e lo p e 2^
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Tayanch nuqtalarni qo\ shish va olib tashlash
Egri chiziq ko£rinishidagi obyektlarga xohlagancha tayanch 

nuqtalarini qo£shsa bo£ladi. Buning uchun segmentning nuqta 
qo£yish joyiga sichqoncha bilan chertiladi va paydo bo£lgan nuqta 
qora doyra shaklli ko£rinishdagi potensial nuqtaga ega bolamiz. Bu 
potensial haqiqiy nuqtaga aylanishi uchun yana panelning 
xossasidagi «+» tugmasi bosiladi (rasmda 1 raqami bilan berilgan).

Keraksiz tayanch nuqtani o£chirish uchun awal o£chiriladigan 
nuqtalar ajratiladi va «-» belgisi bosiladi (2 raqam).

To‘g‘ri chziqli segmentlarni egri chiziqli segmentlarga o‘tkazish
Har qanday segment ikki xilda bo£lishi mumkin, to£g£ri yoki 

egri chiziqli. OopMa (Shape) asbobi yordamida tayanch nuqta 
ajratilganda holat satrida segment turi —To£g£ri (npHMoii) (Line) 
yoki Egri (KpHBoii) (Curve) ko£rsatiladi.

Segmentning bir turdan ikkinchi turga o£tishi uchun segment 
tanlanadi. CBoiiCTBa (Property Bar)dagi ikkita holatdan biri 
tanlanadi: To£g£riga o£tish (To Line) (5 raqam ) yoki Egriga (To 
Curve) o£tish (6 raqam).

Egri chiziqli segmentdan to£g£ri chiziqli ko£rinishga o£tish tez 
amalga oshiriladi, teskarisi birmuncha vaqtni talab qiladi — segment 
egriligi qo£l yordamida bajariladi.

Konturni birlashtirish va uzish
Ocliiq kontumi yopiq konturga aylantirish uchun boshidagi va 

oxiridagi nuqtalar biriktiriladi, bu amal ikkita uslub bilan bajariladi:
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1. Ikkita nuqtani birlashtirish uchun awal nuqtalar ajratiladi 
va CBOHCTBa (Property Bar)ning asboblar satridagi Coc/iMHMTb 
,n;Ba y3Jia (Join Two Nodes) (3 raqamli) tanlaniladi. Agarda ikkita 
nuqta ustma-ust joylashgan bo£lsa, ikkita nuqta bitta nuqtaga 
aylanadi. Agarda qandaydir masofada joylashgan bo£lsa, o£sha 
masofa markazidan birlashtiriladi.

2. Chetdagi nuqtalami birlashtirish to£g£ri cliiziqli segment bilan 
amalga oshiriladi. Bunig uchun CBoiiCTBa (Property Bar) asboblar 
satridagi ABTOMaTiwecKoe 3aMLiKaHHe KOHTypa (Auto-close) (13 
raqamli) tugmasi bosiladi.

3. Agarda kontumi uzmoqchi bo£lsangiz, awal o£sha nuqtalar 
ajratiladi. CBOHCTBa (Property Bar) asboblar satridagi Pa30pBaTL 
KpHByio (Break Curve) ( 4 raqamli) tugmasi bosiladi va natijada 
bitta nuqta o£mida ikkita nuqta paydo bo£ladi.

Kontumi bir nechta konturlarga ham ajratsa bo£ladi, buning 
uchun obyektning kamida bitta tayanch nuqtasi tanlanib H3bjichl 
n0/iK0HTyp (Extract Subpath) tugmasi bosiladi.

Tayanch nuqtalarni tekislash
Shriftlar yoki maxsus belgilar bilan ishlaganda nuqtalarni 

gorizontal yoki vertikal joylashtirishga to£g£ri keladi.
CBOHCTBa (P roperty  Bar) 

satridagi BLipaBHHBaHHe y3JiOB 
(Align Nodes) tugmasi (16 raqam) 
muloqot oynasini ekranga chaqiradi.

Bu oynada xohlagan sondagi 
tayanch nuqtalami gorizontal va vertikal 
holatda joylashtirislilar mavjud.

Boshqarish nuqtalari bilan bir- 
galikda tayanch nuqtalami tekislash 
((JxnaacoK BLipaBHHBaHHe ynpaB- 
jihk)mmx tomck (Align Control Points)) amali bilan bajariladi.

Segmentlarni masshtablash va aylantirish
CorelDRAW dasturida obyektlami transformatsiyalash bilan 

cheklanib qolmay, ba’zi bir segment qismlari bilan ishlash 
imkoniyati bor. Bu amal CBOHCTBa (Property Bar) asboblar 
satridagi ikkita tugma bilan bajariladi.

•  PacTM/KCHMC h  MaciiiTaSHpOBaHHe y3JiOB (Stretch And Scale 
Nodes) (14 raqam) tugmasi bosilganda ajratilgan segment atrofida
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markerlar paydo boladi. Masshtablash amalida OipejiKa (Pick) 
asbobidagi amallar bajariladi.

• Bpam,eHHe h  HaiciiOH y3JiOB (Rotate And Skew Nodes) (15 
raqam) tugmasi bosilganda, ajratilgan segment atrofida markerlar 
paydo bo£ladi. Atrofidagi aylanish amalida CTpejiKa (Pick) 
asbobidagi amallar bajariladi.

• 3jiacTiwHLiH peaaiM (Elastic Mode) (17 raqam) ajratilgan 
obyektlarga alohida transformatsiya beradi.

Hook (Knife) va JlacmuK (Eraser) asboblari
OopMa (Shape) asbobi oynada — Hox< (Knife) va JlacTHK 

(Eraser) asboblari joylashgan bo£lib, berilgan vektorli obyektni 
bir nechta bo£laklarga bo£ladi.

Hox< (Knife) asbobi obyektni bir nechta konturlarga yoki bir 
nechta obyektlarga bo£ladi. Kontumi kesish uchun dastlab birinchi 
tayanch nuqta tanlanadi va pichoq ko£rinishidagi kursor vertikal 
ko£rinishga kelgan holda chertilishi kerak. Ikkinchi nuqtaga 
«pe3HHOBan j ih h h h » tortiladi. Ikkinchi marta chertilislii esa kesislini 
bajaradi. Bu amalni rasm chiqarish orqali bajarsa bo£ladi, buning 
uchun birinchi nuqtaga kursomi qo£yib sichqoncha tugmasi bosilib 
turib xohlagan chiziq chiziladi. Tugma ikkita kontur birlashganda 
qo£yib yuboriladi.
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(Property Bar) ning asboblar panelida ikkita tugmasi 
mavjud:

• CoxpaHHTL KaK o,n;HH o G l c k t  (Leave as one object) bitta 
obyekt qilib saqlash.

• ABTOMaTHnecKoe 3aMLiKaHHe KOHTypa (Auto-Close On 
Cut) H ox  (Knife) asbobi bilan ishlashni tugatgandan keyin 
avtomatik ravishda yopiq kontumi chizadi.

JlacTHK (Eraser) asbobi vektor obyektining kerakmas joy- 
larini o£chiradi. Agar bu asbob bilan o£chirilsa, ikkita bir-biriga 
bog£liq bo£lmagan obyektlar paydo bo£ladi.

0 £chirish kengligini 0,025 m m  dan 2540 mm  gacha o£zgartirsa 
bo£ladi. Bu amal CBOHCTBa (Property Bar) asboblar satridagi 
IIlHpHHa jiacTHKa (Eraser Thickness) da bajariladi.

CeoGoduoe mpaHCfpopMupoeauue (Free Transform) asbobi
Bu asbob ishga tushirilganda CBOHCTBa (Property Bar)da to£rtta 

tugma bilan ishlash imkoniyati tug£iladi: Cbo6o/ihoc Bpam,eHHe 
(Free Rotation) erkin holda aylanish (1 raqami), Cbo6o/ihoc 
OTpaxeHHe (Free Angle Reflection) (2 raqam) erkin holda 
akslanish, Cbo6o/ihoc MacniTaSHpOBaHHe (Free Scale) (3 raqam) 
erkin holda masshtablashtirish va CboSo/ihlih HaiciiOH (Free Skew) 
erkin holda qiya qilish (4 raqam).

Cbo6o/ihoc Bpam,eHHe (Free Rotation) asbobida obyektni o£zi 
atrofida aylantirish uchun awal sichqoncha yordamida tayanch 
nuqta tanlanadi va aylanish richagi paydo bo£ladi, yo£nalish aylanish 
burchagidan aniqlanadi. Bu yerda ko£rsatilgan kursor esa burish 
burchagi hisoblanadi.

Agar burchak markazdan qancha olis masofada joylashgan bo£lsa, 
aniqligi ham yaxshi bo£ladi. Burchakning qiymati holat satrida 
ko£rsatilib turadi. Cbo6o/ihoc OTpax<CHMC (Free Angle Reflection) 
asbobining ishlash prinsipida yuqoridagiga o £xshagan, ya’ni 
shtrixlangan chiziq aKslanish chizig£i hisoblanadi.

Cbo6o/ihoc MacniTaSHpOBaHHe (Free Scale) asbobi yuqori- 
dagi ikkita asboblarga o£xshash ishlatiladi, faqat shtrixlangan richagi 
bolmaydi.

CboSo/ihlih HaKJiOH (Free Skew) asbobi yuqoridagi asboblarga 
o£xshash ishlatiladi, faqat holat satridagi o£qlarga nisbatan siljish 
ko£rsatkichi, akslanish burchagi va masofasi beriladi.

60



□  iJ 
t

n

□
oa
A
*n

X

*

2.4.Matnlar bilan ishlash

CorelDRAW dasturining eng yetishgan tomonlaridan biri 
matnlar bilan ishlash bo£ladi. Dasturda matnni har xil gamiturada, 
ranglarda, keglda va shriftlarda berish imkoniyati bor. Shriftlami 
sirtqi ko£rinishlarini bezashning cheksiz turlari bor.

Matn ishclii oynadan Pc/iaKTMpoBaHMC TeKCTa (Edit Text) 
yordamida kiritiladi.

CorelDRAW  dasturida 
matn ko£rinishi ikki turda 
bo£ladi: sarlavha (artistic) va 
abzas (paragraph). Matn turi 
T c k c t  (Text) asbobi yorda- 
mida kiritiladi.

Sarlavha matni (Artistic 
Text)

TeKCT (Text) asbobi yor- 
damida xohlagan joyga xohla- 
gan matnni kiritsa bo£ladi.

Sarlavha matnini kiritish 
uchun TeKCT (Text) asbobi

D 5DD 450 400 3S0 300 250
D -I

ripnMep 3ar0Ji0B0HH0ro TeKCTa:H

■<

11
9\ HeHaBiDKy Te6si 3a to,])

□ HTO >KHTb 6e3 Te6fl HeT CMJlbl.il
o 9\ HeHaBLDKy 3a to,h
a Hto cmibHeti hm Koro He jno6HJia.n
A HeHaBM>ty Teoa 3a to,H
* 4tO Tbl MOM, 6e3 K0HL|a, 663 OCTaTKaU
t HeHaBMX̂  Teofi 3a to,H

Hto b tbohx MHe pyKax TaK cjia^oy
S- 5\ HeHaBM>Ky Te6si 3a to,H

o-i
2. Hto 6e3 Te6n MeHfi HeT caMonlU
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ishga tushuriladi va kursomi matn kiritiladigan joyga olib borilib, 
sichqoncha bilan bir marta chertiladi, natijada ekranda matn kiritish 
kursori paydo bo£ladi.

Satmi yangi qatordan boshlash uchun <Enter>tugmasi yorda- 
mida kursor ko£chiriladi.

Abzas (blokli) matn (Paragraph Text)
Asosiy matn (main text) katta hajmga ega bo£lib kolonka ichiga 

olib yoziladi va uni blokli matnlar deb ataydi. Ikkinchi farqi uning 
kolonka yoni bo£yicha avtomatik ravishda qo£yiladi, agarda matnlar 
o£chirilsa yoki qo£shilsa avtomatik ravishda siljiydi. Bu turdagi 
matnning asosiy elementlaridan biri abzas hisoblanadi va abzasli 
matnlar deb ham aytiladi. Blokli matnlami yaratish uchun TeKCT 
(Text) dan quyidagicha foydalaniladi:

• Asbobni ishga tushirib,
matn kiritiladigan to£g£ri to£rt- |?.;j ^ r  « —
burchak yoki ellips ko£rinislilar . n J
tanlanadi. Mat.nli to£g£ri to£rt- *- * . n
burchak hech qanaqa para- : ^ ripHMep afeauuHoro i
m etrlarga ega b o £lmaydi va < TeKCTa:
bosmadan chiqarilganda faqat = c
matnning o£zi chiqariladi. " O. ■n™ h IiiiS  DasiueD '

•  M a t n l i  t n £P £r i  t n £r t h n r r h a k  = ^  n P ® B b lL L |S ® T  p a 3 M e pMatnii to g n  to rtburciiak w  ̂ 3HaK“nepenonHeHM?i"
yasalgandan keyin ishga tayyor ■ b BHfle TpeyronbHOfi
ekanligini bildiruvchi yonib- cTpenKM

chib turuvchi kursor chap ' A .■■■■..... - .........m.-  .........
tomonda paydo bo£ladi. £

Blokli m atnlarni kiritish L—
paytida dastur o£zi avtomatik
ravishda kelasi satrga o£tkaziladi, foydalanuvclii faqat abzas oxirida 
<Enter> tugmasini bosislii kifoiya.

Agarda belgilangan to£g£ri to£rtburchakda matn ko£rsatilganda 
ko£payib ketsa, to£g£ri to£rtburchak tagida maxsus belgi — qizil 
rangli uchburchak shaklidagi yo£nalish belgisi ko£rsatiladi.

Matn to£rtburchagi o£lchamlarini o£zgartirish uchun CTpejnca 
(Pick) asbobidan foydalaniladi.

Dastur tomonidan matnning hajmiga va parametrlariga qarab 
balandligini tanlaydi.

Bu rejimga o£tish uchun A63au;HLiH t c k c t  (Paragraph Text) 
bo£limidagi IlapaMeTpLi (Options) oynasidan matnning hajmiga

c.

EBd| 
k

npHMep a63aL4UHoro 
<  TeKCTa:
□ !

ECJIM T6KCT 
npeBbimaef pa3Mep 
3HaK“nepenonHeHM?i" 
b Bi/ifle TpeyronbHoft 

^  CTpeJIKM.
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qarab to£g£ri to£rtburchakni katta yoki kichkina qilish (Expand 
And Slirink Paragraph Text Frames To Fit Text) ga belgi qo£yish 
orqali amalga oshiriladi.

Sarlavha (Artistic Text) matnini abzas matniga (Paragraph 
Text) o‘tkazish

Sarlavha ko£rinishida yozilgan matnni abzas ko£rinishiga yoki 
teskari abzas ko£rinishida yozilgan matnni sarlavha ko£rinishida 
yozishga to£g£ri kelib qoladi. Bu hollarda dastur tomonidan bir 
turdan ikkinchi turga o£tkazish imkoniyatlari bor.

Sarlavha matnini ajratgan holda TeKCT (Text) menyusidagi 
abzasni matnga o£girish (Convert to Paragraph Text), abzas matni 
ajratilganda esa sarlavha matniga o£girish (Convert to Artistic Text) 
so£zlaridan foydalaniladi.

[ P ro p e rty  Bar : T e x t i j |

x: -3 61 .185  m 2 8 8 .7 8 3  mm
1 0 0 .0  %b J

o  |
y: 1 2 9 .3 6 3  m t  2 3 6 .0 6 9  mm

Arial CYR w 6 0 .5 9 4  »  b  j  u F abl U . M O
KoHBepTnpoBaTb TatcT

Bir turdan ikkinchi turga o£tkazishni tezlatish uchun CBoiiCTBa 
(Property Bar) da joylashgan K oH BepTH pO BaTL t c k c t  (Convert 
Text) tugmasi bosiladi.

Matnni formatlash (Format Text)
CorelDRAW dasturi shriftning parametrlarini boshqarish 

imkoniyatiga ega. Matnni kiritmasdan awal parametrlarini belgilab 
olib, kiritilgandan keyin matnni formatlasa ham bo£ladi.

Matnni formatlash menyuning TeKCT (Text) va OopMa- 
THpOBaHne TeKCTa (Format Text) buyrug£i bilan amalga oshiriladi. 
Muloqot oynasida abzasning matnlari uchun oltita parametrlar 
berilgan bo£ladi: nipH (J)T  (Font), BLiKniOHKa (Align), HHTepBaji 
(Space), TaSyjiH H H H  (Tab), PaMKH h  k o j io h k h  (Frames and 
Columns); 3(|)(|)CKTbi (Effects) yoki sarlavha matni uchun uchta: 
nipH (J)T (Font), BLiKJiiOHKa (Align), HHTepBan (Space) beriladi.

niputpm (Font) bo‘limi
nipH (J)T (Font) bo£limi bu matndagi shriftning gamiturasini, 

keglini va boshqa parametrlarini tanlashni bildiradi.
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Shrifl gamiturasi deganda nomi 
va tasviriga ega bo‘lgan belgilar 
majmuasi tushuniladi, masalan,
Times, Helvetica, /leKop, Jla- 
3 y p c K o ro  gamituralari va hokazo.

nipH(|)T(Font) ro ‘yxatida 
operatsion sistemaga o‘rnatilgan 
shriftning bitta gamiturasi tanla- 
nadi. HanepTaHHe (Style) — esa 
quyidagi to ‘rttasidan bittasi tanlanadi: HopMajibHoe npHMoe 
(Normal), HopMajibHoe KypcHBHoe (Normal-Italic). nojiyaaipHoe 
npHMoe (Bold) h nojiyaaipHoe KypcHBHoe (Bold-ltalic).

Size (Kemb) ro‘yxatida esa 0,001 dan 3 000 punktgacha bo‘lgan 
kegl tanlanadi.

0 ‘lchov birligini E/iHHHLia maydonidan o‘zgartiriladi. IIoa- 
HepKHBaHHe (Underline), nepenepKHBaHHe (Strikethru) va 
Ha^HepKHBaHHe (Overscore) matnini muharrirlash paytida 
foydalaniladigan chiziqlami bildiradi va u quyidagilami o‘z ichiga 
oladi: Be3 jihhhh (None), O/iHHOMHan TOHKan (Single Thin), 
O/iHHOMHan TOJicTan (Single Thick). ^BOHHan TOHKan (Double 
Thin), /̂ BOHHaH TOJicTan (Double Thick).

Pe/iaKTMpoBaTb (Edit...) tugmasi esa chiziqlami muharrirlashni 
bildiradi. TojintHHa (Thickness) va CMemeHHe OTHOCHTejibHO 
6a30B0H jihhhh (Baseline Shift) maydonlari chiziq qalinligi va 
joylashishini bildiradigan son qiymatlaridan iborat.

Qo‘shimcha BuKJitomca (Align)
BbiKJiioHKa (Align) faqat abzasning matniga tegishli. Bu yerda 

matnning qanaqa tartibda 
kiritilish parametrlari be- 
rilgan.

Tekislanishlar (Align) 
chap tomondan, o‘ng to- 
mondan, markazdan va 
berilgan format bo‘yicha 
turlari mavjud. BbiKJiioHKa 
(Alignment) maydonida 
yangi tipni paydo qilsa ham 
bo‘ladi.

JjiSl
Font Align |space| Tabs | Frames and Columns | Effects|
-Alignmenl------

None Max. WDrd spscing: |300.0 - J  %
C  Left
|  Cenlei Minl word spacing: 60,0 %

^  Man. char. spacing: 1200.0 %
( Full justifv 
' Foice justifjj

- Lharaclei shift------

Hoiizontal: [0 ^  % of Pl size 

Verticd: 0 ‘  % 0f Pi sjze 

Rotation: |Q-Q degrees

-Indents------

Fiist line: 10-0 mnn 

Left: 10-0 ^  mm 

Hight: 10,0 rnm

OK OTMeHa npwMeHwrb Help

Form at TeKt

?i xi
'ont | Align | Spacej Tabs j Frames and Columns | Effects|

Font Underline: Inonel - |  Edil..
Sise: 124.0 pt Slrikethiu: (nonej j- ]  Edn

Style: [ Noimal jrJ Overscoie: | (none) ■  EdH.
Uppercase: (none) ■
Positiori; j (none) ■

Range keining: |0 ^ X  of space

FONT
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Format bo‘yicha va to ‘liq turdagi chegaraviy intervallarni 
aniqlash kerak. So‘zlar orasida maksimal bo‘sh joy qoldirish (Max. 
word spacing), So‘zlar orasida minimal bo‘sh joy qoldirish (Min. 
word spacing ), Harflar orasida maksimal bo‘sh joy qoldirish 
(Max. char. spacing) parametrlari dastur uchun matnni kiritganda 
avtomatikverstka qilinadi.

Abzas tushunchasi matnning chetidan joy qoldirishni bildiradi. 
Bo‘sh joy qoldirish deganda matnning o‘ng, chap tomonidan va 
so‘z boshidagi bo‘sh joyni qoldirish tushuniladi.

OTCTynti (Indents) maydonida shu parametrlami o‘zgartirish 
imkoniyati bo‘ladi: KpacHan CTpoKa (First line) so‘z boshi, CjieBa 
(Left) chapdan, CnpaBa (Right) o‘ngdan.

Bir yoki bir nechta belgilami ajratganda CMemeHHe CHMBOJia 
(Character shift) da maydon bilan ishlash imkoni tug‘iladi. Bu 
yerda (nojie Horizontal) gorizontal siljish, vertikal siljish (nojie 
Vertical), (nojie Rotation) berilgan burchakga burilish amallari 
bajariladi.

Qatordagi barcha belgilar (baseline) chizig‘iga qarab to‘g‘ri- 
lanadi va uning parametrlari, har bir belgi uchun shriftlar faylida 
saqlanadi. Bu esa, birinchidan matnning satrlarini to‘g‘ri kiritishni 
ta’minlaydi, ikkinchidan bazaviy chiziqdan vertikal yo‘nalishda 
ba’zi bir masofaga siljitishni ta’minlaydi.

Vertikal siljishda shriftlami kichiklashtirganda har xil indekslar 
(pastki, yuqoridagi) avtomat ravishda formatlanadi, tasviriy san’atda 
hambuni ishlatsabo‘ladi.

Hnmepeaji (Space) bo‘limi
HHTepBajiti (Space) da har xil intervallarni qo‘yish yana 

avtomat ravishda keyingi satrga o‘tishni ta’minlaydi.
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C h m b o j i l i  (Character) 
maydonida so£zlar orasidagi maso- 
falar beriladi, ya’ni (Word) — 
foiz nisbatida shriftning orasidagi 
masofani beradi, HHTepjiHHLflx 
(Line) maydonida — foiz nisbatida 
shriftning kegili va shrift balandligi 
beriladi.

HHTepjiHHLHxeM (leading) 
da matn terilganda qo£shni qa- 
torlar orasidagi masofani bil- 
diradi. Bu matnlami kiritish katta 
ahamiyatga ega.

A63au (Paragraph) may- 
doni abzasning atrofidagi ma- 
sofalarni bildiradi, ,3,0 a6r3aua 
(Before paragraph) abzasdan oldin va abzasdan keyin (After 
paragraph), agarda bu ikkitasi qo£shni abzaslarga tegishli bo£lsa ular 
qo£shiladi.

ABTOMaTiwecKHH nepeHOC (Use automatic hyphenation)ga 
bayroqcha qo£yilsa, YcTaHOBKH nepeHOca (Hyphenation Settings...) 
tugmasi bilan ishlash imkoniyati tug£iladi.

TopHHaH 30Ha (H ot zone) maydoni m atnni ko£chirish 
maydonini bildiradi, o £lchov birligi yonidagi maydonlardan 
kiritiladi.

Ta6yjiau,ua (Tab) 
bo‘limi

Ta6yjiHHHH (Tab) 
bo£limi asosan jadvallar 
bilan ishlaganda kerak 
b o £ladi, sababi uning 
yordam ida ustunlarni 
tekislash amali bajariladi.

Muloqot oynasining 
chap tomonidagi hujjat- 
ga o£matilgan tabulyator- 
ning ro£yxati keltirilgan.

Font | Align | Space Tabs | Frames and Columns | Effects |

Tabs Alignment Leadeied - I I  Add teb |
;12,700 mm LLeft □
25,400 mm l Left □
33,100 mm l Left □
50,300 mm l |_eft □
63,500 mm l Left □
76,200 mm l Left □
88,900 mm l Left □
101,600 mm l Left □
114,300 mm l Left □
127,000 mm l  Left □
139,700 mm l  Left □

Sel labs every | j 12,7 ^

Jjxj

_Ll*J

Fofil | Aligr Space j Tabs | Fiames and Columns ] Effects |
-  Charactei-------

Chaiacter: pE ^  X ol space width

Word: |1 X ol space vjidth

Line: 100-° |H  | % of Chai. height

Befoie paragraph | l 00.0 1 X of Char. height

Altei paiagiaph: |100,0 ^  % of Char. height

r  Useautomatichwhenation HyphenationSettings... |

OK | OTMeHa | npMMBHUTb | Help

{H yphenation S ettings J j x j

T  Break capitalized Min. word lenglh: b :

Hotzone: 112,7 mm Min. characlers before: ^ :

Min. characlers after: = :

OK ~| Cancel Help
l
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TaSyjiHTOpLi (Tabs) ustunida gorizontal chiziq b o £yicha 
koordinatalari ko£rsatilgan. Bu koordinatalami osongina o£zgartirsa 
bo£ladi, kerakli katakchaga chertib koordinatalari o£zgartiriladi.

BLipaBHHBaHne (Alignment) ustunida tabulyator tipi o£rna- 
tiladi. Uni o£zgartirish uchun kerakli katakcha tanlanib, sichqon- 
cha bilan chertiladi va u ro£y- 
xat ko£rinisliiga keladi: JIcblih 
(Left), npaBLiii (R ight),
UeHTpajiLHLiH (C enter).
/IecMTMMHbiM (Decimal).

Muloqot oynasidagi tug- 
ma yana bitta tabulyatsiya 
k iritish  im konin i beradi 
(KHonica /loSaBHTL (Add 
tab)), agarda tabulyatsiya soni 
bir nechta bo£lsa (YcTaHOBHTL 
TaSyjiHTOpLi Kaac^Lie (KHomca 
Set tabs every)) yordamida teng bo£lgan masofalardan berilgan 
o£lchamda qo£yiladi.

yqajiHTL TaSyjiHTOp (Delete tab) va yqajiHTL Bce (Delete All) 
tugmalari bitta yoki ajratilgan ro£yxatdagi tabulyatsiyalar o£cliiriladi.

P o m k u  u k o j io h k u  (Frames and Columns) bo‘limi
PaMKH h  k o j i o h k h  (Frames and Columns) bo£limi faqat abzas 

matnida ishlaydi. Uning 
yordamida ko£p kolonkali 
maydonlar bilan ishlash 
imkonini beradi.

MmCjIO k o jio h o k  (Num- 
ber of columns) maydoni- 
dan kolonkalar soni kiri- 
tiladi.

EojiLHioe nojie IIlHpH- 
Ha k o j i o h k h  h  npoSejiLi 
(Colum n width and 
gutter)lar kolonka o£lchami- 
ni va ular orasidagi maso- 
fani bildiradi. HoMep k o j i o h k h  (Column #) ustunida kolonka 
tanlanadi, IIlHpHHa (Width) kolonkaning eni beriladi, npoSeji 
(Cutler) — ustunida kolonkalar orasidagi bo£sh joylar beriladi.

jjjti
Font | Align | Space | Tabs | Frames and Columns Ellects |

EffectType: | B ullet Sjimbol tt: [45

Form at Tent

Font ] Align ] Space | Tabs Ftames and Columns | Effects | 

Numbei of columns: |2 ^

-U J iJ

- Column widlh and gutlei------
Column 8. V/idth: Guttei:

i 178.171 mi^-j 117,5 mn

\~T~ [78.171 m i^  [

r -  l 3  I
Equal column width

Paiagiaph frame width: 173.843 millimeteis Vertical justificalion:
Maintain cunent fiame width | T op

( Autornaticallv adjusl fiame width
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P aB H a n  m n p H H a  k o jio h o k  (Equal column width)da bayroqcha 
qo£yilgan bo£lsa, kolonkalar o£lchami bir xil bo£ladi, faqat bitta 
kolonka parametrlarini kiritish kifoya.

IIlHpHHa a6r3auHOM paMKH (Paragraph frarnc width) maydonida 
ish maydonidagi barcha kolonkalar hajmi ko£rsatilgan.

BepTHKajiLHoe BLipaBHHBaHHe (Vertical justification) to£liq 
bo£lmagan kolonkaning joylashishi beriladi: CBepxy (Top), IIo 
HeHTpy (Center), CHH3y (Bottom) va IIo (J)opMaTy (Full).

dtfMfreKmu (Effects) bo‘limi
3(|)(|)CK Tbi (Effects) bo£limi ro£yxatlarni bezatishda, bosh 

harflami (drop caps) yozishda ishlatiladi.
T nn 3 (J)(J)eKTa (Effect Type) ro £yxatida quyidagilarni 

tanlasliimiz kerak:
• MapKep a6r3aua (BapnaHT Bullet) matn boshiga joylashtirilib, 

boshqacha ko£rinishda yoziladi va matndan alohida bo£lib turadi.
• BapnaHT EyKBHua (Drop cap) so£zining birinchi harfi katta 

qilib yozilgan bo£ladi.

OTCiynLi (Indents) matnni kiritishdagi chegaralami belgilash 
shu matnga nisbatan qo£yiladi. npocToii MapKep (Bulleted) varianti 
abzas ichidagi markeming joylashishini, BLicrynaiomHH MapKep 
(Hanging Indent)varianti esa abzasdan tashqaridagi joylashishni 
bildiradi.

^JxJ
Font | Align | S pace Tabs | Frames and Column; Effects | 

Effecf Type: Drop cap w

Diopped lines: P

Indents

Distance from text: 11,764 “  mm A  = A  =

)ropped Hanging Indent

OK OTMeHa flpM M eHW Tb Help

Abzas markerlari faqat abzas matniga qo‘yiladi.



PaccTOMHnc o t  TeKCTa (Distance from text) maydondagi katta 
harf bilan oralaridagi masofani bildiradi.

npocTan GyKBnua (Dropped) varianti harfni butkul matn 
bo£yicha joylashtiradi, B biC Tynaram aM  6 y i< B nua (Hanging Indent) 
varianti esa asosiy matndagi so£z boshini bildiradi.

CBOHCTBa oSteKTa (Object Properties) panelidagi CBoiiCTBa 
(Property Bar)ni yordamida formatlash.

x: 141.421 m ^ 27.654 mm 100.0 J s  0 0 , 0 0
V: 176.278 m t 7.764 mm 100.0 1 ^ 1

iji AvantGarde Bk BT T 24 T | 5  /  jj f  abj i i  O

Sliriftning parametrlarini CBoiiCTBa (Property Bar) malumotlar 
satri yordamida ham formatlash mumkin.

Matnni ixtiyoriy shaklli obyektga joylashtirish
CorelDRAW dasturi kolon- 

kalaming xohlagan turini yaratish 
imkoniyatiga ega. Buning uchun 
yopiq grafik kontumi matn uchun 
konteyner qilib olinadi. Matnni 
konteynerga joylashtirish uchun 
TeKCT (Text) asbobini ishga tu- 
shurish kerak va kursomi obyekt- 
ning konturiga olib kelib sichqon- 
cha bilan chertiladi. Shtrixlangan 
kontur yuzaga kelgandan keyin 
matnni kiritishni boshlash kerak.

Matnni ixtiyoriy trayektoriya bo‘ylab joylashtirish
Obyekt bilan bog£langan matnni nafaqat obyekt ichiga joylash- 

tirish mumkin, ya’ni konturlar yordamida xohlagan shaklga ham 
keltirish mumkin.

Matn bilan egri chiziqni bog£lash uchun awal ikkalasini ham 
ajratish kerak va menyuning T c k c t  (Text), onpaBHTL t c k c t  no 
TpaeKTOpHH (Fit Text to Path...) buyruqlari bajariladi.

20 30 40 «■ I..........I.............. I.......... I ■

■ 7 1
/ eKcm

\  B  !V\ o67>eKme !

\  !  
X _____________

Property B a r : Tewt
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Matnni kontur trayekto- K 
riyasida ko‘rinadigan holga “ 
keltirish uchun TeKCT (Text) 
tanlanadi va kursomi konturga “ 
olib kelganda kontur shakli 
o‘zgaradi, oxirida sichqoncha " 
bilan chertiladi. Matn kursori 
paydo bolgandan keyin matn ? 
kiritiladi.

Bog‘langan dinamik ob- 
yektlarni boshqarish uchun menyuning OKHo/IIaHejra THna 
Docker (Window/Dockers), HanpaBHTB tckct no TpaeKTOpHH 
(Fit Text to Path) buyrugci yordamida amalga oshiriladi.

^  T qrst 1 0,0 mm * m  3 0 7 4 3  mm ^

OpneHTaHHH TeKCTa (Text Orientation) (1 raqam) trayekto- 
riyaga nisbatan matnning yo‘nalishini aniqlash.

BepTHKanBHoe BBipaBHHBaHHe (Vertical Alignment) (2 raqam) 
vertikal trayektoriyaga nisbatan matnning joylashishi.

Agarda matn ochiq kontur bocyicha joylashgan bolsa, Hanpa- 
b h t b  TeKCT no TpaeKTOpHH (Fit Text to Path) panelida T 0p H 30H - 

TajiBHoe BBipaBHHBaHHe (Horizontal Alignment) da paydo boladi, 
bu esa, matnni gorizontal bocyicha joylashtirishni bildiradi.

r0pH30HTajiBH0e BBipaBHHBaHHe (Horizontal Alignment) yopiq 
kontur uchun matnning kvadrat shakli ichiga olib yoziladi (3 raqam).

Pe^aKTHpOBaTB (Edit...) buyrug‘i HanpaBHTB tckct no 
TpaeicropHH (Fit Text to Path) panelida joylashgan bolib, ekranga 
muloqot oynasini chiqaradi. Bu oynada matnni trayektoriya bocyicha 
(Fit Text P Offset) gorizontal yoki vertikal siljishini bildiradi.

Matnni egri chiziqlarga o‘tkazish
Grafika va verstka dasturlarida shrifl har xil transformatsiyaga 

uchraydi, lekin harfning qismlarini oczgartirish imkoniyatiga ega 
emas.

Shriftlar maxsus dasturlarda yoritiladi, shu dasturlar yorda- 
mida shriftlar qayta muharrirlanadi va mos formatlarda faylga yoziladi.
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TekcT
Operatsion sistemaga ocrnatil- 
gandan keyin barcha amaliy 
dasturlarda ishlash imko- 
niyatiga ega boladi.

Harfni alohida egri chiziqqa 
aylantirishni qaraylik, buning 
uchun belgilangan matnni 
menyuning «YnpaBjieHHe»
(Arrange) dan «IIpeo6pa30-
BaTB b KpHBBie» (Convert to Curves) buyrug‘i yordamida amalga 
oshiriladi va natijada alohida bolgan obyektlarga ega bolamiz. Bu 
buyruq grafik dizaynda keng foydalaniladi. Logatiplami yoritishda 
avval mos keluvchi shrift tanlanadi va firma nomi kiritilib, 
formatlashning barcha usullari ishlatiladi, keyin har bir shrift 
egri chiziqqa konvertizatsiya qilinadi, natijada olingan matnga 
xohlagancha ishlov beriladi.

"N" [i 50 100 150 . . I........................................I.............................................I............................................I . . . . 200 250 300 350 
....................1............................................1.............................................1 ............................................1 . . . .

;i j . . .

Q - ■ ■ ■
= jOGTekatiiie oDuekTa /> aC3auuuM TekcTOM ODt“ hkauue oDuekTa /  \aG3auuMM TekcTOM

Qj PDTekatt ; \ue otuekTa aG3auuuM
: irekcTOM k-—__ODTeltauue o
: jDuekTa __.-TCl;C TOM
: ■bDTekattue otueR . x /" Ta aC3auuuM ■

Q  - IrekcTOM ODTel-taHue \ /oCuekTa a
: ||j3auuuM t eltc tom. \/otTeltauue oGneltTa at:ai

Q - IO-
JIWjH TekCTOM 

uuum
ODTeltauue oDuekTa

■ ■ ■

Grafik obyektni matn bilan joylashtirish
CorelDRAW dasturida obyektli matnlar bilan ishlaganda 

obyektga matn boglanmaydi, grafik obyektga faqat chegaralash 
beriladi, shu sababli abzasning matndagi obyektini joylashtirganda 
avtomatik ravishda chegaralash bajariladi.

Obyektni «o6TeKaeMBin» qilish uchun kursorni obyektga olib 
kelib sichqonchaning o‘ng tomon tugmasi bilan chertiladi, keyin 
06T eK aT B  a63auH biM  t c k c t o m  (Wrap Paragraph Text) buyrugci 
bajariladi. Asboblar panelidagi CBOHCTBa (Property Bar)da 
06T eK aT B  a63auH biM  t c k c t o m  (Wrap Paragraph Text) tugmasi 
ham shu amalni bajaradi.
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Obyekt bilan matn orasidagi masofani o‘zgartirish uchun: 
kursor obyektga olib kelinib sichqonchaning o‘ng tomon tugmasi 
chertiladi va «CBOHCTBa» (Properties...) buyrug‘i bajariladi. Bu 
quyidagicha amalga oshiriladi. «CBOHCTBa o6i>eKTa» (Object 
Properties) panelidan «06iune» (General) tanlab, «CMemeHHe 
o6TeKaHMH TeKCTa» (Text wrap offset)ga masofa uzunligi kiritiladi.

Edit Text J j x |

rp Bangkok C^r ▼ |~24 w
" "  *

OK

1 Cancel

3 t o  B o A b i i r o e  i i o A e  i i p e g ^ a j H a i i c h o  < j . \ a Help

B B o g a  p e g a k T i i p o B a H U H  u  

^ o p M a r o p o B a H i j ^  

T e k c r a
Fornnat TeKL

Import...

Ofilions ▼

Edit Text dialog oynasi
CorelDRAW maxsus matn maharriri bo‘lmagani bilan matn 

m uharriridagi barcha funksiyalar mavjud bo ‘lgan maxsus 
muharrirlash oynasi « PeziaktmpoBaHme TeKCTa» (Edit Text)ga ega. 
Bu oyna menyudagi «TeKCT» (Text) yordamida ishga tushiriladi.

Oynadagi katta joy matnni kiritish, muharrirlash va formatlash 
uchun mo‘ljallangan. Bu oynaga matn fayllarini (K H om ca Import...) 
tugmasi yordamida import qilish imkoniyati ham bor.

Oynaning yuqori qismida m atnni form atlash amallari 
(garniturni tanlash, kegl, abzaslarni markerlash va hokazo) 
joylashgan.

OopMaTHpoBaHHe T e K c ra  (Format Text...) tugmasi esa matnni 
tashqi bezashga mo‘ljallangan. «OnHHH» (Options) tugmasi esa 
asosan matn imlosini tekshirishga bag‘ishlangan.
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Grafik obyektlarni matnga joylashtirish
Dastuming grafik obyektlarini matnli 

blokga joylashtirish imkoniyatlari mav- 
jud, bu obyektlar shriftlarga propor- 
sional ravishda masshtablanadi. Bu 
funksiyalar matnga grafik elementlami 
joylashtirganda juda qo‘l keladi, masalan, 
logatiplar bilan ishlaganda. Grafik 
elementlarni matnli blokga qo‘yish 
paytida, Clipboard bilan ishlanadi yoki 
menyuning Pe/iaKTMpoBaTb (Edit)dagi 
KonMpoBaTb (Copy), Bbipe3aTb (Cut),
BcTaBHTb (Paste) amallaridan bittasi 
ishlatiladi.

Belgilar va maxsus belgilar
CorelDRAW dasturida Chmbojibi va 

CneHHajibHbie 3HaKH (Symbols and 
Special Characters) panelleri mavjud bo‘lib, ekranga menyuning 
OKHo/IIaHejiH T H n a  D ocker (W indow/ Dockers) orqali 
chaqiriladi.

Bu panelning obyektlari ikki xil xossaga ega: agarda hujjatga 
alohida qo‘yilsa, grafik obyekt hisoblanadi, matnga qo‘yilsa — belgi 
hisoblanadi.

Chmbojibi va cneHHajibHbie 3HaKH (Symbols and Special 
Characters) panelning yuqori qismida shriftli fayllar ro‘yxati 
beriladi, tagidagi maydonda esa, tanlangan fayldagi belgilar 
ko‘rinishi beriladi.

Belgini tanlash uchun sichqoncha bilan tanlab chertiladi yoki 
KjiaBHina (Keystroke) ga maxsus 
Alt-[belgi kodi] tugm alardan 
kiritiladi.

Belgi o‘lchovi Kerjib (Symbol 
Size) yordamida amalga oshi- 
riladi.

XleKopaTM BHaH ceTKa H3 c h m -  

b o j io b  va c n e H H a jib H b ix  3HaKOB 

(Tile Symbol/Special Character) 
buyrug‘i palitradan bitta belgini 
bir xil masofalarda joylashtiradi.
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Toming parametrlari IlapaMeTpLi /iCKopaTMBHOM c c tk m  (Tile 
Options) yordamida o£zgartiriladi.

Pa3MepLi ceTKH (Grid size) maydoniga toming gorizontal va 
vertikal parametrlari o£matiladi.

Imloni tekshirish
CorelDRAW  dasturi m atnlar bilan ishlashning barcha 

funksiyalari bilan ishlash imkoniga ega, shu funksiyalardan biri 
matnning imlosini tekshirishdan iborat. Imloni tekshirganda so£z- 
ning to £g£ri yozilishi ta ’minlanib, noto£g£ri so£zlarni o£chirib 
to£g£risi bilan almashtiriladi.

2.5. To‘ldirish va chegaralash 
parametrlari

Zalivka va obvodka parametrlari bilan ishlashda CorelDraw dasturi 
biriktirilgan ikkita guruh asboblariga ega: 3 a n H B K a  (Fill) OSBO^Ka 
(Outline).

b h e h s b ^ h  $
a *  s s e x \ m

1 2 3 4  5  6  7
Agarda yuqoridagi asboblardan foydalanmaydigan bo£lsak, Ee3 

3anHBKH (No Fill) (Fill Flyout ) (6 raqami bilan berilgan) va 
Ee3 o S b o ^ k h  (No Outline) (Outline Flyout 3 raqami bilan 
berilgan)lar tanlanadi.

Bir xil rangli zalivkalar
Obyektlami rangli qilib bo£yash- 

ning (zalivka) eng tez usuli I la j iH rp a  
U b c t o b  (Color Palette) panelidan 
foydalanish bo£ladi, bu panel ekran- 
ning o£ng tomonida hammavaqt 
ko£rinib turadi. Agarda ranglar 
foydalanuvcliining ta ’biga to£g£ri 
kelmasa menyudagi O k h o  (Wmdows) 
buyrug£i va IiBCTOBbie n a jiH T p L i 
(Color Palettes) orqali boshqa panel 
tanlanadi.
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Tanlangan obyektga zalivka qilish uchun sichqonchaning chap 
tomondagi tugmasi chertiladi, obvodka qilish uchun o£ng tomon 
tugmasi chertiladi. Bu amalni « ncpCTac km uah mm» usuli bilan ham 
amalga osliirsa bo£ladi. Buning uchun kerakli rangni tanlaymiz va 
obyektga olib borib tashlaymiz, agarda <Shift> tugmasi bosilgan 
holda bajarilsa zalivka qilinadi, <Alt> tugmasi bosilgan holda amalga 
oshirilsa obvodka bo£yaladi.

OduomoHuaa 3ajimKa (Uniform Fill) muloqot oynasi
Rangning spektrlari 

va imkoniyatlari bilan 
ishlash OflHOTOHHan 
3ajiHBKa (U niform  
Fill) oynasi yordamida 
amalga oshiriladi. Bu 
3 a jiH B K a  (Fill Flyout) 
panelidagi 1 raqamini 
bosish orqali bajariladi.
OSBO^Ka (O utline 
Flyout) ga rang berish 
uchun  paneldagi 2 
raqamiga sichqoncha 
yordamida chertiladi va 
U b c t  o S b o ^ k h  (Outline 
Color) oynasi paydo bo£ladi.

Bu oynaning to£rtta rejimi mavjud:
• UBeTOBLie MO,n;ejiH (Models). Bu ranglar maydonidan 

berilgan rangga mos rangni tanlashni taklif qiladi.
• CMecHTejiH (Mixers). Bu amal birinchidan ranglar seriyasini 

to£rtta rangdan bittasini olishni, ikkinchidan «garmonik akkord» 
ranglami yoritishni taklif etadi.

• CTaH,n;apTHLie (Fixed Palettes) va IIojiL30BaTejiLCKHe na- 
jiHTpLi (Custom Palettes). Obyektlarga ranglarni berishni taklif 
etadi.

•  U b c t o b o c  nojie H c x o ^ h l i h  u b c t  (Old) obyektning rangini 
o£zgartirmasdan awalgi rangni, H o b l i h  u b c t  (New) maydoni esa 
joriy muloqot oynasidagi rangni bildiradi. CocTaBJimomHe uBeTa 
(Components) maydonida ranglar modelining rang parametrlari 
tanlanadi.

• Hmh (Name) ro£yxatidagi yangi rangga nom beradi.

Models | Mixersj Fixed Palettes j ^  Custom Palettes | 

rR e te re n ce - 

Old:

Add T o Palette id . □fitions T CnpaBKa
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IJeem (Color )paneli
U b c t  (Color) paneli asboblar panelidagi mos bolgan 3 a n H B K a  

(Fill) tugmasi (7 raqami bilan berilgan) bosish orqali ko£rsatilgan 
amallami bajaradi.

rpadueummie 30au6ku (Fountain Fill) oynasi
Gradiyent zalivkalar bitta tonli ranglardan bo£lgan zalivkalar- 

dan farq qiladi. Foydalanish yuqoridagi oddiy rang parametrlari 
bilan ishlashga o£xshash bo£ladi.

rpa^HeHTHaH 3ajiHBKa (Fountain Fill) oynasini ekranga 
chaqirish uchun 3 a n H B K a  (Fill) panelidagi tugmani bosish kerak 
(2 raqami bilan berilgan).

F o u n ta in  Fill

Type:

Center offset

Horizontal:|0

Vertical: P

J j x j

B
-O ptions-

Angle:

Steps:

0,0

2 5 6

:
_“J

Edge pad: 0 *

Color blend 

(* T w o co lo r

From: ■  ”

To:
M idpo int:

Custom

[50

V
'O
o

Presets: - PostScript Options..

OK Cancel H e lp

Gradiyent zalivkalaming to£rtta turi mavjud bo£lib, ular Tnn 
(Type) ro£yxatidan tanlanadi.

• 3ajiHBKa JlMHCMHaM (Linear) tipining to£g£ri cliiziq bo£yicha 
bo£yash.

•  3 an H B K a PanHajiLHaa (Radial)ni aylana shakli bo£yicha bo£yash.
• 3anHBKa KoHHqecKaa (Conical)ni konus shakli bo£yicha bo£yash.
•  3anH B K a KBaapaTHaM (Square)ni kvadrat shakli bo£yicha bo£yash.
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Shu bilan birga gradiyent zalivkalar oddiy (bitta berilgan rang 
ustida) va murakkab (bir nechta ranglardan bir-biriga o£tishi) 
bo£ladi.

Agarda /jByxiiBeTHaH pacraaoca (Two color) joriy bo£lsa, u 
holda birinchi va oxirgi ranglar Ot (From) va /Io (To) tugmalaridan 
aniqlanadi. Ikkita rangning bir xil proporsiyada olinishi uchun surgich 
markazda bo£ladi, agar zarur bo£lgan holda uni Cpe/iHMM TOHKa 
(Mid — point) yordamida o£zgartirsa bo£ladi.

fleKopammmie 3ajimKU oynasi
/JeKOpaTHBHaH 3ajiHBKa (Pattern Fill) muloqot oynasini 

ekranga chaqirish uchun asboblar panelidagi 3 a jiH B K a  (3  raqam 
bilan berilgan) tugmasi bosiladi. XteKOpaTHBHan 3ajiHBKa 
(Pattern Fill)ning uchta turi mavjud: ikkita rangli, to £liqrangli 
va nuqtali.

ffeyxu,eemubie dempammnbie 3ajimKU oynasi
Ikkita rangli dekorativ za- 

livkasini ishga tushirish uchun 
2 -HBeTHan 3ajiHBKa (2 - 
color) tanlanadi va /IcKopa- 
THBHan 3ajiHBKa (Pattern 
Fill) muloqot oynasi quyi- 
dagi ko‘rinishga egabo£ladi.

Muloqot oynasi marka- 
zida 2-uBCTHaM 3anHBKaning 
tayyor turlarini tanlaydigan 
tugma joylashadi.

Ikkita rangli zalivkada 
rasm rangi (IlepeflHHH ruiaH 
(Front))va fon rangi (3anHHH 
njiaH (Back)) bo£ladi.
(Create...) tugmasi va /inyx-
HBeTHOH 3ajIHBKH (TwO-
Color Pattem Editor) mu- 
harriri yordamida yangi ikkita 
rangli zalivkalami yaratish yoki eskilarini muharrirlash mumkin. 
Shuning uchun chizilgan bit kartasi (o£lchamini Pa3Mep S l i t o b o h  

KapTLi (Bitmap size) yordamida o£zgartirsa bo£ladi) «shtrix» 
o£lchami (Pen size)dagi pero o£lchamida qo£yiladi.
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nomoufiemHue eeKmopmie u moHenmie 3ameKU oynasi
P a t t e r n  Fill

L oa d.. D e le te

IJriqm Size

x: 10,0 mm W idth: 150 ,8  mm

y: 10,0 mm H r j Height: 150.8  mm I

-  R o w  or column o ffs e l-------

* R ow  ColumnSkewc 0 , 0 1 I

Rotate: |0 ,0 °  ' “ j 10  o l tile size

T ransform fill with objecl
O K C a n c e l H e lp

To£liq rangli zalivka o£zining dekorativ maydoniga ega bo£lib, u 
aloliida *.pat kengaytgichga ega bo£lgan vektor elementlaridan tashkil 
topadi. Agarda IIojiHOiiBeTHaH 3ajiHBKa (Full color) yoki 
nOjihoubcthaM TOMCMHaM 3anHBKa (Bitmap) joriy bo£lsa, u holda 
/IcKopaTMBHaM 3anHBKa (Pattem Fill) oynasi quyidagicha bo£ladi.
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Texture Fill ^ x j

T enture library:

Samples 9 

T enture list:

O ven Element 
O r f s  Eye 
P lateaus 
Quilt
Solar Flare J

O K

Cancel

Help

Options..

S teel W oo l
r .... i . r-. ___ -

Preview Tiling...

jty le  Name: Solder

T exture tt: 19195 Eastern light ±Z: 50 ^  “ I
t t  of drops: 60 N orthern lighl tX: 50 ■ d
M in drop w idth % 0 Shade: i i

Ma>: drop w id th  X 75 Mid-shade: b -  y
Phase offset ±X\ 100 Light:

Ripples density %: 25 Brightness tX “ I

TeKcmypmie 3ajimKU oynasi
CorelDRAW dasturidagi matn zalivkalari nuqtali tasvirlardan 

tashkil topgan bo£ladi, ular xohlagan tasvirlardan ixtiyoriy ravishda 
tanlanishi, fraktal asosida olinishi mumkin, masalan, oynadagi 
sovuqning ko£rinishi.

Matnli zalivkalarning parametrlari TeKCTypHan 3ajiHBKa 
(Texture Fill) oynasida beriladi. Bu oyna asboblar panelidagi 
3 a jiH B K a  (Fill) (4 raqami bilan berilgan) tugmasini bosish bilan 
paydo bo£ladi.

Matnni yozish uchun BnSjiHOTeKa TeKCTyp (Texture library) 
maydonidan bittasini tanlash kerak, keyin TeKCTypLi (Texture 
list) ro£yxatidan matnning turi tanlanadi. Muloqot oynasining 
pastki qismida boshqarish maydonidagi har bir matn turi haqida 
m alum ot beriladi va u har bir matn turi uchun alohida ko£r- 
satiladi.

Har bir maydonning o£ng tomonida qulf shaklidagi belgi bo£ladi. 
Uning vazifasi quyidagicha: agarda qulf ochiq bo£lsa, u holda matnni 
tanlash ehtimoli bor. Masalan, belgining ranggi bir qiymatda 
o£zgarmaydi.
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Hamma parametrlar o£zgartirilgandan keyin tasvimi oynada 
ko£rish uchun n p 0 C M 0 T p  (Preview) tugmasi bosiladi va tasvimi 
dasturda qayta ishlab ekranda ko£rsatadi.

PostScript — 30JIU6KU oynasi

P o s tS c r ip t  T e x tu re

B asketw eave
Birds
B r ic k s
Bubbles
Carpet
C irc le G rid

C o lo r B u b b le s
ColorCircles
I ‘nlnrPrn-gharnhiKin

Param eters-

W idlh :

J

-

10

Spacing (%): 

Maximum gray: 

Minimum gray:

100
100

m
m
m
in
m
m
m
Refresh

OK

Cancel

Help

i
J  W P review  fill

PostScript — zalivka parametrlarini aniqlash uchun PostScript — 
3ajiHBKa (PostScript Texture) muloqot oynasidan foydalanadi, 
bu oyna 3 a n H B K a  (Fill) (5 raqami) panelidagi maxsus tugma orqali 
ishga tushiriladi.

Zalivkani tanlash uchun ro£yxatdan xohlagan bittasini tanlashi 
kerak. Agarda npocMOTp 3anHBKH (Preview fill)ga belgi qo£yilgan 
b o £lsa, oynada zalivkani real ko£rinishi namoyon b o £ladi. 
PostScript — zalivkalar matn zalivkasidan parametrlar berilishi 
bilan bir-biridan farq qiladi. Agarda qandaydir parametri o£zgar- 
tirilgan bo£lsa, yangi parametrlami o£zlashtirish uchun OSHOBJieHHe 
(Refresh) tugmasi bosiladi.

HncmpyMenm HnmepaKmuenan 3ajiueKa (Interactive Fill) 
oynasi

HHTepaKTHBHan 3ajiHBKa (Interactive Fill) CBOHCTBa 
(Property Bar) asboblar paneli bilan birgalikda ishlatiladi.

Bu asbobni ishga tushurish uchun obyektni belgilab va asboblar 
panelidan zalivka turini tanlaydi. Har bir zalivka turidan o£zining
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□
o
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parametrlari foydalanadi. Muharrirlash uchun CBoiiCTBa 
(Property Bar) asboblar panelida maxsus Pe^aKTHpOBaTL 
(Edit...) tugmasi yordamida amalga oshiriladi.

P ro p e r ty  Ba r : I n te ra c t iv e  T e x tu re  F ill

T exture Fill Samples G

2!

P |  Regenerale Texlure | Texture Oplions... | $  Hairline ”■ Dg]

IlapaMempbi o6eodm (Outline Pen) oynasi
Kontuming barcha parametrlari OSBO^Ka (Outline) ( 1 raqami 

bilan berilgan) panelidagi IlapaMeTpLi o S b o ^ k h  (Outline Pen) 
oynasidan kiritiladi.

U b c t  (Color) obvodka rangini bildiradi. Bu tugmaga chertilganda 
quyidagicha palitra ekranga chiqariladi. Agarda boshqa palitra yoki 
rangning boshqa turini tanlash kerak bo£lsa, /Ipyrne (Other...) 
tugmasini bosish orqali amalga oshiriladi va ekranda U b c t  o S b o ^ k h  

(Outline Color) paydo bo£ladi. Bu oynani boshqacha usul bilan 
ham chaqirish mumkin, uning uchun asboblar panelidan OGuo/iKa 
(Outline) (2 raqami bilan berilgan) tugmasi bosiladi.

J j x j

Width:

4-° |poim$ ▼

Style: O.ptions T Options

Help
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TojiniHHa (W idth) maydoni T  
obvodka qalinligini o£matadi. Uning 
eniga mos keladigan o£lchov birlik- 
larini tanlash mumkin.

C t h j i l  (Style) chiziqning har 
xil stillarini tanlaydi — c i u i o i u h o h ,

nyH K T H pH O H , IIITpHXOBOH, LUTpHX 

nyH K T H pH O H  va hokazo.
/IoGaBMTb (Add) va 3aMeHHTL 

(Replace) tugmalari ro£yxatga yangi 
stillami qo£shadi yoki ulami boshqa 
stil bilan o£zgartiradi.

YrjiLi (Corners), IlapaMeTpLi 
o S b o ^ k h  (Outline Pen) muloqot 
oynasida joylashgan bo£lib, o£tkir 
burchaklami chizishda ishlatiladi.

(Options) parametrlari burchakni kesishlarda ishlatiladi. Birinclii 
o£tkazgich o£tkir burchakni, ikkinchi o£tkazgich burchakning 
aylana shakliga kelishini, uchinchisi esa kesishni bildiradi.

K o h h l i  j i h h h h  (Line Caps) m aydoni chiziqlarning, 
shtrixlaming oxirini qanaqa bo£lishini bildiradi.

CTpejiKH (Arrows) maydonidan yo£nalishning ikkitasidan 
bittasi tanlanadigan tugmalar — biri kontur boshini, ikkinchisi 
esa oxirini bildiradi. OnHHH (Options) ro£yxatni ochadi va 
yo£nalishlar bilan ishlashni bildiradi.

Bitta obyektning parametrlarini boshqa obyektga qo‘llash
Foydalanuvchi obyektga qanday parametrlar berganligi va uni 

ikkinchi obyektga qo£llash uchun CorelDRAW dasturida maxsus 
buyruq bor.

Dastlab parametrlar beriladigan obyekt tanlanadi, keyin 
menyuning Pe^aKTHpOBaTL (Edit) va KonnpOBaTL napaMeTpLi 
y... (Copy Properties From...) buymqlari bajariladi, ekranda 
KonnpOBaTL napaMeTpLi (Copy Properties) oynasi paydo 
bo£ladi.

Oynadan kerakli bo£lgan parametrlar tanlanadi: IlapaMeTpLi 
o S b o ^ k h  (Outline Pen). U b c t  o S b o ^ k h  (Outline Color) 3ajiHBKa 
(Fill) h  IlapaMeTpLi T e K C T a  (Text Properties).
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2.6. Qatlamlar bilan ishlash

Qatlam deganimizda obyektlar joylashtiriladigan plyonkasimon 
tekislikni tushunamiz. Bu tekislikni barcha obyektlari bilan siljitish, 
o£chirish, ekranda ko£rsatish va bosmadan cliiqarisliga bog£liqbo£ladi. 
CorelDraw dasturida hujjat yaratilganda to£rtta qatlam bo£ladi: 
birinchi qatlam — tasvir tushadigan (Layer 1), ikkinchisi — 
(Master Grid) tori (setka) uchun, uchinchisi — (Master Guides) 
yo‘nalish uchun va to£rtinchi — «ish stoli» (Master Desktops) 
uchun mo£ljallangan bo£ladi.

Yangi qatlamlami qo£shish obyektlar bilan ishlashda qiyinchilik 
tug£dirmaydi.

Har bir sahifadagi qatlamlar soni bir xil parametrlarda va bir 
xil nomda bo£ladi. Agarda qandaydir qatlam bitta sahifada ko£rinmas 
holga kelib qolsa, boshqa sahifalardagi qatlamlar ham ko£rinmas 
holda bo£ladi. Shu bilan birga barcha saliifada qatlamlarning joylasliish 
tartibi ham birdan o£zgaradi.

Qatlamlar bilan ishlashning flucnemnep oQbeKmoe (Object 
Manager) paneli

Qatlamlar ustidagi hamma ope- 
ratsiyalar (yaratish, o£chirish, to£g£- 
rilash va hokazo) /IncneTMcp oSLeicroB 
(Object Manager) paneli yordamida 
bajariladi.Bu ekranga menyuning 
OKHo\naHejiH THna Docker 
(Windows\Dockers) va /IncncTMcp 
oSteKTOB (Object M anager) 
buyruqlari bilan chaqiriladi.

Panel sarlavhasi tagida to£rtta tugma 
joylashgan bo£ladi (chapdan o£ng 
tomonga qarab):

1. HoBbiii cjioii (New layer) tugmasi yangi qatlamni Cjioh 
(Layer) nomi va mos raqamni qo£shadi.

2. IIoKa3aTb CBOHCTBa 06i.eKT0B (Show Objects Properties) 
tugmasi obyektning xossalarini ko£rsatadi.

3. /Ijih peAaKTHpoBaHHH tugmasi barcha qatlamlar uchun 
tuzatish kiritish imkoniyatini beradi, agarda u o£chirilgan bo£lsa, 
faqat joriy qatlamda islilatsa ham bo£ladi.
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4. Bha AwcneTwepa cjioeB (Layer Manager View) tugmasi 
qatlamlar dispetcheri ko£rinishini ko£rsatadi.

Piktogramma sichqonchani o£ng tomon tugmasi bilan chertilsa 
qatlamning xossasini bildiradigan menyu chiqariladi va uning yordamida 
qatlamni o£chirish yoki uning nomini o£zgartirishi mumkin.

Yangi qatlam yaratish
Yangi qatlam H o b l i h  c j i o h  (New Layer) tugmasi yordamida 

yaratiladi. Foydalanuvchi xohlagancha qatlamlarni yaritish 
imkoniyatiga ega, faqat chegaralanish kompyuter texnik para- 
metrlariga bog£liq bo£ladi.

Qatlamga nom berish
Qatlamga yangi nom berish qatlam yaratilgan paytda bajariladi, 

agarda qatlamga nom berilgan bo£lsa, uning nomini o£zgartirmoqchi 
bo£lsangiz, IlepeHMeHOBaTL (Rename) buyrug£i bilan amalga 
oshiriladi.

Qatlamni joriy qilish
Yangi yaratilgan obyekt xohlagan joriy qatlamga joylashtiriladi, 

shu sababli obyektni o£zimiz xohlagan qatlamga qo£yishimiz uchun, 
qatlamni /IncncTMcp o S L e ic ro B  (Object Manager) paneliriing qatlam 
nomiga sichqonchabilan chertib belgilashimiz kerak. Qatlamning joriy 
bo£lganligini bilish uchun qatlam nomining rangiga qarash kerak, 
agarda u qizil rangda bo£lsa qatlam joriy holda deb tushuniladi.

Qatlamlarning joylashish tartibini o‘zgartirish
Qatlamlami tartibi /IncncTMcp o G l c k t o b  (Object Manager)- 

dan o£zgartiriladi, shuning uchun kerakli qatlamlami sichqoncha 
yordamida pastga yoki yuqoriga surib, joylashish tartibini o£zgar- 
tirish mumkin.

Qatlamlarni o‘chirish
Palitradagi ajratilgan qatlamni va unda joylashgan obyektlami 

o£chirish uchun quyidagi amallar bajariladi:

• <Delete> tugmasini bosish kerak;
• Menyudan yqajiHTL (Delete) buyrug£ini tanlab <Enter>ni 

bosish kerak;
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• M enyudagi ,3,HcneTHep oSteKroB (Object Manager) 
buyrug£idan y q a n H T L  c j i o h  (Delete Layer)ni tanlash kerak.

|  Master Grid, Master Guides, Master Desktop — standart 
•  qatlamlarini o£chirish mumkin emas.

Qatlamlarni fikserlash
Fikserlangan qatlam bitta butun hisoblanib, unda joylashgan 

obyektlar ajratilmaydi, o£zgartirilmaydi, siljitilmaydi va o£chiril- 
maydi. Fikserlanganlik belgisini /IncncTMcp oSLeKTa (Object 
Manager) panelidan qatlamlar satridan «ko£k rangdagi qalam» 
joylashganligidan bilsa bo£ladi.

Qatlamlarni fikserlash uchun qalamning piktogrammasiga 
sichqoncha bilan chertish kifoya, qalam o£zinig rangini o£zgartiradi. 
Ikkinchi marta chertilsa fikserlanadi.

Qatlamlarni vaqtincha ekrandan olib qo‘yish
Fikserlangan qatlamni muharrirlash mumkin emas. Qatlamda 

joylashgan obyektlar ekranda ko£rinish beradi. Agarda foydala- 
nuvchiga bu qatlam kerak bo£lmasa uni ekrandan olib qo£yish 
mumkin. Buning uchun qatlamni ekrandan vaqtincha o£chirib 
qo£yish imkoniyatlari mavjud.

/IncncTMcp o S l c k t o b  (Object Manager) panelidagi C B O H C T B a  

c j i o h  (Layer Properties) oynasidagi B n / i n M b i c  (Visible) 
bayroqchasini belgilash (olib tashlash) orqali amalga 
oshiriladi.

Macmep c j i o h  (Master Layer)dan foydalanish ^
Qatlamning xossasi C B O H C T B a  c j i o h  (Layer Properties) K

oynasidan MacTep c j i o h  (Master Layer) ga bayroqcha 1=1
qo£yadi yoki kontekst menyudagi Macrep c j i o h  (Master) °
buyrug£ini xolilagan qatlamini MacTep c j i o h  ga aylantiradi.
Uning vazifasi ko£p saliifali hujjatlardagi hamma sahifalar —
joylashgan obyektlar ko£rinadigan holga keltiriladi.

Agarda faqat joriy sahifada ko£rinadigan holga keltirish ^
kerak bo£lsa, IIpHMeHHTL CBOHCTBa c j i o h  t o j i l k o  k  T e K y m e i i  J

CTpaHHHLi (Apply all property changes to the current page ^
only)ga bayroqcha qo£yish orqali amalga oshiriladi. &

85



Obyektlarni bitta qatlamdan ikkinchi qatlamga ko‘chirish
Har xil qatlamlarda joylashgan obyektlami ko‘chirib, ulardan 

nusxasini olsa bo'ladi. Buning uchun menyuning panelidagi 
IlepeMecTHTL Ha c j i o h  (Move To Layer...) va KonHpoBaxb Ha c j i o h  

(Copy To Layer...) buyruqlaridan foydalaniladi. Amal bajarilganda 
ekranda qatlam nomini ko‘ rsatuvchi yo‘ nalishi chiqariladi.

Agarda obyektlarni joriy qatlamdan ko‘chirish kerak bolsa, u 
sichqoncha bilan amalga oshiriladi. Buning uchun obyekt yoki 
obyektlar to ‘plamini tanlash kerak va sichqoncha yordamida 
ko‘chirish kerak bolgan joyga olib borib qo‘yiladi.

2.7. Rangli va vektorli effektlar

CorelDRAW vektor dasturida obyektning shaklini OopMa 
(Shape) asbob yordamida o‘zgartirsa boladi, ko‘pchilik hollarda 
obyektning har bir tayanch nuqtasi bilan ishlashga to‘g‘ri keladi, 
bu esa, qiyinchilik tug‘diradi. Bu masalani yechish uchun effekt 
ko‘rinishidagi maxsus dastur ishlab chiqilgan.

Oddiy vektor effektlari
Oddiy vektor effektlariga oddiy obyektdan murakkabga yoki 

teskarisi — murakkabdan oddiyga o‘tadigan obyektlardan tashkil topadi. 
Natijada obyekt shakli hech qanday o‘zgarishga (deformatsiya) 
uchramaydi, faqat uning tashkil etuvchilar yig‘indisi o‘zgaradi.

KoM^HHHpQBaTL (Combine) buyrug‘i



K0M6HHHp0BaTL (Combine) buyrug'i, CBOHCTBa (Property 
Bar) menyuning tashkil etuvchisi YnpaBjieHHe (Arrange) 
yordamida bir yoki bir nechta obyektlami bitta obyektga birlashtiradi. 
Bu buyruq obyektlarning tayanch 
nuqtalarini biriktirganda, niqobga 
olganda yoki teshikchalar paydo 
qilganda qollaniladi.

K0M6HHHp0BaTL (Com bine) 
buyrug'ini foydalanishdan avval 
biriktirilishi kerak bolgan obyektlar 
ajratiladi. Agarda obyektlar har xil 
zalivkalarda bolsa, biriktirilgandan 
keyin eng pastdagi obyekt zalivkasi 
olinadi.

Bu buyruqning ma’nosini yaxshi 
o‘zlashtirib olish kerak: obyektlar applikatsiya prinsipiga asoslangan 
holda o‘zining xossasiga ega bolib, obyektlar bitta bosqichga olib 
kelinib bo‘yaladigan va bo‘yalmaydigan obyektning qismlarini 
qaytadan bo'lishtiradi. Qayta bo'lishtirilganda kesishmaydigan 
obyektlar natijaviy obyektga kiradi, kesishadigan obyektlar esa, 
ko‘rinmas holga keltiriladi.

Jarayonni tushunish uchun shunday qoida bor. Agar o‘zimiz 
chiziqni chapdan o‘ngga o‘tkazsak, u holda obyektni kesib o‘tgan 
birinchi konturdan boshlab zalivka boshlanib, ikkinchi konturda 
zalivka tugatiladi («teshikcha» boladi) undan keyingisida zalivka 
boladi va hokazo.

Pa30umb KOMdunau^uw (Break Apart) buyrug‘i
YnpaBjieHHe (Arrange) menyusida K0M6HHHp0BaTb (Combine) 

buyrug‘i birgalikda Pa36HTL KOM^HHaiuiK) (Break Apart) buyrug‘i
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ham mavjud bo‘lib, ko‘p konturli obyektni tashkil etuvchi 
konturlarga ajratadi va ular alohida bitta obyekt deb tushuniladi. Bu 
amal K0M6nHHp0BaTb (Combine) buyrug‘ini bekor qilishda yoki 
obyektni tashkil etuvchi konturlarga bo‘lib ishlashda foydalaniladi.

Obyektni belgilab CBOHCTBa (Property Bar) panelidagi Y n p a B -  
jieHne (Arrange) buyruqni tanlagandan keyin ishga tushiriladi.

P r o p e r ty  B a r : C u rv e  o r  C o n n e c to r

-169 916 m H-H 41 .067  nnnn 
y: 2C G .107m  J  1C.340mnn

E 00-0 d o  0 
I E 00.0 & 1 J  ' I £ I P 1

Q - l ------------- 1  E '  1B l ^ l s  o-5p» H d J |-00 4>

H3MeHeme (popMbi (Shaping) paneli
YnpaBjieHHe (Arrange) da yana uchta buyruq mavjud bo‘lib, 

K0M6nHHp0BaTb (Combine) buyrug‘ining turlaridan iborat. Bu 
birlashtirishning qo‘shimcha turlarini o‘z ichiga oladi. Uchta buyruq 
Docker panelining umumiy nomi H3MeHeHHe (J)opMbi (Shaping) 
qilib birlashtirilgan hamda CBOHCTBa (Property Bar) panelidagi 
tugmalari ham berilgan.

P roperty  Bar : M u llip le  O b jec ls

x: -91 .9 0 7  m N-H 23.2GG mm 1 1 0 0 .0  %  
y: 222.401 m I  1 9 .2 83  mm 100 .0

*j
Q+

C om bine G roup  U n g rou p  U n g ro u p A II ^  ®  A lign...

KHOnxa KOHOHflbl t
06-befleHeHiie (Wdd)

1 k K̂HOmra KOMSHflbl
nepeceneHHe 
(Inters eotion)

KHOnKa KOMaHflbl 
OrceneHMe (Trim)

Buyruqning ayriqcha tomoniga e’tibor berib, berilgan obyekt- 
laming guruhidan ham foydalansa boladi (obyektlar belgilanib MeHio 
YnpaBjieHHe (Arrange) menyusidagi CrpynnnpOBaTb (Group) 
buyrug‘i bajariladi).

Odbedunumb (Weld) buyrug‘i
YnpaBjieHHe (Arrange) menyusidagi yoki CBOHCTBa (Property 

Bar) panelidagi 0 6 i>eAHHHTb (Weld) buyrug‘i yordamida hamma 
obyektlarni umumiy perimetrlari bo‘yicha kontur chiziladi.



Obyektlarni birlashtirish 
uchun bir yoki ikkita obyekt 
tanlanib OGteAHHHTb c...
(W eld T o ...) tugm asini 
bosish kerak va ko‘rsatilgan 
yo‘nalish yordamida oxirgi 
obyektdagi obvodka, zalivka- 
lami yangi obyektda qollaydi.

CoxpaHMTb opnrHHaji (Leave Original) maydonida quyidagi 
amallar bajariladi.

• KoHenHbiH oGteKT^bi) (Target Object(s)) bayroqchasi 
belgilangan yoki yo‘nalishi ko‘rsatilgan obyektni xotiraga yozishni 
ta’minlaydi.

• flpyrae oGteKTbi (Source Object(s)) barcha obyektlarni 
xotiraga yozishni ta’minlaydi.

nepecenenue (Intersect) buyrug‘i
IlepeceHeHHe (Intersect) buyrug‘i yoki 

CBOHCTBa (Property Bar) panelidagi mos 
tugmalar yordamida obyektlar biriktirilib, 
shaklli barcha obyektlarning kesishidan 
tashkil topgan yangi obyekt yaratiladi.

Ishlash va bayroqchalarning vazifasi 
OGteAHHHTb (Weld) buyrug‘iga o‘xshash 
bo‘ladi.
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Omcenenue (Trim) buyrug‘i
OTceneHHe (Trim) buyrug‘i yoki CBOHCTBa (Property Bar) 

panelidagi mos tugmalarning vazifasi berilgan obyektlar ishidan 
keraksiz bo‘lgan obyektlar birikmasini kesib olib tashlanadi.

Bu buyruqning bajarilishi OSte^HHHTB (Weld) buyrug‘iga 
o‘xshash bo‘ladi.

||[ ^ |  Shaping

_0 j[% _®J
Trim:

Leave  Original: 

S ource Object(s) 

Target Object(s)

Trim...

Murakkab vektor effektlari
Murakkab turdagi vektorlar bilan ishlash menyuning 3(J)(l)eKTLi 

(Effects) yordamida bajariladi. 3c|D(i)eKTbi (Effects) yettita buyruqdan 
tashkil topgan bo‘lib, obyektlar yoki obyektlarning yig‘indisi ustida 
har xil effektlami bajaradi.

IlepcneKmuea (Add Perspective) buyrug‘i



IlepcneKTHBa (Add Perspective) buyrug‘i 3(|)(|)eKTLi (EfFects) 
menyusida joylashgan bo‘lib obyektlarni perspektivasini yaratish 
uchun obyektlarni har xil deformatsiya qiladi. Bu buyruq ajratilgan 
obyektni shtrixlangan burchaklarida to‘rtta markerli ramkaga oladi. 
To‘g‘ri to‘rtburchak ichida foydalanuvchi tomonidan gorizontal va 
vertikal chiziqlarga deformatsiya berishga mo^ljallangan tor 
joylashtirilgan.

Markerlarni siljitish orqali obyektni transformatsiya qiladi va 
bir yoki ikkita nuqtali perspektivasini olamiz. Perspektiva ko‘rinishini 
o‘zgartirish uchun nuqtalarni surish kerak.

3 (|)(|)eKTLi (Effects) menyusidagi KonnpoBaTb (Copy) buyrug‘i 
har xil effektlar ro‘yxatini chiqaradi. Bu buyruq yordamida 
perspektiva parametrlarini ikkinchi belgilangan obyektga qo‘llasa 
bo‘ladi.

Berilgan buyruqda Y^ajiHTB < effekt nomi > (Clear < effekt 
nomi >) bilan effekt, perspektiva parametrlari o‘chiriladi.

Obyektni ajratganda qandaydir effektdan foydalanilsa, dastur 
tomonidan uning nomini ko‘rsatishni so‘raydi.

Envelope buyrug‘i
3(|)(|)eKTLi (Effects) menyudagi 0 6 o j io n K a  (Envelope) buyrug‘i 

vektorli obyektlarni qobig‘ga qo‘yishni bajaradi.
CorelDRAW dasturida bu amal quyidagicha bajariladi:

• Docker turidagi panel;
• CBOHCTBa (Property Bar) asboblar satri;
• MHTepaKTMBHafl o6ojionKa (Interactive Envelope) asbobi.

140 f
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Dockers turidagi panelni ekranga chaqirish uchun:Windows 
menyusidan Toolbars tanlanadi va paydo bo‘lgan oynadan chap 
tomonda Menus dan Customize menyuchasi tanlanadi. Oynaning 
o‘ng tomonidan ikkinchi kolonkadagi &Windows — &Dockers 
menyusini ochamiz, birinchi kolonkadan Effects jildi ochiladi va 
kerakli asbob tanlanadi (bizlar & Envelope buyrug‘ini tanlaymiz) 
va Add, OK tugmalarini bosish kerak. Shunday qilib, bizlar 
Windows — Dockers menyusiga Envelope buyrug‘ini qo‘shamiz. 
Amal bajarilganda ekranda Dockers turidagi Envelope paneli 
ko‘rinadi.

HHTepaKTHBHafl oSojio^Ka (Interactive Envelope) asbobi 
ishga tushurilsa, ajratilgan obyekt atrofida to ‘rtburchak paydo 
bo‘ladi, markerlarni siljitish orqali obyektni xohlagan shaklga 
olib kelsa bo‘ladi. Markerlarni siljitish to ‘rtta muharrirlash 
rejimidan iborat:

1. n o  npHMoii j iH H H e  (Straight Line) rejimi qobiqning 
segmentlarini to‘g‘ri chiziq ko‘rinishida beradi.

2. n o  nyre (Single Arc) rejimi segmentlarni duga ko‘rinishida 
beradi.

3. n o  a b o h h o h  ^yre (Double Arc) rejimi ikkitalik duga 
ko‘rinishida beradi.

4. C b o S o a h h h  pe>i<MM (Unconstrained Mode) rejimi qobiq 
konturlarini OopMa (Shape) asbobi bilan muharrirlaganda 
o‘zgartirish mumkin. Bu deganimiz tayanch nuqtalar va bosh- 
qarish richaglari bilan ishlash imkoni tug‘iladi. Obyektga tayanch 
nuqta qo‘shish yoki uni olib tashlash mumkin bo‘ladi.

Yuqoridagi uchta rejimni maxsus tugmalar bilan amalga oshirsa 
bo‘ladi:

• <Ctrl> tugmasini bosilgan holda siljitish qarama-qarshi 
nuqtani berilgan yo‘nalish bo‘yicha siljitadi.

• <Shift> tugmasini bosilgan holda siljitish qarama-qarshi 
nuqtani berilgan yo‘nalishga qarshi yo‘nalishga siljitadi.

• (<Ctrl> + <Shift>) tugmalarini bosilgan holda siljitish 
tayanch nuqtaning qolgan uchta nuqtalarni bir-biriga teskari 
tomonga siljitishni ta’minlaydi.

,3,o6aBHTfc r 0T0B y i0 oSojio^Ky (Add Preset) tugmasi tayyor 
qobiqlar ro‘yxatidan bittasini tanlashni bildiradi.

Dasturda qobiqni muharrirlashdan tashqari qobig‘ni xarita- 
lashning to‘rtta usuli mavjud:
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1. yrjioBoii (Putty) rejimi 
burchakdagi tayanch nuqtaga 
markerlar qo‘yishni bildiradi.

2. OpHTHHanLHHH (Original) 
rejimi burchak markerlarning 
burchak tayanch nuqtalarda joy- 
lashtiriladi, boshqa tayanch 
nuqtalar qobig‘ chizig‘iga bo‘lib 
beriladi.

3. r 0pH30HTajILHHH (Hori- 
zontal) rejimi obyektni gori- 
zontal chiziqlarini saqlagan holda 
joylashtiradi.

4. BepTHKanLHHH (Vertical) 
rejimi obyektni vertikal chiziq- 
larini saqlagan holda joylashtiradi.

CoxpaHHTL npHMLie (Keep lines) bayroqchasi obyektdagi 
to‘g‘ri chiziqni saqlashni bildiradi.

Har xil o‘zgartirishlami CBoiiCTBa (Property Bar) panelidan 
yoki 3c}x})eKTbi (EfFects) menyusidan O t m c h h t l  oSBO^Ky (Clear 
Envelope) buyrug‘i bilan orqaga qaytariladi.

Ilouiaeoebiu nepexod (Blend) buyrugH
3 (J>(J>eKTLi (Effects) menyusidagi Blend (nomaroBLiii 

nepexoji) buyrug‘i obyektning bir shaklidan ikkinchisiga o‘tganda 
bajarilgan ketma-ketlikni ko‘rsatadi. CorelDRAW dasturida bu 
effektlarni quyidagicha boshqaramiz:
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• Docker turidagi panel;
• CBOHCTBa (Property Bar) asboblar satri;
• MHTepaKTHBHbiH nepexo# (Interactive Blend) asbobi.

Bu effektning eng yaxshi berilgani Docker turidagi panelda, u 
tocrtta: fflara (Steps), YcKopeHHe (Acceleration), IIpeBpameHHe 
UBeTa (Color Direction) va Pa3Hoe (Miscellaneous) tugmalaridan 
iborat.

Amalni bajarish uchun asbob ishga tushiriladi, kursor yorda- 
mida obyekt tanlanadi, sichqonchaning tugmasi bosilib, shtrix 
chizigcini oxirgi olingan obyektgacha suramiz, natijada bajarilgan 
amallar guruhi namoyon bocladi.

IUaau (Steps) tugmasi
IIouiaroBbiH nepexo# (Blend) panelidagi birinchi tugma Illara 

(Steps) obyektlarning oczgarish soni va ular orasidagi masofa 
birinchisidan ikkinchisiga octish sonini bildiradi.

H h c j i o  u i a r o B  (Number o f  steps) kerakli boclgan oradagi 
obyektlar sonini bildiradi.

OHKCHpoBaHHbiH HHTepBan (Fixed spacing) bir-biriga octish 
oraligcini bildiradi. Bu amal faqat ketma-ket octish trayektoriya 
bocyicha boclsa — bajariladi.

BpameHHe (Rotate) maydoni oradagi obyektlarni burishni 
bildiradi.

IleTjiH (Loop) bayroqchasi berilgan obyektlardan bir-biriga 
octishda ular orasidagi trayektoriyani burish xizmatini bajaradi.

ycKopenue (Acceleration) tugmasi
IIoniaroBbiH nepexo# (Blend) panelidagi YcKopeHHe 

(Acceleration) tugmasi obyektlarni qaytadan joylashtiradi va 
joylashish tartibini oczgartiradi.

Y cK opeH H e oS^eicroB (Accelerate objects) maydoni obyektlar 
orasidagi octish oraligci teng boclmagan holatlami yoritadi, agar 
chap tomonga surilsa, berilgan obyektdan oxirgi obyektgacha boclgan 
voqealami tezlashtiradi, ocng tomonga surilsa, oxirgi obyektdan 
boshlanadi.

Y cK opeH H e 3ajiHBKH/ o S b o ^ k h  (Accelerate fills/-outlines) 
yuqoridagi amalga ocxshash bocladi, faqat zalivka, obvodkalar 
uchun bajariladi.
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npHMeroiTb k  pa3Mepy (Apply to sizing) oradagi obyektlami 
YcKopeHHe oGtdCktob (Accelerate objects)ga nisbatan oclchamlarini 
oczgartiradi.

CBH3b ycKopeHHH (Link accelerations) bayroqchasi YcKopeHHe 
o6T>eKroB (Accelerate objects) va Y cK opeH H e 3ajiHBKH/o6Bo^KH 
(Accelerate fills/outlines) maydonlaridagi qiymatlami sinxronlashtiradi.

m
[K> <j=!1

Apply

IJpeepamenue yeema (Color Direction) 
tugmasi

I Ip e B p a m e H H e  ijB eT a  (Color Direc- 
tion) tugmasi bir rangdan ikkinchisiga 
octishni ta’minlaydi, bu amal rpa^HeHTHafl 
3ajiHBKa (Fountain Fill) oynasidagi amalga 
ekvivalent bocladi.

Berilgan uchta tugma bir rangdan 
boshqasiga octish yocnalishini kocrsatadi.

nepexo^ no n p H M O H  j i h h h h  (Straight 
Line Blend) tugmasi berilgan ranglar 
doirasidan tocgcri chiziq bocyicha boshqa 
rangga octishni ta’minlaydi.
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Qolgan ikkitasi IlepexoA no nacoBOH 
CTpejixe (Clockwise Path) va riepexo^ 
npoTHB nacoBOH CTpejiKH (C o u n te r- 
clockwise) mos yo4nalishga soat strelkasi 
bo4yicha spiral shakldagi ranglami o4zgar- 
tirishni bildiradi.

Pa3Hoe (Miscellaneous) tugmasi
Pa3Hoe (Miscellaneous) to4rtta tugmadan 

iborat.
KaprapoBaHHe y3JiOB (Map Nodes) 

tugmasi ishlaganda ekranga maxsus kursor 
chiqariladi. Bu kursor yordamida berilgan 
va oxirgi obyektlar uchun tayanch nuqtalari tanlanadi va dastur 
obyektning ikkinchi obyektga o4tishini ko4rsatadi.

Pa36HTb (Split) tugmasi maxsus kursorni ekranga chiqaradi, 
uning yordamida oradagi obyektni uzib olish imkoniyati bo4ladi.

BoccTaHOBHTb HanajibHbiH o6i>eKT (Fuse Start) va BoccTa- 
HOBHTb KOHenHbiH o6i>eKT (Fuse End) tugm alari khohkh  
Pa36HTb (Split) tugma xizmatini bekor qiladi. Bir-biriga o4tishdagi 
xohlagan bitta obyektni <Ctrl> tugmasini bosgan holda sichqoncha 
chertiladi va joriy bo4lgan tugmalardan bittasini tanlaymiz.

Obyekt va trayektoriyalar tugmalari

Map Nodes 

Split 

Fuse Start | 

Fuse End

U> I

Apply

N e w  Start 

S h o w  Start

N ew  P a th  

Show  P a th

i D e ta ch  From P a th

N e w  E n d  

S h o w  End

I lo n ia ro B b iH  n e p e x o /i  (Blend) panelining pastki qismida uchta 
tugma — H a n a jib H b m  o6i>eKT (Start), K o H en H b iH  o6i>eKT (End) 
va TpaeKTopHfl (Path) joylashgan bo4lib, bu amallaming barchasi 
berilgan obyekt va uning trayektoriyasini aniqlaydi.

Tugmalardan xohlaganini tanlaganda ikkita buymqdan iborat 
menyucha ochiladi. Birinchi buyruq H o b m h  (New) berilgan obyekt,
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oxirgi obyekt yoki trayektoriya ekanligini ko4rsatadi. Ikkinchi buyruq 
IIoKa3aTb (Show) ajratilgan guruhdagi bir-biridan o4tishning boshi 
yoki oxirini va trayektoriyasi ekanligini bildiradi.

Koumyp (Contour) buyrug‘i
Effects (3ct)c|)eKTbi) menyusining Komyp (Contour) buyrug4i 

yoki MHTepaKTHBHbiH HHCTpyMeHT (Interactive Tool) joylashgan 
maxsus tugm asi berilgan obyektdan ichkari yoki tashqari 
yo4naltirilgan kontsentrik shakllami chizadi.
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Contour (KoHTyp) panelida ikkita tugma bo4lib, ulardan bittasi 
konturlaming tashqi ko4rinishini, ikkinchisi esa, konturning rang 
parametrlarini bildiradi.

Birinchi tugma bosilganda IHara (Steps) va CMemeHHe (Offset) 
joriy bo4ladi. KijeHTpy (To center) yordamida CMemeHHe (Offset) 
maydonida berilgan intervallar kontsentrik shakllar bilan to4ldiriladi. 
Faqat ko4chish diam etri b o 4yicha b o 4lm aydi, (teng ikkiga 
bo 4linmaydi), har bir chiziq oldingisidan berilgan masofaga 
siljitiladi, shu sababli, ikkita barobar kontur chiqadi (masalan,
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diametri 100 m m  doira, ko‘chish —10 m m  bo‘lsa, hisob bo‘yicha 
10 ta kontur bo‘lishi kerak, bizda 5 ta chiqadi, sababi ko‘chish 
ikki tomondan bo‘linganligidan).

BHyrpb (Inside) kontsentrik shakllar bilan to ‘ldiriladi, uning 
soni ffla ra  (Steps) maydonidan beriladi, CMemeHHe (Offset) 
dan esa interval aniqlanadi.

Hapyxy (Outside) esa obyektning tashqi qismini kontsentrik 
shakl bilan to ‘ldiradi, shakllar soni LQar (Steps) da beriladi, 
intervallar soni esa CMemeHHe (OfFset) dan aniqlanadi.

U 50 1DDI ........................... I .............................. I

Rangni aniqlash tugmasi effektning ketma-ket o ‘tishidan farq 
qiladi, obvodkaga rang berish pero tugmasi bilan va zalivkaga rang 
berish bo‘yoqli chelak tugmasi bilan amalga oshidladi. Agarda berilgan 
obyekt gradiyent zalivkani zalivka hisobida olgan bo‘lsa, u holda 
ikkita tugma chiqariladi: gradiyentning dastlabki va oxirgi rangi.

Extrude buyrug6i
9(J)(i)eKTbi (E ffec ts) m enyusidag i ^KCTpyAHpOBaHHe 

(Extrude) buyrug‘i eng qiyin b o ‘lgan effektlardan, dasturda 
ajratilgan obyektlarga o ‘ng tomonidan tekislik qo‘shadi va uch 
o ‘lchovli ko‘rinish tashkil qiladi. Bu effektni boshqarish IIoma- 
roB biH  nepexoA (Blend) effektiga o‘xshash. Buning uchun obyekt 
tanlanadi (kursor shakli o ‘zgaradi) va sichqonchaning tugmasi 
bosilgan holda shtrix chizig‘ini bosib turib tortiladi, sichqonchani 
qo‘yib yuboriladigan nuqta krest bilan belgilanib yig‘ilish nuqtasi 
deyiladi.

^KCTpyAHpoBaHHe (Extrude) panelida beshta amal bor: ToMKa 
cxo^a (Vanishing Point) yig‘ilish nuqtasi, BpameHHe (3D



Rotation) aylanish, OcBemeHHe (Lighting) yorug‘lik, LlBeT (Color 
Wheel) rang va OacKa (Bevels) faska.

Tohku cxoda (Vanishing Point) tugmasi
^KCTpyAHpOBaHHe (Extrude) pa- 

neliga joylashgan bo‘lib, yaratilayotgan 
obyekt h a jm in in g  p a ra m e tr la r in i 
aniqlaydi.

Ko‘rish oynasidagi ro‘yxatda 3KCTpy- 
AHpOBaHHa usulini tanlash berilgan:

•  YMeHbineHHe b  raySHHy (Small 
Back) obyektning yig‘ilish nuqtasini 
obyektning orqa qismiga chiqaradi va orqa 
tomonini kichkina qilib ko‘rsatadi;

•  YMeHbineHHe b  nepe^ (Small 
Front) obyektning yig‘ilish nuqtasini 
obyektning oldi qismiga chiqaradi va old 
tomonini kichkina qilib ko‘rsatadi;

•  YBejiHHeHHe b  rjiy6HHy (Big 
Back) obyektning yig‘ilish nuqtasini 
obyektning old qismiga chiqaradi va orqa 
tomonini kichkina qilib ko‘rsatadi;

• YBejiHHeHHe Bnepe^ (Big Front) 
obyektning yig‘ilish nuqtasini obyektning orqa qismiga chiqaradi 
va orqa tomonini kichkina qilib ko‘rsatadi;

• napajuiejibHO b  rjiy6HHy (Back Parallel) ichkariga kirgan 
tomondagi yon tomonlarining parallelligini ta ’minlaydi va old 
tomonlarining tengligini saqlaydi;

• napajuiejibHO Bnepeji (Front Parallel) oldiga chiqarilgan 
tomondagi yon tomonlaming parallelligini ta ’minlaydi, old va orqa 
tomonlar tengligini saqlaydi.

Quyidagi ro‘yxatda yig‘ilish nuqtalari turlari berilgan: ToMKa 
cxojia npHB5i3aHa k o6beKTy (VP Locked To Object) yig‘ilish 
nuqtasi obyektga bog‘langan, ToMKa cxojia npuBH3aHa k CTpaHwue 
(VP Locked To Page) yig‘ilish nuqtasi sahifaga bog‘langan. 
KonnpOBaTb TOHKy cxojja o t  (Copy VP From ...) yig‘ilish 
nuqtasidan nusxa ko ‘chirish, 06m a)i TOHKa cxojja (Shared 
Vanishing point) umumiy yig‘ilish nuqtasi.

1 Entrude

0  9 ©
V an ish ing  Point:

Small B a c k

V P  L o c k e d  To O bject T

Depth : |5 7 .0

H: |45,9G 9 ^  mm

V; |T ^ 6 6 3  ^  mm

M easured  from:

C  P age  orig in 

(• O bject cente r

App ly
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Tjiy^HHa (D epth) m aydonidagi yig‘ilish nuqtasidan yon 
tomonlarining uzunligigacha bo4lgan masofa foiz nisbatida beriladi.

(H va V) maydonlari Tjiy6HHa (Depth) chuqurlik parametr- 
larini bildiradi.

ToHKa cxo^a (M easured from ) m aydonida obyektning 
markaziga nisbatan aniq yig‘ilish koordinat nuqtalari beriladi.

Bpamenue (Rotation) Fazoda obyektlarni 
aylanishlarini ta’minlaydi

Bu amal ikkita variantga ega, birinchisi 
aylanishni qo‘l yordamida bajaradi, ikkinchisi 
esa, aniq sonli raqamlami kiritish orqali beril- 
gan son maydonlari 1, 2 va 3 lar mos ravishda 
X, Y va Z koordinat o‘qlariga mos keladi.

Oceeu^enue (Lighting)
OcBemeHHe (L ig h tin g ) y o rd am id a  

yorug4likdagi uchta rangdan bittasini olib 
tashlash imkoniyati bor.

YorugMikni tashkil etuvchi mos raqam- 
lariga qarab qo‘shsa bo‘ladi. Yorug‘lik tushishi

|| [g| Extrude

g  O jl^  ® ■
Lighting:

Intensitii:

J |W
[7  Use full colof range

Reset_____________|

Apply
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kubdan karkas bilan qarash yordamida olinadi. Har bir manba 
0‘zining intensivligiga ega bo‘lib, HHTeHCHBHOCTb (Intensity) 
maydonidan beriladi. Kerak bo‘lgan manba tanlanib va surgichni 
kerak tomonga surgandan keyin va Hcn0Jib30Barb nojTHOUBeTHbin 
AHana30H (Use full color range) bayroqchasini tanlash bilan 
soya va yorug4likning tushishini aniqroq beradi.

IJeem (Color Wheel)
Tekislikda fazoviy obyektlami tasvir- 

lashda ranglar katta rol o‘ynaydi. BKjia^Ka 
U,BeT (Color Wheel) bir nechta rangli 
zalivkani taklifetadi.

Hcn0Jib30BaTb 3ajiHBKy o 6T>eKTa 
(Use object fill) amali obyekt o4zining 
rangini zalivka sifatida foydalanishni 
bildiradi. KoBpOBan 3ajiHBKa (Drape fills) 
tanlangan b o 4lsa, obyektni to ‘la yon 
to m o n la rg a  a jra tm asd an  b o ‘yashn i 
bildiradi.

CnjioniHaH 3ajiHBKa (Solid  fill) 
fazoviy obyektning ustki qismini bir xil 
rang bilan to ‘ldiradi, bunda rang palitra- 
dan tanlanadi.

njiaBHan 3ajiHBKa (Shade) yorug4- 
likni real im i- 

tatsiyalashda ravon tarqalishini ta’minlash 
m aqsadida foydalanadi. R anglar O t  

(From) va flo (To) tugmalar yordamida 
aniqlanib, yorug4likni hisobga olgan holda 
gradiyentni to4ldirish imkonini beradi.

0acua (Bevels)
Fazoviy obyektning eng oxirgi shtrixi 

obyektning faskasini yaratadi.
OacKa (Bevels) faskani yaratish va 

uning paramertlarini 0‘zgartirish amal- 
larini bajaradi. Faskani yaratish uchun 
npHMeHHTb (|>acKy (Use Bevel) bay- 
roqchasini qo‘yish kerak va uni parametr- 
larini berish kerak.

Extrude

Bevels:

Use Bevel
Show Bevel Only

f-
Bevel depth: [18,555 

Bevel angle: [35,5 '

Reset

Applv
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DiySHHa (J)acKH (Bevel depth) maydoni faskaning o‘lchamini 
beradi, Yroji (J)acKH (Level angle) maydoni — qiyalik burchagini 
ko4rsatadi.

JIuH3a (Lens) buyrugH
Effects (9(J)(J)eKTi>i)dagi JInH3a (Lens) buyrug4i ajratilgan 

obyekt shaklini o 4zgartiradi, masalan, kattalashtiradi, yoki ranglarni 
filtrlaydi va hokazo. Agarda linza obyektlar guruhi ustida tursa, u 
holda obyektning har birini alohida o4zgartiradi.

Bu amal bajarilganda Docker turidagi panel paydo bo4lib, 
unda linzalar ro4yxati va ularni foydalanganda obyekt ko4rinishlari 
beriladi. Tanlangan linzaning turiga bog4liq effekt parametrlari 
o4zgaradi.

• Linza — np03paHHaH (Transparency) obyekt va linza ranglami 
aralashtiradi, bu amal Li,BeT (Color) tugmasi va YpOBeHL (Rate) 
maydonidan linza tiniqligi foiz nisbatida tanlanadi, qiymat qancha 
katta bo4lsa, linza tiniqligi shuncha yuqori bo4ladi.

• Linza — YBejiHHeHHe (Magnify) Ko3(J)(J)HiiHeHT yBejiHqeHiui 
(Amount) m aydonida berilgan qiymatga nisbatan obyektni 
kattalashtiradi.

• Linza — /IpKOCTb (Brighten) obyektni ravshanligini YpOBeHL 
(Rate) maydonida beriilgan qiymatdan aniqlaydi.

• qiymatlar diapazoni:
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Frozen 

nViewpoint 
W  R e m o ve  F a ce

Apply

— 100% dan +100%. Agar +100% bo4lsa, hamma ranglar oq 
rangga ega bo‘ladi, 0% da linza — obyekt rangiga hech qanday ta’sirini 
o4tkazmaydi, — 100% da bo4lsa, hamma ranglar qora rangga o4tadi.

• Linza — MHBepTHpOBaTL (Invert) obyektning ranglarini 
invertizatsiya qiladi: Qora rangni — oq rangga, oq rangni — qoraga 
va hokazo. Agarda invertizatsiya fonga ham ta’sir qilsa, u holda 
YzjajiHTL cJdoh (Remove Face) bayroqchasini qo4yish kerak, 
shunda faqat obyektgina invertizatsiya qilinadi.

• Linza — U , B e T H O H  (Jd h j i l t p  (Color Limit) buyrug4i Li,BeT 
(Color)da o4rnatilgan linza rangidan boshqa obyektning barcha 
ranglarini filtrlaydi. Filtratsiya intensivligi Rate (YpOBeHb) 
maydonidan aniqlanadi, agarda u kam bo4lsa, boshqa ranglarning 
natijaviy rangga tushishi ko4proq bo4ladi. Bu effektga Y z j a j i H T L  (Jd o h  

(Remove Face)dan foydalansa ham bo4ladi.
• Linza — OioateHHe h b c t o b  (Color Add) obyektning rangiga 

linza rangini RGB modeli bilan aralashtiradi.
• Linza — OKpameHHan cepah niKajia (Tinted Grayscale) Bu 

filtr rasmlar bilan ishlashda qo4l keladi.
• Linza — MH(J)paKpacHa5i niKajia (Heat Map) obyekt rangini 

infra qizil shkala bo4yicha konvertatsiya qiladi.
• Linza — U B e T O B O M  (Jd h j i l t p  c  p a c T ^ c K K O H  (Custom Color 

Map) obyekt rangini siljitgich yordamida o4zgartiradi. O t  (From) 
va Ao (To) tugmalari yordamida ranglami o4zgartiradi. Siljitgichning

103



yo‘nalishi quyidagi ro‘yxatda berilgan: IIo npHMon (Direct Palette) 
variantida to ‘g‘ri chiziq bo ‘yicha, IIpHMaH pa^yra (Forward 
Rainbow) tocgcri kamalak varianti va 0 6 paTHa5i pa^yra (Reverse 
Rainbow) teskari kamalak shaklidagi soat strelkasiga nisbatan doira 
shaklida o ‘zgartiriladi.

• Linza — K o H T y p H B iu  p e x H M  (Wireframe) Ovbodka va 
zalivkalaming rangini o ‘zgartiradi. 0 6 B O flK a  (Outline) va 3 a jiH B K a  
(Fill) amallari bilan bajariladi.

• Linza — « P b i6 h h  rjia3» (Fish Eye) obyektlami kattalashtiradi 
yoki kichiklashtiradi. Linzaning o ‘zragish diapazoni —1000% dan 
+ 1000% oraliqda bolib , bu YpOBeHB (Rate) panelida joylashgan 
boladi.

Agarda Ee3 j i h h 3b i (No Lens 
Effects) tanlansa linza olib tashlanib, 
oddiy obyekt kocrinishida beriladi.

3 a M 0 p 0 3 H T B  (F ro zen ) bay- 
roqchasi, linza ostidagi obyektni § 
qotib turgan holda boshqa joyga 
qo‘yishi mumkin. i

ToHKa 3peHHH (V iew point) 
linzadan kocrilgan obyektni siljitish g 
imkoniga ega, bunda obyekt yoki 
linza siljitilmagan holda bajariladi. Bu g 
amalga bayroqcha qocyilgandan keyin 
Pe^aKTHpOBaTB (E dit) tugm asi 
paydo boTadi, tugma bosilgandan 
keyin krest shaklidagi marker chiqadi. M arkerning siljitilishi 
tasviming siljishiga olib keladi.

OdmpaeoHHbiu k j i u h  (Power Clip) buyrug‘i
3(J)(})eKTBi (Eflfects) menyusidagi 06TpaBOHHBiH KJinn (Power 

Clip) buyrugT bajarilganda menyuning buyruqlari va eflfektlarini 
muharrirlash chiqariladi.

Klipga kiradigan barcha obyektlar bitta obyekt boTib hisob- 
lanadi. Klip ustida amallar bajarganda obyektni butunligicha yoki 
uni qismlarga ajratgan holda amalga oshiriladi. Pe^aKTHpOBaTB 
coflepxaHHe (Edit Contents) yordamida muharrirlanadi. Bu amal 
3(J)(})eKTBi (Effects) menyusidagi 06TpaBOHHBiH Kjinn (Power 
Clip) ichiga joylashtirilgan. Agarda ishma-ish ketgan clip boTsa, 
muharrirlash bir necha marta bajariladi.
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Ishni tugatgandan keyin 3ai<0H qH Tb pe/iak tn p o B a H H e  r aH - 
H o ro  ypoBHH (Finish Editing This Level) amali bajariladi. Bu 
amal muharrirlangan obyektni qaytadan konteynerga solib qo‘- 
yishni bajaradi.

Agarda IlapaMeTpBi (Options) (Windows menyusi Toolb 
asbobi) oynasidagi PeflaKTHpOBaTB (Edit) buyrug‘idagi Abto- 
MaTH^ecKoe ueHTpnpoBaHHe ga bayroqcha qocyilgan bolsa, klipni 
tashkil etuvchilarni markazdan joylashtirilgan holda ekranga 
chiqariladi.

HnmepaKmueHaH npo3pamiocmb (Interactive Transparency) 
asbobi

MHTepaKTHBHaH np03paHH0CTB (Interactive Transparency) 
asbobi yordamida vektor grafikasi dasturiga rastr grafika dastur- 
larining amallaridan biri bajariladi, bu amal asboblar panelidagi 
mos tugmalar yordamida bajariladi.

Bu amalning rastrli tasvirlarini kock rangli kocrinishdagi 
obyektlar yaratadi.

MHTepaKTHBHaH np03paHH0CTB (Interactive Transparency) 
asbobi CBOHCTBa (Property Bar) bilan birgalikda ishlab, hamma 
zalivkalardan foydalanish ravshanlik param etrlarini oshiradi. 
CBOHCTBa (Property Bar) satrining kocrinishi tanlangan zalivka 
turiga bogliq.
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Propertv Bar : In te rac tive  Uniform Transparencv 2*1
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Edit (PeAaKTHpOBaTb) tugmasi panelning chap tom onida 
joylashgan bo‘lib, mos zalivka rangidagi asosiy muloqot oynasini 
ekranga chiqarishga moljallangan.

Bu yerda maskalami biriktirishning rejimlariga e’tibor berish kerak, 
bu o‘n sakkizta rangli obyektlar bilan ishlash imkoniyatini beradi.

Ryxatda quyidagilar berilgan: HopMajiLHLiM (Normal) oddiy, 
CjioaceHHe (Add) qo'shish, BLiHHTaHHe (Substract) ayirish, 
Pa3HHija (D ifference) kam aytirish , YcnjieHHe (M ultiply) 
kpaytirish, O cjia6 jieH H e  (Divide) yengillashtirish, Ecjih CBeTjiee 
( I f  L igh ter), E cjih TeMHee (I f  D arker), TeKCTypH3auH5i 
(Texturize), Hue (U,BeTOBOH t o h ) ,  HacLimeHHOCTL (Saturation), 
ilpKOCTL (Lightness), 06pameHHe (Invert), JIorHnecKoe «h» 
(And), JIorHHecKoe «hjih» (Or), JIomHecKoe «HCKJnoHaiomee hjih» 
(Xor), KpacHLiH (Red), 3ejieHLiH (Green), Chhhh (Blue).

HHmepaKmueHon deffropMaujUH (Interactive Distortion) asbobi

MHTepaKTHBHan Aec^opMaiiHii (In terac tive  D isto rtion ) 
asbobining tugmasi MHTepaKTHBHLiH HHCTpyMeHT (Interactive 
Tool) guruhida joylashgan. Buning yordamida obyektlarni awalgi
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turidan katta farq qiladiganday qilib o ‘zgartiradi. Bu asbob 
CBOHCTBa (Property Bar) bilan birgalikda ishlatiladi. Bu yerda

deform atsiyan ing  u ch ta  tu ri mavjud: 
«T5iHH-TojiKaH» (Push and Pull) tortib 
chizing, 3n r3ar (Zipper) zigzag shaklda 
va CKpyHHBaHHe (Tw ister) bu ra lgan  
shaklda boladi.

Bu asbob bilan ishlashning boshqa 
interaktiv asboblardan farqi yo‘q, faqat 
oxirida olinadigan natijadan ko ‘zlagan 
faktorlarga bog‘liq, tasodifiy (masalan, 
kursorning holati yoki uning siljitilgan 
masofasi va hokazo), voqealarga bogliq  
kutilgan natijani bermaydi. Shu bilan birga 
natijaviy «Mahsulot»ni olishning bir nechta 
turli imkoniyatlari bor va ular cheksiz.

HHmepaKmueHon mem (Interactive Drop Shadow) asbobi
HHTepaKTHBHan TeHb (Interactive Drop Shadow) (interaktiv 

soya) asbobi tugmasi MHTepaKTHBHLiH HHcrpyMeHT (Interactive 
Tool) da joylashgan bo‘lib, soyaning har xil effektlarini yaratishga 
moljallangan.
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Bu asbob CBOHCTBa (Property Bar) asboblar satridan ham 
boshqariladi.

HanpaBJieHne t c h m  (Drop Shadow Direction) Soya yo£nalishi 
ro£yxatida soyalaming turlari berilgan: BHyrpL (Inside) Ichida, 
n o  D;eHTpy K O H Typa (Middle) Markazda, H apyxy (Outside) 
Tashqarisida, Ycpe/iHCHHaM (Average) Markazlashgan. rpaHMUbi 
TeHH (D rop Shadow Edges) Soya chegaralari ro £yxatida — 
chegaralar uchun berilgan variantlar keltirilgan: J1 m h cm  h aM 
(Linear) To£g£ri chiziqli, KBa/ipaTHaM (Squared) Kvadrat, H h- 
BepTHpOBaHHan KBanpaTHaM (Inverse Squared) Inversiyalangan 
kvadrat, >KccTi<aM (Flat) Qattiq.

Rang effektlari
CorelDRAW  dasturining asosiy maqsadi rangli effektlar 

yaratish bo£lib hisoblanadi. Bu effektlar nafaqat nuqtali tasvirlar, 
balki vektorli tasvirlar uchun ham ishlatiladi. 3c[)ct)eKTLi (Effects) 
menyusidagi IiBCTOBbie HacTpoiiKH (Color Adjustment) buyrug£i 
ro £yxatni chiqaradi va bu yerda shulardan oltitasi vektorli 
obyektlarga tegishli.

• 5IpK0 CTL-K0HTpacT-HHTeHCHBH0 CTL (B rig h tn ess- 
C ontrast-Intensity) filtri tasvirlarni rang tonlarin i sozlaydi. 
ÎpKOCTL (Brightness) maydoni yorug£lik tushishini o£zgarish 

diapazonini ko£rsatadi, KompacT (Contrast) maydoni — ochiq 
va to £q rangli tonlarini o £zgarishini beradi, HHTeHCHBHOCTL 
(Intensity) maydoni bo£lsa — ochiq tonlar o£zgarishini beradi 
(to£q ranglar o£zgarmaydi).

•  U bc to bo m  SanaHC (Color Balance) filtri belgilangan obyekt 
ranglarini o£zgarishini bildiradi. Bu effektni qiyin tomoni bitta 
rangni o£zgarishi ranglaming balansini bosib, boshqa ranglaming 
o£zgarishiga olib keladi.

• raMiYia (Gamma) filtri yomg£lik va kontrast nisbatlarini 
o£rtacha ton diapazonida qarab, soyalar va yorug£lik tushishini 
sozlaydi. Agarda hech narsa tanlanmasa 1 soni qabul qilinadi, ya’ni 
tasvirga ta’sir qilganda o£zgarmaydi. Agarda gamma ranglar soni 
ortib borsa oqaradi, teskari bo£lsa qoralashadi.

• IjBeTOBOH TOH/HacLimeHHOCTL/CBeTJiOTa (H u e /  
Saturation/Lightness) filtri rang toni va uning to £yinganligini 
o £zgartiradi.
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• HeraTHB (Invert) filtri negativ ranglami olishga yoki rastrli 
tasvirlami olishga moljallangan. Oq va qora ranglar bir-biri bilan 
almashtiriladi.

• nocTcpn3auMM (Posterize) filtri rangli ottenkalami kamay- 
tirishga, ya’ni tasvimi bir nechta lokal ranglarga ajratadi. Bu usul 
grafikada keng foydalaniladi, masalan, plakat turida. Bu buyruq 
tasvirlami trassirovkaga tayyorlashda ham qo£llaniladi.

2.8. Tasvirlarni import va eksportlash

Tasvirlami eksport yoki import qilganda quyidagi konvertorlar 
b o £lishi kerak — oldindan saqlangan m a’lum otlarni dastur 
tushunadigan turiga o£tkazuvchi modullar bo£lishi shart. OLE 
texnologiyasidan foydalanganda konventorlar haqida o£ylamasak ham 
b o £ladi. Ikkinchi tom ondan bu texnologiya obyektlar bilan 
ishlaganda bir qancha cheklashlar qo£yadi, ya’ni obyektlar kloni 
olinmaydigan bo£ladi va hokazo.

Ey(J)ep o6Meua (C lipboard)
M a’lumotlaming eng oddiy almashishi bu Clipboard amalga 

oshiriladi va uning yordam ida quyidagi am allar bajariladi: 
CorelDRAW  dasturi boshqa dasturlarga m atnlarni va grafik 
elementlami olib o£tishni bajaradi, agarda olib o£tilayotgan das- 
turda OLE texnologiyasi bilan ishlash imkonyati bo£lsa.

Pe^aKTHpOBaTL (Edit) menyusi va asboblar panelida quyidagi 
am allar berilgan; KoirapOBaTL (C opy), BLipe3aTL (C ut), 
BcTaBHTL (Paste).

«drag-and-drop» texnologiyasi
«drag-and-drop» texnologiyasi («olib borib tashlash») bir 

dasturdan ikkinchisiga qo£l yordamida rna’lurnotlarni olib o£tib, 
quyidagi holatlarda amalga oshiriladi:

• Agarda vektor obyekti CorelDRAW dasturida bir hujjatdan 
ikkinchisiga olib o£tiladigan bo£lsa.

• Agarda vektorli obyekt ishchi stolga olib o£tiladigan bo£lsa. Bu 
yerda ishchi stoldan boshqa dasturga olib o £tiladi, masalan, 
CorelDRAW va Corel PHOTO-PAINT dasturlar orasidan grafik 
m a’lumotlar olib o£tiladi.
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O tk p m tb  (Open) va H M n o p T n po B a T b  (Import) buyruqlari

Open Drawing

QanKa: Q  KanisevD [D:)

ZH enfleoMaHrasK 
Z ]  MsrcTOE/ieHne ne^arn 
Z]^0T0rPÂMM 

gotovii.bmp 
daemon311.zip 
55.cdr

File name: | ofitqEneHHe. cdr

Files of type: | All File Formats

Sort type: | Default

Keywords:

Notes:

J j  x j

e  cfIiH' OTKpbfTb

0(5t 3EneHHe o padoTe.

^  Backup_of_oCfb3EneHHe.cdr 

pechati.cdr 

9  TEKSTIL.CDR

?! ■ ■ ■
g l2 3 .A V I

~SrelBookPart2.doc

OTMeHa

>1
Preview

_ZJ FileVersion: Version 9

T Compression ratio: 32.2%

Last saved by: 

Last saved in:

CorelDRAW 9 (pc) 
build 337

PyCCKHfi

r  Applv embedded ICC profile 

r  Extract embedded ICC profile 

r  Maintain layers and pages

Menyunuing Oanji (File) va OTKpbiTb (Open...) buyrug4i 
boshqa muharrirlar yordamida yaratilgan hujjatlarni ochadi, bu 
yerda fayllar vektor formatli ya’ni masalan, EPS standart formatli 
bo4lishi kerak.

Yuqoridagi buyruq bajarilgandan keyin ekranda OTKpbiTb 
pHcyHOK (Open Drawing) muloqot oynasi chiqadi, bu yerda faylni 
qaysi jild va qaysi faylda ekanligini ko4rsatish kerak. Bu yerda 
IIpocmotp (Preview)dagi bayroqchani belgilash natijasida fayllar 
ichidagi maTumotlar ko4rsatiladi. Agarda faylni o‘qish mumkin 
boTmasa yoki boshqa sabablarga bogTab o4qilmasa, ko‘rish oynasida 
krest belgisi chiqariladi.

Ko4rish maydoni tagidan fayl haqida maTumotlar chiqariladi:
• BepcH5i ^OKyMeHTa (File Version) satrida hujjat xotirasida 

saqlangan dasturning versiyasi beriladi;
• CreneHb OKaTMH (Compression ratio) satri faylning siqilish 

foizini krsatadi (vektor formati ixcham, oTchami kichik boTadi, 
shunga qaramasdan dastur faylni avtomatik tarzda siqadi);

• CoxpaHeH (Last saved by) satri dastumi versiyasi (platformasi) 
va uning relesi (masalan, build 337) haqida maTumot beradi.

KjnoneBbie cjiOBa (Keywords) va npHMenaHH# (Notes) 
foydalanuvchiga kerakli faylni (agarda berilgan maTumot faylni
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saqlagan paytda kiritilgan boTsa) tez qidirib topib berishda yordam 
beradi.

CoxpaHHTb c j i o h  h  CTpaHHUbi (Maintain layers and pages) 
bayroqchasi hujjatdagi qatlamlar, sahifalar haqida konvertatsiya 
qilishni ta’minlaydi, CDR dan boshqa formatda boTadi.

M enyuning O anji (File) va HMnopTHpoBaTb (Im port...) 
buyrugT CorelDRAW dasturining ochilgan joriy hujjatdagi hujjatni 
import qilishni ta ’minlaydi va u ikkita usul bilan bajariladi:

• Fayllar orasida bogTanish saqlanadi.
• Fayllar orasida bogTanish saqlanmaydi.

116A.JPGFile name:

Files of type: | All File Formats

Sort tvpe: | Bitmap

T  | Full Image

Preview 

□ ptions <<

350 X 2G3 Pixels ,1 G.7 Million Colors (24-bit) 

JPG -JPEG Bitmaps JPEG Compression

Image size: 

File format:

Notes:

Link to high resolution file for output using OPI

|  | Link bitmap enternallv 

| Combine multi-layer bitmap 

r  Apply embedded IC C  profile 

\~ Ewtraot embedded ICC profile 

|  | Check for Watermark 

n  Suppress filter dialog 

\~ Maintain layers and pages

HMnopTHpoBaTb (Im port) m uloqot oynasining OTKpbiTb 
pH cyH O K  (Open Drawing) oynasidan farqi qshimcha funksiyalari 
va mumkin boTgan fayllar ro4yxati katta boTadi.

Pa3Mep H3o6paxeHH5i (Image size) satrida rastrli tasvirlarni 
import qilganda pikseldagi oTchov birligi va ranglarning to4qligi 
bitlarda beriladi.

Pastdagi qatorlarda fayl formati va uning o‘zgachaligi, masalan, 
siqish texnologiyasidan foydalanish va hokazo. Agarda fayl formati 
eskilarini saqlaydiganboTsa, uning matnini, npHMenaHHii (Notes) 
maydonidan kiritamiz.

CB5i3aTb c (|>aHJiOM BbicoKoro pa3pemeHH5i jjjm BbiBO/ja no 
TexHOJiOTHH OPI (Link to high resolution file for output using
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OPI) bayroqchasi dasturning tez ishlashi uchun hujjatdagi fayl 
versiyasini past imkoniyatda yozadi, qaytadan o ‘qigan paytda 
awalgi holatiga qaytaradi.

IIpOBepHTL «BOflHHOH 3HaK» (Check for W aterm ark) 
bayroqchasi modulni ishga tushirishni ta’minlaydi, tasvir haqida 
maxfiy ma’lumotlami qidiradigan modullar ishga tushiriladi.

CBecTH MHorocjiOHHtie TOLieLiHbie H3o6paaceHHH (Combine 
m ulti-layer b itm ap) bayroqchasi ko ‘p qatlam li tasvirlarni 
konvertatsiya qiladi, masalan, Adobe Photoshop (PSD) formatidan 
yoki Corel PHOTO-PAINT (CPT) formatidan oddiy bir qatlamli 
qiladi, CoxpaHHTL c j i o h  h  CTpaHHu,Li (Maintain layers and pages) 
bayroqchasi teskari, vektor obyektlami qatlamlarga va sahifalarga 
ajratib beradi.

IIpHMeHHTL p a3M ein ,eH H L iH  npo(J)HjiL ICO (Apply embedded 
ICC profile) va H3BjienL pa3Mem,eHHLiH npo(J)HjiL ICC (Extract 
embedded ICC profile) bayroqchalari, O t k p l i t l  pHcyHOK (Open 
Drawing) muloqot oynasiga tegishli bo‘lib, joriy hujjatga import 
qilingan faylga rang profillarini o‘rnatish yoki uni chiqarib alohida 
Image Color Matching (ICM) formatli faylga yozishni ta’minlaydi. 
D astur quyidagi form atli fayllarda ranglarning profillarini 
joylashtiradi: CRT, CDR, JPEG, PICT h  EPS.

Tasvirlami ba’zi bir formatlarda joylashtirish uchun qo‘shim- 
cha m a’lumotlar kerak bo‘ladi (masalan, PS, PRN yoki PCD 
formatlari). Bu holda ekranda qo‘shimcha oyna paydo bo‘ladi. Agarda 
import qilishda He b l i b o ^ h t l  ^HajioroBoe o k h o  (J)HjiLTpa (Suppress 
filter dialog) ga bayroqcha qo‘yilsa, import qilish ko‘rsatilgan 
bo‘yicha bajariladi.

CorelDRAW dasturida import qilingan 
tasvirlarni o‘zgartirish uchun amallar baja- 
rilgandan keyin ekranga boshqacha kursor 
chiqariladi. Shu kursor yordamida tasvirni 
hujjatning xohlagan joyiga joylashtirishgan 
bo‘ladi. Bu obyekt ustida masshtablashni ham 
b ajarsa  b o ‘lad i. A garda p ro p o rs io n a l 
masshtablamoqchi bo‘lsak, u holda kursor 
bilan sohani chizib ko‘rsatish kerak. Agar 
<Alt> tugm asi bilan m asshtablashtirilsa 
proporsional bo‘lmaydi.

Agarda masshtablash aniqlikni talab qilsa, 
u holda muloqot oynasidagi HMnopTHpOBaTL

j ? J x |

D:VP0T0rPA<PMM VI 00001.JPG

Select area to crop

lop: P  ^ Width: |305 ^

Left: |253 Height: |350

Units: | pixels _-J Select All

New image size: 320,600 bytes

OK | Cancel | Help |

Crop Image
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(Import) ro‘yxatidan foydalanishga to‘g‘ri keladi. Ro‘yxatda uchta 
variant mavjud:

1. IIojiHoe H3o6pa3ceHHe (Full Image) tasvir hech qanday 
o‘zgarishsiz import qilinadi.

2. H3MeHeHHe napaMeTpOB H3o6pa3ceHHH (Resample) — 
ekranga muloqot oyna chiqariladi, bu oynaning o‘lchamini va import 
qilinayotgan obyekt imkoniyati (oynaning pastki qismi o‘zgartiriladi 
va awalgi fayllar o‘lchamlari baytlarda beriladi).

3. KanpHpoBaHHe H3o6paaceHH5i (Crop) — ekranga muloqot oyna 
chiqariladi, oynada qo‘l yordamida yoki mos bo‘lgan qiymatlami 
o‘zgartirish bilan CBepxy (Top), CjieBa (Left), IIlHpHHa (Width), 
BbicoTa (Height) import qilinadigan yuzani chegaralash mumkin.

HMnopTHpOBaHne (Im port) muloqot oynasidagi Cbh3l  c 
BHeniHHM H3o6pa>KeHHeM (Link bitmap extemally) bayroqcha- 
ning qo‘yilishi import qilishning o‘zgacha rejimi bo‘ladi, ya’ni 
tasvirlar bir-biri bilan bog‘langan bo‘ladi (linked image).

0 ‘zaro bog‘liq tasvirlar
Import qilinganda tasvirlarni boshqa huijatlarga olib o‘tishda 

fayllar o‘lchami kattalashtiriladi, shu sababli tasvimi olib o‘tmay 
faqat o‘tish joyini ko‘rsatish (ssilka) orqali ham bajariladi. Ssilkaga 
qo‘yilgan tasvirlar bog‘langan deyiladi (linked images).

Bu turdagi importdan foydalanishning yaxshi va yomon tomoni 
bor.

Yaxshi tomoni: faylning o‘lchami kichik bo‘ladi, CorelDRAW 
dasturiga murojaat qilmasdan parallel va mustaqil ishlatiladi, huyatdagi 
hamma tasvirlarga o‘zgartirish kiritish o‘miga bir marta o‘zgartiriladi.

Yomon tomoni tasvirlarning joylashgan joyi nom a’lum va 
ssilkalar noto‘g‘ri bo‘lishi mumkin.

Bir-biri bilan bog‘langan tasvirlar bilan ishlash uchun Docker 
turidagi panel ishlab chiqilgan va uni /IncneTqep CBH3en (Link 
Manager) deb ataydi. Bu panel tasvirning barcha nuqtalari bilan 
bog‘lanishni ko‘rsatadi.

Q  Link Manager

Stafus J  Link Page ”
D:\=POTOrPA=PMMM36061.JPG All

B S  DiVPOTQrFWPMMSZlBMP All
|rCt ] D:VPOTOrPA<PMMVI15098JPG 1

-S  &  0 j
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Har bir satrda tasvirlaming bog‘lanishi haqida malumot boladi: 
kichiMashtirilgan tasviri, fayl manzili va nomi, tasvir joylashgan beti.

Panelning pastki tomonida uchta tugma joylashgan:
1. Birinchi tugma tasvir bilan orasidagi bog‘lanishni uzadi va 

bog‘lanish paneli satridan o‘chiriladi.
2. Ikkinchi tugma eskirgan tasvirlami yangilash uchun ishlatiladi.
3. Uchinchi tugma ajmtilgan tasvimi muharrirlash uchun ishlatiladi.
Bu uchinchi tugma yordamida chaqiriladigan kichkina dasturcha

CorelDRAW yordamida ishlatiladi va fayl kengaytmalari mosligiga 
e’tibor beriladi. Shuni e’tiborga olgan holda, ekranga grafik dastur 
emas, tasvirlami ko‘rsatadigan dastur (masalan, ACDSee) yoki 
brauzer — dasturlar (masalan, M I Explorer) chaqiriladi.

0 ‘ng tomondagi pastdagi tugma bog‘lanishni qo‘l yordamida 
boshqarish uchun ishlatiladi, agarda tasvir ko‘rsatilgan jilddan 
tashqarida qolsa, holat satrida qizil belgi bilan ko‘rsatiladi. Aloqani 
qaytadan bog‘lash uchun ko‘rsatkich holat satriga olib borib 
sichqonchaning o ‘ng tom oni bosiladi va ochilgan menyudan 
BoccTaHOBHTL pa30pBaHHyi0 CBH3b (Fix Broken Link) tanlanadi. 
Bu muloqot oynasini chiqarib, Onpe^ejiHTL MecTonojioxeHHe 
ToneHHoro H3o6pa3ceHH5i (Locate External Bitmap)ni tanlash 
kerak. Agarda xotiradan o ‘chirilmagan bo‘lsa, u holda tasvir 
manzilini o ‘zgartirib qo‘yish kifoya.

Tasvirlarni eskportlash.

BMP - W indow s Bitmap

File name: |G raphic1.bm p

Files of type:

S oiUype: | DefauH

Notes:

▼  | Compression type:

Uncompressed T

| Ewport this page only

| Embed ICC profile 

| No white spaces, special characters

| Suppress filter dialog
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Tasvirlarni boshqa formatga eksport qilish uchun quyidagi 
amallarni bajarish kerak: Menyuning Oaiui (File)dan 3iccnop- 
THpOBaTL (Export...) tanlanadi va u ekranga oynani chaqiradi.

T o jil k o  BbwejTeHHbie oGLeKTbi (Selected only) bayroqchasi 
qo‘yilsa, faqat hujjatdagi belgilangan obyektlarni eksport qiladi.

CopTHpOBKa THnoB (J)aHJiOB (Sort type) ro‘yxati Tnnbi (J)aHJiOB 
(Files of type) ro‘yxatini tartibga soladi: IIo yMOjnaHHK) (Default), 
IIo pacniHpeHHio (Extension), IIo onncaHHio (Description), B 
n o p ^ K e  Hcn0Jib30BaHH5i (M ost Resently Used), CHanajia 
BeKTOpHbie (Vector), CHanajia ToneHHbie (Bitmap), CHanajia 
TeKCTOBbie (Text), CHanajia aHHMHpOBaHHbie (Animation).

Ee3 npoSejTOB va c n e iiH a jib H b ix  c h m b o jio b  (No white spaces, 
special characters) bayroqchasi fayl nomidagi bo‘sh joylarni tagi 
chizilgan yozuvda beradi, maxsus belgilarni Web sahifa fayllarida 
ishlatiladigan belgilarga almashtiradi.

Fayllar formati ro ‘yxatidan mumkin bo‘lgan bitta format 
tanlanadi va 3 Kcn0pTHp0BaTb (Export) tugmasi bosilishi bilan 
ekranda muloqot oyna paydo bo‘ladi, bu oynada CDR formatidan 
boshqa formatga o‘tganda saqlanadigan m a’lumotlar beriladi.

2.9. Rastrli tasvirlar bilan ishlash va o ‘zgartirish

CorelDRAW dasturi vektor graflkasi dasturlari ichida eng 
ko‘zga ko‘ringan bo‘lib, u shu sohadagi barcha imkoniyatlarga ega 
muharrirlardan biri hisoblanadi.

Rastrli tasvirlarning parametrlarini o ‘zgartirish.

iResample J j  X ]

Im age  size

W id th : 34  |3 4  - 7-j 1100  — J % | piwels

H e igh t: 9 [ s  ; 100

R e so lu tio n

H orizon ta l: G

V ertica l: G

O rig inal im age size: 

N e w  im age size:

10 * dpi 

10 ■ dpi

A nti-a lias
936  b^tes

✓ M a in ta in  a s p e c t ratio
bytes

M a in ta in  o rig ina l size

□ K C a nce l H e lp  R e se t
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Rastrli tasvirlami asosiy parametrlari geometrik o£lchovlarga 
o£tkazish bo£lib liisoblanadi. Bu parametrlami CorelDRAW mulii- 
tida o£zgartirishda ToMCMHbie M3o6pa>i<CHMM (Bitmaps) menyusidagi 
H3MeHeHne napaMeTpOB H3o6pa3ceHHH (R esam ple...) dan 
foydalaniladi.

P a3Mep H3o6pa3ceHHH (Image size) m aydonidagi (nojie 
Width)da eni bo£yicha qiymati kiritiladi va (nojie Height) balandligi 
bo£yicha qiymatini kiritish kerak.

Pa3pemeHHe (Resolution) m aydonida (nojie Horizontal) 
gorizontal bo£yicha va (nojie Vertical) vertikal bo£yicha imkoniyatlar 
beriladi. Qo£shni maydondagi M/iCHTMMHbic 3HaiiCHHM (Identical 
values) ga bayroqcha qo£yilsa, u holda bir xil bo£ladi, aks holda, 
har xil qiymatlar bo£ladi.

Oynani pastki qismida fayllar o£lchamlari beriladi (cTpOKa 
Original image size) o£zgartirilmagan holda va (cTpOKa New image 
size) parametrlari o£zgartirilgandan keyingi CrjiaaaiBaHHe (Anti- 
alias) bayroqchasi chegaralardagi har xil notekisliklami yo£qotadi.

Vektorli tasvirlarni rastrli tasvirlarga konvertatsiya qilish
CorelDRAW dasturi vektor tasvirlami rastrli tasvirlarga o£tkazish 

imkoniyatiga ega.

lc o n v e r t  to  B itm ap *J|
--------------------------------
. Gravscale (S-bitj || |

□ K
Resolution: 200 dpi

Caricel

Help

354 bytes

^  Anti-aliasing 

Dithered

T ransparent Background 

Apply ICC Profile 

Projected uncompressed file size: 911

Buning uchun obyekt tanlanib, ToMCMHbie M3o6pa>i<CHMM 
(Bitmaps) menyusidan KoHBepmpOBarb b  t o m c m h o c  M3o6pa>i<CHMC 
(Convert to Bitmap...) buymg£i bajariladi. Ekranga chiqarilgan 
muloqot oynasiga rastrli tasvir parametrlarining, ya’ni imkoniyatini 
va rang to £qligini berislii kerak.
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Pa3pemeHHe (Resolution) maydonidagi ro£yxatdan xohlagan 
bittasini tanlash kerak (72, 96, 150, 200 h  300 dpi) yoki o£zi- 
mizning param etrlarni 60 dan 1000 dpi gacha diapazondan 
berishimiz kerak.

Ubct (Color) da oltita rang va rejim modellari berilgan: MepHO- 
SejiLiii niTpHx (1-bit) (Black and W hite), 16 ubctob (4-bit) 
(Colors 16), rpa/iauuu ceporo (8-bit) (Grayscale), Mh/ickcu- 
pOBaHHLiii ubct (8-bit) (Paletted), Ubct mo/iCjIu RGB (24-bit) 
(RGB Color), Ubct MO/icnu CMYK (32-bit) (CMYK Color).

HMUTauuM (Dithered) bayroqchasini o£matish katta hajmdagi 
ranglar gammasidan kamroq gammani konvertizatsiya qilganda 
yetishmaganini mavjud ranglardan olib qo£yiladi.

IIp03paHHLiH (Jioh (Transparent Background) bayroqchasi 
obyekt joylashmagan sohalami markirovkalaydi.

Hcn0JiL30BaTL iiBeTOBOH npo(|)HJiL (Use Color Profile) 
bayroqchasi joriy bo£lgan tashqi qurilmalardagi ranglar profilini 
hisobga oladi, masalan, rangli printer.

CrjiaxHBaHHe (A nti-aliasing) bayroqchasida tasvirning 
chegaralarini, rangini yumshatish uchun ishlatiladi.

R astrli tasvirlarni boshqa ranglar m odellariga o‘tkazish
Rastrli tasvirlar quyida berilgan boshqa rangli modellarga yoki 

rejimlarga o£tkazilishi mumkin:
• Oq-qora shtrixli tasvirlarga;
• Kulrang gradatsiyadagi tasvirda;
• Dupleks tasvirda;
• RGB, CMYK yoki LABning to £liq turlariga:
• Indeksirlangan tasvirlarga (paletted).

Boshqa turga o£tkazganga (konvertizatsiya qilganda) tasvirlarning 
ba’zi bir qismlarini yo£qolishiga olib keladi, bu esa, ranglari ko£p 
b o £lgan tasvirlarni kamroq bo£lganlarga o£tkazganda seziladi, 
masalan, RGB dan CMYKga o£tkazilganda. Qaytadan o£tkazilganda 
yo£qotilganlari tiklanmaydi.

O q-qora shtrixlangan tasvirlarga konvertizatsiya qilish
ToMCMHbie u3o6pax<CHUM /  KoHBepTHpOBaTL b  (Bitmaps /  

Convert To) menyusidagi H e p H O -S e j iL i i i  n iT p n x  (Black and
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Convert to 1 Bit

ConversiGn | Line Art T

-  Options-  .................................... ^ 3 3
Threshold: 1 1 i i i | i i Jj j i i i j i i i | | f l 1 3 ;

H e lp

White) (1-bit) buyrug‘i ekranga quyidagilami chiqaradi. KoHBep- 
T H p o B a T b  b  l -6 H T 0 B 0 e  H 3 o 6 p a 3 c e H H e  (Convert to 1 Bit).

Tnn KOHBepTHpOBaHHH (Conversion) tanlanganda paramertlar 
maydoni o‘zgaradi.

• IIlTpHxoBoe H3o6pa>KeHHe (Line Art) varianti tasviming qaysi 
qiymatlari oq rangga, qaysilari qora rangga tishini ta’minlaydi.

• MMHTaHHH co cjiynaHHbiM pa36pocoM (Error Diffusion) 
varianti. HMHTaijHH c noMombio 06pa3H0B (Ordered), Jarvis, 
Stucki, Floyd-Steinberg, Cardinality-Distribution ton bosqich- 
larini har xil usullarini taklif qiladi. Parametr hisobida H h t c h -  

c h b h o c t b  (Intensity) maydonidan kiritilgan quymatlar ehtimoliy 
darajasini beradi.

• Halftone (PacTpoBoe H3o6pa>KeHHe) varianti qora ranglar 
uchun poligrafik rastrlami eslatadigan tasvirlami olishni ta’minlaydi.

Kulrang gradatsiyadagi tasvirga konversiyalash
Xohlagan nuqtali tasvirlarni kulrang gradatsiya ko‘rinishida 

tasvirlasa bo‘ladi, buning uchun tasvimi ajratish kerak va quyidagilar 
bajariladi: menyuning ToneHHbie H3o6pa>KeHhh/KohBepTHpoBaTb 
b  (Bitmaps/Convert To) va Tpa^aijHH ceporo (8-bit) (Grayscale) 
amallari bajariladi.

Bu jarayon hech qanaqa qo‘shimchalarni talab qilmaydi. Natijada 
rastrli tasvirlar paydo bo'ladi, har bir piksel sakkizta bit bilan
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beriladi, buni 256 talik qilib olsa ham bo'ladi: bunda 0 qora,
255 — bo'lsa, oq rangni beradi.

Dupleks tasvirlarni konversiyalash
/JyiuieKCHoe H3o6pa3ceHHe (duotone) — bu monoxrom tonli 

tasvimi ikkita (uchta, to‘rtta) bosmaga chiqarishning turi bo‘lib 
hisoblanadi. Bunda asosiy rang qora bo‘yoq bo‘ladi, qolgan bo‘yoqlar 
esa — och (kul, och-m alla, havo yoki yashil). Bosmaga 
chiqarishning bu turi ton diapazonini kengaytirish uchun va bitta 
rang ishlatilganda yetishmagan tonlami konversiya qiladi.

Tasvimi yaratish uchun menyuning ToMeMHbie H3o6pa»ceHH5i /  
KoHBepTHpoBaTb b (Bitmaps/Convert To) va /lyiuieKC (8-bit) 
(Duotone) buyrug‘i bilan amalga oshiriladi. Ekranda muloqot oynasi 
ko‘rinadi.

RGB, CMYK u Lab rang modellarini konversiyalash
Rastrli tasvirlar RGB, Lab va CMYK modellariga konvertizatsiya 

qilinadi. Bu turlar kompyuter texnologiyasida, ekranning grafika 
bilan bog‘liq bo‘lgan joylarida ishlatiladi.

Belgilangan obyektni konvertizatsiya qilish uchun quyidagilami 
bajarish kerak: Ubct MO^ejiH buyrug‘i RGB (24-bit), (RGB Color) 
(24-bit), II,BeT MO^ejiH Lab (Lab Color) yoki II,BeT MO^ejiH 
CM YK (32 -b it) (C M Y K  C olor) b u y ru g 'la ri m enyuning  
Towfflbie H306pa3ceHH5i/K 0HBepTHp0BaTb b (Bitmaps/Convert 
To)dajoylashgan.

CMYK turini konvertirlash katta ahamiyatga ega, sababi u 
qurilmalarga bog‘liq bo‘ladi. Bir xil tasvimi har xil qurilmalarga 
konvertirlaganda dastur har xil natija ko‘rsatadi.

Lntensiv rangli tasvirlarni konversiyalash
Indekslangan rangli tasvirlar bir kanalli 8-bitli tasvirlardan

256 ta ranglardan tashkil topadi. Bunday tasvirlar fayllarni kichkina 
o‘lchamlari bo‘lgan tasvirlarda ishlatiladi. Awallari bu tasvirlar 
imkoniyatlari cheklangan videoadapterlardan foydalanilgan edi, 
endilikda Intemetlarda kengroq foydalanilmoqda.

Menyuning TowiHoe H3o6pa>KeHne/Pokhm (Bitmap/Mode) 
sidan MtmeKCHpoBaHHbiH (8-bit) (Paletted)da buyrug‘i tanlansa, 
muloqot oynasidagi KoHBepTHpOBaTb b h H,ne kcnpoBaH h bie uBeTa 
(Convert to Paletted)ni bajarishi kerak.
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2.10. Ko‘p sahifali hujjatlar bilan ishlash

CorelDRAW dasturi verstkali dasturlarga tegishli emas, verstkali 
dasturlarda ko‘p sahifali hujjatlar bilan ishlash imkoniyatlari mavjud. 
Coreldraw dasturida ko‘p sahifali hujjatlar bilan ishlanadi va unda 
999 sahifali hujjatlar bilan ishlash imkoniyati bor. Qoplagan 
funksiyalarining yetishmasligi verskachining ishini yengillashtiradi, 
katta hajmdagi hujjatlarni bir nechta sahifaga joylashtiradi, bunday 
hujjatlarga — reklama bukletlari, kichkina hajmli hujjat, prays-listlar, 
kichkina broshuralar va hokazolar tayyorlanadi.

Sahifa parametrlarini qo‘yish
Sahifalami qo‘yishning asosiy buyruqlari K0Mn0H0BKa (Layout) 

menyusi va IlapaMeTpBi CTpaHHijBi (Page Setup...) buyrugci 
yordamida amalga oshiriladi, natijada ekranga muloqot oynasi 
napaMeTpbi (Options)ning OopMaT (Size) chiqariladi.

2il
El- Workspace 
B -  Document 

|--General 
-  Page 

5ize 
;■■■■ Layout 
I -  Label 

Background 
Guidelines 
Grid 
Rulers 
Styles 
5ave

El - Publish To The Web 
[+]■■ Global

S iz e

(* Normal Paper C  Labels

(* Portrait C  Landscape

Paper:

Width: |21CL0 ^  | millimeters T

Height: |297,0 millimeters

n  Resize current page only 

Resolution: 1300

Bleed: W 1 millimeters

Set From Printer Save Custom Page

Add Page Frame

□ K Cancel Help

Muloqot oynasining yuqori qismida sahifa turini aniqlovchi 
o‘tkazgichlari berilgan. Tpa^HUHOHHbie (|)opMaTbi (Normal Paper) 
va 3 t h k c t k h  (Labels). Paper (OopMaT 6yMam) ro‘yxatida jahonda 
ishlatiladigan formatlar yiindisi berilgan. Agarda hech bir format 
t o ‘g ‘ri ke lm asa , u h o ld a  LQnpHHa (W id th) va BbicoTa 
(Height)lardan foydalanib kerakli parametrlami kiritsa bo‘ladi.
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R o‘yxatning yonida o ‘lchov birligi berilgan CoxpaHHTb 
napaMeTpbi CTpaHHiiBi (Save Custom Page) tugmasi
tayyor bo‘lgan formatli sahifani xotirada saqlaydi.

Pa3pemeHHe (Resolution) maydonida ro‘yxatdan bitta variant 
tanlanadi yoki xohlagan mumkin bo‘lgan son qiymati kiritiladi.

Hcn0Jib30BaTb napaMeTpbi npHHTepa (Set From  Printer) 
tugmasi sahifada berilgan parametrlami joriy printerga o‘rnatadi.

napaMeTpbi (Options) muloqot oynasini chap tomonidagi 
satrdan chaqiriladigan K0Mn0H0BKa (Layout) bo‘limi sahifalami 
joylashtirishini bir nechta variantlarini beradi, o‘z navbatida bu 
hujjatning markeriga ta’sir qiladi.

K0Mn0H0BKa (Layout) ro‘yxatida markerlarni oltita varianti 
berilgan (variantlar ko‘rish oynasidan ko‘rsatib turiladi):

Pa3BopoT (Facing pages) bayroqchasi ekranga ikkita qo‘shni 
sahifalami joylashtiradi.

HanaTb c (Start on) punkti Pa3BopoT (Facing pages)ga 
bayroqcha qo‘yganda joriy bo‘ladi va qaysi betdan aylantirishni 
boshlashni bildiradi (jieBOH (Left Side) chapdan yoki (Right Side) 
o ‘ngdan).

O o h  (Background) hamma sahifalar uchun umumiy fonni 
aniqlaydi. Bu fon zalivka yoki nuqtali tasvir bo‘lishi ham mumkin. 
Ulardan bittasini tanlash imkoniyati bor, buning uchun o‘tkaz- 
gichning bittasini — CiuiomHan 3ajiHBKa (Solid) yoki Tonemioe 
H3o6pa>KeHHe (Bitmap)ni tanlash kerak.

Sahifa qo‘shish
Hujjat boshida o‘zi bitta sahifa bo‘ladi.Yangi sahifalar qo‘shish 

uchun berilgan ikkita «+» tugmalardan bittasi tanlanadi, birinchisi 
bosilishi bilan joriy sahifa oldiga yangi sahifa qo‘yiladi, ikkinchisi 
bosilsa, joriy sahifadan keyin yangi sahifa qo‘yiladi.

Shu bilan birga bir nechta sahifalami qo‘shsa ham bo‘ladi, buning 
uchun menyuning K0Mn0H0BKa (Layout) va /I,o6aBHTb CTpaHHiiy 
(Insert Page...)ni bosish kerak va 
ekranga muloqot oynasi chiqariladi.

/I,o6aBHTb ... CTpaHHii (Insert ... 
pages) maydonida ldan 998 gacha 
qiymat beriladi. Ishchi oynani pastki 
qism ida sahifalar raqam lari bilan 
beriladi va xohlagan sahifaga tegishli 
raqamni bosish orqali o‘tiladi.

l ln s e r t  Page ■
Insert  ̂ pages

C  Before 

(* After
page:

Portrait C Landscape

□ K Cancel
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Ho (Before) va Ilocjie (After) lar joriy saliifadan oldin yoki 
keyin qo£yiladigan saliifalar raqamlari C rpaHMua (Page) da beriladi.

Bitta sahifadan ikkinchisiga o£tish sahifalami boshqarish bloki 
yordamida yoki K0Mn0H0BKa (Layout) menyusidagi IlepeiiTH k  

cxpaHHue (Go to Page...) buyrug£i yordamida o£tiladi. Bunda 
paydo bo£lgan oynaga o£tislii kerakbo£lgan saliifa raqami kiritiladi.

Sahifalarni o‘chirish
Keraksiz sahifalarni albatta o£chirib tashlash kerak. Buning 

uchun  m enyuning K 0Mn0H0BKa (L ayout) dan, yqajiHTb 
c rpaHMuy (Delete Page...) buyrug£i tanlanadi va namoyon bo£lgan 
oynada quyidagi amallar bajariladi.

y^ajiHTL crpaHMuy (Delete page) maydoni o£cliirilislii 
kerak bo£lgan sahifa raqamini kiritish kerak. IIo CTpaHHuy ... 
BKjnoqHTejiLHO (Through to page ... Inclusive) maydonidagi 
bayroqcha belgilangan bo£lsa, o£chiri1ishi kerak bo£lgan saliifalaming 
oxirgi raqami kiritiladi.

Sahifaga nom berish
CorelDRAW dasturining sahifalariga nom  berish o£zgacha 

xarakterga ega bo£ladi. Bu protsedura matn muharrirlari va verstka 
dasturlaridagi sahifalarga nom berishdan farq qiladi. Sahifalarga nom 
berish hujjat bilan ishlashni osonlashtiradi.

K 0 M n 0 H 0 B K a  (Layout) menyuning Ilep eH M eH O B aT b  C T paH H uy  

(Rename Page...) buyrug£i yordamida saliifalami nomlasa bo£ladi.
Muloqot oynasidan kiritilgan nom mos sahifaning vkladkasiga 

chiqariladi.

Property Bar panelidagi sahifalar paramertlari
Agarda hech qanaqa obyekt tanlanmagan bo£lsa, CBOHCTBa 

(Property Bar) asboblar paneliga quyidagi parametrlar chiqariladi 
va ulami o£zgartirish imkoniyati bo£ladi.

P ro p e r ty  Bar: No S e le c t ion

Birinchi ro£yxatdan saliifa formati tanlanadi, keyingi satrdan 
sahifa o£lchamlari beriladi, ikkita tugma, saliifa oriyentatsiyasini 
beradi va ikkita biming ustida ikkinchisi joylashgan, yuqorisi hamma 
sahifa parametrlarini, pastkisi faqat joriy sahifa parametrlarini 
o£zgartiradi.
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Bu xossadan shuni ko£rish mumkinki CorelDRAW dasturida 
sahifalar o£lchamlari, oriyentatsiyalari har xil bo£lishini ko£rsatadi.

III. PHOTOSHOPDA ISHLASHNING ASOSLARI

3.1. Asosiy tushunchalar

Photoshop dasturi — grafik muharriri bo£lib, rastr (nuqtali) 
tasvirlar bilan ishlashga m o£ljallangan (rastr formatli grafik fayllar, 
fotografiya, tasvirlar va hokazo).

Ekrandagi piktogram m a asboblarini faollashtirish uchun 
sichqoncha bilan chertish kifoya. Piktogrammalami yon tomonida 
kichkina yo£nalishjoylashganbo£ladi. Agarda yo£nalishga chertilsa, 
palitra ocliiladi va bizlar shu guruhga kiruvchi asboblami tanlash 
imkoniyatiga ega bo£lamiz.

Asboblar bilan ishlashning yana bir qulay to- 
monlaridan biri klaviatura yordamida ekranga chaqirish 
(har bir asbobga mos keluvchi harfni yodda saqlab 
qoling). Agarda siz tugmalar kombinatsiyasini yoddan 
chiqargan bo£lsangiz, u holda kerakli bo£lgan asbob 
ustida bir necha soniya sichqoncha yordamida ko£rsatib 
tursangiz, sizga tugm alar kom binatsiyasi haqida 
m a’lumot beradi (3.1-rasm). Guruhdagi asboblarni 
ketma-ket joylashganiday qilib chaqirish uchun Shift 
va mos tugma bosiladi. Yoki Alt tugmasi bosilgan holda 
mos asbobni sichqoncha bilan ko£rsatish orqali amalga 
oshiriladi.

Opsia panelida har bir asbobga mos holda o£zining 
parametrlari beriladi (masalan, aralashtirish rejimi, 
tiniqlilik qiymati). Opsiya paneli ekranning yuqori qismida 
joylashganbo£ladi. (Buhaqda «Opsiya paneli» qismida 
kengroq berilgan.) — 3.2-rasmga qarang. Opsiya 
panelidagi parametrlar qanday asbob tanlanishiga qarab 
o£zgaradi.

□.F*
\ M ove T ool iy .l

% y .
s . s .

<.T.
V

S.X

■
3 3  J

3.1-rasm.
Asboblar

paneli.

w P  Auto Select Layar I-  Show Bourding Box I ^ B I  l i j  - i

Automatically select a layer by clicking on a visible piwel

3.2-rasm . Opsiya paneli. 
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Photoshop dasturining panellari 
Asboblar paneli

Opsiyalar panelini o ‘ng tomonida joriy asbobning piktogram- 
masi joylashgan. Agarda piktogramma yonidagi yo‘nalishga chertilsa, 
menyucha paydo bo‘ladi, bu yerdan boshqa asbobni tanlash 
imkoniyatiga ega bo‘lamiz. Bu yerdagi menyucha ro‘yxatini 
muharrirlasa bo‘ladi, ya’ni kam foydalaniladigan asboblarni olib 
tashlasa va ko‘p foydalanadiganlarini joylashtirsa bo‘ladi. Har bir

asbobni opsiyasi o ‘zgarmay 
saqlanib, u o ‘zgartirilmagan va 
qaytadan tiklanmagan bo‘ladi. 
Yuklash, qo‘shish va saqlash 
amallari maxsus tugmalar yor- 
damida yoki panel menyuchasi 
yordamida bajariladi (3.3-rasm). 
Hamma asboblar uchun ixti- 
yoriy opsiya tanlanishi uchun 
Reset All Tools (hamma asbob- 
larni awalgi holiga qaytarish) 
b u y ru g ‘i yoki Edit > 
Preferences > General
( n p a B K a  >  Y c T a H O B K H  >
06mHe) oynasidagi Reset All 
Tools ni s ichqoncha b ilan  
bosing.

Edit > Preferences > Display& Cursors (npaBKa > YcraHOBKH > 
OToOpaaceHHe&Kypcopbi) oynasidan kursorning asboblar paneli 
piktogrammasi qanday ko‘rinishda bo‘lishini tanlash mumkin.

Agarda asbobdan n o to ‘g ‘ri foydalanilsa, «0» taqiqlash  
piktogrammasi chiqariladi. Sichqoncha yordamida joriy oynaga 
chertish orqali nima uchun joriy asbobdan foydalanib bo‘lmasligi 
haqida ma’lumot olasiz.

3.4-rasmda Photoshop dasturining asboblar paneli berilgan. 
Guruhga kiradigan asboblar yonida asboblami tugmalar yordamida 
chaqirish tugmalari («ropaMaa K riaB H m a») berilgan.

Bu amal quyidagicha bajariladi, Shift tugmasi bilan birgalikda 
mos ko‘rsatilgan tugma bosiladi, bu holda asboblar panelida 
joylashgan tartib bo‘yicha ketma-ket chaqiriladi (3 .5—3 .2 1 -rasmlar).

. /  Healing Brush 21 pixels 

^  Magnelir L-asso 24 pixels 

% Crop 5 inch x 4 inch 300 dpi 

Fill with Bubbles Pattern 

T  Horizontal Type Myriad Roman 24 pt

I”  Current Tod Only

</ Sort B)i Tool 
i/ Show All Tool Preseti: 

Show Cunent Tool Presets

T ext Only 
</ SmallList 

Large Lisl

Reset Tool 
ResetAIITools

Pretet Manager...

Reset ToqI Presets... 
LoadTGolPresets... 
Save Tool Presets... 
Replace Tool Presets...

ArtHistori)
Brushes
Crop and Marquee 
Text

3.3-rasm. Asbobni tanlash paneli.
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-- (»1
] Rectangular Marquee Tool (M)

A

i > . \ .

a

■

3.4-rasm. 
Asboblar 

paneli.

3.5-rasm. 
Geometrik shaklga 

ega sohani ajratuvchi 
asboblar palitrasi.

3.6-rasm. Xohlagan 
shaklga ega sohani 

ajratuvchi asboblar 
palitrasi.

3 .7-rasm. 
Tasvirning 
defektlarini 
o‘chiruvchi 

asboblar 
paneli.

U  n *

m P Healing Brush Tool J 

^  O  Pa^ch Tool J

*  - T ,  

4 - \ ,

s
Z l Z) _ )

■ ■ ■

P A
jr.

■1. ■ d
& %

 ̂Clone Stamp Tool S 
 ̂Pattern Stamp Tool S

R t
T

d . \ .
a  k  
o  ^spa o u

3.8-rasm. 
Klonlashtirish 

asboblar palitrasi.

/ j?  Eraser Tool 

/ )  Background Eraser Tool

Magic Eraser Tool

V

3.9-rasm. 0 ‘chirish 
asboblar palitrasi.

125



77 (*'
L_J

f>,%
n j'.
y .y .

w.
&.o.

| BlurTool R 

Sharpen Tool R 

. ‘  Smudge Tool R

S>. A 
O ^■

|o j^
3 □□

3.10-rasm. Tasvir 
chegaralari aniqligini 

nazorat qiluvchi 
asboblar palitrasi.

3.11-rasm. To‘g‘ri chiziq bo‘yicha 
ajratish asboblar palitrasi.

LJ ^  

% J'.

6 .Q .
\  T
E
s,
~n>

Pen Tool 

^■ 'Freeform Pen Tool 

r̂+ Add Anchor Point Tool 

' ^  Delete Anchor Poin-t Tool

fs, Convert Poini Tool

3.12.-rasm. 
K onturlar bilan 

ishlovchi asboblar 
palitrasi.

3.13-rasm. 
Eslatmalarni 

yaratuvchi asboblar 
palitrasi.

[I], N-
P A  .
fef. ■ j j f : li ■ '

~ y y     '

& C>

\  T
A . \

'A 
n i

j  j  j

3.14-rasm. 
Bo‘laklar bilan ishlovchi 

asboblarning palitrasi.
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p.-\
y ?  | ^  ^  Eruih Tool

j  y ;  ■ Pencil I

<̂ .<xT
0. '3.
V, T
i. \.
a > .
Q ^

-I-

© a

3.15-rasm.
Rasm

chizuvchi
asboblarning

palitrasi.

[ 1 3  v+p - \
n j '
J . S . .

9
0.Q
V. T
s>.\

aoB
S>Q

History Brush Tool 

^ yj Art History Brush

3.16-rasm. Tasvimi 
yaratishdagi ketma-ketlik 
(tarixi) bilan ishlovchi 
asboblaming palitrasi.

f>-%
% ? .
J.S.
dLSf.

■ i_ J  Gradient Tool <5

., 4. Paint Bucket Tool <3

\  T
i . \ .

9. / .
©  ^

m

3 3  J

3.17-rasm. Zalivkali 
asboblar palitrasi.

P.
% J '
y . y

& a
6K
\,T
b .\
m ./

t *. ’■ Burn Tool 

Sponge Tool

3.18-rasm. Tasvirlarni 
oqartiruvchi va 
qoraytimvchi 

asboblarning paneli.

— I w
>■*

P .%
%  y .  

s . s .

^ , a .

V f T

i . \ .

a / .

■ ”P  Horizontal Type Tool T 

|*J* Vertical Type Tool T 

W Horizontal Type Mask Tool T 

|*]rj  Vertical Type Mask Tool T

■
□  □ □

3.19-rasm. Matnlar 
bilan islilovchi 

asboblarning paneli.
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lll.
P A  
% s.

s.
%. 

&. Ll

\ j
o l V

■ [~ | Rect-angle Tool U 

Q  Rounded Rectangle TqoI U 

Q  EIHpse Tool U 

Q P olygonToo l U 

Line Tool U 

^J^Custom Shape Tool U

a

o  ^

m

j  j  j

S>E3

3.20-rasm. Obyektni 
vektorli asboblar bilan 

chizish paneli.

3.21-rasm. Ranglar, burchaklar 
va masofalar bilan ishlovchi 

asboblarning paneli.

^  G031.tif @ 100% [RGBtt)

3.22-rasm. Notes asbobi yordamida yaratilgan eslatma.
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[ f i  A d o b e  P h o to s h o p  - [F ile  B row se r]

File E d it im a g e  Layer S e le c t Filter V ie w  W in d o w  H e lp

J Feather: |0 px Anti-aliased S ty le : |Normal

lOOJi

' t - l  | MoO K O M nbK jrep \ (E :) \P h o to s \L o _ re s  ~ ^ ] ©

<E:)
M orereso  

Photos 

! [ ...._ J  H i_res

| _j Q Z
i  _ J  Readmefi

J

3.23-rasm. Palitrani saqlash uchun opsiya panelidagi maydon (oblast).

I y\ *

45
Mode: |Normal ----------3  O p a c ity : |10096 | > | Flow: |5094 | > |

3.24-rasm. Brush asbobi uchun opsiya paneli.

1 1
F e a th e r: |o p x  l~~ ^nti-a liased S ty le : |N orm a l T |

■

3.25-rasm. Rectangular Marquee asbobi uchun opsiya paneli.

Notes (IIpHMeHaHHK) asbobi yordam ida (3 .13-rasm da 
ko‘satilgan), Acrobat dasturiga mos keladigan formatga ega bo‘lgan 
matnli eslatmalar yoritiladi. Bu eslatmalar bosmadan chiqarilmaydi. 
U lar faqat mijozga, bosmaxonaga va hokazo kerakli bo‘lgan 
m alum otlarni yetkazish uchun xizmat qiladi. Eslatma belgisiga 
chertish orqah paydo bo‘lgan oynada (3.22-rasm) berilgan eslatma
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matnini olasiz (bu matnni qayta muharrirlash mumkin). Audio 
eslatmalar Audio Annotation (ovozli eslatmalar) yordamida 
yoritiladi (3.13-rasmda berilgan).

Opsiya paneli

Opsiya paneli har bir asbob uchun parametrlar qiymatini 
tanlash uchun ishlatiladi (masalan, tiniqlilik ko‘rsatgichi, so‘nish 
nuqtasining boshlanishi, aralashtirish rejimi) — 3.24-rasmga qarang. 
Opsiya panelining o‘ng tomonidagi soha palitralari saqlash xizmatini 
bajaradi (3.23-rasm). Tanlangan asboblar turiga qarab panelga 
chiqadigan parametrlari o ‘zgarib turadi (3.24—3.29-rasmlar). Siz 
kiritgan, tanlagan qiymatlarni o‘zgartirmaguningizcha saqlanadi. 
Palitrani, opsiya panelini ekranning xohlagan joyiga qo‘yishimiz 
mumkin.

I O E j U k J D U  Mode: |Normal 3 ]  Op-aci-ty: | l0 0 9 i |

3.26-rasm. Gradient asbobining panel opsiyasi.

l l A R I l n a  | | T t f  | Q  O  \  . ' h I?  A uto  A dd /D e le te  J

3.27-rasm. Pen asbobining panel opsiyasi.

1

1

U □ £ §  U  □  O  O  \  -

3.28-rasm. Rectangle asbobining panel opsiyasi.

|H e lvetic^ t ]  3  a d  |sh arp

3.29-rasm. Type asbobining panel opsiyasi.

Uchib chiquvchi yordamlar (B cn jib iB a io m M C  nô CKa3KH)

Kursorni asboblar piktogrammasidagi xohlagan asbobga olib 
borib asbobning nomini bilsak bo‘ladi va uni joriy qiladigan 
tugmalarni ham ko‘rish mumkin (3.1-rasmda berilgan). Mos 
ravishda palitra funksiyalari haqida ham yoki opsiya qiymatlari haqida

130



m a’lumot olishingiz mumkin (3.2-rasmga qarang).Uchib chiquvchi 
m a’lumotni ko‘rsatishni ishga tushirish uchun Edit > Preferences 
> General (IIpaBKa > YcTaHOBKH > OSmne) oynasidagi Show 
Tool Tips (IIoKa3BiBaTb BciuiBiBaiomHe no/icKa3KH)ni belgilash 
kerak.

Asbob (TopHMMc) tugmalari

3.1 -jadvalda eng ko‘p foydalaniladigan buyruqlar va ularga mos 
keladigan tugmalar berilgan.

3.1-jadval

Buyruq Tugmalari

Joriy bo‘lgan barcha palitralami 
va asboblar panelini ko‘rsatish /  yo‘qotish

Tab

Uchib chiquvchi menyuning bog‘langan 
asboblarini ketma-ket chaqirish

Shift + asbobini joriy qilish 
tugmasi yoki Alt tugmasi 

bosilgan holda asbobning 
piktogrammasiga sichqoncha 
yordamida chertish

Joriy qatlam yoki asbobning 
aralashtirish rejimiga o‘tish

Shift+«plus» yoki 
Shift+«minus»

Photoshop dasturida ishchi oynaning ko‘rinishi

Photoshop dasturining ishchi oynasi 3.30-rasmda berilgan.
Shichqoncha yordamida chertilsa qo‘llanmalar bilan ishlovchi 

menyu chaqiriladi. Bu menyu quyidagi buyruqlardan iborat: 
Restore (BoccTaHOBHTB) Qayta tiklash, Move (IlepeMecTHTB) 
Siljitish, Size (Pa3Mep) 0 ‘lcham, Minimize (CBepHyn>) Kichkina 
qilish, Maximize (Pa3BepHyn>) Katta qilish va Close (3aK p B m > ) 

Yopish. Agarda Edit tugmasi bosilsa, hujjatlar bilan ishlovchi menyu 
chaqiriladi. Hujjatlar menyusi quyidagi asosiy buyruqlardan iborat: 
Restore (BoccTaHOBHTB) Qayta tiklash, Move (IlepeMecTHTB) 
Siljitish, Size (Pa3Mep) 0 ‘lcham, Minimize (CBepHyTB) Kichkina 
qilish, Maximize (Pa3BepHyTB) Katta qilish, Close (3aK pB iT B ) 
Yopish va Next (Cjie^yiomHH) Kelasi.

Nomer panelining xohlagan asbobi sichqoncha bilan chertilsa, 
muloqot oynasiga, kichkina menyuchaga va buyruqlarga ruxsat 
olinadi.
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Tanlangan asbobning parametrlarini aniqlash uchun opsiya 
panelidan foydalanamiz.

QoTlanma oynasini yig‘ish uchun M inim ize bosiladi va natijada 
piktogramma masalalar paneliga joylashtiriladi. Oynaning awalgi 
holiga qaytarish uchun shu belgiga sichqoncha bilan chertish kifoya.

M axim ize (Pa3BepHyTb) yoki hujjatdagi tugmalarni bosish 
esa oyna oTchamlarini imkoniyat boricha kattalashtiradi. Agarda 
oynani awalgi holatiga qaytarmoqchi boTsangiz, Restore tugmasidan 
foydalaning. Oyna awalgi holiga qaytgandan keyin Restore tugmasi 
M axim ize tugmasiga aylanib qoladi.

Yopish tugmasi qoTlanmani yopish uchun xizmat qiladi.
Sarlavha tugmasi tasviming nomi, masshtabi, joriy qatlam nomi 

yoki Background (O o h )  identifikatori va tasvirlanish rejimi haqida 
maTumot beradi.

Hujjatni yigTshtirib qo‘yishsa boTadi, buning uchun M inim ize  
tugmasidan foydalaniladi, natijada hujjat piktogrammasi qoTlanma 
oynasini chap tomonning pastki qismiga joylashtiradi. Agarda Restore 
(BoccTaHOBHTb) tugmasi sichqoncha bilan chertilsa oynani awalgi 
holiga qaytariladi.

Agarda tasvirni yoki palitrani yopmoqchi boTsangiz piktogram- 
maga cherting.

Oynadagi chiziqni na- 
moyon qilish uchun View  
> S h o w  R u lers (B h a  > 
I l o K a 3 a T b  j i h h c h k h )  buy- 
ruqlaridan foydalaniladi. 
K urso r h o la ti m ark er 
yordamida mos chiziqcha- 
larni ko‘rsatadi. Chiziqcha 
uchun oTchov birliklari 
E d it  >  P r e f e r e n c e s  >  
U nits& R ulers ( I lp a B K a  >  
YCTaHOBKH >  EnMHMUbl H 3 -

MepeHHH&jiHHeHKH) buy- 
ruqlari yordamida tanlanadi.

Dastur 13 ta palitraga 
ega, ulami ekran bo‘yicha 
siljitish  g u ru h lan ish n i 

3.30-rasm. Photoshop o^zgartirishi yoki sukut (no
ekranining ko‘rinishi. ym0ji'iaH  HK)) saq lagan
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holda qabul qilishi mumkin. Palitra guruhidagi palitra nomiga 
(vkladkaga) chertilsa, u berilgan stekning eng yuqorisiga 
joylashtiriladi.

Asboblar panelini yoki joriy bo‘lgan palitralarini ko‘rsatish/ 
yo‘qotish uchun Tab tugmasini bosing.

Holat satrida quyidagi paramertlarning qiymatlari ko‘rsatiladi: 
D ocum ent S ize (Pa3Mep noKyivieHTa) Hujjat oMchami, D ocum ent 
P roflle  (npo(J)Hjib ^OKyMeHTa) Hujjat proflli, S cra tch  S izes  
(06i»eM naMHTH) — operativ xotira hajmi, bu holda Photoshop 
dasturiga tegishli Efficiency (9 (J)(J)eKTHBH0CTb) Samaradorlik — 
foydalangan operativ xotira, Timing (BpeMM) Yaqt va Current 
Tool (TeKymHH HHCTpyMeHT) — joriy asbob nomi. Holat satrini 
kursor yordamida, tasvirni sahifada qanday ko‘rinishga ega 
bo‘lishini ko‘rish uchun sichqonchaning tugmasini bosib ushlab 
turiladi. Agarda bu amalni Alt tugmasi bilan birgalikda bajarsak, 
u holda ekranda tasvirning hajmi, kanallar soni, rejimi va 
ajrataolish (pa3pemeHHe) haqidagi m a’lumot beriladi. Yaqtni 
noldan boshlab hisoblash uchun T im ing (BpeMH) dan foy- 
dalaning.

Photoshop dasturining M enyusi 

File menyusi
File (Oanji) menyusining buyruqlari 

quyidagi amallami bajarishda foydalaniladi: 
yangi fayl yaratish, mavjud faylni ekranga 
chiqarish, joylashtirish, yopish, xotirada 
saqlash, skayner qilish, im port yoki 
eksport qilish, tasvimi bosmaga chiqarish, 
faylni set yordamida uzatish, operatsiya- 
la rn i av to m a tla sh tir ish  va n ih o y a t, 
Photoshop (3.31-rasm) dasturidan chiqib 
ketish. Agarda qo‘shimcha qo‘llanmalardan 
(ImageReady yoki GoLive)dan foyda- 
lanm oqchi b o ‘lsangiz F ile  > Jum p to  
(Oanji > nepeHTH b ) menyuchasi orqali 
o‘tasiz.

menyusi.

Hite
New... Ctrl+N
Open... Ctrl+0
Browse... Shft+Ctrl+O
Open As... Alt+Ctrl+0
Open Recent ►

Close Ctrl+W
Save Ctrl+S
Save As... Shft+Ctrl+S
Save for Web... Alt+Shft+Ctrl+S
Revert

Place...

Import ►
Enport ►

Workgroup ►

Automate ►

File Info...

Page Setup... Shft+Ctrl+P
Print with Preview... Ctrl+P
Print... Alt+Ctrl+P
Print One Copy Alt+S hft+Ctrl+P

Jump To ►

Exit Ctrl+Q
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Edit menyusi
E d it (IIpaBKa) Tuzatish (3.32- 

rasm) menyusi yordamida quyidagi 
amallar bajariladi: tasvirlarni muhar- 
rirlash buyruqlari: nusxalash, transfor- 
matsiya qilish (ko‘rinishini o‘zgartirish), 
qo‘yish va tasvir ranglarini qaytadan 
aniqlash, berilgan shakldagi va o‘lcham- 
dagi kistlarni yaratish, har xil shakllar 
va figuralar yaratish. Fade (Ocjia6umb) 
menyuchasi buyruqlari ko‘zlangan amal- 
lar effektini kamaytirish (masalan, eng 
oxirgi ishlatilgan filtrdan tuzatish (kor- 
rektirovka) yoki chizishni boshqa amal- 
lar bilan almashtiradi). Purge (Ohhc- 
th tb ) menyuchasi buyruqlari xotirani 
tozalaydi. Yanada E d it menyuchasi 
yordamida C o lo r  S e t t in g s  (XapaK- 
TepHCTHKH uBeTa) muloqot oynasini 

3.32-rasm. Edit ochib, P r e s e t  M a n a g er  (MeHeA^ep
menyusi. HacTpoeK)dan va Preferences (YcTaHOB-

KH)dan foydalanib ranglarni o‘zgartiradi.

Image menyusi
Im age (H3o6paaceHHe) Tasvir menyusi- 

ning M ode (PeacHM) menyuchasi yordamida 
(3.33-rasm), tasvirlar sakkizta imkoniyatning 
biriga o‘tkazilishi mumkin. Adjustments (Kop- 
peK TH pO B K H ) menyuchasi tasvir ta’sirchanligi 
(toni), to‘yinganligi, ravshanligini o‘zgartiradi.
Im age S ize  (Pa3Mep H3o6paaceHH5i) Tasvir 
hajmining menyuchasi yordamida fayl hajmini, 
tasvirni ajrata olishni, o‘lchamlarini o‘zgartira 
olish imkoniyatiga ega. Canvas S ize (Pa3Mep 
xojiCTa) muloqot oynasi tasvir joylashgan 
ishchi maydon o ‘lchamini o ‘zgartirganda 
ishlatiladi.

Image menyusi.

Im a g e

M o d e  ►

A d ju s tm e n ts

D u p lic a te ...

A p p l^  Im a g e ... 

C a lc u la tio n s ...

im a g e  S ize ... 

C a n v a s  S ize ... 

R o ta te  C a n v a s  ► 

C ro fi 

T rim ...

R e v e a l^ilA II

H is to g ra m ...

3.33-rasm.

rEdiT
Undo Rectangular Marquee Ctrl+Z 
StepForward Shft+Ctrl+Z 
StepBackward Alt+Ctrl+Z

M fflB Shft+Ctrl+F

Cut
Copv
Copi! Merged 
Paste 
Paste Into 
Clear

Ctrl+X
Ctrl+C

Shft+Ctrl+C
Ctrl+V

Shft+Ctrl+V

Check Spelling...
Find and R eplace TeKt...

FiJI...
Stroke...

Free Transform 
T ransform

Ctrl+T
►

Define Brush...
Define Pattern...
Define Custom Shape...

Purge ►

Color Settings... 
Preset Manager... 
Preferences

Shft+Ctrl+K

►
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Layer

New
D uplica te  Laver... 

De lete

Layer Properties... 

Layer St^le

N ew  Fill Layer

N ew  Adjustm ent Laver

Change Layer Content

La^er Content Dptions...

l y p e

Rasterise

N ew  Layer Based S.lice

A dd  Layer M ask 

Enable Layer M ask

A dd  V ecto r M ask 

Enable V ec to r M ask

Uni

Arr;

Group w ith P revious Ctrl+G 

igroup Shft+Ctrl+G

ange 

A lign L inked 

D istribute L inked

L o c k  All Lavers In Set..

Merge D ow n 

Merge Visib le 

Flatten Image

Ctrl+E

Shft+Ctrl+E

M atting

3.34-rasm. 
Layer menyusi.

Layer menyusi
L ayer ( C j i o h )  Qatlam menyusida 

joylashgan buyruqlar (3.34-rasm) qat- 
lamlarni qo‘shish, nusxalash, o ‘chirish, 
o ‘zgartirish, guruhlash, stekda joylashgan 
tartibni o ‘zgartirish, o ‘zaro bog‘langan 
qatlam larn i boshqarish, qatlam larni 
biriktirish, maskani qo‘shish va tasvirni 
b itta qatlamga aylantirish am allarini 
bajaradi. Buyruqlarni bajarish tezligini 
oshirish uchun L ayers ( C j i o h )  palit- 
rasidan foydalansa maqsadga muvofiq 
bo‘ladi.

Select menyusi
S e le c t  (BbiAejiHTb) ajratish (3.35- 

rasm) menyusidagi All (Bce) buyrug‘i 
yordamida hamma qatlamlar ajratiladi. 
D ese lect (C h h tb  BbwejreHHe) Ajratishni 
bekor qilish buyrug‘i esa teskari amalni 
bajarib, ajra-
tishni bekor qi- 
ladi. R e se le c t
(B0CCTaH0BHTb 

BbiAejieHHe) 
Ajratishni tik- 

lash buyrug‘i esa D e s e le c t  buyrug‘i 
bilan ajratishni bekor qilishni orqaga 
qaytarib awalgi holini tiklaydi. C olor  
R an ge (flHana30H hbctob) buyrug‘i 
ranglarni hisobga olgan holda ajratadi. 
M enyuning  boshqa buyruq lari esa 
ajratilgan soha chegarasini kengaytiradi, 
siqadi, tekislaydi yoki rastushevkalaydi 
va a jra tilg an  so h ala rn i k an a lla rd a  
saqlaydi yoki kanallardagi sohalarni 
yuklaydi.

Select

All
Deselect
Reselect
Inverse

Ctrl+A
Ctrl+D

Shft+Ctrl+I

Color Range...

Feather...
Modify

Alt+Ctrl+D

Grow

Similar

TransforrmSelection

Save Selection...

3.35-rasm. 
Select menyusi.
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Filtr menyusi
Filtr (OnjTbTp) menyusi tasvirlarni va 

guruhlangan tasvirlarni m uharrirlashda 
ishlatiladigan filtrlarning keng diapazonini 
o‘z ichiga oladi. Digimarc (fliwKMMaK) filtri 
inson ko‘ziga ko‘rinmaydigan mualliflik 
belgisini tasvirlarga qo‘yib beradi (3.36- 
rasm).

Oldingi versiyalaridan farqi shuki, bu 
versiyada menyuga Im age menyusining 
ikkita buyrug‘i joylashtirilgan. E xtra ct  
(H 3Bjienb) buyrug‘i m urakkab sohani 
ajratish uchun ishlatiladi. Liquify (Hcica- 
3HTb) buyrug‘i esa, tasvirning nuqtalarini 
berilgan yo‘nalishda siljitadi. 3.36-rasm. Filtr

menyusi.
View menyusi
V iew  (Bh,u;) menyu buyruqlari (3.37- 

rasm), ekranda nima tasvirlangan, nima 
tasvirlanm agan, shularni nazorat qiladi.
G a m u t W a rn in g  (npe^ynpe^m eH H e o 
raMMe) buyrug‘i to ‘rtta rangli bosmada 
chiqmaydigan ranglami ajratib beradi. Proof 
Setup (YcTaHOBKH n p o 6 H o r o  O T nenaT K a) 
menyucha buyruqlari tasvir bosmaga qanday 
holda chiqarilayotganini ekranda ko‘rsatib 
beradi. V iew  menyucha buyruqlari tasvir 
masshtabini boshqaradi, shu bilan birga 
ekranga chizg‘ichni, koordinatomi, yordam- 
chi chiziqlar va sohalami chiqaradi.

Window menyusi
W in d ow  ( O k h o ) m enyu buyruqlari 

(3.38-rasm) har xil palitralarni ko‘rinmas/ 
ko‘rinadigan holga keltiradi. Bu menyuda 
ochilgan tasvirlar ro‘yxati ham joylashgan bo‘lib, xohlaganini joriy 
qilishi mumkin.

Windows operatsion sistemasida ishlaganda bu menyu yordamida 
oynani (holat satrini) olib qo^yish (o‘rniga qo^yish) amallarini 
bajarish mumkin.

View

Proof Setup ►

Proof Cojors Ctrl+Y

GamutWarning Shft+Ctrl+Y

Zoom In Ctrl++

Zoom Out Ctrl+-
Fit on Screen Ctrl+0

Actual Pixels Alt+Ctrl+0

Print Size

Ewtras Ctrl+H

Show ►

Rulers Ctrl+R

i/ Snap Shft+Ctrl+;

S n a p jo ►

Lock Guides Alt+Ctrl+j
Clear Guides

New Guide...

Lock Slices

Clear Slices

3.37-rasm. View 
menyusi.

Lam Ctrl+F

EKtract... Alt+Ctrl+X
Liquif^... Shft+Ctrl+X
Pattern Maker... Alt+S hft+Ctrl+X

Artistic ►
Blur ►
Brush Strokes ►
Distort ►
Noise ►
Pinelate ►
Render ►
Sharpen ►
Sketch ►
Stylize ►
T enture ►
Video ►

Other ►

Digimarc ►
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Window

Documents ► 
Workspace ►

v* Tools 
*/ Options

File Browser

*/ Navigator 
Info

CoIqi

Swatches
Styles

Histori; 
Actions 
T ool Presets

*/ Layers 
Channels 
Paths

Brushes

Character
Paragraph

*/ Status Bar

3.38.-rasm.
Window
menyusi.

Adobe Help Center

| Product Help | Expert Support More Resources 0

<f a  1 m s  as m Help for: -  | Q »  |Type in s wcrd or phrase

j  Contents '  Indei \^ookmarks

3J
► Using Adobe Help Center
► Legalnotices

M fe  Adobe Help Center is a free, downloadable application th a t 
provides access to  product Help, Adobe Expert Support, and 
learning resources on Adobe.com,

To use product Help, you must have an Adobe product installed 
th a t indudes Adobe Help Center.

3.39-rasm. Help Window menyusi.

Help menyusi
H elp (IloM om b) m enyusin ing  buyruq lari 

Photoshop dasturining qo‘llanmasini interaktiv 
ko‘rinishda ko‘rish, Adobe kompaniyasi haqida 
oxirgi yangiliklarni olish, Adobe O nline yoki 
ekrandagi am alni (3.39-rasm ) bajarish haqida 
yoriqnomani olish uchun internet tizimiga ula- 
nishni bajaradi.

1 r r
J Styles \

] S " S ~ p

■ ■ ■ £

£ 3 m J
j j  3* \ A

-L j_
?
=t
4 f l

:

3.40-rasm. Guruhdan 
palitrani ajratish.

3.41-rasm. Yangi palitra 
yaratish.

Agarda awalgi Photoshop versiyasi ustiga yangisi yozilsa, 
palitralar joylashishi awalgi versiyanikiga mos keladigan bo‘ladi.
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PALITRALAR 

Palitralardan qanday foydalansa b o‘ladi

Photoshop dasturidagi k o ‘zlangan am allar siljitiladigan 
palitralar yordam ida bajariladi. Ekranda palitralar ko‘p joy 
egallamasligi uchun palitralar sukut saqlagan holda quyidagi 
guruhlarga biriktirilgan: N avigator/Info (HaBnraujia/HH^opMauHa) 
Navigatsiya/Ma’lumot, C olor/S w atch es/ Styles (U,BeT/06pa3Hbi/ 
C t h jih ) Rang/Ko‘rsatmalar/Stillar, H istory/A ctions/T ool Presets  
(HcTopH^/AeHCTBH5i /H a 6op HHCTpyMeHTOB) T arix /A m al/ 
Asboblar majmuasi, L a y ers /C h a n n e ls /P a th s  (CjioH/KaHajiti/ 
KoHTypLi)Qatlamlar/Kanallar/Konturlar va Character/Paragraph  
(LIipH(})T/A63au)Shrift/Abzas.

Xohlagan palitrani ochish uchun W indow ( O k h o ) buyruq- 
laridan foydalanamiz. Ko‘rsatilgan palitra shu guruhga kiradigan 
boshqa palitralar ustiga joylashtiriladi.

Bir xil palitralar opsiya panelidagi Type tugmasiga chertish 
yordamida ham ochiladi, masalan, Type ( T c k c t ) asbobining 
C haracter/Paragraph palitrasi. Tab tugmasini bosish orqali barcha 
ochiq palitralarni, asboblar panelini ko^rinadigan/ko^rinmas 
hollarga keltiradi. Agarda Shift+Tab tugmalar kombinatsiyasi bosilsa, 
asboblar panelidan tashqari ochiq turgan palitralami ko‘rinadigan /  
ko‘rinmas hollarga keltiradi.

Agarda shu guruhdagi qandaydir palitrani boshqalari ustiga 
joylashtirmoqchi b o clsangiz ocsha palitra nomiga sichqoncha 
yordam ida chertish kifoya. Palitrani guruhdan ajratib olish 
imkoniyati ham bor, shuning uchun vkladka (palitra nomi)dan 
ushlab olib chiqish kerak, agarda guruhga palitra qo‘shmoqchi 
bo‘lsangiz vkladkadan ushlab turib tashlash kerak (3.40—3.41- 
rasmlar), shu bilan birga guruhga boshqa guruhni ham qo‘shsa boladi 
va vkladkadan ushlab guruh ustiga tashlash kerak. Manipulyator 
yordamida palitra o ‘lchamlarini o ‘zgartirish, (o‘ng tomondagi 
burchakdan tortish kerak) kattalashtirish yoki kichiklashtirish 
mumkin.

Agarda palitrani y ig‘ moqch i /kattalashti rmoqch i bo‘lsangiz, palitra 
nomiga ikki marta sichqoncha bilan cherting yoki oynaning o‘ng 
yuqori qismidagi mos tugmasiga bir marta bosish kerak. Agarda 
palitra o ‘lchami sukut saqlagan holdagidan boshqacha bo‘lsa, awal 
Minimi/e tugmasiga sichqoncha bilan cherting, bunda palitra olchami
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sukut saqlagan holda qayta tiklanadi, keyin kattalashtirish uchun 
yana bir marta bosish kerak.

Agarda Edit >  Preferences >  General (Ilp aB K a >  YcraHOBKH > 
06iu;He) muloqot oynasidagi Save P a lette  L ocations (C oxpaH H T b 
pacnojioaceHHe na/iHTpa) ga bayroqcha qo‘yilgan bolsa, Photoshop 
dasturidan chiqib ketgan paytdagi palitralar qanday joylashgan 
bo‘lsa qaytadan dasturga kiradi va shu holda ekranga chiqariladi.

Xohlagan paytda sukut saqlagan palitra guruhini qayta tiklash 
mumkin, shuning uchun Window >  W orkspace > R eset P alette  
Locations ( O k h o  > Pa6oLiee n o jie  > BoccraHOBHTL p acn o jio aceH H e 
na/iHTp) buyruqlaridan foydalanish lozim.

Palitra maydonlari yoki muloqot oynasi qiymatlarini qisqa vaqt 
ichida o ‘zgartirish uchun aw al palitraga cherting, keyin yo‘nalish 
tugm alari yordamida kam aytirm oqchi yoki ko‘paytirmoqchi 
bo‘lsangiz yuqoridagi tugmalarni bosish kerak.

U chib  chiqadigan siljitishdan ikki xil usulda foydalaniladi 
(3.42-rasm): sichqonchanibosgan holda yo‘nalishli tugmanibosing 
va siljigichni torting yoki siljishi kerak bo‘lgan shkalaga sichqoncha 
bilan cherting va u avtomatik ravishda siljiydi. Siljitgich panelini 
yopish uchun paneldan tashqaridagi sichqoncha bilan cherting 
yoki E nter tugmasini bosing. Agarda siz yo‘nalishli tugmani 
chertgan bo‘lsangiz, siljitgich panelini ochish uchun Esc tug- 
masini bosing, shunda siljitgichning oxirgi berilgan ko‘ rinishi paydo 
bo‘ladi.

- To le rance : |32  V  Anti-a liased P  Contiguous 1”  Use All L a ye rs O p a c ity : |8 5M  | ► |

------------------------------- z s -  1

3.42-rasm. Uchib chiqadigan siljitgich.

Color palitrasi
C olor (U ,B eT ) palitrasi (3.43-rasm) ranglarni tanlash yoki 

aralashtirish uchun ishlatiladi. Ranglami tasvirlarga har xil chizish 
asboblari yoki tuzatish-kiritish buyruqlarini masalan, Fill (3a/iHTL) 
yoki Canvas S ize (Pa3Mep xojiCTa) yordamida berish mumkin. 
Palitraning menyusidan rang modelini tanlang. Ranglami aralash- 
tirish uchun siljitgichni surish orqali amalga oshiriladi. Rangni tez 
tanlash uchun tayyor holda foydalanish kerak, buning uchun
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tayyor bo‘lgan ranglar paneli 
chertilad i, bu panel C o lo r  
palitrasining past qismida joy- 
lashgan.

C o lo r  P ic k e r  (Bi>i6op 
LXBeTa) rang tanlash panelini 
ochish uchun asosiy yoki fon 
rangini tanlab kvadratga bir 
marta chertish kerak, agarda 
jo riy  b o ‘lm asa ikki m arta  
chertish kerak.

Swatches palitrasi
S w a tc h e s  (06pa3ULi) 

palitrasi — 3.44-rasmda berilgan 
bo‘lib, tayyor ranglardan foy- 
dalanmoqchi bolsangiz, ishla- 
tiladi. Ranglar palitrasiga alohida 
Sw atchesni qo‘shish yoki olib 
tashlash m um kin. Palitra  
menyusining buyruqlarini yuk- 
lash, boglash, xotirada saqlash 
mumkin.

Styles palitrasi
S ty le s  ( C th j ih )  palitrasi 

(3.45-rasm) awalgi yaratilgan 
effektlar va ularning birikmala- 
rini xotirada saqlashdan foyda- 
laniladi. Bu amal aw al faqat 
ImageReady dasturida mavjud 
edi, hozir esa, Pho toshop  
dasturida ham ishlatiladi.

D L R L------ •[ "
■ ■ “ --------

B 1-------------------------

Grayscale Slider 
RGB Sliders 
HSB Sliders 
CMVK Sliders 
Lab Sliders 
Web Color Sliders

Copy Color as HTML

✓ RGB Spectrum 
CMVK Spectrum 
Grayscale Ramp 
Current Colors

Make Ramp Web Safe

3.43-rasm. Color palitrasi 
va menyusi.

ANPA Colors
DIC Color Guide
FOCOLTONE Colors
HKSE
HKSK
HKSN
HKSZ
Mac OS
PANTONE metallic coated 
PANTONE paslel coated 
PANTONE pastel uncoated 
PANTONE process coated 
PANTONE solid coated 
PANTONE solid matte 
PANTONE solid to process 
PANTONE solid uncoated 
TOVO Colors

3.44-rasm. Swatchesning 
palitrasi va menyusi.

Navigator palitrasi
N a v ig a to r  (HaBHrauHn) (3.46-rasm) palitrasi yordamida 

tasvirning bitta parchasini oynada ko‘rsatadi yoki shu parchaning 
masshtabini o ‘zgartiradi.

Dock to Palette V/ell

✓ Small Thumbnail 
Small List

Preset Manager...

ResetSiAiatches... 
Load Swatches... 
Save Swatches... 
Replace Swatches...
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□ ■ - i

m ■ ■ m * J f

E - m i

New Stjie...

T exl Only 
SmallThumbnail 
Laige Thumbnail 
Small List 
Large List

•t Manager...

Reset Styles... 
Load Stiiles... 
SaveSMes...

Abstract Styles 
Buttons
Glass Button Rollovers 
Glass Buttons 
Image Effects 
Photographic Effects 
Rollover Buttons 
Text Effects 2 
Text Effects 
T extures

3.46-rasm. Navigatorning 
palitrasi va menyusi.

3.45-rasm. Stylesning 
palitrasi va menyusi.

1 B Q |
| N-avigaior ''j  In fo  \ ©

R : C :
j f  G : 

B :
,4 M : 

‘ ‘ Y :
K :

+  M : ^  Y :
W : 

l ,  H .

3.47-rasm. Info palitrasi.

+, 7,48
0,39 0

#1 R : 255 #2 R : 255
-H G : 255 G : 255

E : 255 E : 255

Info palitrasi
Info (HH(|)opMaiiHfl) palitrasida kursor ko‘satgan pikselning 

rang komponentalari ko‘rsatiladi (3.47-a rasm ). Shu bilanbirga tasvir 
uchun tanlangan ranglar haqida m a’lum otlar uchun tayyor 
ranglaming kamida to‘rttasi joylashtirilgan bo‘ladi (3.48-rasm). Agarda 
ranglarni tuzatish uchun muloqot 
oynasi ochilgan bo ‘lsa, ranglar 
palitrasini o‘zgartirilmasdan awalgi 
va keyingi rang lari haq ida  
m a’lumotlar beriladi. Shu bilan 
birga tasvirda kursor joylashgani 
haqida x va y o‘qlarini koordinatalari 
hamberiladi (3.49-b rasm).

Palitrada boshqa m a’lumotlar 
ham bo‘lishi mumkin va u qanday 
asbob joriy  holda turganligiga 
bog‘liqbo‘ladi: masalan, ajratilgan 
q ism ni s iljitg an d a  n u q ta la r  
orasidagi m asofa, figuralarn i 
qurganda yoki Measure (H3Me- 
p H T e j i b )  asbobidan foydalan- 
ganda; tasvirdan qirqib olinadigan

3.48-rasm. #1, #2 tayyor 
ranglar haqida m alumotlar.

I H Q
| Navigator ''j In fo  \  ©

R : H : „

jf = :  a jt s ■ 6a  B .

, X :
+  Y : B r  W :  l., H .

3.49-rasm. Info palitrasi.
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sohani, ramkaning olcharni (3.47 b-rasm); yoki transformatsiya 
qilinayotgan obyektning eni (W), balandligi (H), burchagi (A), 
vertikal (V) va gorizontal (H) qiya chiziqlari (3.49 b-rasm). 
chizg£ichning olcharn birliklarini o£zgartirishi uchun 3.47 b-rasmda 
ko£rsatilgan yo£nalishga sichqoncha bilan chertish kerak.

3.49 a-rasmda ko£rsatilgan yo£nalishga sichqoncha bilan chertish 
kerak va uni qo£yib yubormay turib, chiqadigan rn a ’lu r n o t la r n in g  

re jim in i tan la sh  kerak: A c tu a l C o lo r  (T e K y m iH  p e* H M  
m 3o6pax<e h mm ) ta sv i rn i joriy rejimi, P roof C olor, G rayscale, R G B , 
W eb, H S B , CM YK , Lab C olor, Total Ink yoki joriy qatlamni 
O pacity (H en p 03p aM H 0C T b ) parametr qiymatlarini bering. Rang 
haqida m a’lumot beruvchi rejim joriy tasviming rejimidan farq 
qilishi mumkin.

E slatm a
Agarda ranglar haqidagi m alum otda “!” belgisi turgan bo£lsa, 

rang CMYK palitrasidan tashqariga chiqib ketganligini bildiradi, 
bosmaga chiqarishda tasvir o£zining ko£rinishini o£zgartiradi.

Ranglar haqida yoki o£lcham birliklari haqida m a’lumot olish 
uchun Info O ptions (Onunn najiHTpLi Info) oynasidan foyda- 
lanamiz. Bu oynaga ruxsatni palitra menyusidagi P alette O ptions 
(Onuuu najiHTpLi) buyrug£i beradi.

Layers palitrasi
Yangi tasvir yaratganda tasvir foni tiniq rangda bo£lmaydi. Layers 

( C j io h )  palitrasi qatlamlami qo£shish, o£chirish, ko£rinadigan/ 
ko£rinmas holga olib kelish, nusxalash, guruhlash, bog£lash va 
fonning yuqori qismida joylashgan qatlamlami joylashish tartibini 
o £zgartirishi kerak (3.50-rasm ). H ar b ir qatlam ga o £zining 
aralashtirish rejimi va tiniqlilik rejimlari mos kelib va har bir 
qatlamni boshqa qatlamlarga to £liqsiz turda muharrirlash imko- 
niyatiga ega bo£lamiz. Shu bilan birga qatlamlami maskaga (mask) 
bog£lasa ham bo£ladi. Standart turdagi qatlamlardan tashqari, 
Photoshop dasturida ikki xil turdagi qatlamlami ham yaratsa bo£ladi: 
korrekiirovkalanadigan qatlam (adjustment layer), bu vaqtincha 
ranglardan foydalanishda yoki qatlamdagi rangni korrektirov- 
kalaganda ishlatiladi; va muharrirlanadigan matn qatlami (e d ita b le  
type layer), bu Type ( T c k c t )  yoki Vertical Type (BepTHKanLHLiii 
tckct) asboblarini ishga tushirganda avtomatik ravishda paydo bo£ladi. 
Agarda qatlamga qandaydir effekt ishlatilsa (masalan, Inner Glow
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(B H y ip eH H ee  c b c m c h m c ) ,  Drop Shadow ( O t 6 p o c h t l  t c h l ) ) ,  q a t la m  
n o m i  e n id a  eflfekt p ik to g r a m m a s i  v a  u c l i ib  c l i iq u v c li i  m e n y u d a n  
c h a q ir is h  tu g m a s i  c h iq a d i.

Faqat joriy qatlamnigina muharririasa bo£ladi (tanlangan yoki 
joriy). Qatlamni tanlash uchun Layers palitrasidan qatlam nomiga 
sichqoncha yordamida chertish kerak.

Yangi qatlamdagi eng pastki qatlam foni tiniq bo£lmagan 
holatidan tiniq holatiga o£tkazish uchun Contents (ConcpxaHMC) 
guruhidagi muloqot oynasidan, Transparent (n p 0 3 p a H H L ra )  ga 
bayroqcha qo£yish kerak. Bu menyuning File > New (Oaitn > 
H o b l ih ) buyrug£i yordamida chaqiriladi.

Palette Options...

3.50-rasm. Layers palitrasi.

3 .2 .  P h o to sh o p  d a stu rid a g i ran g lar

Bu dasturda ranglar bilan bog£liq bo£lgan asosiy tushunchalar 
ko£rib chiqiladi (rang modeli, tasvirlash rejimlari va aralashtirish 
rejim lari), shu bilan birga Photoshop dasturidagi ranglarni 
boshqarish haqida m alum otlar beriladi.
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Rang haqida asosiy tuchuncha 

Piksellar

Photoshop dasturidagi tasvirlar ekranda rastr ko‘rinishida 
beriladi, ya’ni to‘g‘rito‘rtburchak toming tugunlarida joylashgan har 
xil rangdagi nuqtalaming yig‘indisi. Piksel deb nomlanadigan 
nuqtalar qandaydir bir rangni yoki soyani beradi. Tasviming bitta 
qismini kattalashtirib piksellami muharrirlash mumkin (3.51-rasm).

Photoshop dasturidagi har qanday rastr ko‘rinishidagi tasvir 
b o ‘lib hisoblanadi; u skaner yordamida olindimi, boshqa 
muharrirdan eksport qilindimi yoki Photoshop dasturida chizish 
yoki muharrirlash yordamida yaratilganidan qat’i nazar. Rastr 
tasvirlar bilan ishlovchi dasturlar jivopisli, fotografiya yoki fotoreal 
(ranglar farqi juda kam tasvirlar) tasvirlar bilan ishlaydi. Agarda 
chizish asboblaridan bittasini tanlagan holda qatlam ustidan kursomi 
olib o‘tilsa, kursordan o‘tgan piksellar bo‘yalgan bo‘ladi.

RGB va CMYK ranglari

Monitor ekranidan rangli tasvimi olish uchun qizil, yashil va 
ko‘k (Red, Green, Blue — RGB) nurlari ishlatiladi. Agarda bu 
uch rangni bir-biriga toza holda aralashtirsak u holda oq rangni 
olamiz (3.52-rasm).

To‘rtta rangli bosmada uchta asosiy bo‘yoqlar ishlatiladi: ko‘k 
(C, cyan), purpur (M, magenta) va sariq (Y, yellow) — 3.53- 
rasmdaberilgan.

Bu ranglami aralashtirganimizda qoraroq tiniq bo‘lmagan rang 
paydo bo‘ladi. To‘q qora rangni olish uchun printerlarda qora siyoh 
(K, black) bilan kam miqdordagi ko‘k, purpur yoki sariq siyohlar 
bilan aralashtiriladi.

Monitor ekranidagi ranglaming tasvirlanishi yorug‘lik tushi- 
shiga, monitor haroratiga va aylanamizdagi predmetlaming rangiga 
bog‘liq bo‘ladi. Shu bilan birga, real hayotdagi ranglar bosmadan 
chiqarilmaydi, ekranda tasvirlangan hamma rang bosmadan 
chiqarilmaydi, ba’zi bir ranglar bo‘lsa, monitor ekranida tasvir- 
lanmaydi. Hamma monitorlar RGB modeliga asosan tasvirlanadi, 
CMYK — rangi esa simulyatsiya qilinadi. Faqat CMYK modelini 
bosmaga chiqarishda ahamiyati katta. Agarda siz berilgan tasvimi 
set yordamida uzatmoqchi bo‘lsangiz yoki kinoplenka qurilmasiga
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bermoqchi boclsangiz, u tasvirlarning RGB rejimidan CMYK 
rejimiga octishi uchun bosh qotirmasa ham bocladi.

Red  

Green

Blue
3.52-rasm. Kompyuter monitoriga ranglarni qo‘shish.

Cyan Magenta Yellow Black

3.53-rasm. Bosmaxona bo‘yog‘ining asosiy ranglari.

HHflMKaTop L|BeTa, He 

BxoflflmnM b rpaMy

3.54-rasm. Color 
palitrasidagi undov belgisi.

1 rr
1 Navigator 'l Info \  (V)

R : 157  ̂ G : 178 ■> B : 233
C : 36! 

., M : £4! 
m V : 0! K : 0! 4

, X : 2,63 Y : 1,23 z l \ f

1/lHflMKaTop L|BeTa, He 

Bxoflflii|MM b rpaM y

3.55-rasm. Info palitrasidagi 
undov belgisi.
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Agarda siz bosmaga chiqadigan (gammaga kirmaydigan) rangni 
tanlasangiz, Color (IJbct) palitrasidagi undov belgisi chiqariladi 
(3.54-rasm). Shu belgi Info (HH^opMairHH) palitrasida ham 
chiqariladi, agarda kursor kocrsatayotgan piksel rangi gammaga 
kirmasa (3.55-rasm).

Photoshop dasturidagi Gamut Warning (IIpe^ynpe^eHHe o 
raMMe) buyrugci yordamida bosmaga chiqarilmaydigan ranglami 
boshqa rang bilan berish mumkin va keyin Sponge (IySica) asbob 
yordamida rangning gammasiga octkazib olsa bocladi.

Photoshop dasturidagi ranglami tanlash panelida yoki Color 
panelidan quyidagi ranglar modelini tanlash mumkin: Grayscale 
(Il0JiyT0H0B0e H3o6pa3ceHHe), RGB (red-green-blue — KpacHtiH- 
3ejieHLiH-cHHHH), CMYK (cyan-m agenta-yellow-black — 
rojiySoH-nypnypHLiH-xejiTLiH-HepHLiH) yoki Lab (lightness-a 
axis-b axis — hpkoctl h  iiBeT Ha ochx a h  b).

Kanallar

Photoshop dasturidagi rasmlar bir yoki bir nechta yarim 
tiniq holdagi ranglardan tashkil topgan boclib, bular kanallar 
deb ataladi. Masalan, RGB rejimidagi tasvirlar qizil, yashil, 
kock kanallardan tashkil topgan bocladi. Bu haqda kengroq 
ma’lumot olmoqchi boclsangiz rangli tasvirni ochib, Channels 
palitrasini sichqoncha bilan Red, Green, Blue elementlarining 
har biriga alohida chertib kocrsangiz bocladi, bunda faqat chertilgan 
kanal namoyon bocladi. Keyin RGB (Ctrl+~ tugmalar majmuasi) 
elementiga chertsak, awalgi holini tiklaymiz. Agarda kanallar har 
xil ranglarda berilmagan boclsa, u holda Edit > Preferences > 
Display&Cursors oynasidan Color Channels in Color (K aH ajiLi b  
iiBeTe) ga bayroqcha belgisini ocmatish kerak.

Ranglami korrektirovkalaganda bitta kanalga tegishli bocladi, 
faqat oczgartirish kocp kanallarda kocrsatiladi va olib boriladi, 
kompozit tasvirlashda (Channels palitrasining eng yuqoridagi 
elementi) tasviming hamma kanallariga bir vaqtda ta’sir qiladi. 
Maxsus yarim ta’sirchanlik kanallari tasvirning ajratilgan sohasini 
maska sifatida saqlaydigan alfa kanallar deyiladi va ularni tasvirga 
qocshsa bocladi (3.56 a-rasm). Shu bilan birga qiyachiziqli rangli 
kanalni ham qocshsa bocladi (3.56 b-rasm). Muharrirlash ishlari 
faqat joriy boclgan kanallar bilan olib boriladi.

Kanallar soni qancha kocp boclsa, tasviming hajmi shuncha 
katta bocladi (xotiradan katta joy egallaydi). RGB rejimining uchta
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kanali bilan (qizil, yashil va ko‘k) yarimta’sirchanli rejimning bitta 
kanaliga nisbatan uch barobar katta hajmga ega bo‘ladi. Bu tasvir 
CMYK rejimida esa to‘rt barobar katta diskdan joy egallaydi.

Web-graflka

Agarda siz web sayt uchun tasvir yaratayotgan bolsangiz, RGB 
rang modelidan foydalaning. Faqat shuni esda saqlang, RGB rang 
yoki boshqa model ranglari Web-brauzeming ranglar modeli bilan 
mos tushmasligi mumkin. Sifatli bolgan tasvir natijasini olish 
uchun Web yoki Visibone palitrasini Swatches palitrasiga yuklang, 
Web Color Sliders (IIoji3yHKH Web-HBeTOB) va Color palitrasidagi 
Make Ramp Web Safe (Web uchun ranglarni kiradigan qilib 
bering) opsiyalardan foydalaning.

3.56-rasm. Tasvir kanallari. 
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Har bir tasvir rejimida sukut saqlaydigan kanallar soni

3.1-jadvalda ranglarning sukut saqlaydigan kanallar sonining 
nechta bo‘lishi berilgan.

3.1-jadval

Bitta Uchta To‘rtta

Bitmap RGB CMYK
Grayscale Lab
Duotone Multichannel
Indexed Color

im age

M ode ► Bitmap... 

G rayscale 

Duotone  

Indexed Color... 

✓ RGB Color 

CMYK Color 

Lab Color 

M u ltichannel

A djustm ents ►

D uplicate ... 

App l^ Image... 

Ca lculations...

im age  Size... 

Canvas Size... 

R o ta te  C anvas  ► 

CrojD 

Trim...

R evea l All

✓ 8 B its /C hanne l 

16 B its/C hanne l

Color Table...

Assign Profile... 

Convert to Profile...
Histogram ...

1399 :
3.57-rasm. Mode 

menyuchasi.

I Yiew
| Proof Setup >| Custom...

Proof Cojais Ctrl-t-Y 
GamutWarning Shft+Ctrl+Y V Working CMYK 

Working Cjian Plate 
Working Magenta Plate 
Working Yellow Plate 
Working Black Plate 
Working CMY Plates

Zoom jn Ctrl++ 
Zoom Out Ctrl+- 
Fit on Screer Ctrl+0 
Actual Pixels Alt+Ctrl+0 
PrintSize

Macinlosh RGB 
Windows RGB 
MonitorRGB

Estras Ctrl+H 
Show ►

Rulers Ctrl+R Simujste Psper Whife 
Simulate Ink Black

Snap Shft+Ctrl+; - 
Snaplo ►

Lock Guides Alt+Ctrl+;
Pear Guides 
NewGuide...

Lock Slices
PeaT Slices

3.58-rasm. Bosmaga chiqarishdan 
oldin nusxa uchun parametrlarni 

kiritish menyuchasi.

3.3. Ishning boshlanishi

Bu dasturda ishni qanday boshlash o‘rganiladi: Photoshop 
dasturini ishga tushirish, tasvirlami skaner qihsh, yangisini yaratish, 
oldin mavjud bolgan faylni ochish va Photoshop dasturiga xohlagan 
tasvimi qo‘yish. Shular bilan bir qatorda, tasviming olchamlarini 
ajrataohsh va fayl hajmini o‘zgartirish; tasvir joylashgan canvas 
o‘lchamini o‘zgartirish; qanday qihb kesish, aylantirish, saqlash, 
nusxa ohsh va dastumi yopish qarab o‘tiladi. Shu bilan birga ko‘rish 
masshtablarini o‘zgartirish, oynadagi tasvirlami siljitish va tasvirlami 
ekranda ko‘rsatishlami qarab o‘tamiz.
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Dasturni ishga tushirish

Windows 95, 98, ME, 2000, XP yoki NT operatsion dasturida 
Start (IlycK) tugmasiga sichqoncha bilan cherting, bu masalalar 
panelda joylashgan bo‘ladi, Programs (IIporpaMMbi) ni tanlang, 
keyin Adobe, Photoshopni tanlang va Adobe Photoshop ga sichqoncha 
bilan cherting (3.59-rasm).

(Agarda Sizning ishchi stolingizda Photoshop dasturi uchun 
piktogramma boclmasa, Adobe Photoshop papkasini oching va 
ishchi stolga uni olib octing.)

3.59-rasm. Photoshop dasturining ishga tushirilishi.

Ikkinchi uslub: My Computer (Moh K O M ntiO T ep) katalogidagi 
Adobe Photoshop papkasini oching va ikki marta Photoshop 
dasturining papkasiga cherting (3.60-rasm).

Uchinchi uslub: Photoshop dasturiga tegishh xohlagan fayllarni 
ikki marta cherting ( 3.61-rasm).
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f c '  P h o t o s h o p  7 .0 B E B
OpaBica Bna M36paHHoe CepBHC CnpaBt;a V

Q  Ha3aa -  Q  ' $  L P riOMCK i f l a n i c H  |[i| T

AApeci | Q  C:\Program Files\Adcibe\Photoshop 7.0 

rianiCM
-  | 'i Prograrm Files m

+ £ 3 1200CUPLUS

+i Accessories

3 Adaptec

- _ l Adobe
- ^ y P h o to s h o p

+ Help

Helpers 

Legal 

+ . Plug-Ine

± S )  Presets
+ . Required

+ .. 5amples

+ ahead

i  Q  CHAT 
± .: Ccimrmcin Files

ComPlus Applicati 

+D l o  DIRECTX
&  DivX J i

FrontPage Express V  B&Photoshop

m m ii i  s n i >3i <m

Ip iH e lp  

:Helpers 

: Le gal 

. Plug-Ins 
D  Presets 

. Required 

. Samples 

_ IAC E.d ll

^ A d o b e  Photoshop 7.0  Read Me 

S l  AGM.dll 
_ |  Asn.er.dll 

_JBib.dll 

_ |  CoolType.dll 

'-.,i ImageReady 

_|Im ageReadyRe£,d ll 
[ * |  JS32.dll 

_ |  MPS.dll 

o j  M svcrtl0 .d ll 

_IO PP.dll 

_ |  PDFL50.

B nepexofl 

A j Photoshop 

_y]Photoshop 

_ |  Photoshop.dll 

_JPlugin.dll 
_J  PSUT9516.DLL 

Psut9532.dll 

_IPSViews.dll 

_ j  ShFolder.dll 

«i| TypeLibrary 
_ |  Uninst.dll 
2iilUninst.i£U

3.60-rasm. Photoshop dasturining papkasi.

Samples

OpaBKa Bma M36paHhoe Cepenc CnpaBKa « - 1

Q  Ha3dA w ^  I JD ftoncK nanKM ma-
AApec^ | Q  C:\Program Files\Adobe\Photoshop 7.0\Samples 

flanKM

flepexoA

Program Files 
G) £ 3  1200 CU PLUS 
a £3 Accessories 
E) |£ )  Adaptec 
E) Adobe

Photoshop 7.0 
(S Help
S  E )  Helpers 

I r ^  Legal 
Sl Plug-Ins

Presets 
Required 

□  l t )  Samples 
i s  D  Droplets 

Q  ImageRe
a Ea ahead 
S) C l  CHAT 
a Ea Common Files

ComPlus Application; 
E) £ |  DIRECTX

>

Q D roplete
Ir^l ImaoeReadv Animations

@  Ducky 
|i* |Dune 
Êagle 
y j  Flower 

"^H arves t 
^  Morning Glass 
| t |  Old Image 
i^]Palm Tree (CMYK) 
0 Pasta 

Peppers 
Piccolo site 

"§£ Postcard 
[SjRanch House 
^JStamp 

"S^Tomato 
[^T rave l Poster.pdf 
i^ ) Waterfall(16bit)

3.61-rasm. Photoshop dasturining fayllari. 
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Xohlagan tasvimi yaratish, 
ocliish, muharrirlash va ulami 
12 ta Photoshop formatli tur- 
larini xotirada saqlash mumkin 
(3.62-rasm). Shunga qaramas- 
dan faqat bir nechta formatlar 
ishlatiladi: TIFF, GIF, JPEG, 
EPS va Photoshop dasturining 
formati.

Photoshop dasturi har xil 
formatlarda ishlay olish imko- 
niyatini hisobga olib, tasvirlami 
xohlagan m anbaidan olish 
imkoniyati bor: skaner yorda- 
mida grafik muharrirlaridan,

Tasvirlar manbai Photoshopj*. PS D PI> D
BM P (K.B M P ;K.R LE ;K.DIB)
Com puServe GIF (KGIF)
P hotoshop EPS (*.EPS)
P hotoshop DCS 1.0 (KEPS)
P hotoshop DCS 2.0 (KEPS)
EPS TIFF P review  (K.EPS)
Filmstrip (X.FLM)
JPEG (“ .JPG ;“ .JPEG ;“.JPE)
G eneric P D F r .P D F r .P D P r .A I)
A c ro ba l ToLichU p Image (“ ,P D F;“ .A I;“ .PDP) 
P hoto  CD C.PCD)
PICT File (“ P C T;“ PICT)
Pixar (-.PXR)
PNG C.PNG)
R aw  (".R AW )
S citex CT (“ .SCT)
Targa (-.T G A ;“ .V D A ;M C B ;“ .VST)
TIFF C .TIF;“ .TIFF)
W ire less Bitmap (“ W B M P ;“ .W BM )

3.62-rasm. Photoshop
dasturidagi tasvirlarning 

fayllari.
kompakt diskdan, fotorasm-
dan, vediotasvirlardan va boshqa operatsion dasturdan olinadi. 
Tasvimi Photoshop dasturi yordamida ham yaratsa bo£ladi.

Skanerlash

Skaner yoki raqamli kamera yordamida olingan tasvirlar, 
slaydlar, fotografiyalar, tasvirlar raqamli shaklga o £tkazilib, 
kompyuter bulami qabul qila oladigan shaklga keltirgandan keyin 
muharrirlash va boshmaga chiqarish mumkin. Photoshop dasturidan 
foydalanib yoki boshqa maxsus dasturlar yordamida skaner qilish 
mumkin va olingan natijani Photoshop dasturi qabul qiladigan 
formatda xotiraga yozish mumkin.

Skaner yordamida sifatli tasvimi olish uchun dastlab skaner 
qilinadigan tasvimi yaxshilab tekshirib, tanlab oling. Ba’zi bir 
skanerlar tasvirning ottenoklarini kamaytiradi, natijada tasvir 
kontrastligi ortadi, shu sabablarga bog£liq tanlangan fotorasmning 
ranglar balansi yaxshibo£lishi kerak. Agarda tasvimi o£zingiz skaner 
qilmoqchi b o £lsangiz skanerlash param etrlarini tanlashda 
adashmang.

Skaner qilingan tasvir sifati skaner turiga ham bog£liq bo£ladi. 
Agarda Siz tasvimi Photoshop dasturi yordamida o£zgartirmoqchi 
bo£lsangiz (masalan, filtrlarni qo£llash yoki kist yordamida
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ko£zlangan sondagi shtrixlarni solish), u holda qimmat bo£l- 
magan RGB—tasvir qiladigan planshet skaner qilinadi. Agarda 
ranglarni va tasvirning detallarini aniq berish kerak bo£lsa, 
slaydlar bilan ishlaydigan pristavkali skaner yoki slayd-skaner 
kerakbo£ladi.

Agarda sizga yuqori sifatli professional tasvirlar kerak bo£lsa, u 
holda servis markazlarida CCDO skanerlarida yuqori tan olishlikda 
skanerlash kerak(Scitex Smart-Scanner) yoki barabanli skanerlarda 
qilgan ma’qul bo£ladi.Oxirgi model skanerlari ranglaming har xil 
turlarini va soyalami va h skaner qila olish imkoniyatiga ega. Bu 
skanerlar CMYK — formatli tasvirlarni yaratadi, hajmi katta 
bo£ladi.

Skanerlash uchun dasturiy ta’minot haqida 
asosiy ma’lumotlar

Skaner qilish uchun m o£ljallangan dasturiy ta ’minotlar 
ko£zlangan opsiyalami beradi. Hamma dasturlar uchun eng ko£p 
ishlatiladigan ma’lumotlar quyida berilgan. Skaner qilingan tasvir 
faylining hajmi va sifatini berilgan rejimdan ajrataolish masshtabi 
tasvir kesilishiga bog£liq bo£ladi.

F o t o r a s m n i  y o k i  t a s v i m i  s k a n e r g a  q o £y ib ,  Preview ( l l p c / i -  
B apH T ejiL H L iii n p 0 C M 0 T p )  y o k i  PreScan (n p e f lB a p H T e jiL H a H  
HH(J)opMaHHH o  CK aHH pO BaH HH )ga s i c h q o n c h a  b i l a n  c h e r t in g .



Skaner qilishdan oldin Scan 
mode (PeaaiM c i<ah m po nah m m ) 
param etr qiymatini bering. 
Black-and-W hite Line Art
(McpHO-6cjibm)ni tanlang, hech 
qanday ottenok bermaydi, agarda 
tasvirda ko£zlagan ranglar bor 
bo£lsa, Grayscale (IIojiyTOHO- 
b o h )  yoki Color (IlBeTHoii)lar 
million rang turlarini beradi. Har 
xil ranglarga ega bo£lgan Color 
rejimidagi fayl hajmi Grayscale 
rejimiga nisbatan uch barobar 
katta hajmga ega bo£ladi.

Skanemi ajrataolish (ppi)dyuymdagi piksellar bilan o£lchanadi 
va Resolution (Pa3pemeHHe) parametri bilan 3.63—3.65-rasmlarda 
berilgan.Tasvimi ajrataolish qancha yuqori bo£lsa, shuncha ko£p 
nuqtalar bo£ladi, demak, tasvimi detallari haqida ko£p ma’lumot 
berilgan bo£ladi. Shu bilan birga faylning hajmi ham katta bo£ladi.

Kompyuter resurslarini tejash uchun eng kam ajrataolishni 
tanlang. Ajrataolishni o£zingizga kerakli bo£lganidan yuqori 
qilmang: kerak bo£lgan tasvir faylining hajmi katta bo£ladi, bu 
tasvimi ekranda, setda yoki bosmadan chiqarishda ancha vaqt 
ketadi, shu bilan birga tasvir sifatli emas. Ikkinchi tomondan, 
past ajrataolishda bosmaga chiqarilgan tasvir aniq va ravshan 
bo£lmaydi. [Ko£pchilik holda fotorasmlarni ajrataolishni skaner 
qilganda 200—300 ppi, poligrafik tasvirlar uchun — 600 ppi da 
tanlagan ma’qul bo£ladi.]

Tasvimi bosmaga chiqarmasdan avval bosmaga chiqadigan 
tasvimi ajratib olib tanlash kerak. Buning uchun awal bosmaga 
chiqaruvchi qurilmani yoki fotoqurilmani ajrataolish imkoniyatini 
bilish kerak, yana rastr liniaturasini qanday bo£lishini ham bilish 
kerak (skanerdagi ajrataolish bosmaga chiqaruvchi qurilmadagi 
ajrataolishdan farq qiladi).

Yarimta’sirchan1i1ik tasvirlar uchun ajrataolishni rastr liniaturasiga 
nisbatan bir yarim marta katta qilib (1 dyuym yuzadagi chiziqlar 
soni) yoki rangli tasvirlar uchun ikki marta katta qilib berish 
kerak. Yuqoridagi ajrataolish imkoni skanerlari (600 ppi va undan 
katta) shtrixlangan tasvirlar uchun kerak bo£ladi. Masalan, agarda 
tipografiyada oq-qora tasvimi 133 ta chiziqli ekranda bosmaga
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chiqarmoqhi bo£lsak, u holda skaner ajrataolishini 200 ppi qilib 
berish kerak bo£ladi. Agarda mahsulotni fotoqurilmalar yordamida 
tayyorlamoqchi bo£lsa (bunda yarim ta’sirchanlik texnologiyasi yo£q), 
u holda, skanemi ajrataolishini ko£rsatishni so£rang. Faylga mos 
keladigan hajmni tanlashda 3.2-jadvaldan foydalansa bo£ladi.

Agarda tasviming bir qismini skaner qilmoqchi bo£lsangiz, u 
holda kadrirovaniyc qilish kerak. Kerakli bo£lgan tasvir parchasini 
olish uchun awaldan ko£rib olish oynasidan siljiydigan chega- 
ralami o£zgartiring. Tasvir kesishga tayyor bo£lgan faylning hajmini 
birmuncha kichiklashtiradi.

Ba’zi bir holatlarda masshtablashga to£g£ri kelib qoladi. Agarda 
tasviming o£lchamini kattalashtirmoqchi bo£lsangiz, u holda 100% 
katta bo£lgan masshtab tanlang. Tasvirlami kattalashtirganda yoki 
ajrataolishni orttirganda Photoshop dasturida yoki boshqa 
qo£shimchalarda tasvir yuvilgan holda bo£ladi, sababi qo£shimcha 
ma’lumotlarni kiritish uchun dastur matematik interpolyatsiya 
usulini qo£llaydi. Tasvir haqidagi aniq ma’lumot faqat skaner qilish 
paytidagina yozilgan bo£ladi.

3.1-jadval

Kanaldagi 16 bitli rejim uchun muharrirlash asboblari va buyruqlari

Asboblar Adjustments menyuchasining 
buyruqlari

Boshqalar

Manquee Levels Canvas Size
Lasso Auto Levels Histogram
Measure Auto Contrast Duplicate
Zoom Curves Image Size
Hand Color Balance Rotate Canvas
Eyedropper Brightness/Contrast filtrlar
Slice Hue/Saturation
Color Sample Channel Mixer
Crop Gradient Map
Clone Stamp Invert
History Brush Equalize
Pen guruhining 

asboblari
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Hamma parametrlami o£matib bo£lgandan keyin skaner qilishni 
boshlash kerak. Buning uchun Scan (CKaHHpOBaTL) tugmasini 
chertib, fayl saqlanadigan papkani ko£rsatish kerak.

16 bitli kanal rejimi

0 £rtacha sifatli skanerlar bilan ishlaganda raqamli tasvirlaming 
har bir kanaliga 12—14 ta bitli ma’lumotlar mos keladi.

Oxirgi moduldagi skanerlar raqamli ko£rinishdagi tasvirlami 
bitta kanalga 16 ta bitli ma’lumot mos keladigan qilib beradi.Agarda 
16 bitli skanerda ranglar daipazoni katta bo£lsa va optik zichligi bo£lsa 
(kamida 3,3 bo£lsa), u holda qo£shimcha piksellaming ranglarini, 
soyalarini hatto qora joylarini ham ko£rsatadi. Photoshop dasturidagi 
kanaldan 16 ta bitli bo£lgan CMYK—faylni ochish imkoniyati bor 
(umuman olganda 4 ta kanalda 64 bit). Tasvir haqidagi hamma 
m a’lumotlar saqlanadi va tasvirlarni muharrirlash va tuzatish 
kiritish imkoniyati bor. Faqat 16 ta bitli tasvimi 8 ta bitli ko£rinishiga 
o£tkazish kerak, shuning uchun Image > Mode $  8 Bits/Channel 
(M3o6pax<CHMC > PeaaiM > 8 6 h t  H a  K a H a j i )  buyrug£ini bajarish 
kerak. Bu turdagi tasvirlarga ikkita turdagi cheklamalar qo£yiladi. 
Birinchidan, 16 ta bitli tasvirlar faqat bitta qatlamga ega bo£ladi. 
Ikkinchidan, Photoshop dasturida xohlagan asbob qo£llanilmaydi. 
Kanaldagi 16 ta bitli tasvirlar uchun asboblar va buyruqlar 3.1- 
jadvalda berilgan.

Photoshop dasturidan foydalanib skaner qilish uchun skaner 
moduli yoki Twain moduli Adobe Photoshop\Plug-lns dagi Import- 
Export papkasi ichida joylashgan bo£lishi kerak.

Skaner qiluvchi modulni chaqirish

Birinchi marta skaner moduli chaqirilganda Ffle > Import (Oaitn > 
HMnopT) menyuchasidan Twain_32 Source varianti tanlanadi, 
Twain da skaner qurilmasini tipi ko£rsatiladi (3.66-rasm) va keyin 
Twain_32 yoki WIA buyruqlaridan bittasi tanlanadi. Endi skaner 
qilish dasturiga ruxsat olish uchun File menyusidan Import > 
Twain_32 yoki Import > WIA lardan bittasini tanlash kerak. WIA 
protokoli bo£yicha import qilish faqat Windows ME/2000/XP da, 
skaner yoki raqamli kamera drayverlari WIA (Windows Image 
Acquirisation) texnologiyasining o£zida saqlash sharti bilan ishlaydi. 
WIA (Windows Image Acquirisation) esa TWAIN texnologiyasi

156



rivojlangan bo£lim va Microsoft tomonidan ishlab chiqilgan. WIA 
TWAIN ga nisbatan umumiy bo£lib hisoblanadi. Bu esa, o£z 
navbatida interfeysga ham ta’sir qiladi: WIA drayverlari hamma 
qurilmalar uchun bir xil ko£rinishga ega bo£ladi. Shu bilan birga, 
WIA drayver birmuncha tezlik tomonidan ham yuqori. Faqat WIA 
drayverlar asosan rangli kameralarga m o£ljallangan, skaner 
drayverlari firma tomonidan ishlab chiqilgan dasturlarga nisbatan 
esa, birmuncha kamroq imkoniyatga ega (3.67 va 3.68-rasmlar). 
Shularga qo£shimcha WIA negativ va slaydlami raqamli qila olmaydi.

'■■] F i l lc r i  N|Enhnncc --J Fillcr* N Aboul

S con  M ode  Set1ing3

Sean Mode r C ob r [24b it] -
S can SDLice c R oflec tive

jG-an Gizc Custom -
R atok itiD n [ 300 j
D esc ieen L N one

* &  'A

I ll J p il t

S u J in j  |n| ||

-i Vi>idlh | pt fjf| 

1 HeiDht
. [ I r c h  c

Image Sise 2 G G 2 2 .0 0 K B

(y )

ipot ■r;| £ £]
S  M LS TE K  1200  CU FLUS BBl

3.66-rasm. Skaner qilish parametrlarini TWAIN—drayveri uchun 
nastroykalash oynasi.

Agarda sizning skaneringizda Photoshop dasturi yordamida skaner 
qilish drayveri bo£lmasa, u holda tasvimi boshqa qo£shimchalar 
yordamida skaner qiling va TIFF formatida xotirada saqlang, keyin esa, 
Photoshop dasturidan qayta ochib, xohlagan formatda saqlash mumkin.
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File

New... 
Open... 
Browse... 
Open As...

Ctrl+N
Ctrl+0

Shft+Ctrl+O
Alt+Ctrl+0

Close 
Save 
Save As...
Save for Web... 
Revert

Ctrl+W 
Ctrl+S 

Shft+Ctrl+S 
Alt+S hft+Ctrl+S

PJace...

PDF Image...
Enport ► Annotations...

Workgroup  ̂_ WIA Support...

Automate ►

File Info...

PrinL. Alt+Ctrl+P 
Print One Copy Alt+Shft+Ctrl+P

Jump T o ►

Ewit Ctrl+Q

3.67-rasm. Skaner qilish 
parametrlarini WIA-drayveri uchun 

nastroykalash oynasi.

Skanemi ajrataolishni to‘g‘ri 
tanlash uchun quyidagi ko 'r- 
satmadan foydalaning.

Photoshop dasturi yordamida 
skaner qilish

1. Skaner qilish modulini 
tanlang yoki File > Import > 
Twain_32 (Oaftji > HMnopT > 
Twain_32) yoki File > Import 
> WIA buyruqlaridan bittasini 
tanlab bajaring.

2. P rescan (IIpe^Ba- 
pHTeJILH afl HH(|)OpMaiJH5I o 
CKaHHpoBaHHH) tugm asiga 
cherting. Tasvir saqlangan fayl 
hajm ini a jra tao lishda va 
masshtablarini o'zgartirganda 
o^zgarishiga e’tibor bering (3.66— 
3.67-rasmlar).

3.68-rasm. Raqamli fotokameradan tasvirlami qabul qilish oynasi.
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3. Yuqoridagi yo‘llanmada ko‘rsatilganlarni skaner qilish 
rejimini va ajrataolishini tanlang.

4. 0 ‘zxohishingizgabog‘liq. Skaner qilishda boshqa masshtabni 
tanlang.

5. Scan (CKaHHpoBaTL) tugmasiga cherting. Skaner qilingan 
tasvir yangi oynada nomsiz chiqariladi.

6. Tasvimi xotiraga yozing («Fayllami saqlash»ni qarang). Agarda 
rangni to‘g‘rilamoqchi bo4lsangiz «Ranglaming berilishi»ga murojaat 
qiling. Agarda tasvirni burmoqchi bo‘lsangiz, «Tasvimi ba’zi bir 
burchakka burish»ni o‘qing.

Skaner qilganda yoki mavjud boigan tasvir uchun 
ajrataolishni aniqlash

Photoshop dasturidagi ajrataolish, boshqa xohlagan rastr 
dasturlardagiday monitorning ajrataolishi bilan bog‘liq bo‘lmaydi, 
demak, tasvimi chiqarish qurilmalaridan fayl hajmlarini o‘zgar- 
tirib yoki uni hisobga olmagan holda berish mumkin.

Agarda Photoshop dasturidagi masshtabni ko‘rganda 100% ga 
teng bo‘lsa, monitoring ajrataolishdan katta ajrataolishga ega bo‘lsa, 
ekranda bosmadan chiqqaniga qaraganda katta ko‘rinadi.

Hammavaqt bosmaga chiqarish qurilmasi uchun qilingan 
o‘lchamlarni ajrataolishga bergan ma’qul bo‘ladi.

1. Yangi RGB — hujjatni File > New (Oaftji > Hoblih) 
yordamida yarating, uning enini, uzunligini bering, 72 ppi qilib 
ajrataolishni tanlang, oxirida OK tugmasini bosing (5 qadamda 
tasvirdagi ajrataolishga tuzatish kiritiladi).

2. Image > Image Size (H3o6paaceHHe > Pa3Mep 
H3o6paaceHH5i) oynasini oching.

3. Oynaning o‘ng tomonidagi Auto (Abto) tugmasini bosing.
4. Descreen (Screen, bu drayverlar turiga bog'liq bo'ladi) 

maydonidan dyuymdagi chiziqlar soniga o‘lchanadigan chiqarish 
qurilmasining rastr lianiturasini kiriting (lpi — lines per inch), 
ya’ni tipografiyada ishlatiladigan qiymat (3.69-rasm). Umumiy qilib 
olganda Descreen filtri o‘zining nastroykasiga ega emas, uni faqat 
o^chirish yoki qo'shish mumkin. Ba’zi bir paytlarda skaner 
qiladigan dasturlarda muarni yoki poligrafik rastrni pasaytirish 
uchun yuvish filtrlari ishlatiladi. Shularni e’tiborga olib skaner 
qilishda bularni ko‘zda tutish kerak.
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5. Quality (KanecTBo) da Draft (06biMHoe)ga qo£ying, bu rastr 
lianiturasi 1 tengligini bildiradi, Good (Xopomee) — rastr lianiturasi 
1,5 ga teng Best (Jlyqmee) — rastr lianiturasi 2 ga teng.

6. OKtugmasiga cherting.
7. Resolution (Pa3pemeHHe) maydon qiymatini yozing, u 

Image Size oynasida Document Size (Pa3Mep ^OKyMeHTa) 
guruhida joylashgan. Skaner qilish paytida ana shu qiymatni kiritishni 
esdan chiqarmaslik kerak bo£ladi.

A uto  R eso lu l io n

Bcreen: SMKBW  lines /cm

Quality 

r  Qraft 

(* Good 

Best

n

QK

Cancel

3.69-rasm. Tasvir o ‘lchamining o ‘zgarishi.

Agarda keyinchalik masshtabni kattalashtirmoqchi/kichik- 
lashtirmoqchi bo£lsangiz, aijataolishni shu masshtabga ko£pay- 
tirish kerak, shundagina skaneming ajrataolishi to£g£ri berilgan 
bo£ladi. Agarda tasvimi masshtablashni skaner qilish paytida amalga 
oshirsangiz u holda bu amalni bajarish shart emas.

8. OK tugmasiga cherting. Endi tasvirga ajrataolish to£g£ri qo£yildi.
3.2—3.3-jadvallarda malumotlar keltirilgan, bular yordamida 

skaner qilingan fayl hajmini va har xil ajrataolish bo£lganida 
chiqarish qurilmalari va rastr lianiturasi qanday bo£lishi berilgan.

3.2-jadval
Skaner qilingan fayllarning hajmlari

0 ‘lcliam
(dyuymida)

PPI
(ajrataolisli)

Oq-qora 
(1 bit)

Yarim ta’sirclianlik 
(8 bit)

SMYK rangli 
(24 bita)

2x3 150 17 K 132 K 528 K
300 67 K 528 K 2.06 MB

4x5 150 56 K 440 K 1.72 MB
300 221 K 1.72 MB 6.87 MB
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8x10 150 220 K 1.72 MB 6.87 MB
300 879 K 6.87 MB 27.50 MB

Hajmlar faqat bitta kanal uchun berilgan (TIFF fayli uchun) 
hech qanaqa alfa-kanal yo£q.

3.3-jadval

Chiqarish qurilmasi va rastr lianiturasi uchun 
ko‘k rangning ta’siri

Rastr lianiturasini ajrataolish (LPI)

Chiqarish
(DPI)

60 85 100 133 150

Lazerli printerlar 300 600 26 101 13 51 37 21
Fotoqurilmalar 1270 2540 256* 224 256* 162 256* 92

256*
72

256*

Bosmaxonada tasvir faylini yaratganda qanday rastr lianiturasini 
o £rnatish kerakligini biling. Fotoqurilm alar uchun qanday 
ajrataolish bo£lishini biling. Bir xil fotoqurilmalar 2540 dpi yuqori 
bo£lgan ajrataolishga ega bo£ladi.

Web-grafika uchun ajrataolish

Setlar uchun tasvirlar yaratganda avval foydalanuvchi brauzer 
oynasi o£lchamini bilishi, keyin shu tasvir yordamida oynani qaysi 
tomonini yopmoqchi ekanligini ko£rsatishi kerak. Setda o£tirgan 
foydalanuvchi monitoringni ajrataolish qancha bo£lishini ham 
bilishingiz kerak. Web-saytda websnapshot. com bergan malumotiga 
qaraganda, foydalanuvchilar monitorlarning yarmidan ko£pi 
800x600 pikselda ekan. Agarda panellami va surgich yo£lakchasini 
hisobga olsak, ish maydoni 740x460 pikselda qoladi. Ko£pchilik 
setdan foydalanuvchilarda monitoring brauzer oynasi bilan 
to£ldirilmaydi, shulami hisobga olib, 660x420 dan katta bo£lmasligi 
kerak.

Bosh hujjat yarating, ajrataolish 660x420 pikselli, har bir 
dyuymga 72 pikselda to£g£ri kelar ekan, buni shablon qilib oling. 
Ish paytida hujjatni fon tarzida bering, sababi Web-sahifa uchun 
tasvir yaratganda ekranning qaysi tomonida ekanligini bilish kerak.
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Holt satridan foydalanish

Windows sistemasida ishlaganimizda Window > Show Status 
Bar (Okho > IIoKa3aTL CTpOKy cocTOMHMM)ni  tanlang, bu holat 
satri yordamida chiqariladi yoki Hide Status Bar (CnpHTaTL CTpOKy 
C0CT0MHMM)ni tanlang, bu esa, holat satrini ko‘rinmas holga olib 
keladi.

Agarda uchib chiquvchi menyuda holat satr tasviridagi 
qo£shimchaning pastida joylashgan bo£lsa, Document Sizes 
(Pa3MepLi noKyMCHTa) belgilangan bo£ladi. Holat satrida tasviming 
saqlanadigan qatlamlari biriktirilgan (birinchi raqami) fayl hajmi 
va ko£p qatlamli tasvirlar uchun fayl hajmi beriladi (ikkinchi 
raqami) — 3.70-rasmda berilgan.

3 .70-rasm. Holat satridan kerakli bo‘lgan m alum otni olish uchun menyu.

Agarda Document profile (npo(J)HJiL noKyMCHTa) aktivlash- 
tirilgan bo£lsa, u holda holat satrida hujjatning rang profillari berilgan 
bo£ladi, agarda hujjat hech qanday profilga ega bo£lmasa u holda 
«Untagged» so£zi cliiqariladi.

Scratch Sizes ( 0 6 l c m  n a M M T n )  punktini tanlashda holat 
satrining chap tomonida ochiq bo£lgan hujjatlaming hajmi, o£ng 
tomonida esa, Photoshop dasturi uchun operativ xotiradan 
egallagan hajmi beriladi. Agarda birinchi son ikkinchisidan katta 
bo£lsa, u holda dastur vertual xotiradan foydalanayotgan bo£ladi.
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Efficiency (34)(|)eKTHBHOCTL) opsiyasini tanlab, dasturni 
qancha vaqt operativ xotirada ishlaganini ko£rsatadi. Agarda 100% 
dan kam bo£lsa, u holda diskdagi vaqtincha joydan foydalangan.

Current Tool (TeicymHH HHCTpyMeHT) punktini tanlash 
natijasida joriy vaqtda ishlayotgan asbob haqida malumot beriladi.

Bulardan tashqari, holat satri ustida sichqonchani ushlab turib, 
sahifani berilgan qog£oz o£lchamlarga mos kelishini tekshirib 
ko£rasiz (markerlami ham hisobga olgan holda).

Fayl hajmi

Windowsda ishlaganda, tasvir faylining haqiqiy hajmini 
ko£rmoqchi bo£lsangiz, Windows Explorer yordamida bizlarga 
kerakli b o £lgan fayl joylashgan papkadan Size (Pa3Mep) 
kolonkasini ko£ramiz (3.71-rasm). Yanada aniq sonlarda ko£rmoqchi 
bo£lsangiz fayl piktogrammasini sichqonchaning o£ng tomoni 
bosiladi va paydo bo£lgan menyudan Properties (C B O H C TB a) ni 
tanlaymiz.

Holat satrining ucliib cliiqadigan menyusining qaysi opsiyasi 
tanlanganidan qat’i nazar, Alt tugmasini holat satri ustiga olib 
borib bosib turib, tasvimi fayldagi hajmini, kanallar sonini, qanday 
rejimda ekanini va ajrataolishni ko£rsa bo£ladi.

O D ro p le ts nanna c (JiafLnaMH ZS.0&.2002 13:55
Animations nanKa c (fiariJiaMH 28.06,2002 13:55

T^Banner 2 669 KE Adobe Photoshop I . .. 12.03,2002 12:28
^ D u c k y 287 KB PMcyHOK TIF 06,04,2002 15:57
'gjj Dune 1 068 KE PncyHOKTIF 06,04,2002 15:57

Eagle 1 614 KB Adobe Photoshop I . .. 12,12,2001 12:03
^  Flower 3 941 KE Adobe Photoshop I . .. 16,01,2002 11:53
^ H a rv e s t 4 310KE Adobe Photoshop I . .. 02,04,2002 21:11
^j> Morning Glass 5 5S6 KB Adobe Photoshop I . .. 02,04,2002 21:11

Old Image 174 KE PMcyHOKJPEG 02,04,2002 21:11
Palnn Tree (CMVK) 789 KE PncyHOKTIF 06,04,2002 15:57

(tjPasta 1 323 KB P n c y H O K  JPEG 02,04,2002 21:11
IJPeppers 21SKE PricyHOK JPEG 02.04,2002 21:11
^  Piccolo site 2 293 KE Adobe Photoshop I . .. 02,04,2002 21:11

3 .71-rasm. Fayllar haqida m alum ot beruvclii oyna. 
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Yangi tasvirni yaratish

1.File > New (Oaftji > H o b m h )  ni tanlang yoki Ctrl+N 
tugmalar majmuasidan foydalaning.

2. Name (Hmh) maydonida qanday nomga ega bo‘lishini ko‘ring — 
3.72-rasm.

3. Menyudan Width (IIlHpHHa) va Height (BbicoTa) may- 
donining enidan o‘lcham birliklarini kiriting.

4. Width va Height qiymatlarini bering.
5. Resolution (Pa3pemeHHe) parametrining ajrataolish qiymatini 

bering.
6. Mode (Pe>KMM)ning uchib chiqadigan menyusidan tasvirning 

rejimini tanlang. Keyinchalik tasvirni boshqa rejimga o‘tkazsa ham 
bo‘ladi (rejimlar haqida 2-bo‘limda kengroq berilgan, «Tasvir 
rejimlari»).

7. Contents (CoflepacHMoe) o‘tkazishni White (Bejibra) ga yoki 
Background Color ( O o h o b & ih  u,BeT)ga qo‘ying. Fon rangini qanday 
tanlashga 10-bo‘limda to ‘xtab o ‘tiladi. Yoki Transparent 
(ripo3pa'iHbiM ) opsiyasini belgilang, agarda fonni tasvir qatlamiga 
aylantirmoqchi bo‘lsangiz.

Name: |1____

Image Size: L 3 7 M

ntitled-1

Preset Sizes: 8 0 0  x 60 0

Width: 800 pixels

Mode:

Height: |600 | pixels

Resolution: |2 8 ,3 4 6  | p ixe ls /cm

3RGB C o lo r

Contents

Whjte

Background C o lo r 

<* T ransparent

O K

Reset

3 .72-rasm. Yangi tasvirning parametrlar oynasi. 
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3 .73-rasm. Yangi — nomlanmagan tasvirning oynasi.

Bir yoki bir nechta qatlamga ega Photoshop formatlarning biri 
PDF yoki Advanced TIFF kengaytmali fayllarda saqlanadi. Agarda 
siz faylni boshqa qo‘shimchaga eksport qilmoqchi bo‘lsangiz, 
tasviming qatlamlarini biriktirib, nusxasini boshqa formatda saqlash 
kerak, sababi bir xil qo‘shimchalar tiniq bo‘lgan qatlamlami qabul 
qiladi. (Qatlamlar haqida keyingi 7 va 14-bo‘limlarda kengroq to‘xtab 
o‘tamiz.)

8. OK tugmasiga cherting (yoki Enter tugmasi). Tasvirlash 
oynasi chiqariladi (3.73-rasm).

Photoshop dasturidagi tasvirlarni ochish

Adobe Illyustrator faylini ochish uchun quyidagi ko‘rsatmadan 
foydalaning: «EPS, PD F form atli fayllarni ochish yoki 
Illyustratorda qanday qilib yangi tasvirni yaratish»; «fayllarni EPS, 
PDF formatlariga joylashtirish; Photoshop dasturidagi Illyustrator 
yordamida fayllami yaratish».

1. Menyuning File > Open (Oaftji > OTKpbiTb), File > 
Browse (Oaftji > IIpocMOTp) buymqlarini tanlang yoki Ctrl+O 
tugmalar majmuasidan foydalaning.
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2. Ocliish kerakbo£lgan faylni tanlang (3.74-rasm). Agarda tasvir 
kichiklashtirilgan nusxada saqlangan bo£lsa, tasvimi ko£rish uchun 
Show Preview (IIpeflBapHrejiLHLiH np0CM0Tp)ga sichqoncha bilan 
cherting. Agarda Ffle > Browse yordamida ochganbo£lsangiz, hamma 
tasvirlar kichiklashtirilgan formatda berilgan bo£ladi, xolilaganini 
sichqoncha yordamida tanlab ko£rsa bo£ladi (3.75-rasm).

l ?l*l
OanKa: | a  Lo.ie: E[J t i * .  (hT|||_ f f i l

3  6001 (1 tl|6 0 0 7  lif y  6013.lif y i  60' 9.tif
3  6002. ff B|G008tif g| 6014.tif i  6020.tif
B 6003. ff iieoootif 1 6015.tif I3 6021 M
B 6004. ff Bieoiotif 0 6016.tif Bl 6022.tif
H 6005. ff 1 6017.tif i  6023.tif
B 600G.if Q G012 tif Q G018.tif H G024.tif

*  1 1 1 \

Mmv 'patona. |6011 tif OTKpbfTb

Xnn <t>aHnoB: |ab hormats 3 OTMeha

3 .74-rasm. Faylni ochish.

Miniatyurani yaratish bir 
qancha vaqtni olislii mumkin, 
agarda katalogda tasvirlar soni 
ko£p bo£lsa, u holda qiyinchilik 
tug£diradi.

Hamma formatli fayllami 
ekranga cliiqarish uchun Files 
of type (Thtili 4)aiinoB) uchib 
chiqadigan menyusidan All 
Formats (Bce (J)opMaTLi) 
variantini tanlash kerak.

Tasvir ochilgandan keyin 
uni Photoshop dasturidagi 
mavjud formatlarda saqlash 
mumkin.

3 .75-rasm. Browse yordamida Agarda siz ochmoqchi bo£l-
fayllarni ochish. ga n  fa y l nomi, fayllar ro£y-
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xatidan chiqmasa, bu format uchun Photoshop dasturida modul 
mavjud emasligini bildiradi. Uni o£matish kerak bo£ladi.

3. Fayl nomini ajrating va Open ( O t k p l i t l )  tugmasiga cherting 
yoki fayl nomini ikki marta sichqoncha bilan cherting.

S a m p le s - I n i  x

® cPiji rp a E K a  Bm a M36p3HHoe C ip b m c  CnpaBKa 1 *
^ j  Ha3a4 -  t & ^  1 noncie r la n rH nni'

A flp e c : | 0  C :\P r3gr.arn File5\A d 3be\P hoto<hop 7 .0 \S ;m p l;s T f le je x o f l

rianKH

I  &  120C CU PLU5 

Accessories 

0  A da p te c  

-  ( £ )  Adobe

-I  £ 3  Phoboshop 7 ,0  

E Melp

D llc lpcrs
. j  Legal

I  E j  Pluo-Ins 

t  l£ )  Presets 
E y  Reqjired 

t  &  Sample'
+ Q  chesd 
± £ 3  CHAT 

0  lO  '-u iiii iiu n F ilc i

ComPlus A pp licc tio n  

DIP.ECTX 

0 1  DivX

 l l l

CuLky

3 .76-rasm. Windows Explorer dasturidagi Photoshop formatining
fayl belgisi.

Profillar mos kelmagan holda 2-bo£limda berilgan yo£riq- 
nomadan foydalansa bo£ladi.

Yana bir formatlar uchun yana bir muloqot oyna chiqariladi. 
Masalan, agarda EPS, Adobe Illyustrator yoki PDF-fayllarni 
ochganda, tasvir hali vektor ko£rinishidan rastr ko£rinishiga o£tka- 
zilmaganbo£lsa, u holda Rasterize Generic Format (PacT cpn3auM M  
4)opMaTa) oynasi cliiqariladi. Bu haqda «EPS, PDF formatli yoki 
Illyustrator dastur fayllarini ochish» bo£limida kengroq berilgan.

Bir xil formatlami ochish uchun maxsus modullar kerak bo£ladi, 
masalan, Scitex Ctrl yoki PICT Resource. Bularga o£tish Ffle > Import 
(Oaiin > MiYinopT) menyudagi buyruqni tanlash orqali bo£ladi.
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Fayl ochilganda aniq formatni ko‘rsatish uchun menyuning 
File > Open As (Oaiiji > OTKpbiTb KaK) buyruqlarini bajaring va 
ochilgan menyudan kerakli format tanlanilib, keyin Open 
(OTKpbiTb) tugmasini bosing.

Joriy oynalar orasidan bir-biriga tez o‘tish uchun «qaynoq» 
tugmalardan Ctrl+Tab foydalaning.

Yaqinda yopilgan faylni ochish uchun menyuning File > Open 
Recent (Oaiiji > HeziaBHo oTKpbiTbie) buyruqlaridan foydalaning.

Miniatyuralar

Windows sistemasida ftjia to to , npoBOflHHK (Windows 
Explorer) dasturi uchun tasvirlarni miniatyura nusxalarini 
yaratishga tog‘ri keladi, bu menyuning Views (Bmi) da Large 
Icon (KpynHbie 3HaLiKM) opsiyasi tanlanganda ekranga chiqariladi. 
Miniatyurani yaratish uchun faylni xotirada saqlaganda Save 
Thumbnail (Coxpamm> o6pa3eu)ga bayroqcha qo‘yish kerak. Agarda 
Open (OTKpbiTb) oynasiga chiqariladigan hamma fayllar ketma- 
ketligi uchun miniatyuralar qilish kerak bo‘lsa, Edit > Preferences > 
Saving Files (IIpaBKa > YcTaHOBKii > CoxpaHeHHe (|)aiijioB) 
oynasini oching, Image Previews (11 peziBapMTejTbH biii npocMOTp 
H3o6pa3ceHHii)maydonini tanlang va Always Save (Bcer^a 
coxpaiMTb) variantini tanlang (3.77-rasmga qarang). Miniatyuralarga 
ega bo‘lish uchun tasvir fayli quyidagi kengaytmalarning biridan 
iborat bo‘lishi shart: PSD, JPG, PDF yoki TIF. Fayllarni saqlagan 
paytda miniatyuralarni paydo qilish uchun, Image Previews 
(n  peziBap MTejT bH bi ii npocMOTp H3o6paaceHHii) maydonidan Ask 
When Saving (CnpaniHBaTi> npn coxpaHeHHH)ni tanlang. 
Tasvirning ba’zi bir o‘lchamga ega bo‘lgan miniatyurasi xotirada 
saqlangandan keyin faylning hajmi ham katta bo‘ladi. Keyingi 
ketma-ket saqlanadigan tasvirlar uchun Open (OTKpbiTb) faylining 
ochilish oynasida ko‘rinishi uchun Windows Thumbnail 
(MHHHaTiopa Windows) ga bayroqcha qo‘yish kerak.

Kodak Photo CD faylini ochish

Photoshop dasturida Kodak Photo CD formatli fayllar Kodak 
PCD Format (OopMaT Kodak PCD) muloqot oynasi yordamida
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ochiladi. Photo CD formatli tasvir RGB yoki Lab Color formatli 
ko‘rinishlarga o‘tkaziladi.

1. Menyuning File > Open (Oaiiji > OTKpbiTb) buyruqlarini 
tanlang yoki Ctrl+O tugmalar majmuasidan foydalaning.

2. Photo CD formatli faylni toping va uning nomiga ikki marta 
cherting yoki Photo CD formatli fayl nomini ajrating va Open 
(O T K pbiT b) tugmasini bosing.

Piefeiences

General

Color Picker: Adobe ----------------- 3

Interpolation: | Bicubic (Better) ]£ ]

RedoKey: | Ctrl+Z (Toggles Undo/Redo) ^ ]  Histon/States: [20 

Print Keys: | Ctrl+P: Print w ith Preview f  Ctrl+Alt+P: Print ]£ ]

3.77-rasm. Windows sistemasida fayllarni saqlash 
rejimlarini o ‘rnatish.

3. Source Image (Hcxo^Hoe H3o6pa3ceHHe) guruhi 3.78- 
rasmda berilgan parametrlariga o ‘tish uchun Resolution 
(Pa3pemeHHe) qiymatini tanlang. Tasvir o‘lchami 768x512 pikselli 
bo‘lsa, 10,5x7 dyuymli joyni egallaydi. Tasvirning eni, uzunligi 
Resolution (Pa3pemeHHe) uchib chiquvchi menyuda beriladi. 
Ma’lumot kiritish profilini uchib chiquvchi menyu Profile 
(IIpo(|)Hjib) tanlaydi. Image Info (HH(|)opMaHHa 06 H3o6pa- 
xeHHH) maydonida skaner va plyonkaning turi haqida ma’lumot 
bo‘ladi.

4. Destination Image (I],ejieBoe H3o6pa3ceHHe) parametrlar 
guruhida ochiq bo‘lgan tasvirlar qo‘llaniladi. Bu qiymat tasvir 
o‘lchamlari bilan birgalikda tasvirning ekrandagi hajmini beradi. 
Ochiq turgan tasvirga ranglar sohasini tanlang (RGB yoki Lab). 
Kerakli yo‘nalishga Orientation (OpneHTaHHa) bayroqchasini 
qo‘ying.

5. OKtugmasiga cherting. Photoshop dasturining ekranida tasvir 
ochiladi.
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Kodak faylining profillari

Kodak kompaniyasi 4045 va 4050 modellarini plyonkadan o‘qish 
uchun va yana boshqa 3.4 versiyali profillarini PhotoCDda almashtirish 
uchun ishlatiladi (3.4-jadval).

3.4-jadval

Kodak faylining profillari

Profil Q o‘Uanishi

Photo CD 4050E-6 V3.4 Ektachromeda 4050 modelga skanerlash
Photo CD 4050K-14 V3.4 Kodachromeda 4050 modelga skanerlash
Photo CD Color 
Negative V3.0

Rangli negativlardan kichik modeUarga 
skanerlanadi yoki hech qanaqa modeli 
ko£rsatilmaydi

Photo CD Universal E-6 V3.2 Universal Ektachromedan kichik modeUarga 
skanerlanadi yoki hech qanaqa 
modeli ko£rsatilmaydi

Photo CD Universal K-14 V3.2 Universal Kodachromedan kichik modeUarga 
skanerlanadi yoki hech qanaqa modeli 
ko‘rsatilmaydi

DCS 2 .0  F o im a t

Preview: TIFF (1 bit/pixel)

DCS: | Single Fiie DCS, No Composite

B O K

Cancel

Encoding: | Einary

r Include Halftone Screen 

r Include Transfer Function

I-  Include Vector Data 

r  Image Interpolation

3.78-rasm. Windows sistemasidagi DCP formatning muloqot oynasi.

EPS, PDF formatli fayllarni yoki Illyustrator dasturining 
fayllarini yangi tasvir sifatida ochish

Fayllar EPS yoki Adobe Illyustrator formatlarida bolsa, ulami 
Photoshop dasturida ochish va joylashtirish uchun ularni berilgan
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obyektga m o‘ljallangan formatdan Photoshop formati rastrli 
ko‘rinishga o‘tkaziladi. Quyida berilgan EPS yoki Adobe Illyustrator 
formatli fayllarni ochish uchun yo‘riqnoma bo‘yicha ishlang. Yoki 
bo‘lmasa «EPS, PDF yoki Adobe Illyustrator dasturidagi fayllarni 
Photoshop dasturida ochish» bo‘limiga qarang, bunda EPS—fayli 
Photoshop dasturini mavjud formatda ochadi.

Bitta betli PDF-faylini ochish uchun Open (OTKpbiTb) 
buyrug‘idan yoki Place (Pa3MecraTb)dan foydalaning. Agarda 
ko‘p sahifali PDF—faylni ochmoqchi bo‘lsangiz, File > Automate 
> MultiPage PDF to PSD (Oaiui > ABTOMaTH3aijH5i > 
MHorocTpaHHHHbiH PDF b  PSD) buyruqlarini tanlang. Bu haqda 
keyingi bo‘limlarda kengroq, «PDF formatli fayllarni Photoshop 
dasturli formatiga o‘tkazish»da berilgan.

Photoshop dasturida Illyustrator 9 va 10 fayllari uchun maxsus 
format ishlatiladi.Generic PDF (He EPS).

1. Menyudan File > Open (Oaiui > OTKpbiTb) buyruqlarini 
tanlang yoki Ctrl+O tugmalar majmuasidan foydalaning.

2. Agarda Files of type (Tnn 4)aiuiOB) menyusida fayl nomi 
yo‘q bo‘lsa, u holda All Formats (Bce 4>opMaTbi)ni tanlang.

3. Ochish lozim bo‘lgan faylni toping va ajrating, keyin Open 
(OTKpbiTb) tugmasiga cherting yoki ikki marta faylni nomiga 
cherting.

Bir sahifadan k o ‘p 
bo‘lgan PDF—fayli ochil- 
ganda, boshqacha muloqot 
oynasi ochiladi (3.79-rasm). 
Bu yerda «oldiga» yoki 
«orqaga» yo‘nalishlarini 
bosish orqali, o ‘zingizga 
kerakli bo‘lgan sahifani 
topamiz va OK tugmasini 
bosamiz. Yoki bolmasa, Go 
to page... (IlepeHTH k  

C T paH H ite ...) tugmasini 
bosamiz, kerakli bo‘lgan 
sahifa raqami kiritiladi va 
OK tugmasiga ikki marta 
bosamiz (3.80-rasm).

PDF Page Seleclor

5elect the Page to Open: lr........... o k .............;l
Page 1 o f2 4

^ | Cancel |

Go to Page...-------------1

3.79-rasm. K o‘p sahifali 
P D F -fay ln i yuklash.

| G o  to Page

1
Go to  Page: |4| OK

Cancel

3.80-rasm. Sahifalar
nomerini kiritish oynasi.
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4. 0 ‘zingizning ix- 
tiyoringizda. Rasterize 
Generic EPS (hjih PDF) 
format (PacTepH3au;HH 
(J>opMaTa Generic EPS 
( h jih  P D F)) m uloqot 
oynasidagi Constrain 
Proportions (CoxpaHHTt 
nponopHHH)ga bayroqcha 
o‘rnating, bu tasvirning 
bo‘yi va eni saqlanishi 
uchun shunday qilinadi 
(3.81—3.82-rasmlar).

5. 0 ‘zingizning ix- 
tiyoringizda. Menyudan 
Width (IIlHpHHa) va 
Height (BticoTa) may- 
donida shunday o‘lcham 
birliklarini tanlang va tas- 
vir o‘lchamini bering.

6. Resolution (Pa3- 
pemeHHe) maydonidan 
sizning tasviringiz uchun ajrataolish qiymatini kiriting. Bu yerda 
tasvimi almashtirmasdan awal qiymatlaming tog‘ri berilishi sizning 
tayyor tasviringiz sifatini yaxshilaydi.

7. Mode (Pokmm) uchib chiquvchi menyudan tasvir rejimini 
tanlang (2-bo‘limdagi «Tasvir rejimlari»ga qarang).

8. Anti-aliased (CrjiaacHBaHHe)ga bayroqcha qo‘ying, bu 
o‘tish notekisliklarni yo‘qotadi va o‘tish chegarasini yumshatadi.

9. OK tugmasini cherting.
Agarda PDF—faylida xavfsizliklar qo‘yilgan bo‘lsa, ularni 

Acrobat Exchange yordamida olib tashlash kerak, keyin faylni 
ochish mumkin bo‘ladi.

PDF va EPS—fayllar tiniq (npoipaH H bin) fonda beriladi. Oq 
fonni olish uchun yangi qatlam yarating, fon rangini oq qiling 
(yoki o ‘zingiz xohlagan rangni tanlang), keyin quyidagi 
buyruqlarni bajaring Layer > New > Background from Layer 
(C jioh > H o bh h  > O oh H3 cjioh).

iR asterize  G eneric PDF Format Bl
ImageSize: I.IM OK

Wldth: 15.38 | cm Cancel |

Height: |23,4Z | cm

Resolution: [0 | pixels/inch

Mode: CMYK Color

W Anti-alia;pd W ConstrainProportions

3.82-rasm. Rasterize Generic PD F 
format muloqot oynasi.

Rasteiize G ene iic EPS Foimat Bl
1 , 1

Image Size: 20K 1 OK 1
Width: 12.54 1 cm '■ l - i

— 1 J : a
Canrel |

Height: |2.54 | cm 

Resolution: | [ 0  | p ixe ls /rch  

Mode: | CMYKColor _*J

Anti-aliased Constrain Proportions

3.81-rasm. Rasterize Generic EPS 
format muloqot oynasi.
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EPS, PDF yoki Adobe Illyustrator dasturining fayllarini 
Photoshop dasturida mavjud bo‘lgan faylda ochish

Sizlar obyektga mo‘ljallangan 
(vektorli) tasvirlarni Photoshop 
dasturida ochmoqchi bo‘lsangiz, 
u holda rastr ko‘rinishiga aylanadi 
va Photoshop dasturidagi fayllar 
formatlariga tushadi. Ajrataolinish 
qancha yuqori bo‘lsa, rendring 
natijasi shuncha yuqori bo‘ladi.

Shu bilan birga Illyustrator 
dasturi oynasidagi konturn i 
Photoshop dasturiga olib o‘tish ham mumkin, bu holda kontur 
yangi qatlamda paydo bo‘ladi.

1. Photoshop dasturidagi tasvirni oching.
2. File > Place (Oanji >

P a 3 M e c T H T t)  m e n y u s i d a n  
b u y r u q n i  ta n la n g .

3. Ochilishi kerak bo‘lgan 
faylni toping va ajrating 
(3.84-rasm). Agarda ko‘p 
sahifali PD F—faylini och- 
moqchi bo‘lsangiz, u holda 
kerakli sahifa tanlanib, OK 
tugmasi bosiladi.

4. Place (Pa3MecTHTi>) 
tugmasini bosing. Tasvirning 
yuqori qismida ramka hosil bo‘ladi. Agarda kerak bo‘lsa, bu 
yangi rasm shu oyna ichidan chiqishi uchun pastga bosing 
(3.85-rasm).

5. 0 ‘z ixtiyoringizda. Quyidagi berilgan buyruqlar ketma- 
ketligini bajaring (Undo buyrug‘i yordamida xohlagancha orqaga 
qaytarsa bo‘ladi).

Rasmning o‘lchamini o‘zgartirish uchun ramkalarning chega- 
ralovchi manipulyatorini torting. Shift tugmasini bosib, tasvimi 
o‘zgartirilgan holda xotirada saqlasa bo‘ladi.

Tavsirni bir joydan ikkinchi joyga surish uchun sichqoncha 
yordamida ramka ichkarisiga cherting va sichqoncha tugmasi bosil- 
gan holda tasvimi boshqa joyga olib o‘ting.

? | x |

OariKa: | Sl Lo_res ~ 3 ®J Ml df\ [ee jf|

Mma cpaSjia: |j | Place

Iwn(pafl/ioe: |ParsableFormats(KAI;".EPS;KPDF;K.PDP) _Hl OTMeHa 

File Size:

3.84-rasm. Place muloqot 
oynasi.

*j

-  PasteAs: 

f* Pixels 

r  Path

r  Shape Layer

3.83-rasm. Paste muloqot 
oynasi.

ZOTZj

Cancel

P aste
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3.85-rasm. Adobe illyustrator dasturida yaratilgan «Delphi» so‘zini, 
Photoshop dasturidagi faylga joylashtirish.

Agarda tasvirni aylantir- 
moqchi bo4lsangiz, kursorni 
ramka tashqarisiga joylashti- 
ring va sichqoncha tugmasini 
bosilgan holda aylantiring. 
0 4qlarga nisbatan aylanitirish 
uchun markaziy nuqtasini ham 
boshqa joyga o4zgartirsa bo4ladi.

6. Tasvirni turgan holatini 
saqlab qolish uchun Enter 
tugmasini bosing yoki che- 
garalovchi ramka ichiga ikki 
marta cherting (3.86-rasm). 

Tasvimi o4chirmoqchi bo4l- 
sangiz Esc tugmasini rastr ko4rinishidagiga almashtirish paytida 
yoki oldin bosish kerak. Agarda bu amal bajarilgan bo4lsa, u 
holda Layers ( C j io h )  palitrasidagi bu qatlamni Trash (Y na jiH T b) 
tugmasiga olib borib tashlang.

3.86-rasm. Photoshop 
dasturiga Illyustrator dasturida 
yaratilgan notalarni o ‘tkazish.
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Fayllarni xotiraga saqlash 

Yangi yaratilgan tasvirlarni xotiraga saqlash

1. File > Save (Oanji > CoxpaHHTb) buyrug4ini tanlang yoki 
Ctrl+S tugmalar majmuasidan foydalaning.

2. File name (Mmm ^anjia) maydonidan fayl nomini kiriting.
3. Faylni diskdagi joylashadigan joyini aniqlab bering. Agarda 

joriy papkadan yoki diskdan boshqa joylarga joylashtirmoqchi 
bo4lsangiz, muloqot oynasining yuqori qismida joylashgan 
menyudan kirib ko4rsating.

4. Save As (CoxpaHHTb xak) uchib chiquvchi menyusidan 
fayl formatini tanlang (3.87-rasm). Agarda tasvir ko4p qatlamli 
bo4lsa, ular Photoshop dasturining formatlari Advanced TIFF va 
Photoshop PDF larda saqlanadi.

5. Save (CoxpaHHTb) guruhiga kerakli bo4lgan bayroqchalami 
qo4ying; shu bilan birga ranglar uchun ham bayroqcha qo4ysa bo4ladi, 
agarda fayldagi profillar mavjud bo4lsa bu Color: Embed Color 
Profile (IjBeT: BcTpoeHHbiH ixbctoboh npo4)Hjib) yordamida 
bajariladi.

JlanKa: 1 1 3  L o _ re s

S) GOOTtif 

S l  60 02 . tif 

3  G 003.tif 

3  G 004.tif 

3 |  G 005.tif 

g |  G00G.tif

<LJ

~zi e J m J
a  G 007.tif B  G013 .tif a  G019.I

S) G 008.tif S) G014 .tif H G020.I

3 G 009.tif S )  G015 .tif B) 6021.1

3 G 010.tif 3 )  601 G.tif B) 6022.1

3| G 011.tif 3) G 017.tif 3) 6023.1

g| G 012.tif S G 018.tif gj 6024.1

Jj
M m 3 cpaflna: 16 0 2 5 .tif | CoKpaHWTb |

-

Form at: T IFF  (K.T IF ;“ .T IFF ) □TMBHa |

m m m ^ m m m m m m m m ib a v e  U p tio n s  

S a ve :

Color:

P h o to s h o p  EPS (K.E P S ) 
P h o to s h o p  D CS 1 .0 r .E P S )  
P h o to s h o p  D CS 2 .0  (K.E PS) 
JP E G  (K.JP G ;“ .JP E G ;K.JP E) 
P h o to s h o p  P D F  (K.P D F ;K.P D P ) 
R a w  (K.R A W )
S c ite n  CT (K.S C T)
T IF F  (K.T IF ;K.T IF F l

I IL L  Mrofile: U . b . W e b  L o a te d  (b W U h 1) w l

W  J h u m b n a il P ” U se  L o w e r C ase E n te ns ion

3.87-rasm. Save As muloqot oynasi. 
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6. Save (CoxpamrrL) tugmasini bosing.
Qatlamga ega tasvirlarning nusxalari qatlamlarsiz avtomatik 

tarzda saqlanishi uchun Maximize backwards compatibility in 
Photoshop formats (MaKCHMajiLHaa coBMecTHMocTL 4)opMaTOB 
Photoshop) ga bayroqcha qo‘yilishi kerak. Bu amal tasvirni boshqa 
qo‘shimchalarga export qilinishda qo‘l keladi.

Qatlamlar, vektorlar va effektlarni saqlash

Faqat Photoshop formatlarining ichida, Advanced TIFF — 
Photoshop PDF yordamida quyidagi elementlar saqlanadi:

• Bir nechta qatlamlar va qatlam tiniqligi;
• Tuzatish mumkin bo‘lgan qatlamlar;
• Muharrirlashning matn qatlamlari;
• Qatlam effektlari;
• To‘rlar (setka) va yo‘naltirilgan chiziqlar;
• ICC—ranglarni boshqarish profili (PICT, JPEG, DCS va 

EPS formatlarida), shu bilan birga profillar ham saqlanadi;
• Lab tasviriy rejimlari (EPS va DCS formatlarida rejimning 

o‘zini ham saqlaydi).
Duotone rejimidagi tasvir Advanced TIFF formatida saqlana 

olmaydi.
Qatlamlarni tasvirlarning nusxasi tarzida birlashtiring, bu 

original tasvirda bo‘lmasin, keyinchalik ko‘p qatlamli tasvirlar bilan 
ishlash mumkin bo‘ladi.

Save (CoxpaHHTb) buyrug‘i bajarilganda oldingi tasvirning 
nusxasini yangisi bilan almashtiriladi.

Mavjud bo6lgan tasvirlarni saqlash

Tasvirni saqlash uchun File> Save (Oanji > CoxpaHHTb) 
buyruqlarini tanlang yoki Ctrl+S tugmalar majmuasidan foydalaning.

Oxirgi saqlangan nusxasini qaytarish

File > Revert (Oanji > 06paTHTL) buyrug‘ini bajarish 
natijasida, hujjatning saqlangan oxirgi versiyasini orqaga qaytaradi. 
History (Mctophh) palitrasi bo‘lsa, bir nechta amallarni orqaga 
qaytarish imkoniyati bor. Uning sherigi — History Brush (Boc-
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CTaHaBjiHBaiomafl k h c tl ) asbobi bo‘lib, bu — tasvirning ba’zi bir 
joylarini qayta tiklash amalini bajaradi. Revert buyrug‘i History 
panelida alohida voqeaga bo‘lib beriladi, demak, bu amalni xohlagan 
paytda oldin bajarilgan voqealami bosib orqaga qaytarish mumkin.

Tasvirning yangi versiyasini saqlash

Save As (CoxpaHHTb Kax) buyrug‘idan foydalanib, tasvimi boshqa 
rejimda saqlash mumkin yoki dizayn variatsiyasi uchun nusxadan 
foydalansa bo‘ladi. Masalan, tasvirni CMYK versiyasida saqlash 
mumkin, berilgan tasviming o‘zini RGB rejimida qoldiramiz.

1. File > Save As ( O a n n  >  CoxpaH H Tb Kaic) b u y r u g ‘in i ta n la n g  
y o k i Ctrl-H Shift+S tu g m a la r  m a jm u a s id a n  fo y d a la n in g .

2 . F a y lg a  y a n g i n o m  b er in g  y o k i o ld in  b er ilg a n  fa y l n o m in i  
o ^ z g a r tir in g . Bu a m a l File name (H m h  ( J m H J i a )  ( 3 .88- r a s m )  
m a y d o n id a n  k ir itilad i. Use Lower Case Extension (P acn iH peH H e  
CTpOHHbiMH 6yKBaMH) g a  b a y r o q c h a  q o ‘y s a n g iz , u h o ld a  fa y l  
k e n g a y tm a s i k ic h k in a  h arflar b ila n  y o z ila d i.

JlanK a: Samples

Z ]  Droplets

Z ]  Im ageReadv Animations 

^Bannerpsd 
^ E a g le .p s d  

^FIowerpsd 
HarvesLpsd

3  s j
^ M o r n in q  Glass.psd 

^ jP ic c o lo  site.psd 

^ P o s tc a rd .p s d  

Ranoh House.psd 

^ jT o m a to .p s d

Ranch House.Mm3 cpaflna:

Format: | Photoshop (K.PSD;K.PDD)

Save Options 
Save:

Color:

CoKpaHWTb

OTMeHa

r  Ih u m b n a il

r~ As a Copi! r~ Annotations

r~ A I|^H C hanne ls  | ~  Spot Colors

Layers

Use Proof Setup: W ork ing  CMYK 

F  ICC Profile: Grayscale ■ Gamma 2.2

F  Use Lower Case Extension

3.88-rasm. Save As muloqot oynasi. 
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3. Tasvirni yangi versiyasi saqlanadigan papkani tanlang.
4. Save As (CoxpaHHTi> Kaic) uchib chiquvchi menyudan 

faylning boshqa formatini tanlang. Bunda faqat tasvirning joriy 
rejimiga tegishli formatlar bilan ishlash mumkin.

Agarda tanlangan format ko‘p qatlamli bo‘lmasa, u holda Layers 
(C jio h ) opsiyasi bilan avtomatik tarzda ishlash mumkin bo‘lmay 
qoladi, saqlangan tasvir bitta qatlamli bo‘ladi.

5. Save (CoxpaHHTfc) va Embed Color Profile (Bctpohti> 
HBeTOBOH npo(f)HjTb) guruhlariga o‘zingiz xohlasangiz bayroqlar 
qo‘ying, agarda bu opsiyalar bilan ishlash mumkin bo‘lsa.

Save As a Copy (CoxpaHHTt b  BHjie KonHH)ga bayroqcha 
qo‘ying, bu fayl nusxasini olib qo‘yadi va original tasvir bilan 
ishlashni davom ettiradi.

6. Save (C oxp aH H T t) ga sichqoncha bilan cherting. Agarda siz 
boshqa formatlar bilan ishlamoqchi bo‘lsangiz Adobe Photoshop- 
dan ma’lumotnoma olishingiz mumkin. Yangi fayl versiyasi ochiq 
ko‘rinishda qoladi, joriy tasvir yopiladi.

Agarda siz fayl nomini o‘zgartirmoqchi bo‘lsangiz, faqat Save 
(CoxpaHHTt) tugmasi chertilgan bo‘lsa, u holda eslatma oynasi 
paydo bo‘ladi. 0 ‘zgartirmoqchi bo‘lsangiz Replace (3aMeHHTB)ni 
cherting yoki Cancel (OTMeHa)ni cherting, bu amal oldingi 
muloqot oynasini Save As (CoxpaHHTt KaK)ga olib keladi.

3.4. Rastrli tasvirlar haqida tushunchalar

Bu dasturda esa tasvirning o‘lchamini, ajrataolishni qanday 
o‘zgartirish, tasvirni kesib olish, tasvirlarni qanday aylantirishga 
to‘xtalib o‘tamiz.

Photoshop dasturidagi o‘lchamlarni o‘zgartirganda joriy bo‘lgan 
tasvirni ham  saqlab qolish m um kin (Resample Image 
(OTCjiexHBaTB H3MeHeHH5i) ga bayroqcha qo‘yilishi kerak), bunda 
o‘lchamlari o‘zgartirilgan tasvirning aniqligi yo‘qoladi. Mana shuning 
uchun tasvirlarni bir xil o‘lchamdagi tasvirlar bilan ishlashda 
skaner qilish kerak yoki o‘sha o‘lchamdagi tasvirlar bilan ishlash 
kerak. Agarda interpolyatsiyadan qochib bo‘lmasa, u holda ishning 
oxirida tasvir aniq bo‘lishi uchun Unsharp Mask (MacKa 
H epe3K O C T H ) filtridan foydalaning («Unsharp Mask filtrini 
qo ‘ llanishi»ni qarang).
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Image Size

Pixel Dimensions: 628K (was 628K) 

Width: |490 | pixels

Height: [328 | pixels
] OK

Reset

Auto...

Document Size:

Width: |17,28

Height: |11,57

Resolution: 72

cm

cm

pixe ls/inch

Constrain P roportions

W jResampie jmage:! Bicubic

3.89-rasm. Image Size oynasi.

Bosmaga chiqarish oldidan (asvirlar 
o‘lchamlarini o‘zgartirish

l.Im age > Image Size (H 3o6paaceHHe > Pa3Mep 
H3o6pax<eHH5i) menyusining buyruqlarini tanlang.

2. Constrain Proportions (CoxpaHHTb nponopuHH)ga bayroqcha 
qo‘ying, agarda tasvir eni uzunligini nisbatlarini saqlash kerak 
bo‘lsa (3.89-rasm). Agarda enini uzunligiga bog‘liqsiz turda 
o‘zgartirmoqchi bo‘lsangiz bayroqchani olib tashlang.

3. 0 ‘z ixtiyoringizda. Tasvirni ajrataolishni saqlash uchun 
Resample Image (O t c j t ex<hBaTb H3M eHeHH5i)ga bayroqcha qo‘ying.
3.90-rasmda berilgan interpolyatsiya usullaridan bittasini tanlang: 
N earest Neighbour ( E j m x a i i i i i H H  coce/i), Bilinear 
( B n j iH H e H H b iH )  yoki Bicubic (E H K y 6 H H e c K H ii) .  Bikibik 
interpolyatsiya tasvirining sifatiga kamroq ta’sir qiladiganlar turiga 
kiradi.

4. Uchib chiquvchi menyudan Width (IIlHpHHa) va Height 
(BbicoTa)dagi qiymatlarni tanlang, Document Size (Pa3Mep 
AOKyMeHTa) guruhida joylashgan bo‘ladi va bu qiymatlar o‘lcham 
birliklari turini bildiradi.
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Image Size xJ

Pixel Dimensions: 628K

Width: |100 | percent

Document Size: 

Width: |49CT

Height:

Resolution:

| points

|27 ,33  | picas

|28 ,346  | p ixe ls/cm

F  Constrain Proportions 

Resample image: | Eicubic

Height: flOO | percent ^
]s

3  - |

OK

Reset J
Auto...

J.90-rasm. Image Size oynasidagi bayroqchalarni o ‘rnating.

5. Berilgan Width (IIlH pH H a) va Height (B b ico T a )g a  yangi 
tasviming eni va uzunlik qiymatlar sonini kiriting. Agarda Resample 
Image (OrcjiexHBaTb H3MeHeHH5i)ga bayroqcha qo4yilmagan bo4lsa, 
ajrataolish o4zgaradi.

6. OK tugmasini bosing.
A gard a a w a lg i  p a ra m etr la m i q ayta  t ik la m o q c h i b o 4lsa n g iz , Image 

Size (Pa3M ep H 3o6p axeH H 5i), A lt  tu g m a s in i v a  b ir  p a y td a  Reset 
(BoccTaHOBHTb) tu g m a s in i b o s in g .

Shu bilan birga tasvirni bosmaga chiqarishdan oldin o4lcham 
birliklarini o4zgartirish uchun quyidagi oynadan foydalansa bo4ladi, 
bu oyna File > Print with Preview ( O a n j i  > I le H a T b  c 
npe^B apH TejibH biM  np0CM 0Tp0M ) buyruqlari yordamida chaqiriladi, 
faqat tasvir ajrataolishi o4zgaradi.

Bosmaga tasvirni chiqarishdan oldin ko‘rish

Bosmaga chiqariladigan tasviming o4lchamlari qog4oz o4lcham- 
lari bilan mos kelishi uchun sichqonchani oynaning pastki qismida 
joylashgan holat satriga olib borib bosib turing yoki menyudan 
File > Print with Preview (OaHJi > IleHaTb c npe^BapHTejibHbiM
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np0CM0Tp0M) buyruqlarini tanlang. Agarda 
ekranda bosmaga qanday holda chiqarilishi 
kerak bo4lganini chiqarmoqchi bo4lsangiz, 
View > Print Size (Bh,zi > Pa3Mep npH 
nenaTH) buyruqlaridan foydalaning.

Yuqori ajrataolish

Skaner qilingandan keyin tasvir piksel- 
lar to4plamidan iborat bo4lib, uni bosmaga 
chiqarishda o4lchami va ajrataolishi bilan 
bog4liq bo4ladi. Agarda ajrataolishda yoki 
tasvir o4lchamlari o4zgarganda piksellar soni 
saqlanadigan bo4lishi uchun Image > 
Image Size (H3o6paxeHHe > Pa3Mep 
H3o6paxeHH5i)dan Resample Image 
(OTCJiexHBaTb H3MeHeHH5i) bayroqchasi 
olib tashlangan bo4lsa. Agarda bu bayroqcha

3.91-rasm. Bosmaga qo4yilgan bo 4lsa, tasvirni bosmaga
Chtasv\mT kô rishdin chicLarishda ajrataoUshning ko‘payib ketishiga 

va tasvir o4lchamining kamayib ketishiga olib 
keladi (1-dyuymdagi piksellar soni) yoki teskari holat bo4lishi 
mumkin.

Agarda faylda ajrataolish keragidan katta bo4lsa, u holda (rastr 
lianiturasidan ikki marta katta bo4lsa), qo4shimcha piksellarni 
Document Sizeda, Resample Image (T e n e p b  n iH pH H a, B bicoT a h  

p a 3 p e m e H H e  B3aHM03aBHCHMbi) bayroqchasini olib tashlab 
joylashtirsa bo4ladi va oxirida ikki karra katta bo4lgan ajrataolishni 
kamaytirsa bo4ladi. Tasvirning eni, bo4yi avtomatik tarzda 
kattalashadi, faqat piksellar soni va fayl o4lchami o4zgarmaydi, 
tasvirdan bitta ham piksel qo4shilmaydi yoki olib tashlanmaydi. 
Agarda tasvir o4lchamlarini kattalashtirmoqchi bo4lsangiz, Resample 
Image (O t c jiexHBaTb H3MeHeHH5i) bayroqchasini qo4ying va Width 
(II lH p H H a ) dan qiymatlarni kiriting. Balandlik qiymati proporsional 
ko4rinishda o4zgaradi, fayl o4lchami va piksellar soni ortadi, faqat 
buning uchun interpolyatsiya kerak bo4ladi, shuning uchun OK 
tugmasini bosgandan keyin tasvirning ravshanligini orttirish kerak, 
Unsharp Mask (Maci<a Hepe3K0CTH) filtridan foydalaning.

\Be
N e w ...

□  pen... 

B rGw se... 

O p e n  A s ...

□  p e n  R e c e n t

Ctrl+N

C trl+ 0

Sh ft+C trl+O

A lt+ C tr l+ 0

►

C lose C trl+ W

S a v e Ctrl+S

S a v e  A s ... S h ft+C trl+S

S a v e  for W e b . .. 

R e v e rf

A lt+ S  h f t+C trl+S

P la ce ...

Im port ►

Enport ►

W o rk g ro u p ►

A u to m a te ►

File In fo ...

P a g e  S e tu p ... S h ft+ C tr l+ P

P rin t w ith  P re v ie w...  C trl+P

Print... A lt+ C tr l+ P

P rin t O n e  C opi) A lt+ S  h f t+C trl+P

J um p T o ►

Ewit Ctrl+Q
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Tasvirda ajrataolishni o ‘zgartirish

Agarda ajrataolishni ko‘paytirsak, ya’ni Resample Image 
(0TCJie3CHBaTL M3MeHeHMH) bayroqchani qocyib interpolyatsiya 
qilinsa, yangi piksellar qocshiladi, tasvirning fayl olchami katta- 
lashadi, faqat sifati pasayadi. Agarda ajrataolishni kamaytirsak, u 
holda fayldan ma’lumotlar yocqoladi, faqat uni qayta tiklash uchun 
History palitrasidan faylni yopishga qadar tiklash mumkin. 
Tasvirdagi interpolyatsiyadan keyin yuvilgani faqat bosmaga 
chiqarilganda bilinadi, ekranda uning farqi bilinmaydi. Mana shulami 
e’tiborga olib tasvirlarni skaner qilish yoki mos olchamda olish 
tavsiya etiladi.

1. Image > Image Size ( H 3 o 6 p a 3 c e H n e  >  P a 3 M e p  
M3o6pa>KeHMH) m e n y u s in in g  b u y ru q la r in i b ajaring.

2. Tasvirning eni, uzunligi haqidagi ma’lumotlarni saqlash 
uchun  (eni va b o cyi), Resample Image (OTCJie^HBaTL 
H3MeHeHHH)ga bayroqcha qocying (3.92-rasm). Agarda tasvirdagi 
piksellar sonini saqlamoqchi boclsangiz bayroqchani olib tashlang. 
Balandligi va eni oczgaradi, faqat piksellarning umumiy soni 
saqlanadi.

3. Resolution (P a 3 p e m e H H e ) m a y d o n ig a  q a n d a y d ir  q iy m a t  
b er in g .

4. OK tugmasini bosing.

1 Im age S iz e E
nxe i uimensions: 1 1

Width: ESE Reset

i ,J«
Height: | 3 2 S pixels Auto...

UULUI1 Itl II Dlde.

Width: 17,29 l c m  H n

liffl 1
Height: 11,57 1 cm H J "

1
Resolution: |72 1 pixels/inch

1
W ^ js t r a in  Proportions 

R Resample jmage: | Bicubic _▼]

3.92-rasm. Resample Imageda bayroqchasi tasvir 
interpolyatsiyasini boshqaradi.
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History Brush ( B o c c T a H a B j r a B a i o m a H  k h c t l )  asbobi 
interpolyatsiya qilingandan keyin ishlamaydi. Joriy holdagi tasvir 
bu asbob uchun awaldan berilgan qiymat bolib hisoblanadi.

Berilgan oichamga tasvir oichamini olib kirish

Fit Image (noflomaTL H3o6pa3ceHHe) buyrug‘i tasvirning 
ajrataolishga hech qanday ta ’siri bo ‘lmaydi, faqat uning 
olchamlariga ta’siri bor.

Tasvir oclchamlarini 
kichiklashtirmoqchi bol- 
sangiz mana shu buyruq- 
dan foydalaning.

1. File > Automate > 
Fit Image (O anji >
ABTOMaTHHeCKH > IIo- 
flO T H aT L  H 3 0 6 p a 3 C e H H e )  
buyruqlarin i tanlang 
(3.93-rasm).

2. Tasviming eni va balandligini piksellarda bering. Boshqa 
maydonlarga avtomatik tarzda tuzatish kiritiladi, bular faqat O K  
tugmasini bosgandan keyin bajariladi, shunday qilib, balandligi va 
eni saqlanib qolinadi.

3. OK tugmasiga cherting.

Tasvirning oichamlarini avtomatik tarzda o ‘zgartirish

Resize Image (H3MeHHTL pa3MepLi H3o6pa>i<eHHH) buyrugci 
tasvirning nusxasini avtomatik tarzda nusxalaydi va nusxani 
olchamlarini avtomatik tarzda oczgartiradi. Siz faqat ketma-ket 
berilgan qiymatlarni kiritishingiz kerak, qolgan ishni Photoshop 
dasturining oczi bajaradi.

1. Help > Resize Image (IIoMomL > H3MeHHTL pa3MepLi 
H3o6pa>i<eHHH) menyusidan buyruqlami tanlang.

2. Octkazgichni Print (TtenaTL) yoki Online (OHjiaHH)ni 
qocying, 3.94-rasmda kocrsatilganday qilib, Next (flajiLine) 
tugmasini bosing.

3. Kerakli bolgan bosmaga chiquvchi tasvir oclchamini bering 
(3.95-rasm), keyin Next (flajiLine) tugmasini bosing. Agarda oldingi 
qadamda Online rejimi tanlangan boclsa, Finish ( T o t o b o )  tugmasiga
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1 F il Image
— rn n d ra in  Within

OK
W idth: |J@ | p ixels

Cancel
H eight: |3 2 8  pixels

3.93-rasm. Fit Image oynasining 
buyruqlari.



sichqoncha bilan cherting. Tasvirni bosmaga chiqarish uchun 
qolgan amallarni bajaring.

Resize Image W izard

This w izard w iil help you to  resize your image using the 
appropriate resolution.

What w ill this image be used for?

Print 

C  Online

Cancel Back Next

3.94-rasm. Bosmaga chiqarishni tanlash (ekranga 
yoki printerga).

Resize Image W izaid

What is the desired size o f the image?

Width: |21 ,17  fcm  3

Height: |2 1 J 7  [cm ^ ]«

Cancel Back Next

3.95-rasm. Bosmaga chiqarishda o‘zimiz xohlagan tasvir 
olcham larini kiritish.
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4. Ko‘rsatilgan qiymatlarni belgilang yoki bosmaxona ko‘rsat- 
masi bo‘yicha boshqa lianitura rastrini kiriting (3.96-rasm), keyin 
Next (flajibine) tugmasini cherting.

5. Tasvir sifatini tanlash Quality (KanecTBo)da bajariladi, 3.97- 
rasmda berilgan va tasviming natijaviy o‘lchamlariga e’tibor bering, 
bu esa Results (Pe3yjibTaT) maydonidan beriladi. Agarda keyinchalik 
qandaydir bir ma’lumot berilgan bo‘lsa, uni o‘qish lozim. Agarda 
davom ettirmoqchi bo‘lsangiz Next (flajibine) tugmasini cherting.

6. Oxirida Finish (IbTOBo) tugmasini cherting (3.98-rasm) va 
tasvimi xotirada saqlab, tasvirning olchamlarini o‘zgartiring. Agarda 
bekor qilmoqchi bolsangiz Cancel (OTMeHa) tugmasini bosing.

R esize Im age W izard

W hich ha lfto ne  screen (LPI) w il l  be used to  p rin t y o u r image?

C  65  

C  B5 

^  1 3 3  
C  150 

C  2 0 0  

C  O the r [

D e scrip tion

Appropriate fo r  \veb p rin ting , ve e k iy  magaEine, etc.

Cancel Back Next

3.96-rasm. Rastr lianiturasini tanlash.

Resize Im age W izard

What level o f  im age qua lity  w o u ld  you like?

1.5xLower Q uality 1 x 
Smaller File

Results
Original Image Size: 1055k

New Image Size: S139k

Pixels Per Inch: £00

2 x  Higher Quality 
Larger File

The new file is la rger than the original which -will 
f \  resu lt in a lo v e r  quality image. For best re su lts , 

rescan at a higher resolution.

Cancel Back Ne:-:t

3.97-rasm. Kerakli bolgan sifatni tanlash. 
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Resize Image Wizard

You have now CGmpleted the Resize Image Wizard.

Your image has been resized and the file has been duplicated.

If you would like to sharpen the focus o f your image, go to the 
Filter menu and choose Unsharp Mask from  the Sharpen section.

3.98-rasm. Tasvir o ‘lchamlarini o ‘zgartirishni yakunlash.

3.99-rasm. Tasvir aniq ko‘rinishda berilgan.

Unsharp Mask filtridan foydalanish

Agarda tasvir o‘lchamlarini yoki ajrataolishni o‘zgartirgan 
bo‘lsangiz, Resample Image (OrcjieacHBaTb H3MeHeHHH)da bayroqcha 
mavjud bo‘lgan bo‘lsa va keyin tasvimi CMYK rejimiga o‘tkazsangiz
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yoki tasvirdagi o‘zgartirishlarni (transformatsiya) amalga oshirsangiz, 
u holda interpolyatsiya natijasida tasvir aniqligi yo‘qoladi. Berilgan 
Unsharp Mask (Macica Hepe3KOCTH) filtri yordamida fokusirovka 
effekti qilinadi. Bu filtr ikkita qo‘shni nuqtalar orasidagi kontrast- 
likni orttiradi (ko‘paytiradi), agarda ular bir-biri bilan kontrastlikda 
bo‘lsa. Filtrning keyingi parametrlarini ham ko‘rsatsa bo‘ladi: 
ravshanlik parametrini oshirish Amount (KojmnecTBo) yordamida; 
kontrastni oshirish uchun har bir nuqta atrofidagi nuqtalar sonini 
oshirish (parametr Radius (Pa^nyc)); filtrning qaysi nuqtalarga 
ta’sir qilishini va qaysilariga ta’sir qilmasligini aniqlash uchun joriy 
kontrastlikning minimal ko‘rsatkichini ko‘rsatish kerak (parametr 
Threshold (Ilopor)).

Filtmi Unsharp Mask qoTlash effekti ekranda bilinishi mumkin, 
yuqori ajrataolishli printerlarda esa u sezilmaydi.

1. Filter > Sharpen > Unsharp Mask ( O h j ib tp  >  Pe3KOCTb >  
H e p e 3 K o e  M acK H p o B aH H e) menyusining buyruqlarini tanlang 
3.99-rasm.

2. Amount (K o jm n e c T B o )  
filtri, p iksellar orasidagi 
kontrastlik qanchaga kattala- 
shishini ko‘rsatadi (3.100-rasm). 
F iguralar yoki obyektlar 
uchun kichkina son tanlang 
(50 dan kichik boTsin); agarda 
tasvirda chegaralari aniq bo‘lgan 
obyektlar bor boTsa, kattaroq 
sonni koTsating. Son kattalashib 
ketsa, u holda yuqori kontrastli 
sohalarda oreol paydo boTadi 
(3.101-rasm). Tasvir oTchami 
katta boTgani sari aniqlikni 
kamroq o ‘zgartirish kerak. 
Yuqori ajrataolishli tasvirlar 
uchun Amount (K o jiH n ecT B o ) 
parametr qiymatini 150 dan 
200 % oraliqda oling.

3. Radius (Pa^nyc)ning qiymatlarini tanlash birmuncha qiyin 
boTadi: tasvirning natijaviy oTchamini, ajrataolishini va tasvirda 
nima berilganini aniq berish lozim. Radius parametrining qiymatini 0,1

3.100-rasm. Unsharp Mask 
filtrining parametrlari.

Unsharp Mask

Ih resh o ld : |oj levels

Radius: 11,5 pixels

W P rev iew
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3.101-rasm. Har xil oreollarning chegaraga yaqin joylarda paydo bo‘lishi 
va ranglar markazining Unsharp Mask filtrida Amount—160%, 
Radius—1,5, Threshold — O qiymatlari berilganda o ‘zgarishi.

dan 250 gacha diapazonda berish 
kerak va shu bilan birga chegaraga 
yaqin joylardagi yuqori kontrastli 
joylarning qiymatlarini to4g4ri 
bering. 1 va 2 qiymatlaridan 
boshlab ko4ring. Katta sonlar 
kontrastligi yuqori joylarning 
kontrastligini yanada oshiradi 
(3.102-rasm).

Tasvimi ajrataolish qancha 
yuqori, nuqtalar soni esa qancha 
ko4p bo4lsa, yuqori kontrastli 
sohalarga o 4tish  chegarasi 
shunga mos holda radiusning 
katta qiymatini talab qiladi. 
Kontrastligi past bo4lgan tas- 
virlar uchun katta qiymatli ra- 

dius bering va kichik qiymatni murakkab bo4lgan yuqori kontrast- 
dagi tasvirlarga berib ko4ring.

Radius qiymati qancha katta boMgani sari Amount parametr 
qiymati shuncha kichik va teskari bo4ladi.
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3.102-rasm. Unsharp Mask filtrini Amount — 130%, Radius — 6,0, 
Threshold — O qiymatlarini o ‘zgartirish natijasida kontrastligi 

va ravshanligi.

4. Threshold (ITopor) parametrining qiymatlarini b  zinana- 
30H e 0 dan 255gacha diapazondan tanlansa minimal kontrastli tasvir 
uchun soha o4zgartirilmasdan oldingisi olinadi. Agarda 0 ko4rsa-

_d 100M jJ
Amount: fl60 %

= 5
Radius: [L5  pixels

W j -----
Ih resho ld : [T s j levels

■—6 =

tilsa, filtmi hamma tasvirlarga 
ishlatsa bo4ladi. Agarda qiymati 
0 dan katta bo4lsa, yuqori 
kontrastli joylaming chegaraga 
yaqin joylarida ravshanlik 
yuqorilashadi va past kont- 
rastlilarda ravshanlik kam 
miqdorda o4zgaradi. Agarda 
Threshold (Ilopor) parametr 
qiymatini o4zgartirsak, Amount 
(KojimecTBo) va Radius (Pa- 
j\nyc) param etrlar qiymat- 
larining kasrida bo4ladi, bunda 
chegaraga yaqin joylardagi 
kontrastlikni orttiradi. Qan- 
qaydir nosozliklami (SHUM)
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3.103-rasm. Unsharp Mask filtrini Amount — 160%, Radius — 1,5, 
Threshold — 15 qiymatlari bilan o‘zgarganda ranglaming yumshoq 

shaklga (MarKHH) o‘tishi.

yocqotish uchun Threshold (Ilopor) parametr qiymatlarini 8 va 
20 orasida berish kerak (3.103-rasm).

5. OK tugmasiga sichqoncha yordamida cherting.
Skanerlangan tasvirdagi don shaklidagi nosozliklarni yocqotish 

uchun Filter > Blur > Gaussian Blur (OnjrbTp > Pa3MbiTHe > 
PasMbrme no Tayccy) filtrini kichkina qiymati bilan octing (1 dan 
kichik) va keyin bir yoki ikki marta Filter > Sharpen > Sharpen 
Edges (OmibTp > Pe3KOCTb > Pe3KOCTb KOHTypOB)ni ishlating, 
bu tasviming yanada aniq chiqishini ta’minlaydi.

Unsharp Mask filtrini ishlatgandan keyin katta tasvirlardagi 
filtrni ishlatib, ekranda kocrish uchun kutishga majbur boclamiz, 
shunday boclmasligi uchun oldin tasvir chiqadi va oyna oclchami 
beriladi, keyin Preview (npe^B apH T ejibH biH  n p 0 CM0 Tp) ga 
bayroqcha qocysangiz, katta ekranda chiqarib berib, kerakli boclgan 
qiymatlarni muharrirlasa bocladi.

Unsharp Mask filtrini bir yoki bir necha rangli kanallarda qocllab 
kocring (masalan, RGB—tasvirida qizil, yashilga). Ikkita kanalda 
ravshanlikni oshirib, bir xil radiusli qiymatni bering. Tasvirni Lab 
rejimiga ham olib octsa bocladi va L kanaliga filtr qocysa bocladi, u 
yorugclikni oshiradi, bunda rang piksellari oczgarmaydi.
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